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CẨN THẬN 
(Luôn đọc hướng dẫn trước khi sử dụng sản phẩm.) 

 

Khi thiết kế hệ thống, luôn đọc tài liệu liên quan và cân nhắc cẩn thận đối với vấn đề an toàn. 

Trong phần này, cần chú ý đến những điểm sau và sử dụng sản phẩm thật cẩn thận 

 

[CHÚ Ý KHI THỰC HÀNH] 

CẢNH BÁO 

Không chạm vào tiếp điểm khi vẫn đang cắm điện để tránh bị điện giật 

 

Trước khi mở vỏ bọc an toàn, chắc chắn tắt nguồn hoặc đảm bảo an toàn 

 

Không chạm vào bộ phận di chuyển   

 

CẨN THẬN 

Làm theo chỉ dẫn của người hướng dẫn 

 

Không tháo rời khối module của máy hoặc thay đổi đấu nối điện mà không có sự đồng ý của hướng dẫn. 

Làm như vậy có thể dẫn đến hỏng, trục trặc, khiến bản thân bạn bị thương hoặc hỏa hoạn 

 

Tắt nguồn điện trước khi lắp vào hoặc tháo khối module ra. Không làm theo có thể 

dẫn đến sự cố hoặc điện giật 

 

Khi thiết bị Demo (ví dụ như bảng X/Y) phát ra những âm thanh/mùi bất thường, ấn vào “Power switch” hoặc 

“Emergency switch” để ngắt nguồn 

 

Khi có vấn đề xảy ra, thông báo cho người hướng dẫn sớm nhất có thể 
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GIỚI THIỆU 

 
Quyển sách này nói về bộ điều khiển khả trình, phương pháp chỉnh sửa chương trình với GX 

Works2, hướng dẫn bên dưới và hướng dẫn ứng dụng để hiểu lập trình MELSEC-Q series. 

Hệ thống nhiều CPU khả dụng cho series MELSEC-Q với nhiều khối module CPU, nhưng 

quyển sách này chỉ nói về trường hợp một module CPU được sử dụng. 

 

 
 

(1) QCPU User's Manual (Hardware Design, Maintenance and Inspection) 

·····························································································SH-(NA)080483ENG 

Explains the hardware. 

(2) QnUCPU User's Manual (Function Explanation, Program Fundamentals) 

·····························································································SH(NA)-080807ENG 

Explains the functions and programming method. 

(3) MELSEC-Q/L Programming Manual (Common Instruction) 

·····························································································SH(NA)-080809ENG 

Explains details of each instruction. 

(4) GX Works2 Beginner's Manual (Simple Project) 

·····························································································SH(NA)-080787ENG 

(5) GX Works2 Version 1 Operating Manual (Common) 

·····························································································SH(NA)-080779ENG 

(6) GX Works2 Version 1 Operating Manual (Simple Project) 

·····························································································SH(NA)-080780ENG 

(7) Before Using the Product 

··········································································································· BCN-P5782 

(8) Analog-Digital Converter Module User's Manual 

·····································································································SH(NA)-080055 

(9) Digital-Analog Converter Module User's Manual 

·····································································································SH(NA)-080054 

(10) I/O Module Type Building Block User's Manual 

·····································································································SH(NA)-080042 
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Những tài liệu liên quan có thể xem dưới đây: 
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“Rơle”, còn được gọi là rơle điện từ, là một bộ chuyển để chuyển sang tín hiệu rơle. Rơle là thành phần quyết định để 

tạo nên một thang logic. 

 1) Cấp điện cuộn dây  Tạo từ trường 

• Tiếp điểm thường mở đóng  (dẫn 

điện) 
 •  Tiếp điểm thường đóng 

     mở 

2) Ngắt điện cuộn dây 

Giải từ trường 

• Tiếp điểm thường mở mở (không    

dẫn điện) 

• Tiếp điểm thường đóng đóng lại. 

(dẫn điện) 

Cuộn 

dây 
 

Tiếp điểm 

thường đóng 
Tiếp điểm 

thường mở 

CHƯƠNG 1  CƠ BẢN VỀ BỘ ĐIỀU KHIỂN KHẢ TRÌNH 

 
1.1 Chương trình 

 

Nếu 1 bộ điều khiển khả trình là một mạch điều khiển hình thang. Nó được miêu tả bởi 
đầu vào ladder, đầu ra ladder, và các hoạt động tuần tự bên trong 

 
Hình 1.1 Cấu hình bộ điều khiển khả trình 

 

Một bộ điều khiển khả trình là thiết bị điện trung tâm giống như máy tính siêu nhỏ. Thực 

tế, một bộ điều khiển khả trình là tổ hợp của rơle, bộ định thời, và bộ đếm. Như hình 1.1, 

hoạt động tuần tự bên trong được thực thi bởi việc bật hoặc tắt cuộn dây. Bật/tắt của 

cuộn dây phụ thuộc vào điều kiện kết nối  (theo nối tiếp hay song song) và dẫn đến công 

tắc mở hay công tắc đóng. 

 
 

 
 
 
 

PLC 

PB1 X6 T1 
Y70 

X0 Y74 PL 

Y71 
LS1 X1 Rơle đầu ra 

Y74 
Y72 

X2 

Y73 
 

Y74 

Van điện  
trường 

MC 

Tiếp điểm 
từ trường 

X3 K30    
PB2 Y74 X6 

X4 T1 

Y75 
X5 Bộ 

định 
thời 

Sensor Y76 
X6 

Rơle vào 
(cuộn dây ảo) 

Tiếp điểm 
cho đầu ra 
ngoài 

COM COM 

(+) (-) 

Mạch vào Mạch ra Hoạt động tuần tự nội Module đâu ra Module đầu vào 

Bật/tắt rơle đầu 
vào với tín hiệu 
ngoài 

Kích hoạt hoạt 
động tuầnt tự nội 
bởi tiếp điểm rơle 
đầu vào. 

Truyền hoạt động 
bật/tắt của rơle đầu 
ra. 

Kích hoạt tải 
ngoài. 

 
Chân 
chung 

Cuộn dây 
bật 

Cuộn dây tắt 

Tiếp điểm 
thường mở 

Tiếp điểm 
thường đóng 

Không dẫn 

Không dẫn 
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Dưới đây là chu trình tín hiệu của hoạt động tuần tự bên trong của hình  

1.1 

1) Khi cảm biến bật lên, cuộn dây của rơle đầu vào X6 bị nhiễm từ 

2) Cuộn dây của rơle đầu vào X6 nhiễm từ dẫn điện cho tiếp điểm thường 

mở X6 và cuộn dây của rơle Y74 nhiễm từ. (bộ định thời không bị nhiễm 

từ ở thời điểm này, tiếp điểm thường đóng vẫn dẫn điện). 

3) Vì cuộn dây của rơle Y74 bị nhiễm từ, tiếp điểm lối ra ngoài Y74 dẫn 

điện và tiếp điểm từ (MC) được bật lên 

4) Tắt cảm biến đi giải từ hóa cho cuộn dây của rơle đầu vào X6 và tiếp 

điểm thường mở X6 trở nên không dẫn điện. 

Vì tiếp điểm thường mở Y74 vẫn duy trì dẫn điện, cuộn dây vẫn bị nhiễm 

từ (hoạt động tự duy trì) 

5) Khi cuộn dây của rơle đầu ra Y74 bị từ hóa (với tiếp điểm thường mở 

Y74 dẫn điện), tắt cảm biến đi (với tiếp điểm thường đóng  X6 dẫn điện) 

từ hóa cuộn dây ở thời điểm T1 và bộ định thời bắt đầu đo thời gian 

Sau 3s (K30 nghĩa là 3.0s), tiếp điểm thường mở của bộ định thời dẫn 

điện và tiếp điểm thường đóng không dẫn điện. 

6) Cuối cùng, cuộn dây của rơle đầu ra Y74 giải từ hóa và tải từ của tiếp 

điểm giảm xuống. Do đó, quá trình tự hoạt động của rơle đầu ra được 

giải phóng 

 

 

 
Biểu đồ thời gian dưới đây mô tả hoạt động của rơle đầu vào/ra theo 

thời gian. 
 

 

Input X6 

Output Y74 

(Coil) Timer T1 

(Contact) Timer T1 

3 sec. 

Sơ đồ hoạt động 

Hoạt động tuần tự  

Đầu vào 

Đầu 
ra

a  

Bộ định 
thời 

Bộ định 
thời 

3s. 

(Cuộn dây) 

(Tiếp điểm) 
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X6 T1 

0 Y74 

Y74 

Repeat 
operation 

K30 

T1 

Y74 X6 

4 

10 END 

(a)Biểu đồ ladder (b) Bảng hướng dẫn 

Hoạt động tuần tự bên trong có thể coi như một chương trình của bộ 

điều khiển khả trình. Chương trình được lưu trong bộ nhớ chương 

trình tương tự như hướng dẫn dưới đây. 
 

 

 

Thứ tự bước Tập lệnh 

 

Biến 

0 LD X6 

1 OR Y74 

2 ANI T1 

3 OUT Y74 

4 LD Y74 

5 ANI X6 

6 OUT T1 K30 

10 END  
 

 

 

Hình 1.2  Chương trình 
 

 

    Một chương trình là một tập hợp của rất nhiều tập lệnh và biến. 

 
    Một lệnh gồm tập lệnh và biến. Thêm vào đó, lệnh thể hiện trình tự 

hoạt động. Thứ tự các lệnh là thứ tự hoạt động (tập lệnh cũng được 
gọi là lệnh) 

 

 

    Các bước thực hiên thay đổi dựa trên loại lệnh hoặc phương pháp 

cài đặt để tạo giá trị sử dụng cho I/O và hoạt động ( càng nhiều 

bước thực hiện thì hoạt động càng phức tạp) 

    Lệnh lặp từ bước 0 đến từ lệnh END (nó còn được gọi là ‘hoạt động 

lặp lại, “chu trình hoạt động” hoặc “quét”).  

Thời gian cần thiết cho một chu trình từ đầu đến cuối được gọi là 

chu trình hoạt động (chu kì quét) 

    Số bước thực hiện từ bước 0 đến lệnh END là độ dài hay độ lớn 

của toàn bộ chương trình 

    Chương trình được lưu vào bộ nhớ chương trình bên trong CPU. 

Hoạt động được thực thi theo khối hình thang 

Một khối hình thang thay đổi từ lúc bắt đầu thực thi lệnh (LD,LDI) 

đến lệnh OUT (bao gồm cả lệnh dữ liệu) 
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1.2 Quy trình xử lí chương trình 

 
Chương trình hoạt động được thực thi tuần tự từ bước bắt đầu của chương trình theo 

thứ tự từ trái qua phải và từ trên xuống dưới (theo thứ tự 1,2…. 17) theo khối hình 

thang được chỉ ra như hình dưới. 

1) 2) 

X0 X1 

0 
 

 

4) 5) 

X2 X3 

3 

3) 

Y10 

7) 

Y11 

6) 

X4 

 

 

8) 

X5 

7 
 

 

 

 

 

 

 

 

 

 

 

 

15) 

X9 

17 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
16) 

XA 

9) 

X6 
 

 

 

11) 

X7 
 

 

 

13) 

X8 

10) 

Y12 

12) 

Y13 

14) 

Y14 

17) 

Y15 
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Battery for QCPU (Q6BAT) 

Q7BAT-SET 

Battery holder Battery for QCPU (Q7BAT) 
 

Q8BAT-SET 

Q8BAT connection cable Battery for QCPU (Q8BAT) 

Memory card 

1.3 Cấu hình module MELSEC-QnUD  
(1) Universal PLC 

Universal PLC - QCPU được sử dụng cho việc đào tạo trong tài liệu này, vì thế, 
“QCPU” đùng để chỉ “ Universal model QCPU” trừ khi có chú ý khác. 

(2) Cấu hình cơ bản của một hệ thống điều khiển khả trình 

Hình dưới là cấu hình của một bộ điều khiển khả trình thật sự 
 

 

 
 

Hình 1.3 Cấu hình module MELSEC-QnUD (khi Q3DB được sử dụng) 

Universal model QCPU 

Q3   DB multiple CPU high speed main base unit 

Extension cable 
Power supply module/I/O module/Intelligent function module/Special function module 

Q5   B extension base unit 

Q6   B extension base unit 
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Khối cơ bản  chính Khối cơ bản mở rộng    
(cần khối module cấp 
nguồn) 

(Không cần khối cấp 
nguồn) 

With three 
I/O modules Q52B 

(Cho hai module) 
Q33B Q63B 

With five  

I/O modules 

Q35B Q65B Q55B 

V 

Q68B Q38B 

Với 12 
module I/O 

Q612B Q312B 

Khối cơ bản chính nhiều CPU tốc độ cao 

Với 8 

module I/O 

Q38DB 

Với 12 
module I/O 

Q312DB 

 

 
 

 
 
 

 

 
 

 

 
 

 
 
 

 
 
 

 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

• Chức năng chính của khối cơ bản là: module cấp nguồn, CPU 

module, và module I/O, cung cấp nguồn 5VDC từ module cấp 

nguồn đến module CPU và module I/O, và truyền tín hiệu điều 

khiển đến mỗi module. 

Khối cơ bản 
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Tên module Đầu vào Đầu ra 

Q61P 100V to 240VAC 5VDC 6A 

Q62P 100V to 240VAC 5VDC 3A, 24VDC 0.6A 

Q63P 24VDC 5VDC 6A 

 

Q64P(N) 
100V to 120V/AC200 to 

240VAC 

 

5VDC 8.5A 

Q61P-D 100V to 240VAC 5VDC 6A 

 

 
 

 

 

Loại CPU 

 

Dung lượng  

(tối đa) 

 

Tốc độ xử lí lệnh 

cơ bản 

 
Số điểm I/O tối đa cho một 

khối điều khiển  

khả lập trình 

Q00UJCPU 10K step 120ns 256 điểm 

Q00UCPU 10K step 80ns 1024 điểm 

Q01UCPU 15K step 60ns 1024 điểm 

Q02UCPU 20K step 40ns 2048 điểm 

Q03UD(E)CPU 30K step 20ns 
 

 

 

 

 

 

 

4096 điểm 

Q04UD(E)HCPU 40K step  

 

 

 

 

 

9.5ns 

Q06UD(E)HCPU 60K step 

Q10UD(E)HCPU 100K step  

Q13UD(E)HCPU 130K step 

Q20UD(E)HCPU 200K step 

Q26UD(E)HCPU 260K step 

Q50UDEHCPU 500K step 

Q100UDEHCPU 1000K step 

 

 
 

I/O điểm 

   Định dạng 

 

8 điểm 
 

16 điểm 
 

32 điểm 
 

64 điểm 

M
o

d
u
le

 đ
ầ
u
 v

à
o
 

120VAC –  – – 

240VAC  – – – 

24VDC (điểm chung dương) –   

24VDC (đầu vào tốc độ cao)  – – – 

24VDC 

( tiếp tiếp điểm chung) 
âm) 

–   – 

5/12VDC –   

M
o

d
u
le

 đ
ầ
u
 r

a
 Công tắc đầu ra –  – – 

Công tắc đầu ra độc 

lập 
 – – – 

Đầu ra Triac  –  – – 

Đầu ra transistor (sink)    

Đầu ra transistor (source) –   – 

I/O kết hợp  –  – 

Module I/O 

Module CPU 

Module cấp nguồn 
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Một QCPU được trang bị một bộ nhớ tích hợp sẵn như bình thường để lưu trữ 
các tham số và chương trình, do đó, chương trình có thể chạy mà không cần một 
thẻ nhớ  

Thẻ nhớ cần trong những trường hợp trong bảng bên dưới. 
 

Loại Mô tả 

 

 

 

 

Card SRam 

Dữ liệu có thể viết hoặc thay đổi bên trong bộ nhớ 

<ví dụ cách sử dụng> 

 Để boot 

 Để lưu trữ dữ liệu mẫu truy dấu  

 Để lưu trữ dữ liệu theo dấu SFC 

 Để lưu trự dữ liệu lịch sử lỗi 

 

 

 

 

Card Flash 

Nội dung của bộ nhớ chương trình hoặc tệp nào đó có thể được ghi ở một thời điểm nhất định 

Dữ liệu mới được viết vào thay thế tất cả dữ liệu gốc. Dữ liệu có thể đọc bằng lệnh READ của 
chương trình 

<ví dụ cách sử dụng> 

 Để boot 

 Khi thay đổi dữ liệu là không cần thiết 

 

 

 

 

 

Card ATA 

Dữ liệu có thể được viết hoặc thay đổi trong chương trình 

Bộ điều khiển khả lập trình dữ liệu người dùng của một thẻ ATA có thể truy nhập bởi tệp lệnh 
access (như lệnh FWRITE) trong dãy chương trình qua định dạng CSV hoặc dạng nhị phân. 

<ví dụ cách sử dụng> 

 Để boot 

 Cho bộ điều khiển khả trình dữ liệu người dùng (dữ liệu thông thường) 

 
 

 

 

 

 

 

 

 

 

Thẻ nhớ 

• Phải có thẻ nhớ khi dung lượng dữ liệu vượt quá dung 

lượng bộ nhớ tích hợp, RAM tiêu chuẩn và ROM tiêu chuẩn 

• Chọn card bộ nhớ theo độ lớn của chương trình hoặc theo 

loại dữ liệu được lưu 

• Lắp pin dự phòng trước khi sử dụng card RAM loại 

SRAM.Dữ liệu card SRAM không thể lưu dự phòng trừ khi 

pin được lắp vào 

• Format card bộ nhớ trước khi sử dụng nó 

• Dữ liệu có thể viết vào card flash 100.000 lần, và với card 

ATA, dữ liệu có thể viết vào 1.000.000 lần. 

Thẻ nhớ 
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< tham khảo: cấu hình bộ nhớ hệ thống của Universal Q-CPU > 
 

 

Bộ nhớ của Universal Q-CPU bao gồm những khối sau. 
 

Bộ nhớ chương trình 

(cache chương trình) 
RAM

 

Tham số  Chương trình   

Ghi chú thiết bị Giá trị thiết bị ban đầu 

Tham số  Chương trình       

Ghi chú thiết bị Giá trị thiết bị ban đầu 

ROM tiêu 

chuẩn 

Tham số 

 

 

 

Chương trình 

Thanh ghi tệp Local device 
 

 

Tệp lấy mẫu truy dấu

 

 
Ghi chú thiết bị Giá trị thiết bị ban đầu 

 

 

 
Dữ liệu người dùng khối điều khiển 

 

 

Tệp lưu trữ trong chức 

năng backup dữ liệu 
 

 

Tệp sử dụng trong chức năng 

SP.DEVST/S.DEVLD  

 

 

 

 

 

Module 
CPU 

 

 

Thẻ nhớ 
*1 

 

 

ROM 

 
Tham số  Chương trình     

Ghi chú thiết bị Giá trị thiết bị ban đầu 

Thanh ghi tệp 

 

RAM tiều 
chuẩn 

Thanh ghi tệp 

 

 

 
Biến cục bộ 

 

Tệp lấy mẫu  

Truy dấu 

Module thu 

thập lịch sử lỗi 
 

 

 

 

*1: Thẻ nhớ không thể sử dụng cho  Q00UJCPU, Q00UCPU, Q01UCPU. 

*2: Q00UJCPU không có RAM tiêu chuẩn. 

 

• Bộ nhớ chương trình: Bộ nhớ lưu chương trình và tham số cho một module CPU hoạt động 

Một chương trình hoạt động được thực thi bằng việc đưa chương 

trình được lưu trong bộ nhớ chương trình đến bộ nhớ cache 

chương trình. 

• Bộ nhớ cache   Một bộ nhớ cho chương trình hoạt động. 

Một chương trình hoạt động được thực thi bằng việc đưa chương 

trình được lưu trong bộ nhớ chương trình đến bộ nhớ cache 

chương trình. 

• RAM tiêu chuẩn: Một bộ nhớ dùng để sử dụng thanh ghi tệp, biến cục bộ, lấy mẫu truy 

dấu mà không cần thẻ nhớ. 

Sử dụng RAM tiêu chuẩn như là một thanh ghi tệp tạo khả năng truy 

nhập tốc độ cao như ghi dữ liệu. 

RAM tiêu chuẩn còn được sử dụng để lưu trữ cho module thu thập 

lịch sử lỗi. 

• Standard ROM: Một bộ nhớ dùng để lưu trữ dữ liệu như các tham số và chương trình 

• Thẻ nhớ (RAM): Dùng để lưu trữ trên biến cục bộ, gỡ lỗi dữ liệu, dữ liệu truy dấu 

SFC, và dữ liệu lịch sử lỗi với các tham số và chương trình. 

• Thẻ nhớ (ROM): Card flash dùng để lưu trữ tham số, chương trình và thanh ghi tệp. 

Một card ATA lưu trữ các tham số, chương trình, và dữ liệu người 

dùng của bộ điều khiển khả trình (tệp bình thường). 
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Điểm chú ý  

 

Backup an toàn cho lưu trữ dài hạn 

Những chương trình và tệps tham số được tự động backup đến bộ nhớ 

chương trình (Flash ROM) mà không cần nguồn dự phòng. Nó ngăn cản việc 

mất dữ liệu chương trình và tham số do mất nguồn. 

Thời gian cho nguồn dự phòng cũng giảm đi đáng kể. 

Thêm vào đó, dữ liệu quan trọng (như dữ liệu thiết bị) có thể back up đến ROM 

tiêu chuẩn để tránh mất dữ liệu do hết pin trong trường hợp đi vắng lâu ngày. 

Dữ liệu backup được phục hồi tự động khi bật nguồn lần sau  

        

CPU bộ nhớ tích hợp Không cần 

nguồn 
Bộ nhớ 

(Flash ROM) để bảo vệ 

Bộ nhớ Không cần dữ liệu 
Viết chương trình cache  nguồn 

(SRAM) dự phong 

Để chạy 

Công cụ chương trình 
lập trình 

 

Dữ liệu thiết bị 

Backup Latch data 
Bộ nhớ thiết bị   execution Backup 

condition is tệp 

Thanh ghi tệp ON (Standard ROM) 

(RAM tiêu chuẩn) 
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1.4 Tín hiệu I/O ngoại vi và số I/O 
(1) Đi dây của địa chỉ I/O 

Tín hiệu đầu ra của thiết bị ngoại vi là đầu vào bộ điều khiển, số đầu vào được 

quyết định bởi vị trí lắp đặt và số cuối của module đầu vào kết nối và sử dụng 

trong một chương trình. 

Hoạt động này dẫn đến đầu ra (cuộn dây), sử dụng số đầu ra mà số này được 

quyết định bởi vị trí cài đặt và số cuối của module đầu ra đến nơi mà module 

ngoài đầu ra được kết nối.. 
 

0 1 2 3 4 Thứ tự khe  
 

 

 

 

 

 

(Cấp (CPU) 
nguồn) 

(QY) 

(QX) Đế cắm 
Số đầu vào Số đầu ra 

Y10 
PB1 V1 

X0    

CS1 
X1 

Y11 
V2

 

CS2 Số đầu vào là hệ thập lục bắt đầu bằng 0 
X2 

Y12  Số đầu vào/ra cùng sử dụng chung một số. 

PB2  V3 
"X: ở trước mỗi số để chỉ đầu vào, 

X3    
“Y” ở trước mỗi số để chỉ đầu ra. 

PB3 Y13 
X4 RL 

 Số tối đa của một QCPU (Q mode) 

LS1 
X5 Y14 

số đầu vào/ra là 4096. 
GL 

LS2 
X6  Số đầu vào/ra thỉnh thoảng tham chiếu tới   

Y15 số I/O  (vào/ra). 

LS3 
X7 MC1 

LS4 

X8 Y16 
MC2

 
PB4 

X9 
Y17 

PB5 MC3 
XA 

CS3 
XB 

COM1 

XC 
Y18 

XD 

Y1F 
XE 

 
XF COM2 

 

COM 
 

 

Module đầu ra 

 
 
Module đầu vào  

 

Hình  1.4 Đi dây biến I/O
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Đế cắm (Q33B,Q35B,Q38D)B,Q312(D)B) 

0 1 2 3 4 5 6 7 8 9 10 11 Thứ tự khe 

Số I/O 

Đế cắm với 3 khe 
(Q33B) 

Đế cắm với 5 khe (Q35B) 

Đế cắm với 8 khe (Q38(D)B) 

Đế cắm với 12 khe(Q312(D)B) 

• Số I/O của một khe (một module) được sắp xếp theo thứ tự từ trên xuống trong đơn vị 16 điểm (0 đến F14). 

Như một chuẩn, module 16 điểm nên được gắn đến tất cả khe. 

    Ví dụ, hình dưới đây miêu tả số I/O của module 32 điểm được gắn vào khe số 5. 

Đế cắm 

Số khe 0 1 2 3 4 5 6 7 
Số I/O của khe bên 
cạnh khe với module 
32 điểm bị thay đổi 
(Số này được chỉ định 
theo thứ tự từ những 
số bên dưới) 

• Số I/O được đưa vào khe trống (một khe không có module I/O nào được gắn vào). 

Ví dụ, nếu khe thứ 3 còn trống, số I/O được đưa vào như hình dưới (trong phần cài đặt ban đầu) 

Số của điểm được chỉ định có thể thay đổi bằng cài đặt. 

Đế cắm 

0 1 2 3 4 5 6 7 Số khe 

• Đối với cấu hình nhiều CPU (2 đến 4 CPUs), số I/O được chỉ định từ một khe ở bên cạnh khe mà CPU được gắn vào 

 

(2) Số I/O của đế cắm 

 Số I/O của những module I/O được đính vào một khối cơ bản như hình dưới. 

Cấu hình được sử dụng cho cả module I/O và module chức năng thông minh 
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Đế cắm chính (Q38(D)B) 

0 1 2 3 4 5 6 7 Số khe 

Cáp mở rộng 

Đế cắm mở rộng (Q68B) 

8 9 10 11 12 13 14 15 

Các tham số cho phép cài đặt khác nhau từ một 
số khe. 
Ví dụ, một khối chính với 12 khe có thể đặt như 
khối chính với 3 khe và ngược lại. 
Do đó, có thể dễ dàng xử lí khi mở rộng trong 
tương lai, và tránh khoảng trống của các số I/O 
khi đổi hệ thống hiện hành sang một hệ thống 
mới. 
Chi tiết hơn xem tại QnUCPU User's Manual 
(giải thích chức năng, chương trình cơ bản). 

Đế cắm mở 
rộng đầu 

(Q65B) 

19 16   17 18 20 

Đế cắm mở 
rộng thứ hai 

Đế cắm mở rộng (Q68B) 

21   22   23 24 25   26 28 27 

Đế cắm mở 
rộng thứ ba 

• Khe của đế cắm mở rộng cũng được sắp xếp từ trên xuống dưới theo đơn vị 16 điểm 
• Số I/O của đế cắm mở rộng được chỉ định từ số cuối cùng của thiết bị cơ sở hoặc của đế cắm mở rộng trước. 

• Gán “0” cho tham số có thể chỉ định số I/O đến khe trống hoặc vùng không có khe. 

 

(3) Số I/O của đế cắm mở rộng 

Kết nối đến một đế cắm mở rộng khi số khe của đế cắm chính là không đủ. 

Số I/O dược chỉ định theo như cài đặt ban đầu 

Cấu hình này được áp dụng cho cả module I/O và module chức năng thông minh. 

. 
  

 
 
 

 
 
 

 
 
 

 
 
  

 
 
 

 
 
 

  
 
 

 
 
 

 
 
 

 
 
  

 
 
 

  
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

Bảng dưới đây cho thấy số đế cắm mở rộng có thể có. 
  

Loại CPU Số trạng thái (bao gồm cả cái kết nối với 
GOT bằng kết nối bus) 

Universal Model Q00UJCPU 2 

Q00UCPU, Q01UCPU, Q02UCPU 4 

Khác với những loại trên 7 
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Module CPU Module đầu ra 

Module cấp nguồn Module đầu vào 
Đế cắm Q38DB 

Q61P  QCPU Khe        QX QY 

42P 

(64 

Q64 

AD 

(16 

Q62 

DAN 

(16 

trống 42 

(64 

điểm)    điểm)       điểm)   điểm) 

X0 
đến 

X3F 

Y40 
 đến 

Y7F Cáp USB 

Thiết bị ngoại vi Cửa sổ I/O 

Y6F Y60 Y5F Y50 Y4F Y40 

Y77 Y76 Y75 Y74 Y73 Y72 Y71 Y70 

Y7F Y7E Y7D Y7C Y7B Y7A Y79 Y78 

X3F X30 X2F X20 

X7 X6 X5 X4 X3 X2 X1 X0 

1 9   4   2 4 1   3   6 MELSEC-Q ON 

OFF 

Đầu vào A/D Đầu ra D/A  XF XE XD XC XB XA X9 X8 

ON 

OFF 

1.5  Cấu hình hệ thống và và số I/O của thiết bị DEMO 
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CHƯƠNG 2 : THAO TÁC TRÊN GXWORKS2 
 

GX Works2 là một công cụ lập trình dùng để thiết kế, gỡ lỗi, và duy trì chương 

trình trên Window 

GX Works2 đã cải thiện chức năng và khả năng thao tác, với những tính năng 

dễ sử dụng hơn khi so sánh với GX Developer đã có. 

 
 Chức năng chính của GX Works2 

GX Works2 quản lý các chương trình và thông số đầu vào của dự án cho mỗi 
CPU điều khiển khả trình 

 Lập trình 

Chương trình có thể được tạo ra trong một Dự án đơn giản theo cách 

tương tự với GX Developer. 

  Lập trình cấu trúc trong một dự án cấu trúc cũng khả thi với GX Works2 
 

 
 

 Cài đặt tham số 

Tham số cho CPU điều khiển khả trình và tham số cấu hình mạng có thể 

được đặt với GX Works2. 

Tham số cho khối chức năng thông minh cũng có thể được cài đặt. 

  
 

 Viết/đọc dữ liệu đến/từ một CPU điều khiển khả trình 

Tạo chương trình tuần tự có thể được viết/đọc từ một CPU điều khiển khả 

trình sử dụng Read từ PLC/Write của chức năng PLC. Đồng thời, với 

chương trình thay đổi chức năng trực tuyến, chương trình tuần tự có thể bị 

thay đổi ngay cả khi CPU điều khiển khả trình đang chạy (RUN). 

 
 

 

  

Đọc dữ liệu 

Viết dữ liệu 
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 Quan sát/soát lỗi 
Tạo chương trình tuần tự có thể được viết cho CPU điều khiển khả trình và giá trị 

của thiết bị khi hoạt động của nó đang được theo dõi trực tuyến/ngoại tuyến. 

Chương trình có thể theo dõi và soát lỗi  

 Chuẩn đoán 
Trạng thái lỗi hiện tại và lịch sử lỗi của CPU điều khiển khả trìnhcó thể được chuẩn 

đoán.  

Với chức năng chuẩn đoán, công việc khôi phục có thể được hoàn thành trong thời 

gian ngắn. 

Với chức năng theo dõi hệ thống (cho QCPU (Q mode)/LCPU), thông tin cụ thể trong 

module chức năng thông tin có thể được lấy về. Điều này giúp cho rút ngắn thời gian 

phục hồi dữ liệu khi hệ thống đang lỗi. 

 
Chuẩn đoán trạng thái khối điều khiển 

khả trình CPU (chuẩn đoán PLC) 
 

 

 

 

Chuẩn đoán trạng thái 

khối điều khiển CPU 

(chuẩn đoán PLC) 
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2.1 Tính năng trong GX Works2 

 
Phần này giải thích tính năng của GX Works2. 

 

 

(1) Loại dự án trong GX Works2 

Trong GX Works2, loại dự án có thể được chọn từ những dự án đơn giản hoặc 

dự án cấu trúc. 

(a) Dự án đơn giản 
 Dự án đơn giản tạo ra các chương trình tuần tự sử dụng tập lệnh cho CPU   

điều khiển khả trình Mitshubishi. 

Chương trình trong một dự án đơn giản có thể được tạo ra tương tự như 

GX developer đã có. 
 

 
 

(b) Dự án cấu trúc 
Trong một dự án cấu trúc, chương trình có thể được tạo ra bởi lập trình cấu  

trúc. 

Bằng việc phân mảnh một chương trình điều khiển thành các chương trình  
thông dụng nhỏ, lập trình ra một chương trình có mức độ quản lí cao và sử 
dụng linh hoạt. 

 

Chương trình tuần tự được tạo ra 

bởi kết hợp các POU (Đơn vị tổ 

chức chương trình) 

POU Tệp ctrình 

Khối ctrình  A Ctrình chính Function block 1 

Khối ctrình  B 
Function block 2 

Khối ctrình  C Ctrình SUB1 

Function 1 Khối ctrình  D 

Function 2 Khối ctrình  E 

Tệp chương trình 

Chương trình MAIN 

Chương trình SUB1 

Chương trình SUB2 

Lập trình tương tự như GX Developer 

Chương trình được tạo với các tập lệnh của bộ điều 
khiển khả trình. 
Chương trình tạo ra có thể hoạt động như chương 
trình trình tự 

Khối chức năng 1 

Khối chức năng 2 

Chức năng 1 

Chức năng 2 
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Library tệp 

(2) Tăng cường khả năng sử dụng của chương trình 

Những dự án được tạo bởi GX Developer đã có được tối ưu trong một dự án 

đơn giản. Tối ưu những thứ đã có giúp tăng hiệu năng của thiết kế chương 

trình. 

<GX Developer> <GX Works2> 
 

 
 

(3) Chia sẻ Đơn vị tổ chức chương trình (POU) như một thư viện 

Trong một dự án cấu trúc, những chương trình, nhãn quốc tế, và cấu trúc 

thường sử dụng có thể được đăng kí như là thư viện người dùng. Tối ưu thư 

viện người dùng này giảm thời gian cần thiết để tạo ra những chương trình. 

 

Dự án  A 
 

 

Dự án B 
 

 

Dự án C 
 

 

Dự án D 
 

 

Dự án được tạo  

với GX Developer 

Có thể sử 

dụng với GX 

Works2 
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(4) Các ngôn ngữ lập trình 

Có nhiều ngôn ngữ lập trình có thể sử dụng được với GX Works2 nên việc chọn 
ra ngôn ngữ tối ưu sẽ dựa vào khả năng điều khiển 

  
 

 

 
 

(5) Tính năng khác 
 

(a) Soát lỗi ngoại tuyến 

Soát lỗi ngoại tuyến sử dụng chương trình mô phỏng với GX Works2. Nó 
cho phép soát lỗi để đảm chương trình tuần tự tạo ra bảo hoạt động bình 
thường mà không kết nối GX Works2 đến CPU điều khiển khả trình. 

 
Kết nối đến khối diều khiển 
khả trình là không bắt buộc 

theo dõi và soát lỗi tương tự như cách soát lỗi bằng CPU điều khiển 
khả trình. 

Chức năng mô phỏng 

Không kết nối đến CPU điều khiển khả trình, chương trình có thể được 

<ST> 

Lập trình theo ngôn ngữ dạng chữ như 

ngôn ngữ C 

<Ladder cấu trúc> 

Lập trình chương trình ladder biểu đồ 

<SFC> 

Lập trình làm rõ quy trình 

<Ladder> 

Lập trình tương tự như GX Developer 
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(b) Bố cục màn hình có thể tùy chỉnh theo mong muốn của người dùng 

Cửa sổ lưu động cho phép thay đổi bố cục màn hình của GX Works2 mà 
không có sự hạn chế . 

 

Thay đổi bố cục màn hình 

mà không có sự hạn chế. 
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2.1.1 MELSOFT iQ Works 

 
MELSOFT iQ Works tích hợp phần mềm kĩ thuật (GX Works2, MT Developer2, và 

GT Designer3). 

Chia sẻ thông tin như thiết kế hệ thống và lập trình trong toàn bộ hệ thống điều khiển 

giúp cải thiện hiệu năng của việc thiết kế chương trình và hiệu năng của việc lập trình, 

giúp làm giảm giá thành. 

 
 

 

Gợi ý  

Để khởi động MELSOFT Navigator và mỗi phần mềm kĩ thuật, click vào nút Start và theo 

hướng dẫn dưới đây 

• MELSOFT Navigator: [Ứng dụng MELSOFT]  →  [MELSOFT  iQ  Works]  →  [MELSOFT 

Navigator] 

• GX Works2: [Ứng dụng MELSOFT] → [GX Works2] → [GX Works2] 

• MT Developer2: [Ứng dụng MELSOFT] → [MT Works2] → [MT Developer2] 

• GT Designer3: [Ứng dụng MELSOFT] → [GT Works3] → [GT Designer3] 

MELSOFT iQ Works 

GX Works2  

(phần mềm lập trình bộ 

điều khiển khả trình) 

MT Developert2 (phần 

mềm lập trình khôi điều 

khiển truyền động) 

GT Designer3 

(phần mềm thiết kế 

GOT) 

MELSOFT Navigator 

(công cụ quản lí cấu hình hệ thống) 

Chia sẻ thông tin thiết kế giữa 

các phần mềm 

Thiết kế thông tin 

cơ sở dữ liệu 
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[Mục đích của môi trường kĩ thuật] 
 

 
 

 

Gợi ý  

là một FA khái niệm tích hợp của MITSUBISHI ELECTRIC.  

 T ích hợp Q/tăng cường chất lượng/thông minh&nhanh/đột phá&Tìm kiếm 

ERP 
(Tài nguyên doanh nghiệp) 

MES 
(hệ thống thực hiện sản xuất) 

Engineering environment 

Điều khiển và  HMI Mạng 

1) Tích hợp môi trường phát triển độc lập với mỗi 

thiết bị 

2) Chia sẻ thông tin thiết kế trong quá trình phát triển 

(thiết kế hệ thống, lập trình, kiểm tra/khởi động, và vận hành/điều hành) 
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2.2 Kiến thức căn bản để sử dụng GX Works2 

 
2.2.1 Cấu hình màn hình trong GX Works2 

 

 

 

1) Title bar 
2) Menu bar 

3) Toolbar 

4) Tab 

7) Edit screen (work window) 
5) View contents display area 

6) View selection area 
8) Output window 

9) Status bar 
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1) Thanh tiêu đề 
Thanh tiêu đề thể hiện tên của dự án đang sử dụng 
 

 
 

2) Thanh Menu 
Thanh menu được sử dụng khá thường xuyên khi làm việc với GX Works2. Click  
vào thanh menu để chọn những chức năng khác nhau từ thanh menu 

3) Thanh công cụ 
Thanh công cụ gồm những biểu tượng rất trực quan và dễ sử dụng cho những 
chức năng thông dụng. Nó khiến các thao tác nhanh hơn. 

 

 
 

4) Tab 
Khi làm việc với nhiều cửa sổ đang mở, nó thể hiện theo dạng trình duyệt tab . 
Click vào tab sẽ kích hoạt cửa sổ làm việc tương ứng. 

5) Xem nội dung hiển thị 
Xem nội dung hiển thị thể hiện nội dung của trình hiển thị hiện tại. 

6) Xem vùng đang chọn 

Xem vùng đang chọn vùng thể hiện nội dung của vùng hiện tại 
 

7) Màn hình chỉnh sửa (cửa sổ làm việc) 
Màn hình chỉnh sửa thể hiện nhiều loại màn hình như màn hình tạo chương trình 
và màn hình tạo comment để chỉnh sửa biểu đồ lader, chú thích, và tham số. 

8) Cửa sổ đầu ra 

Cửa sổ đầu ra thể hiện sự biên dịch và kiể mtra kết quả (như lỗi và cảnh báo). 

9) Thanh trạng thái 

Thanh trạng thái thể hiện thông tin trạng thái của GX Works2. 
 

 

Trạng thái của phím  
CAP Lock 

Hiện mode hiện tại. 

Chỉ loại 
CPU. 

Thể hiện CPU Vị trí con trỏ hiện Trạng thái của 
phím Num Lock được kết nối tại. 

Đưa con trỏ vào biểu tượng để biết 
chức năng . 

Đóng hoặc thay đổi kích thước GX Works2. Phóng to hoăc trở lại GX Works2. 

Tên và đường dẫn của 
dự án đang mở. 

Thu nhỏ GX Works2. Đó ng  GX 
Works2. 
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Thay đổi kích thước hiển thị theo chế độ 
phóng to theo % 

Thay đổi kích thước hiển thị theo số phóng to tùy 
chọn (từ 50 đến 150%). 

Thêm độ rộng của ladder tự động để hiển thị 
toàn bộ ladder. 

2.2.2 Chỉnh sửa ladder 
 

Phần này nói về màn hình làm việc của GX Works2 chỉnh sửa ladder và hoạt động 

cơ bản của nó. 

(1) Chỉnh sửa màn hình 
 

 

(2) Thay đổi kích thước màn hình trên màn hình chỉnh sửa 

Kích thước màn hình của mà hình chỉnh sửa bị thay đổi. 
 

1) Click [View] → [Zoom]. 
 

 

Hộp thoại Zoom xuất hiện. 
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(3) Thay đổi cỡ chữ trên màn hình chỉnh sửa 

Cỡ chữ trên màn hình có thể thay đổi 

1) Chọn [View] → [Text Size] → 

[Bigger]/[Smaller]. 
 

 

Cỡ chữ được thay đổi mỗi lần thực hiện 

bước này trong phạm vi 10 lần.. 
 

 

 
 
 

 
 
 

 
 
 

 
 

 
 

 

 

 
 

 

(4) Hiện/ẩn chú thích 

Ghi chú thiết bị (nhãn ghi chú), ghi chú, và biểu ngữ có thể hiện ra hoặc ẩn đi. 

1) Chọn [View] → [Comment]/[Statement]/[Note]. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

Gợi ý  

 

Hiện/ẩn chú thích 

Chú thích có thể hiện hoặc ẩn bằng thao tác sau.  

[Tool] → [Option] → "Program Editor" → "Ladder" → "Comment" 
 

 
* Chi tiết của thao tác này được giải thích trong trang sau 
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(5) Đặt số dòng và cột để hiện comment 

Cài đặt Option cho phép thay đổi chỗ số hàng và cột để hiện ghi chú thiết bị 

1) Click [Tool] → [Option]. 
 

Màn hình Option hiện lên.. 
 

 
 
 

 
 
 

 

 
 

 
 

 

2) Click "Program Editor" → "Ladder" → "Comment". 
 

 

Màn hình để đặt  định dạng thể hiện ghi chú thiết 

bị xuất hiện. 

 

 
 
 

 

 
 

 
 

 
(Đến trang sau) 

Chú thích hiện hoặc ẩn phụ thuộc vào 
chỉnh cài đặt phần này cùng với phương 

pháp đã nói đến ở trang trước. 
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(Từ trang trước) 
 

 
 

 
 

Ví dụ) 

4 hàng 8 cột 2 hàng 5 cột 
 

 

 

 

Đặt số hàng hiển thị từ 1 đến 

4 
Đặt số hàng hiển thị từ 5 đến 8 
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(6) Cài đặt số công tắc hiển thị trong chương trình ladder 

Cài đặt phần này cho phép đổi số công tắc hiển thị trong 1 hàng. 

1) Click "Program Editor" → "Ladder" → "Ladder 

Diagram" trong màn hình Option. 

 
Màn hình cài đặt  Display  Format cho biểu đồ 

ladder hiện ra. 

 
 

 
 
 

 
 
 

 

 
 

 

Đặt số bước nối hiển thị trong một hàng 
thành 9 hoặc 11 công tắc 
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(7) Đổi tên nhãn hiển thị và thiết bị hiển thị 
Một chương trình sử dụng nhãn có thể đổi giữa tên nhãn và tên thiết bị. 

Chú thích nhãn và chú thích thiết bị được sử dụng sẽ cho chú thích trên màn 

hình tương ứng. 

Những thiết bị sử dụng với trình biên dịch có thể chuyển đổi chế độ hiển thị tên 

nhãn sang hiển thị tên thiết bị. 

1) Click [View] → [Device Display]. 
 

 

Màn hình để cài đặt Display Format cho biểu đồ 

hình thang hiện ra. 

 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

 

Ví dụ) 

Hiện tên nhãn 

 

 

Tên thiết bị
 

 

 

 

 
 

 

Gợi ý  

Hiện/ẩn nhãn ghi chú và ghi chú thiết bị 

Để kiểm tra chú thích nhãn và chú thích thiết bị, cài đặt phần chú thích hiển thị (xem 

phần 2.2.2(4)). 



2 - 17  

1) Move the cursor! 

(8) Ẩn một khối ladder 

 Khối ladder sau khi biến đổi có thể ẩn đi 

 Khối ladder đi cùng với câu lệnh được đặt ẩn đi còn câu lệnh hiện lên. 

 
 

(a) Ẩn một khối ladder 
 

1) Đưa chuột đến khối ladder muốn ẩn. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

 
 

 
 

 

(Đến trang sau) 

 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

2) Click [View] → [Non-Display Ladder Block]. 
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The ladder block is hidden. 

1) Move the cursor! 

(Từ trang trước) 
 

 

3) Khối ladder được chọn đã bị ẩn đi. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
(b) Hủy bỏ lệnh ẩn khối ladder 

 

1) Di chuyển chuột đến khối ladder ẩn hiện 

đang màu xám. 
 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

 
 

 
 

 

(Đến trang sau) 

 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

2) Click [View] → [Display Ladder Block]. 
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The hidden ladder blocks are displayed. 

     (Từ trang trước) 
 

 

3) Khối ladder được chọn đã bị ẩn đi.. 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

Gợi ý  

Hiện/ẩn khối ladder  

• Nhiều khối ladder có thể được ẩn hoặc hiện.. 

• Tất cả khối ladder có thể hiện hoặc ẩn bằng việc [View] →[Display All Ladder 
Block]/[Non-Display All Ladder Block]. 

• Khối ladder còn có thể hiện hoặc ẩn bởi Phải chuột   → [Displaying/hiding ladder 
blocks]. 



2 - 20  

2.2.3 Dự án 
 

Phần này giải thích cấu hình của một dự án được hiển thị theo dạng cây. Nội dung 

hiển thị khác nhau theo loại bộ điều khiển khả trình. Dưới đây là một ví dụ cho một 

dự án đơn giản của QCPU (Q mode)). 

 

< Dự án đơn giản (không nhãn) > 

Đặt tham số. 

Cài đặt cho khối chức năng thông minh. 

Đặt chú thích cho các biến chung. 
 

 

 

 

Đặt chế độ hoạt động cho mỗi chương trình. 
 

 
Tạo chương trình. 

GX Works2 Version 1 Operating Manual Simple Project 

 
Đặt chú thích cho các biến cục bộ. 

Đặt biến nhớ 

Đặt giá trị biến khởi tạo 

 

< Dự án đơn giản (có nhãn)> 
 

 

Đặt tham số. 

Cài đặt cho module chức năng thông minh. 

Chú thích cho biến chung. 

Đặt nhãn chung. 

GX Works2 Version 1 Operating Manual Simple Project 
 

 

Đặt chế độ hoạt động cho mỗi chương trình. 
 

 
 

 
 
 

Tạo chương trình. 

GX Works2 Version 1 Operating Manual Simple Project 

 
Chú thích cho biến cục bộ. 

Đặt biến nhớ 

Đặt giá trị thiết bị khởi tạo. 
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1) Một dự án với mỗi GX Works 

Một GX Works2 có thể chỉnh sửa chỉ một dự án. 

Để chỉnh sửa hai hay nhiều hơn cùng lúc, chạy số chương trình GX 

Works2 bằng với số dự án. 

 
2) Chú thích biến 

Chú thích biến của GX Works2 được phân loại vào chú thích biến chung 

và chú thích biến cục bộ. 
 

Loại chú thích Số chú thích Mô tả 

 

 

 
Chú thích biến 
chung 

 

 

 
1 

Một ghi chú thiết bị tự động được tạo ra khi 

một dự án được tạo 

Chú thích chung được đặt để sử dụng ghi 
chú thiết bị chung giữa nhiều chương trình. 

 

 

 

Chú thích cục bộ 

 

 

 
Bằng với số chương 

trình. 

Một ghi chú thiết bị được tạo bởi người 
dùng. 

Không một ghi chú thiết bị cục bộ được có 
trước khi tạo một dự án mới. Vì vậy, hãy tạo 
một ghi chú thiết bị cục bộ nếu cần thiết. 

Đặt tên giống với chương trình tuần tự 
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3) Select! 
5) Click! 

2) Select! 

4) Select! 

1) Click! 

6) GX Works2 starts up. 

2.3 Thao tác trước khi tạo chương trình tuần tự 

 
2.3.1 Khởi động GX Works 2 

 

 

 

 

1) Click biểu tượng  

 
2) Chọn [All Programs]. 

 

 

3) Chọn [MELSOFT Application]. 
 

 

4) Chọn [GX Works2]. 
 

 
 

5) Click [GX Works2]. 
 
 

 
 

 

 
 

6) GX Works2 khởi động. 

Đặt con trỏ chuột lên thư mục cần vào để 
hiện ra menu 

(Click trái chuột hay double-click chuột là 
không cần thiết) 



2 - 23  

4) Click! 

5) Click and select! 

2) Select! 

3) Click and select! 

1) Click! 

2.3.2 Tạo một dự án mới  

 
1) Click   trên thanh công cụ và chọn [Project] → 

[New Project] ( Ctrl  + N ). 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

2) Click vào "Project Type". 
 

 
3) Danh mục "Project Type" hiện lên. Chọn 

"Simple Project". 
 

 
 
 

 
 
 

 
 
 

 
 

 

4) Click the "PLC Series" list button. 
 

 
5)    Danh mục "PLC Series" hiện lên. 

   Select "QCPU (Q mode)". 

 

 

 
 
 

 
 
 

 
 
 

 

 
(Đến trang sau) 
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9) A new project is opened! 

8) Click! 

6) Click! 

7) Click and select! 

OK 

(Từ trang trước) 
 

 
 

6) Click vào nút "PLC Type". 
 

 
7) Danh sách "PLC Type" hiện ra. Chọn  

 "Q06UDH".. 
 

 

8) Click 
vào 

 

 

 
 
 

 
 
 

 
 
 

 
 

 
 

9) Một dư án mới được tạo ra. 
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Q06UDHCPU 

(1) 

2.4 Các bước chuẩn bị để khởi động CPU 

 

Cần đặt chế độ công tắc và xóa bộ nhớ built-in trước khi viết một chương trinh lên 

CPU. 

 
Kết nối và đặt chế độ công tắc từ (1) dến (3) như hình dưới (Hình vẽ bên 

dưới là một ví dụ của Q06UDHCPU). 

 
 

 
 
 

 

 
 

 
 
 

 

(2) 

 

 

(3) 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

(1) Kết nối đến nguồn 

Kết nối đến pin bởi vì pin bị tháo ra khi vận chuyển 

 
(2) Đặt còng tắc 

Đặt công tắc RUN/STOP/RESET về vị trí STOP. 
 

 

(3) Kết nối cáp USB 
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1) Click! 

2) Double-click! 

3) Double-click! 

4) Click! 

5) Double-click! 

OK 

(4) Cài đặt Connection Destination 

Phần này giải thích làm thế nào để cài đặt kết nối giữa PC và PLC. 
 

1)  Click chọn "Connection Destination" 

trong vùng chọn lựa ở cửa sổ Navigation. 

 
 

 
 
 

 
 
 

 

 
 

 
 
 

 

 

2) Cửa sổ Connection Destination hiện lên. 

Click đúp chuột "Connection1" trong 

Current Connection. 

 
Hộp thoại Transfer Setup hiện lên. 

 

 
 
 

 
 
 

3) Click đúp chuột "Serial USB" của PC side I/F. 
 
 

 
 
 

 

 

4) Hộp thoại PC side I/F Serial Setting hiện 

lên. Chọn "USB" và click vào nút . 

 
 

 
 

 
 
 

5) Nhấp đúp chuột vào "PLC Module" của PLC 
side I/F. 

 

 
 
 

 

(Đến trang sau) 
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6) Click! 

7) Click! 

OK 

OK 

(Từ trang trước) 
 

 
 

6) Hộp thoại PLC side I/F Detailed Setting 

of PLC Module hiện lên. Chọn "QCPU 

(Q mode)" và click chọn         . 

 
 

 
 

 

7) Click   
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1) Click! 

2) Select the target memory. 

3) Click! 

4) Click! 

5) Click! 

6) Click! 

Execute 

Yes 

OK 

Close 

(5) Xóa bộ nhớ tích hợp trên CPU 

Phần này mô tả làm thế nào để xóa bộ nhớ chương trình của QCPU 
 

1) Click [Online] → [PLC Memory Operation] → 

[Format PLC Memory]. 
 

 

 
 
 

 
 
 

 
 

 

 
 
 

 
 

2) Hộp thoại Format PLC  Memory hiện ra. 

Chọn “Program Memory” ở ô Target 

Memory. 

 
 

3) Click 
vào 

.

 
 
 

 
 
 

 

 

4) Click 
vào 

để bắt đầu xóa.. 

 

 

 
 
 

 
 
 

5) Để hoàn tất quá trình xóa, khi    
hộp thoại bên trái hiện ra, chọn

b
u
t
t
o
n
. 

 
 

 
 
 

 

6) Click 

vào  

và đóng hộp thoại. 
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1) Click! 

2) Check. 

3) Check. 

4) Click! 

5) Click! 

6) Click! 

7) Click! 

Execute 

Yes 

OK 

Close 

(6) Xóa bộ nhớ thiết bị từ CPU 

Phần này mô tả làm thế nào để xóa hết biến nhớ từ QCPU.. 

1) Click [Online] → [PLC Memory Operation] → 

[Clear PLC Memory]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

2) Hộp thoại Clear PLC Memory hiện ra. Kiểm 

tra "Clear Device's whole memory" đã được 

chọn. 

 

3) Chọn "Include Latch". 
 

4) Click vàon 
 
 

 
 
 

 

5) Click vào  

 

để xóa biến chốt. 

 
 
 

 
 

 

6) Khi lệnh xóa được hoàn tất hộp thaoij 

ở bên trái hiện ra. 

       Click vào . 
 

 
 

 
 

7) Click vào    để đóng hộp thoại. 
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1) Click! 

2) Click! 

4) Click! 

Clear History 

Yes 

Close 

(7) Xóa lịch sử lỗi trong CPU 

Phần này diễn giải làm thế nào để xóa dữ liệu lịch sử lỗi được lưu trên QCPU. 
 

1) Click [Diagnostics] → [PLC Diagnostics]. 
 
 

 
 
 

 
 
 

 
 
 

 

 

2) Hộp thoại PLC Diagnostics hiện ra. 

Click vào                    . 
 

3) Hộp thoại xác nhận hiện ra. 

Click vào .. 
 

4) Click  để đóng hộp thoại. 
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1) Click! 

2) Enter time! 
3) Click! 

Execute 

(8) Đặt thời gian cho bộ điều khiển khả trình CPU. 
Đặt ngày, tháng năm, giờ, phút, giây, số ngày một tuần cho đồng hồ 

trên bộ điều khiển khả trình. 

Để sử dụng chức năng đồng hồ, sử dụng GX Works2 hoặc một 

chương trình tuần tự. Cài đặt hoặc đọc dữ liệu liệu đồng hồ trong GX 

Works2. 

 
1) Click [Online] → [Set Clock] để hộp thoại Set 

Clock hiện lên. 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

 

2) Đặt ngày, tháng, năm, giờ, phút, giây, và 

ngày trong tuần trong hộp thoại Set Clock. 
 

3) Click the . 
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F5 

Esc 

Enter 

Shift 
F5 

Enter 

6) The symbol is displayed! 

8) Press "Enter"! 

7) Enter "Y70"! 

   3) The symbol is displayed! 

5) Press "Enter"! 
4) Enter "X0"! 

2) Press "Enter"! 

1) Enter "X2"! 

A ladder program to be created 

X2 X0 

Y70 

Y70 

X3 

Y71 

F7 

Enter 

2.5 Tạo một chương trình ladder  

 
2.5.1 Tạo một chương trình ladder sử dụng phím chức năng (bàn phím) 

 

 

Xem hướng dẫn bên dưới để tạo chương trình ladder 

như hình bên. 

 
 
 

 
 
 

 
 
 

 
 

 

1) Nhấn để mở cửa sổ Enter Symbol. 

Nhập "X2". 

Nếu đánh sai bất kì kí tự nào, nhấn 

và gõ lại. 

2) Nhấn  để xác nhận. 
 

 
 

 

X2 

3) BIểu tượng vừa 
nhập( 

 

)hiện ra. 

 

4) Nhấn + , và nhập "X0". 

 

5) Nhấn để xác nhận. 
 

 
 

6) Biểu tượng vừa 
nhập( 

 
X0 

) is displayed. 

 

7) Nhấn ,và nhập "Y70". 

 

8) Nhấn để xác nhận.. 
 

 

 
(Đến trang sau) 

• Nút OK hoặc Exit được sử dụng để xác nhận 
hoặc hủy bỏ. 

Tạo một chương trình ladder 
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F6 

Enter 

F5 

Enter 

F7 

Enter 

19) The symbol is displayed! 

16) The symbol is displayed! 

18) Press "Enter"! 

17) Enter "Y71"! 

12) The symbol is displayed! 
 

13) Move the cursor! 

15) Press "Enter"! 

14) Enter "X3"! 

9) The symbol is displayed! 

11) Press "Enter"! 

10) Enter "Y70"! 

(Từ trang trước) 

 

9) Biểu tượng vừa nhập( Y70 ) hiện ra. 

 

10) Nhấn nút ,và nhập "Y70". 

 

11) Nhấn  để xác nhận. 
 

 

12) Biểu tượng vừa nhập 
( 

Y70 

) hiện ra. 

 

 

13) Di chuyển chuột đến dưới biểu 
tượng 

Y70 

. 

 

14) Nhấn , và nhập "X3". 

 

15) Nhấn để xác nhận. 
 

X3 

16) Biểu tượng vừa nhập 
( 

 

) hiện ra. 

 

17) Nhấn , và nhập "Y71". 

 

18) Nhấn để xác nhận. 
 

 
 

19) Biểu tượng vừa nhập ( Y71 ) hiện ra. 
 
 

 
 
 

 

 
 

20) Kết thúc quy trình. 
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   6) The symbol is displayed! 

   8) Click!   7) Click , 
then enter "X70". 

1) Click ,    2) Click!   
  then enter "X2".   

3) The symbol is displayed! 

4) Click , 5) Click! 

then enter "X0". 

A ladder program to be created 

X2 X0 

Y70 

Y70 

X3 

Y71 

Exit 

OK 

OK 

OK 

2.5.2 Tạo một chương trình ladder sử dụng thanh công cụ 
 

 

Làm theo những bước dưới đây để tạo ra một 

chương trình như hình bên trái. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1) Click   để mở cửa sổ Enter Symbol. 

Nhâp "X2". 

Nếu trong lúc làn bấm nhần vào nút nào đó, click 

 

2) Click nút để xác nhận. 
 

 

X2 

3) Biểu tượng vừa 
nhâp( 

 

) hiện ra. 

 

4) Click trên thanh công cụ và nhập "X0". 

 

5) Click nút . 
 

 
 

6) The entered symbol ( 

 

X0 

) is displayed. 

 

7) Click on the toolbar, and enter "Y70". 

 

8) Click the button. 
 

 

(Đến trang sau) 

Tạo một chương trình ladder 
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16) The symbol is displayed! 

18) Click! 17) Click , then enter "Y71"! 

19) The symbol is displayed!    

9) The symbol is displayed!    

11) Click! 

10) Click , 
then enter "X0". 

12) The symbol is displayed! 

13) Move the cursor! 

14) Click , 
15) Click! 

then enter "X3". 

OK 

OK 

OK 

(Từ trang trước) 
 

 

9) Biểu tượng vừa nhập ( Y70 ) hiện ra. 
 

 

10) Click trên thanh công cụ và nhập "Y70". 

 

11) Click nút . 

 

 

12) Biểu tượng vừa nhập ( 
Y70 

) hiện ra. 
 

 

13) Đưa chuột đến dưới biểu tượng 
Y70 

. 

 

14) Click trên thanh công cụ và nhập "X3". 

 

15) Click nút . 

 
X3 

16) Biểu tượng vừa nhập ( 
 

) hiện ra. 

 

17) Click trên thanh công cụ và nhập "Y71". 

 

18) Click nút . 
 

 

 
 

19) Biểu tượng vừa nhập ( Y71 ) hiện ra. 
 
 
 

 
 

 

 

20) Quy trình kết thúc. 
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1) Click! 

F4 

2.6 Chuyển đổi chương trình (Chuyển đổi ladder) 
 

 

1) Click [Compile] → [Build] ( ). 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

 
 

2) Chương trình ladder đã bị chuyển đổi. 

 

 

Nếu lỗi xuất hiện trong suốt quá trình chuyển 
đổi, con trỏ sẽ tự di chuyển đến điểm lỗi của 
chương trình ladder. Kiểm tra những điểm đó và 
sửa lại chương trình nếu cần thiết. 
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2) Set the switch to "STOP"! 

3) Click! 

4) Select a program to be 

written by clicking on data! 

5) Click! 

6) Click! 

Parameter + Program 

Execute 

Yes 

2.7 Đọc/Viết dữ liệu đến/từ khối CPU điều khiển khả trình 

 
(1) Viết dữ liệu đến CPU 

 

1) Coi như chương trình ladder (chương trình 

tuần tự) đã được tạo ra với GX Works2 để 

thực hiện bước tiếp theo. 

 
2) Đặt công tắc RUN/STOP/RESET trên 

CPU để STOP. 

 

 
 

 
 
 

 
 
 

 

3) Click   trên thanh công cụ hoặc vào 

[Online] → [Write to PLC]. 
 

 
 
 

 
 

 

4) Từ thẻ "PLC Module, click để chọn 

chương trình và tham số để viết lên 

CPU hoặc vào  để 
chọn chương trình và tham số mục tiêu. 

 

5) Click để chấp nhận đã chọn . 
 

 
 
 

 
 
 

 
 
 

 
 

 

6) Nếu một tham số hoặc chương trình đã 

được viết, hộp thoại xác nhận sẽ hiên ra để 

hỏi xem có xóa dữ liệu cũ không. Click 

. 
 
 

 

 

 

(Đến trang sau) 
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8) Click! 

9) Click! 

Close 

Close 

(Từ trang trước) 
 

 
7) Hộp thoại thể hiện tiến trình hiện ra. 

 
 

 
 
 

 
 
 

 
 
 

 
 

 

8) Thông báo "Completed" hiện ra khi quá 

trình viết hoàn tất. Sau đó click . 
 
 

 
 
 

 
 
 

 
 

 

 
 

9) Click nút  để đóng hộp thoại. 
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1) Click! 

2) Select a program to be 
read by clicking on data! 2) Select the 

target memory! 

3) Click! 

4) Click! 

6) Click! 

Parameter + Program 

Execute 

Yes 

Close 

(2) Đọc dữ liệu từ CPU 

1) Click   trên thanh công cụ hoặc click [Online] 

→ [Read from PLC]. 
 
 
 

 
 

 

2) Từ thẻ "PLC Module”, click để chọn chương trình 

và tham số để đọc từ CPU. Hoặc 

click 

chương trình mục tiêu. 

để chọn tham số và  

 

Chọn "Program Memory/Device Memory" cho 

"Target Memory". 

 

3) Click để chấp nhận đã chọn. 
 

 
 
 

 
 

 
4) Nếu một chương trình hoặc tham số tồn tại, một 

hộp thoại xác nhận xóa dữ liệu cũ sẽ hiện lên. 

Click . 
 
 

 
 

 

5) Hộp thoại thể hiện tiến trình hiện ra . 
 

 

6) Thông báo "Completed" hiện lên khi quá trình 

đọc hoàn tất. Sau đó, click . 
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3) Click! 

2) Set the switch to "RUN"! 

2.8 Quan sát trạng tháichương trình ladder 
 

 

1) Coi như chương trình ladder (chương trình 

tuần tự) đã được viết vào CPU điều khiển 

khả trình để tiếp tục bước sau. 

 

 
2) Đặt công tắc RUN/STOP/RESET trên 

CPU để RESET (trong khoảng 1s.), đặt 

nó trở lại STOP, và đặt nó về RUN. 

 
 
 

 

 

 

3) Click   trên thanh công cụ hoặc click [Online] 

→ [Monitor] →[Start Monitoring]. 
 

 
 
 

 

 
 

4) Chọn menu khác kết thúc menu giám 

sát. 

 
 
 

 
 
 

 

 

 

1) Xác nhận đồng hồ LED Y70 sáng lên bằng cách đặt công tắc chuyển mạch X2, 

và đồng hồ đó vẫn sáng sau khi công tắc chuyển mạch tắt đi. 

2) Xác nhận đồng hồ LED Y70 tắt đi bằng cách ấn (đang bật) nút (công tắc chuyển 

mạch) X0, và đồng hồ không sáng lên khi nút (công tắc chuyển mạch) được giải 

phóng (tắt đi). 

3) Bật công tắc chuyển mạch X3 làm bật đồng hồ LED Y71. 

Luyện tập 
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X0 

X0 

(1) Trong mode giám sát, hộp thoại Monitor Status bên dưới hiện ra bất chấp trạng 

thái giám sát 
 

 
1) 2) 3) 4) 5) 

 

1) Trạng thái kết nối 

Thể hiện trạng thái kết nối giữa một CPU điều khiển khả trình và một 

máy tính cá nhân sử dụng chức năng mô phỏng được bắt đầu. 

 
2) Trạng thái RUN/STOP 

Thể hiện trạng thái CPU điều khiển khả trình được điều khiển bởi công 

tắc khóa trên CPU điều khiển khả trình hoặc sự điều hành từ xa nhờ 

GX Works2. 

 
3) Trạng thái ERR. (chuẩn đoán PLC) 

Thể hiện trạng thái lỗi của CPU điều khiển khả trình 

Click vào biểu tượng màn hình của màn hình chuẩn đoán PLC (*1). 

 
4) Trạng thái USER  (chuẩn đoán PLC) 

Thể hiện trạng thái lỗi  người dùng của CPU điều khiển khả trình.  

Click vào biểu tượng màn hình của màn hình chuẩn đoán PLC (*1) 

 
5) Chu kỳ quét 

Thể hiện chu kỳ quét tối đa của CPU điều khiển khả trình được giám 

sát. 

Bộ điều khiển khả trình Q-series thể hiện chu kỳ quét theo đơn vị 0.1 

ms. 

*1: Đối với chuẩn đoán PLC, xem phần 2.8. 
 

 

(2) Trạng thái của ladder được thể hiện như bên dưới. 
 

1) Hiển thị của một công tắc khi X0 = OFF 

X0 
 

Tiếp điểm thường mở 
(không dẫn) 

Tiếp điểm thường đóng 
(dẫn) 

 

HIển thị của một công tắc khi X0 = ON 

X0 
 

 

Tiếp điểm thường mở  Tiếp điểm thường đóng 
(dẫn) (không dẫn) 

 

2) Hiển thị của một lệnh cuộn dây đầu ra, lệnh so sánh công tắc tương 

đương, và lệnh cuộn dây tương đương. 

Không thực thi, * 
Điều kiện chưa bắt đầu 

Thực thi, * 
Điều kiện được bắt đầu 

*: Lệnh để so sánh công tắc tương đương và cuộn dây tương đương 

là SET, RST, PLS, PLF, SFT, SFTP, MC, FF, DELTA, và DELTAP. 
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1) Double-click! 

2) Enter "Y72"! 

4) Enter "Y72"! 

5) Click! 

Enter 

F4 

(3) Sửa đổi ladder trong quá trình giám sát 

Phần này giải thích quy trình để sửa đổi Y70 thành Y72 trong quá trình giám 

sát. 

1) Click đúp      ( Y70 ). 
 
 

 
 
 

 
 

 

2) cửa sổ Enter Symbol hiện ra.  

Nhập "Y72". 

 

3) Nhấn nút . 
 

 
 

4) Click đúp     ( 
Y70 

) và chuyển "Y70" thành 
"Y72". 

 
 
 

 
 
 

 
 

 

5) Click [Compile] → [Build] ( ). 
 
 

 
 
 

 
 
 

 
 
 

 

6) Quá trình sửa đổi hoàn tất 
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1) Click! 

2.9 Chuẩn đoán lỗi CPU điều khiển khả trình 
 

 

1) Click [Diagnostics] → [PLC Diagnostics]. 
 

 

 
 
 

 
 
 

 
 
 

 

 
 

2) Màn hình PLC Diagnostics hiện ra. 

2) 
 

 
 
 

 

1) 

3) 

 

5) 
 

 

4) 
 
 
 

 
 
 

 

 

7) 
 

 
 
 

 

6) 
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 Tên Mô tả 

1) Trạng thái giám sát Thể hiện trạng thái giám sát hiện tại 

2) 
Danh sách kênh kết 

nối 
Thể hiện đường kết nối đã được đặt 

 

 

 

3) 

 

 

 

Trạng thái hoạt động 
CPU 

 Với một hệ thống CPU đơn lẻ 

Thể hiện trạng thái hoạt động và trạng thái công tắc của CPU điều khiển khả trình. 

 Với nhiều hệ thống CPU 

Thể hiện trạng thái hoạt động và trạng thái công tắc của CPU số1 đến số 4. 

• "Uninstallable/Blank" thể hiện một khe với không module nào lắp vào. 

 
4) 

Hình ảnh CPU điều 

khiển khả trình 
 
Thực hiện hoạt động trực tuyến của CPU điều khiển khả trình. (xem lại Gợi ý). 

 

 

 

 

 

 

 

 

 

5) 

Thông tin lỗi Chọn cái này để thể hiện thông tin lỗi hiện tại của CPU điều khiển khả trình. 

 

 

 

 

 

 

 

Thông tin trạng thái 

PLC  

Chọn cái này để thể hiện thông tin trạng thái của CPU điều khiển khả trình. 
 

 

6) Lịch sử lỗi Thể hiện lịch sử lỗi gần nhất bằng cách click vào nút   . 

7) Biểu tượng chú giải 
trạng thái 

 

Thể hiện biểu tượng trạng thái trên màn hình. 

 

Điểm chú ý  

Thao tác trực tuyến 

Chức năng PLC Memory Operation và chức năng Remote Operation có thể thực thi từ ảnh của CPU 

điều khiển khả trình. 

Khi con trỏ di chuyển đến ảnh của CPU điều khiển khả trình, menu chức năng được mở rộng. Click 

vào ảnh của CPU điều khiển khả trình để thể hiện những thành phần có thể đặt. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
<Set Clock/Write Title> 

 

 

 

 

 

 

<Remote Operation> 

<PLC Memory Operation> 
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1) Check! 

A ladder program to be created 

X2 X0 

Y70 

Y70 

Y72 

X3 

Y71 

2) Double-click! 

2.10 Chỉnh sửa chương trình ladder 

 
2.10.1 Sửa đổi một phần của chương trình ladder 

 

Phần này diễn giải làm thế nào để điều chỉnh một 

phần của chương trình ladder như hình bên. 

(OUT   Y71 → OUT   Y72) 
 

 
 
 

 
 
 

 
 
 

 

 
1) Xác nhận "Overwrite" được hiển thị ở 

phần bên phải bên dưới màn hình. 

 

 

 
 

2) Click đúp vào điểm để sửa lại. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

(Đến trang sau) 

Nếu "Insert" hiện trên màn hình, click vào 

để thay đổi hiển thị về "Overwrite". 

Ins  

Nếu "Insert" hiển thị trên màn hình, công tắc hoặc 

cuộn dây được thêm vào biểu đồ. 

<Khi sửa X2 thành X5> 

Thêm vào! 

X5 X2 

<Khi sửa SET thành  RST> 

SET   M3 

RST  M3 

Thêm vào 

Tạo một chương trình ladder 
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6) The modified diagram is displayed! 

5) Click! 
4) Enter "Y72"! 

3) The Enter Symbol window is displayed! 

F4 

OK 

(Từ trang trước) 
 

 
 

3) Cửa sổ Enter Symbol hiện ra. 
 

 
 
 

 
 
 

 
 
 

 
 

 

 
 

4) Click vào hộp chỉnh sửa và nhập "Y72". 

 

5) Click nút để xác nhận thay đổi. 
 

 
 

6) Chương trình ladder được điều chỉnh hiện ra. 
 

 

7) Để chuyển đổi chương trình ladder, click 

[Compile] → [Build] ( ). 
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Alt 

1) Click! 

3) A line is created! 

2) Drag! 

A ladder program to be created 

X2 X0 

Y70 

Y70 
Y73 

X3 

Y72 

F10 + 

2.10.2 Vẽ/ xóa đường thẳng 

 
(1) Vẽ đường thẳng 

 

Phần này diễn giải làm thế nào để thêm một 

đường thẳng vào chương trình ladder như hình 

bên. 

 

 
 

 
 
 

 
 
 

 
 
 

 

1) Click (  ) trên thanh công cụ. 
 
 
 

 
 
 

 

 

 
 

2) Kéo con chuột từ điểm bắt đầu đến điểm kết 

thúc. 

 

 
 

 
 

 
 

3) Một đường thẳng được tạo ra khi trái 

chuột được thả ra. 

 
 

 
 
 

 

 
(Đến trang sau) 

Một đường thẳng được tạo ra ở bên trái chuột. 

Tạo một chương trình ladder 
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6) The symbol is displayed! 

5) Click! 4) Click , 
then enter "Y73"! 

F4 

OK 

(Từ trang trước) 
 

 
4) Click trên thanh công cụ và nhập "Y73". 

 

5) Click nút . 
 
 

 
 
 

 
 

 

 
 
 

 

 
 

6) Biểu tượng vừa nhập ( Y73 ) hiện ra. 

 
7) Để chuyển đổi chương trình ladder, click 

[Compile] → [Build] ( ). 
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Alt F9 

1) Click! 

4) Press "Delete"! 

3) The line is deleted! 

2) Drag! 

A ladder program to be created 

X2 X0 

Y70 

Y70 
Y73 

X3 

Y72 

Delete 

F4 

(2) Xóa đường thẳng  

 
Thực hiện những bước dưới đây để xóa 

một đường thẳng như hình bên. 

 
 
 

 
 
 

 
 
 

 
 
 

 

1) Click        ( + ) trên thanh công cụ. 
 
 

 
 
 

 
 

 

 
 

2) Kéo chuột từ điểm bắt đầu đến điểm kết 
thúc. 

 

 
 
 

 
 
 

 
 

 

3) Đường thẳng bị xóa khi trái chuột thả ra. 

 

 
 
 

 

 
 

4) Nhấn nút         để xóa Y73 . 

 

5) Để chuyển đổi chương trình ladder, click 

[Compile] → [Build] ( ). 

Đường thẳng được vẽ cho lệnh END không thể 
xóa. 

Tạo một chương trình ladder 
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2) The menu 
is displayed! 

1) Click to move the cursor! 

A ladder program to be modified 

X7 

Y77 

X2 X0 

Y70 

Y70 

X3 

Y72 

2.10.3 Chèn/xóa một hàng 
 

(1) Chèn hàng 
 

 
Phần này diễn giải làm thế nào để thêm một jangf 

vào chương trình ladder ở hình bên trái. 

 

 
 

 
 
 

 
 
 

 
 
 

 
 

1) Click on any point of the row to move the 

cursor. 
 

 

 
 

 

 

 
 

2) Phải chuột vào điểm bất kì trên màn 

hình tạo chương trình ladder để hiển 

thị menu. 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

 
 

(Đến trang sau) 

Một hàng được thêm vào trên hàng được chọn với 
con trỏ. 

Tạo một chương trình ladder 

Click vào điểm bất kì của hàng để di 
chuyển con trỏ đến. 
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Shift Ins 

4) A new row is inserted! 

3) Click! 

6) Click! 5) Click , 
then enter "X7"! 

OK 

(Từ trang trước) 
 

 
 

3) Chọn [Edit] → [Insert Row] 

( + ). 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

4) Một hàng mới được chèn vào trên hàng 

được chọn. 
 

 
 
 

 
 
 

 

 

5) Click   trên thanh công cụ để mở cửa 

sổ Enter Symbol. Nhập "X7". 

 

6) Click nút để chấp nhận. 
 
 
 

 
 
 

 
 
 

 

 

 
(Đến trang sau) 
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10) The symbol is displayed! 

7) The symbol is displayed! 

8) Click , 
9) Click! 

then enter "Y77"! 

F4 

OK 

(Từ trang trước) 
 

 
X7 

7) Biểu tượng nhập vào ( ) hiện ra. 

 

8) Click trên thanh công cụ, và nhập "Y77". 

 

9) Click nút . 
 

 

 
 

 

 
 
 

 

 
 

10) Biẻu tượng vừa nhập ( Y77 ) is 

ra. 

 
11) Để chuyển đổi chương trình ladder đã sửa, 

click 

[Compile] → [Build] ( ). 

hiện 
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2) The menu 

is displayed! 

1) Click to move the cursor! 

A ladder program to be modified 

X7 

Y77 

X2 X0 

Y70 

Y70 

X3 

Y72 

(2) Xóa hàng  

 

Phần này diễn giải làm thế nào để xóa hàng 

từ chương trình ladder như hình bên. 
 
 
 

 
 
 

 
 
 

 

 
 

 
 

 
1) Đưa con trỏ đến hàng muốn xóa. 

 

 
 

 
 
 

 
 

 
 

2) Kích chuột phải đến bất kì điểm nào 

trên màn hình tạo chương trình ladder 

để hiển thị menu. 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 
 

(Đến trang sau) 

Tạo một chương trình ladder 
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Shift Del 

4) The row is deleted! 

3) Click! 

F4 

(Từ trang trước) 
 

 

3) Chọn [Edit] → [Delete Row] 

( + ). 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
 

4) Hàng được chọn đã bị xóa. 
 

 

5) Để chuyển đổi chương trình ladder, click 

[Compile] → [Build] ( ). 
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3) Click to cut! 

Range of cut or copy 

1) Click to move the cursor! 

A ladder program to be modified 

X7 

Y77 

X2 X0 

Y70 

Y70 

2) Drag to specify the area! 

X 

2.10.4 Cắt/sao chép chương trình ladder 
 

Phần này diễn giải làm thế nào để sao chép và cắt 

chương trình ladder như hình bên. 
 

 

 
 
 

 
 
 

 
 
 

1) Click vào điểm bắt đầu chương trình ladder 

muốn cắt để đặt con trỏ. 

 
 

 
 
 

 

 

 

2) Kéo chuột bao phủ ladder để nhận diện vùng 

ladder muốn cắt. 

Vùng được chọn đã được chuyển màu. 
 

 
 

 

 

3) Click trêm thanh công cụ hoặc vào [Edit] → 

[Cut] (   Ctrl +  

 

) để cắt vùng mong muốn 

 

 

 
 
 

 

 
 

(Đến trang sau) 

Click vào số bước và kéo chuột sang ngang để nhận 
diện vùng trong đơn vị khối ladder. 
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C 

6) Click ! 

 

 

 

 

 

The ladder is pasted above this block! 

 
7) Click to move the cursor! 

 

 

 

(Từ trang trước) 
 

 
4) Click vào điểm bắt đầu của chương trình 

ladder muón sao chép để đưa con trỏ tới. 
 

 
 
 

 
 
 

 

5) Kéo con trỏ bao trùm ladder để nhận diện 

vùng muốn cắt . 

Vùng được chọn được chuyển màu. 
 

 
 

 

 

6) Click trên thanh công cụ hoặc vào [Edit] → 

[Copy] (   Ctrl + 

muốn. 

để sao chép vùng mong   

 

 
 

 
 

 

7) Click vào bất kì khối ladder nào để đặt con 

trỏ đến ladder. Ladder muốn sao chép 

được dán vào trên hàng đặt con trỏ. 

 
 

 
 
 

 

(Đến trang sau) 

Click vào số bước và kéo chuột sang ngang để nhận 
diện vùng trong đơn vị khối ladder. 
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V 

9) Completed! 

8) Click! 

Từ trang trước) 
 

 

8) Click trên thanh công cụ hoặc [Edit] → 

[Paste] (   Ctrl + 

mong muốn. 

) để dán vùng  

 

 
 
 

 

 

9) Ladder bị cắt hoặc sao chép được dán vào. 
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1) Click! 

2) Click! 

3) Click! 

4) Double-click! 

5) Display! 

Parameter + Program 

Execute 

2.11 Kiểm tra dữ liệu 
 

Phần này diễn giải làm thế nào để kiểm tra dự án đang mở với dữ liệu trên CPU 

điều khiển khả trình. 

 

1) Click [Online] → [Verify with PLC]. 
 

 
 

 
 
 

 
 
 

 

2) Hộp thoại Online Data Operation hiện ra. 

Click nút . 

 

3) Click nút . 
 

 
 
 

 
 
 

 
 
 

 

 

 

4) Kết quả kiểm tra hiển thị trên cửa số Verify 

Result. 

 
Để kiểm tra chi tiét dữ liệu, click đúp vào hàng 

tương ứng. 

 

 

5) Chi tiết của kết quả được hiển thị. 
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Ctrl S 

7) Click! 

2) Specify the location to 
store the project! 

4) Set a project name! 

5) Set a title as necessary! 

6) Click! 

1) Click! 

 
3) Set a workspace name! 

  

 
 

 

 

Save 

Yes 

2.12 Lưu chương trình ladder 

 
2.12.1 Lưu dự án mới tạo hoặc ghi đè dự án 

 
 

 
 

 
1) Click trên thanh công cụ hoặc vào [Project] 

→ [Save] ( + ). 
 

 

 
 

 
 
 

 

 

 

(Chỉ khi một dự án mới tạo được lưu) 
 

 

2) Chỉ định địa điểm để lưu dự án . 

 
3) Đặt tên vùng làm việc. 

 
4) Đặt tên dự án. 

 
5) Đặt một tiêu đề nếu cần thiết. 

 

6) Click nút để xác nhận. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

7) Click nút . 

Dự án mới đã được lưu. 

Lưu dự án đã có hoàn thành xong ở bước này 
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7) Click! 

2) Specify the location to 
store the project! 

4) Set a project name! 

5) Set a title as necessary! 

6) Click! 

1) Click! 

 

3) Set a workspace name! 

  

  

 
 
  

 

Save 

Yes 

 

Gợi ý  

• Vùng làm việc 
Vùng làm việc cho phép GX Works2 quản lí nhiều dự án chỉ với một tên. 

• Khi địa điểm lưu tồn tại 
Khi địa điểm lưu (vùng làm việc và dự án) tồn tại, thư mục chứa vùng làm việc được xác định trong  
"Workspace/Project List". 

• Số kí tự cho một tên vùng làm việc, dự án, và tiêu đề 

Xác định tên vùng làm việc, tên dự án, và tiêu đề trong khoảng 128 kí tự 
Tuy nhiên, tổng số kí tự của tên đường dẫn địa điểm lưu + tên vùng làm việc + tên dự án phải nằm 
trong 150. 

 

2.12.2 Lưu một dự án với một tên khác 
 

1) Click [Project] → [Save as]. 
 

 
 
 

 
 
 

 
 
 

 
 

 

2) Chỉ định địa điểm để lưu dự án . 

 
3) Đặt tên vùng làm việc. 

 
4) Đặt tên dự án. 

 
5) Đặt một tiêu đề nếu cần thiết. 

 

6) Click nút để xác nhận. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

7) Click nút . 

Dự án mới đã được lưu. 
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Ctrl O 

Yes 

No 

3) Double-click! 

4) Click! 

5) Click! 

1) Click! 

Yes 

No 

Yes 

No 

Cancel 

2.13 Đọc một dự án đã lưu 
 

 
 

1) Click trên thanh công cụ hoặc vào [Project] 

→ [Open] ( + ). 
 
 
 

 
 
 

 

 

 
 

2) Xác định địa điểm nơi dự án muốn đọc 

được lưu. 

 

3) Click đúp vào vùng làm việc muốn đọc. 

 
4) Click vào dự án muón đọc. 

 
5) Click vào nút đó để bắt đầu đọc dự án đã 

chọn. 

 

 
 
 

 
 
 

 
 
 

 
 

Mỗi hộp thoại xác nhận được hiện ra trong những trường hợp dưới đây; 

(Khi một dự án khác đã được mở) 

 

 
 
 

 
 
 

 
 
 

 

(Khi một dự án khác được mở mà không chuyển đổi) 
 

 
 

(Khi dự án khác đang được mở mà chưa được lưu) 

 

 

 

·········Thoát khỏi dự án. 

··········Giữ dự án mở. 
 
 

 
 
 

 
·········Thoát khỏi dự án mà không 

chuyển đổi dự án. 

··········Giữ dự án mở. 

(Tiếp tục chỉnh sửa chương trình 
ladder.) 

 
 

 

·········Thoát khỏi dự án sau khi lưu nó. 

··········Thoát khỏi dự án mà không lưu 

nó. 

····Giữ dự án mở. 
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2) Click! 

Open 

Yes 

2.14 Mở dự án theo định dạng khác 

 
Phần này diễn giải làm thế nào để mở một dự án được tạo với GX 

Developer trong GX Works2. 

1) Click [Project] → [Open Other Data] 

→ [Open Other Project]. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

2) Hộp thoại Open Other Project hiện ra. Xác 

định dự án muốn mở và click 

. 
 

 
 
 

 
 
 

 
 
 

 

 

 
 

3) Thông báo ở bên trái hiện ra. 

Click nút . 
 
 

 
 

 

 
 

4) Dự án được tạo với GX Developer được 

mở. 
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1) Click! 

2) Select! 

3) Click! 

Save 

Yes 

 

Gợi ý  

• Trạng thái sau khi một dự án với định dạng khác được mở 
Khi một dự án trong một định dạng khác được mở, dự án đang ở trạng thái chưa được biên dịch . 
Biên dịch tất cả chương trình trong dự án trước khi thực thi điều hành trực tuyến như viết dữ liệu và 
giám sát. 
Khi một trạng thái biên dịch lỗi xuất hiện, sửa lại chương trình tương ứng theo như hướng dẫn lập 
trình. 

 

2.15 Lưu dự án với định dạng khác 

Phần này diễn giạ làm thế nào để lưu một dự án đơn giản của GX Works2 theo định 

dạng GX Developer. 

1) Click [Project] → [Export to GX Developer 

Format Tệp]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

2) Hộp thoại Export to GX Developer 

Format Tệp. Xác định địa điểm để lưu 

dự án. 

 
3) Nhập một tên dự án và click  nút 

 

 
 

 
 
 

 
 
 

4) Thông báo ở bên trái hiện lên.  

Click 

 . 
 
 

 
 
 

 

 

5) Dự án được lưu với định dạng GX 

Developer. 
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MEMO 
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Số của biến. 

Kí  h iệu 

CHƯƠNG 3 BIẾN VÀ THAM SỐ BỘ ĐIỀU KHIỂN KHẢ TRÌNH 
 

3.1 Biến 
Biến là một phần tử ảo cho việc lập trình bộ điều khiển CPU, tương tự các phần tử 

(như tiếp điểm và cuộn cảm) mà nó viết nên một chương trình. 
 

  
 

 

Các dạng Mô tả Ghi chú 
 

 

X 

 

 

Đầu vào 

Gửi các lệnh và dữ liệu đến bộ điều khiển khả trình thông qua 

các thiết bị ngoài như nút bấm, chuyển mạch lựa chọn, chuyển 

mạch giới hạn và chuyển mạch số. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
• Biến bít 

• Chủ yếu là tín hiệu 

bật/tắt 

Y Đầu ra 
Các đầu ra đưa đến các cuộn dây, khởi động từ và các đèn chỉ 
thị và chỉ thỉ số. 

M Rơ-le nội 
Rơ-le phụ bên trong bộ điều khiển nó không thể đưa trực tiếp ra 
thiết bị ngoài. 

L  Rơ-le chốt 
Rơ-le phụ họat động liên tục bên trong bộ điều khiển nó không 
thể đưa trực tiếp ra thiết bị ngoài. 

 

 

B 

 

 

Rơ-le liên kết 

Rơ-le trong cho liên kết dữ liệu nó không thể đưa trực tiếp ra 

thiết bị ngoài. Tại đây không được quy định bởi thông tin liên kết 

ban đầu mà được sử dụng như rơ-le trong. 

 

 
F 

 

 
Bộ chỉ báo 

Được sử dụng để phát hiện lỗi. Thiết lập một chương trình 

phát hiện lỗi trước và khởi động chương trình trong khi bộ 

điều khiển chương trình đang chạy để lưu trữ các giá trị số 

vào một thanh ghi riêng D. 

register D. 
V Rơ-le biên 

Rơ-le trong lưu trữ các kết quả hoạt động  

SM Rơ-le đặc biêt Rơ-le trong mà lưu trữ trạng thái CPU. 

SB Rơ-le liên kết đặc 
biệt 

Rơ-le trong cho liên kết dữ liệu mà nó biểu thị một trạng thái 
giao tiếp hoặc lỗi. 

 
 

 

FX 

 

 

Đầu vào chức 
năng  

Rơ-le trong mà nó giữ dữ liệu bật tắt và được ghi bởi một lệnh 

gọi chương trình con trong một chương trình con. 

FY  Đầu ra chức 
năng 

Rơ-le mà nó chuyển kết quả hoạt động từ chương trình con  
sang một nguồn gọi chương trình con. 

T(ST) Bộ định thời 
Bộ định thời bao gồm  dạng: định thời tốc độ thấp, định thời tốc 
độ cao, bộ tích phân tốc độ thấp và bộ tích phân tốc độ cao. 

 

 

 

 

 

 

• Biến dạng từ 

• Chủ yếu là dữ liệu 

• Một từ gồm 16 bit. 

• Có thể được ghi bởi 

đầu vào ~.* (* = 0 đến 

F (cơ số 16)). 

C Bộ đếm 
Bộ đếm gồm hai dạng: bộ đếm cho các chương trình PLC và bộ 
đếm cho các chương trình PLC xử lý ngắt. 

 D Thanh ghi dữ liệu Bộ nhớ lưu trữ dữ liệu bộ điều khiển khả trình. 

W Thanh ghi liên kết Thanh ghi dữ liệu cho liên kết dữ liệu. 

R Thanh ghi tệp 
Thanh ghi mở rộng cho thanh ghi dữ liệu, nó sử dụng RAM 
hoặc thẻ nhớ. 

SD Thanh ghi đặc 
biệt 

Thanh ghi lưu trữ trạng thái CPU. 

SW Thanh ghi liên kết 
dữ liệu 

Thanh ghi dữ liệu cho liên kết dữ liệu nó lưu trữ trạng thái giao 
tiếp và thông tin lỗi. 

FD Thanh ghi chức 
năng 

Thanh ghi trao đổi dữ liệu giữa nguồn gọi vòng lặp chương trình 
con này với chương trình con khác. 

 

Z Thanh ghi chỉ số 
Thanh ghi thay đổi biến (X, Y, M, L, B, F, T, C, D, W, R, K, H, và 
P) 

Y 74 X6 T2 
Y74 

Y74 
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Các dạng Mô tả Ghi chú 

FD 
Thanh ghi chức 
năng 

Thanh ghi trao đổi dữ liệu giữa nguồn gọi vòng lặp chương trình 
con này với chương trình con khác. 

 

 

Z Thanh ghi chỉ số 
Thanh ghi thay đổi biến (X, Y, M, L, B, F, T, C, D, W, R, K, H, và 
P) 

N Lồng Hiển thị kiến trúc được lồng của bộ điều khiển chủ. 

P Con trỏ 
Xác định vị trí nhảy của các nhánh chỉ dẫn (CJ, SCJ, CALL và 
JMP). 

I 
Con trỏ ngắt Xác định một vị trí nhảy tương ứng với hệ số ngắt khi một hoạt 

động ngắt diễn ra. 
 

 

J 

Mạng số. 

Đặc điểm thiết 

bị 

Sử dụng để chỉ rõ số mạng trong lệnh liên kết dữ liệu. 

 

 

U 

Số I/O .  

 
Được sử dụng để chỉ ra số I/O trong module chức năng thông 

minh dành cho các lệnh 

 

 

K 
Hằng số thập 

phân 

Được sử dụng để chỉ ra các: giá trị thiết lập bộ đếm định thời, 

số con trỏ, số con trỏ ngắt, số chữ số của biến bit và các giá trị 

lệnh cơ bản. 

H 
Hằng số thập lục 
phân 

 

Được sử dụng để chỉ các giá trị lệnh cơ bản/ứng dụng. 

E Hằng số thực 
Được sử dụng để chỉ ra số thực của lệnh 

"Chuỗi kí 
tự" 

Hằng số chuỗi kí 
tự 

Được sử dụng để chỉ chuỗi kí tự như các lệnh 

Jn\X 

Jn\Y 

Jn\B 

Jn\SB 

 

 

 

Biến liên kết 

trực tiếp 

 

 

 

Biến có thể truy xuất trực tiếp đến một biến liên kết của một 

mô-đun mạng. (Làm mới các tham số thiết lập không được yêu 

cầu) 

• Biến bit 

• Tín hiệu on/off . 

Jn\W 

Jn\SW 

• Biến dạng từ 

• Dữ liệu  

• Một từ gồm 16 bit 
 

 

Un\G 

Mô-đun chức 
năng thông minh Biến có thể truy xuất trực tiếp bộ nhớ đệm của một mô-đun 

chức năng thông minh. 
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3.2 Tham số 
 

Tham số là các giá trị thiết lập cơ bản được gán vào bộ điều khiển khả trình để điều 

khiển các đối tượng. 

Các tham số được phân chia thành các tham số PLC, tham số mạng, và mật khẩu 

từ xa như bên dưới. 

 
* Các vùng in đậm thể hiện các mục đã được sắp xếp trong cuốn sách này 

Mục Mô tả 

  

T
h
a
m

 s
ố
 P

L
C

  

 

Tên PLC  
   Nhãn  Cài đặt (tên và ứng dụng) của bộ điều khiển khả trình CPU. 

Ghi chú Cài đặt chú giải cho nhãn của bộ điều khiển CPU. 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
Hệ thống PLC 

Cài đặt giới hạn bộ định thời Cài đặt giới hạn thời gian của bộ định thời tốc độ thấp và tốc độ cao. 

Tiếp điểm RUN-PAUSE  Cài đặt tiếp điểm cho điều khiển RUN và PAUSE của CPU 

Tiếp xúc hợp lệ thao tác sao 
lưu dữ liệu khóa. 

Cài đặt các thiết bị tiếp điểm để thực hiện sao lưu dữ liệu khóa  (Chỉ dành cho Universal 
QCPU) 

Thiếp lập lại từ xa Thiết lập để cho phép hoạt động cài lại từ xa nhờ GX Works2. 

Trạng thái đầu ra từ STOP 
đến 

RUN 

Cài đặt trạng thái đầu ra (Y) khi bộ điều khiển chuyển từ STOP sang RUN. 

Thuật toán xử lí số thực Thiết lập để xử lí số thực (chỉ dánh cho mô-đun hiệu suất cao QCPU) 

Thiết lập mô-đun chức năng 
thông minh 

• Cài đặt tham số mô-đun 

• Cài đặt số bắt đầu I/O 

Số con trỏ chung Cài đặt số bắt đầu của con trỏ được sử dụng như con trỏ chung 

Điểm chiếm giữ bởi khe trống  
Cài đặt số khe trống cho đơn vị cơ bản chính hoặc mở rộng. 

 

Cài đặt ngắt hệ thống 
• Cài đặt số bắt đầu của các bộ đếm ngắt 

• Cài đặt khoảng thực hiện cho các con trỏ ngắt. 

Cài đặt chương trình quét cố 
định/ Chương trình ngắt 

 

 

Cài đặt thực hiện phá hủy tốc độ cao của một chương trình ngắt. 

 

Đồng bộ mô-đun 
Thiết lập đồng bộ khởi động bộ điều khiển CPU với mô-đun chức năng thông minh 

 

Cài đặt tương thích A-PLC  Cài đặt để sử dụng chuỗi vùng nhớ đặc biệt/thanh ghi đặc biệt MELSEC-A  

 

Cài đặt xứ lí dịch vụ 
Cài đặt thời gian xử lí dịch vụ. (chỉ cho mô-đun quốc tế QCPU) 

 

Cài đặt thay đổi mô-đun  
Cài đặt tham số này để thay thế mô-đun CPU sử dụng một thẻ nhớ (chỉ dành cho mô-đun 
QCPU). 

 
 

 
 
 

 
 

 

Tệp PLC 

 

 

Thanh ghi tệp 

• Cài đặt tệp thanh ghi tệp được sử dụng trong một chương trình 

• Cài đặt để truyền dữ liệu đến ROM chuẩn ở hoạt động sao lưu dữ liệu chốt (chỉ 

dành cho mô-đun quốc tế QCPU) 

Chú giải tệp được sử dụng 
trong một lệnh 

 

Cài đặt tệp chú giải các biến mà nó được sử dụng trong một chương trình. 

Giá trị thiết bị ban đầu  Cài đặt giá trị thiết bị ban đầu được sử dụng trên bộ điều khiển CPU 

Tệp cho thiết bị cục bộ Cài đặt tệp thiết bị cục bộ được sử dụng trong một chương trình 

Tệp sử dụng cho 

lệnh 

SP.DEVST/S.DEVLD 

 

Cài đặt tệp lệnh đọc ghi ROM được sử dụng trong một chương trình         

(chỉ cho mô-đun quốc tế QCPU) 

 
 
 

 
 
 

 

 
RAS PLC 

Cài đặt WDT (đồng hồ hẹn 
giờ) 

 

 

Cài đặt WDT của bộ điều khiển chương trình CPU. 

Kiểm tra lỗi Cài đặt để phát hiện lỗi được chỉ định 

Phương thức hoạt động khi có 
một lỗi 

 

Cài đặt bộ điều khiển khả trình khi có một lỗi được phát hiện 

  Quét hằng số Cài đặt chu kỳ quét hằng số 

 

Lịch sử hỏng hóc 
Cài đặt đích lưu trữ lịch sử lỗi của bộ điều khiển CPU (chỉ dành cho mô-đun hiệu suất cao 
QCPU) 

Thời gian thực hiện chương 
trình tốc độ thấp 

Cài đặt thời gian thực hiện chương trình tốc độ thấp trong mỗi chu kỳ quét. (chỉ dành cho 
mô-đun hiệu suất cao QCPU) 
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Mục Mô tả  

  

T
h
a
m

 s
ố
 P

L
C

 

 

 

Tập tin khởi 
động 

Tùy chọn khởi động Cài đặt để làm sạch chương trình khi khởi động lên. 

 

Cài đặt tệp tin khởi động 
Cài đặt dạng, tên dữ liệu, ổ đĩa nguồn truyền và ở đĩa đích truyền trong tệp khởi động 

 

Chương trình 
Cài đặt tên tệp và các kiểu thực hiện khi một vài chương trình được ghi đến bộ khởi động 
CPU 

  

SFC 
Cài đặt phương thức khởi động và điều kiên khởi động của một chương trình SFC và 
phương thức đầu ra ở khối dừng 

 

 

 

 

 

 

 

 
Biến  

Số biến Cài đặt số điểm được sử dụng cho mỗi thiết bị của bộ điều khiển chương trình CPU 

 

Chốt (1) bắt đầu/kết thúc 
Cài đặt phạm vi chốt (số biến ban đầu/số biến kết thúc) với chuyển mạch RESET/L.CLR hoặc 
một thao tác mở khóa từ xa. 

 

Chốt (2) bắt đầu/kết thúc 
Cài đặt phạm vi chốt (số biến ban đầu/số biến kết thúc) không xóa với chuyển mạch 
RESET/L.CLR hoặc một thao tác mở khóa từ xa. 

Khởi động/kết thúc biến cục 
bộ  

Cài đặt phạm vi (số biến ban đầu/số biến kết thúc) của các biến như một thiết bị cục bộ. 

Cài đặt mở rộng thanh ghi tệp Cài đặt mở rộng thanh ghi dữ iệu và thanh ghi liên kết. (chỉ dành cho mô-đun quốc tế QCPU) 

Cài đặt chỉ số cho biến ZR 

 

Cài đặt số khởi động của Z đến 32 bit chỉ số, hoặc sử dụng thanh ghi chỉ số ZZ cho cài đặt 
32-bit chỉ số  (chì dành cho mô-đun quốc tế QCPU) 

 

 

 

Chỉ định I/O  

 

Chỉ định I/O  
Cài đặt tên, loại, sô điểm của I/O và số khởi động I/O cho mỗi mô-đun được gán trên mỗi đơn 
vị cơ sở 

 

Cài đặt cơ bản 
Cài đặt loại, số khe của đơn vị cơ bản, loại mô-đun cấp nguồn, và loại cáp mở rộng. 

 

 

 

 

 

 

 

 

 

 

 

  Cài đặt đa 

CPU  

Số  PLC Cài đặt số bộ điều khiển CPU trong hệ thống sử dụng nhiều CPU. 

 

Phương thức hoạt động 
Cài đặt phương thức hoạt động của hệ thống đa CPU khi một lỗi dừng diễn ra trong bất kì 

CPU nào từ số 2 đến số 4. 

Trạm chủ Cài đặt số CPU cho CPU chủ. 

Cài đặt khởi động đồng bộ đa 
CPU 

 

Chọn mô-đun CPU được khởi động đồng bộ 

Thay đổi mô-đun online Thiết lập để cho phép thay đổi mô-đun online trong hệ thống đa CPU. 

Chia sẻ I/O khi sử dụng nhiều 

CPU 

Cài đặt để lấy lại trạng thái I/O của mô-đun I/O hoặc mô-đun chức năng thông minh được 
điều khiển bởi bộ điều khiển CPU khác. 

Cài đặt vùng giao tiếp 

(cài đặt làm mới) 

 
Cài đặt chia sẻ bộ nhớ dữ liệu khả dụng giữa các CPU. 

Cài đặt vùng truyền dẫn đa 
CPU tốc độ cao 

 

Cài đặt vùng người sử dụng, tự động làm mới, xác nhận chỉ định và vùng hệ thống. 
 

 

 

Cài đặt cổng 

Ethernet tích 

hợp sẵn 

Cài đăt địa chỉ IP  Cài đặt địa chỉ IP và định dạng đầu vào của địa chỉ IP. 

Mã dữ liệu giao tiếp Chọn mã nhị phân hoặc mã ASCII cho giao tiếp 

Nút cài đặt mở Cài đặt giao thức hệ thống mở và số cổng trạm chủ. 

Nút cài đặt FTP  Cài đặt để sử dụng hàm  FTP 

Nút cài đặt thời gian Cài đặt để sử dụng hàm SNTP và định thời. 

 

 

Giao tiếp kiểu 

nối tiếp 

Tốc độ truyền Cài đặt tốc độ truyền 

Kiểm tra tổng Cài đặt kiểm tra tổng. 

Thời gian chờ truyền 

 

Cài đặt thời gian chờ truyền 

Thay đổi trực tuyến Cài đặt để cho phép thay đổi chương trình trực tuyến. 

T
h
a
m

 s
ố
 

m
ạ
n
g
  

Ehternet/CC IE/MELSECNET 
Cài đặt tham số mạng cho Ehternet, MELSECNET/10, MELSECNET/H, và liên kết CC 

 

 

CC-LINK 
 

Cài đặt tham số cho CC-LINK 

Mật khẩu từ xa Cài đặt mật khẩu để giới hạn truy nhập thông qua Ethernet hoặc mô-đun giao tiếp đặc biệt. 
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1) Kích đúp! 

2) Click! 

3)Thay đổi! 

4) Click! 

End 

• Khi GX Works2 khởi động, nó dùng các giá trị thiết lập sẵn như các tham số. 

Các giá trị này là mặc định (các giá trị ban đầu) 

• Bộ điều khiển chương trình có thể chạy với các giá trị như cũ, tuy nhiên, thay đổi 
chúng trong một phạm vi xác định là cần thiết. 

 

Khi lỗi tính toán gây ra, bộ điều khiển chương trình sẽ thay đổi trạng thái STOP ở 

giá trị mặc định, tuy nhiên, việc thay đổ i các tham số sẽ duy trì bộ điều 

khiển CPU chạy. 

Ví dụ lỗi tính toán 

• Trong lệnh chia, quá trình xử lí chia dư 0 được thực hiện. 
 

1) Click đúp "PLC parameter" trên cửa sổ 

Navigation  

 

 
 
 

 
 

 

2) Hộp thoại cài đặt tham số Q sẽ xuất hiện. Click 

tab "PLC RAS" . 

 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

3) Thay đổi cài đặt "Computation Error" trong 

"Operation Mode When There Is an Error" 

sang "Continue" 

 

4) Click   

Ví dụ hoạt động: thay đổi chế độ hoạt động khi một lỗi tồn tại 
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MEMO 
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CHƯƠNG 4 CÁC LỆNH CƠ BẢN VÀ LỆNH TUẦN TỰ - PHẦN 1- 
 

4.1 Danh sách các lệnh được giải thích trong chương này 

 
Trong chương này giải thích các lệnh tuần tự và các lệnh cơ bản như bảng 

dưới đây: 
 

Kí hiệu lệnh  
(Tên) 

 

 

Chức năng 

 

 

Biểu tượng 
(Các biến được sử dụng) 

Kí hiệu 
lệnh 

(Tên) 

 

 

Chức năng 

 

 

Biểu tượng 
(Các biến được sử dụng) 

 

 

 

OUT 

Ra  

 

 

 

 

Đầu ra cuộn 
dây 

 

 

 
 

Chỉ định một phần của 
biến bit hoặc biến từ 

 

 

 

 

CJ 

 

 

 

Điều kiện nhảy 

(không trễ) 

 

 

 

CJ Pn 

n = 0 to 4095 

con trỏ  

 

 
MC 

Điều khiển 

chính 

 

 

 

Khởi động điều 

khiển chính
*1

 

 

Chỉ định một phần của biến bit 
hoặc biến từ 

 

 

Nn MC  Nn 

n = 0 đến 14 

Lồng 

 

 

 

 

SCJ 

 

 

Điều kiện nhảy 

Nhảy sau khi 

quét 

 

 

 

SCJ Pn 

n = 0 đến 4095 

con trỏ  

 

 

MCR 

Reset 

điều 

khiển 

chính 

 

 

 
Kết thúc kiểm 

soát chính 

 

 

 
MCR Nn 

n = 0 đến 14 

Lồng 

 

 

 

 

CALL 

 

 

 
Gọi chương trình 

con 

 

 

 
CALL    Pn 

n = 0 đến 4095 

con trỏ 

 

 

 
SET 

Cài đặt 

 

 

 

 

Cài đặt các biến  

 

 

 

SET 
 

 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

 

CALLP 

 

 

Gọi một chương 

trình con  

 

 

 

CALLP   Pn 

n = 0 đến 4095 

Con trỏ 

 

 

 
RST 

Cài đặt lại 

 

 

 

 

Cài đặt lại các 
biến 

 

 

 

RST 

 
 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
RET 

Trở về 

 

 
Trở về từ một 

chương trình con 

 

 

 

 

RET 

 

 

 
PLS 

Xung  

Xung   

Tạo các xung 

cho một vòng 

chương trình 

khi một tín 

vào hiệu tắt 

 

 

 

PLS 

 
 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

 

FEND 

 

 
Kết thúc một 

chương trình 

thường xuyên 

chính 

 

 

 

 

FEND 

 

 

 
PLF 

Pulf 

Pulf  

Tạo các xung 

cho một vòng 

chương trình 

khi một tín 

vào hiệu tắt 

 

 

 

PLF 
 
Chỉ định một bít của biến từ 
hoặc biến bit 

   

 

*1: Trong GX Works2, trạng thái on/off của kiểm soát chính được hiển thị trong một 

thẻ trên màn hình. 
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<Danh sách các lệnh không được giải thích trong chương này: phần 1> 

"Giới thiệu: KHÓA HỌC PLC "các lệnh được trình bày bên dưới thì PLC dòng A cũng 

hỗ trợ .  

Tham khảo "MELSEC-Q/L Programming Manual Common Instruction" để biết chi tiết 
hơn. 

 

Kí hiệu 

lênh 

(Tên) 

 

 

Chức năng 

 

 

Biểu tượng 
(Các biến được sử dụng) 

Kí hiệu 

lệnh 

(tên) 

 

 

Chức năng 

 

 

Biểu tượng 
(Các biến được sử dụng) 

 

 

 

LD 

Tải  

Thao tác lệnh logic 

Bắt đầu thực hiện 

một tiếp điểm 

thường mở 

 

 
 

Bắt đầu thực hiện tiếp điểm 

thưởng mở 

 

 

 

MRD 

Dây dẫn 

 

 

 

Rẽ nhánh 

 

  

 

 

LDI 

Tải ngược 

Thao tác lệnh  logic 

Bắt đầu thực hiện 

một tiếp điểm 

thường đóng 

 

 

 

 

 

Bắt đầu thực hiện tiếp điểm 
thưởng đóng 

 

 

 

MPP 

Pop 

 

 

 

Kết thúc rẽ 

nhánh 

 

  
 

 

 

 

AND 

And 

Thao tác lệnh 

logic AND 

Kết nối nối tiếp của 

các tiếp điểm 

thuờng mở. 

 

 

 
 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

NOP 

Nop 

 

 

 

 

Được bỏ qua 

 

 

 

Để trống hoặc xóa chương 

trình 

 

 

ANI 

And 

ngược 

Thao tác lệnh 

logic ngược lệnh 

AND  

Kết nối nối tiếp của 

các tiếp điểm 

thường đóng 

 

  
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

END 

Kết 
thúc 

 

 

Quá trình END kết 

thúc một chương 

trình 

 

 

 

Phải được sử dụng như việc 

kết thúc một chuương trình 

 

 

 

OR 

Or 

Thao tác lệnh logic  

OR  

Kết nối song song 

của các tiếp điểm 

thường mở 

 

 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
STOP 

 

 

 
Dừng hoạt động 

 

 

 
STOP 

 

 

 

ORI 

Or ngược 

Thao tác logic 

ngược  OR  

Kết nối song song 

của các tiếp điểm 

thường đóng 

 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

SFT 

Dịch 

 

 

 

 

Dịch một bit của 

biến 

 

 
SFT 

 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 
ANB 

Khối And  

 

Thao tác lệnh AND 

giữa các khối logic 

Kết nối nối tiếp của 

các khối 

  

 
SFTP 

Dịch P 

 

 

Dịch một bit của 

biến ( với xung 

) 

 

 

SFTP 
 

 

Chỉ định một bít của biến từ 
hoặc biến bit. 

 

 
ORB 

Khối Or 

 

Thao tác lệnh OR 

 giữa các khối logic 

Kết nối song song 

của các khối 

  

 

 
NOPLF 

 

 

Bỏ qua 

 (để một trang 

ngăn) 

 

 

 

NOPLF 

 

 

MPS 

Đẩy 

 

 

 

Khởi động một 
nhánh 

 

  

 

 

 

PAGE 

 

Bỏ qua 

(công nhận như 

bước số 0 của N 

trang) 

 

 

 

PAGE n 
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<Danh sách các lệnh không được giải thích trong chương này: phần 2> 

Các lênh được liệt kê dưới đây dành cho PLC dòng Q và không hỗ trợ cho PLC dòng 
A 

Một phần được giải thích trong "Q Programming Applied Course". 

Tham khảo "MELSEC-Q/L Programming Manual Common Instruction” để biết thêm 
chi tiết. 

 

Kí hiệu 
lệnh  
(Tên) 

 

 

Chức năng 

 

 

Biểu tượng 
(các thiết bị được sử dụng) 

Kí hiệu 

lệnh 

(Tên) 

 

 

Chức năng 

 

 

Biểu tượng 
(các thiết bị được sử dụng) 

 

 

 

LDP 

Tải  P 

 

 

 

Xung suờn lên  

 

 

 

 

 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

 

MEF 

 

 
Chuyển đổi kết 

quả thành xung 

sườn xuống 

 

  
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
LDF 

Tải F 

 

 

 
Xung sườn xuống 

 

 

 

 

 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
INV 

Nghịch 
đảo 

 

 

 
Nghịc đảo kết 

quả xử lý 

 

  
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
ANDP 

And P 

 

 

 
Nối nối tiếp tiếp 

điểm  xung lên 

 

 

 

 

 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
EGP 

Edge P 

 

 
 Chuyển đổi kết 

quả thành xung 

sườn xuống  

 
Vn 

 

 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
ANDF 

And F 

 

 

 
Kết nối nối tiếp 

của  xung xuống 

 

 

 

 

 
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
EGF 

Edge F 

 

 
Chuyển đổi kết 

quả thành xung 

sườn xuống 

 
Vn 

 

 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
ORP 

Or P 

 

 
Kết nối song 

song thêm  xung 

lên 

 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 

 

FF 

 

 

 
Nghịch đảo đầu vào 

của một biến 

 

 

 

FF 
 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
ORF 

Or F 

 

 
Kết nối song 

song thêm  xung 

xuống 

 

 

Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
DELTA 

Delta 

 

 
Chuyển đổi đầu ra 

trực tiếp thành 

xung  

 

 

 
 
 

DELTA 

DY 

 

 

 

 

MEP 

 

 
Chuyển kết quả 

thành xung sườn 

lên 

 

  
Chỉ định một bít của biến từ 
hoặc biến bit 

 

 

 
DELTAP 

Delta P 

 

 
Chuyển đổi đầu ra 

trực tiếp thành 

xung  

 

 
 
 

 

DELTAP 

DY 
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OUT SET RST 4.2 Sự khác nhau giữa  và / 

 

Tên dự án QB-1 

Tên dự án MAIN 
 

 
 

X0 

0 Y70 

 

 

  • Lệnh OUT biến được bật khi điều kiện đầu vào bật và biến tắt khi điều kiện đầu vào 

tắt. 

[Biểu đồ thời gian] 
 

X0 
 

 

 
Y70 

 

Tên dự án QB-2 

Tên dự án MAIN 
 

 
 

X0 

0 SET 
 

 

 

X1 

2 RST 

 

 

Y70 
 

 

 

 

Y70 

 
 

 

  • Lệnh SET bật biến khi điều kiện đầu vào bật, và giữ trạng thái biến thậm chí khi 

điều kiện đầu vào tắt. 

Tắt biến khi sử dụng lệnh  RST  

[Biểu đồ thời gian] 

 

X0 

 

 
 

X1 
 

 
 

Y70 

Lệnh SET/RST  

Lệnh OUT 
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3.0giây
. 

Mở tiếp điểm  T0,Cuộn Y70 

Đóng tiếp điểm 0b, C u ộ n  
Y71 

Dạng  Số đinh thời 

Định thời  tốc   Đếm thời gian 

độ thấp…... theo đơn vị 100ms. 

 

 

Mặc định 

T0 đến T2047 
(2048) 

Định thời tốc Đếm thời gian 

độ cao·········  theo đơn vị 10ms. 

Định thời tốc Tích lũy thời 

độ thấp có gian theo đơn 

nhớ·············   v ị  100ms. 

 

 

Mặc định: 0 
 

Giá trị có thể 

được thay đổi sử 

dụng  thông số. 

Định thời tốc Tích lũy thời 

độ cao có gian theo đơn 

nhớ ·············  v ị  10ms. 

 

4.3 Đo bởi bộ định thời 

 

Tên dự án QB-3 

Tên chương trình MAIN 

 

K30 
X5 

0 T0 

 
Cài đặt giá trị hẹn giờ (thời gian giới hạn: 3.0 giây.) 

T0 

5 Y70 
 

 

 
T0 

7 Y71 
 

*: OUT T là một lệnh 4 bước. 
 

[Biểu đồ thời  gian] 
 

 

• Tiếp điểm định thời hoạt 

động trễ bởi việc cài đặt 

thời gian sau khi cuộn đây 

được cấp nguồn. (định  

thời trễ quá trình mở) 

• Phạm vi cài đặt định thời 

từ K1 đến K32767. 

Định thời  tốc độ thấp (100 

ms) 0.1 đến 3276.7giây. 

Đinh thời tốc độ cao (10ms)  

0.01 đến 327.67sec. 

• Khi giá trị định thời được 

cài đặt là 0, nó được bật 

bởi việc thực hiện lệnh. 

 

•  Bốn dạng định thời khả dụng. 
 

   

• Thay đổi lệnh đầu 

ra   (OUT) thành 

OUTH để chọn 

định thời tốc độ 

cao hoặc bộ định 

thời tốc độ cao có 

nhớ  

. 

• Để sử dụng bộ định thời 

có nhớ, cài đặt các tiếp 

điểm thiết bị  cho bộ định 

thời có nhớ trong việc cài 

đặt thiết bị của tham số 

PLC. 

                               Tham khảo mục 6.4 để xem giải thích về bộ định thời có nhớ 

 

Tiếp điểm X5 

Cuộn dây T0 
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1 2 3 11 12 0 

(giá trị hiện tại bộ đếm) 

 

Tiếp điểm X7 (đầu vào lệnh RST) 

Cấu hình trực tiếp sử dụng 

thanh ghi dữ liệu D cũng có 

hiệu quả đối với bộ đinh thời 

4.4 Đếm bởi bộ đếm 

 

Tên dự án  QB-4 

Tên chương trình MAIN 

 

X1 

0 
 

 

 

C20 

5 

 

 

C20 

 
Cài đặt giá trị trong bộ đếm 

 

 

Y72 

 

 

X7 

7 RST C20 

 

*: OUT C là một lệnh 4 bước 
 

[Biểu đồ thời gian] 
 

 

• Bộ đếm tiến đếm khi một 

tín hiệu đầu vào . 

• Sau khi đến, các tín hiệu 

theo sau đầu vào không 

được đếm. 

• Bộ đếm bắt đầu đếm, 

trạng thái tiếp điểm hoặc 

giá trị bộ đếm hiện tại 

không thay đổi cho đến 

tận khi lệnh  RST được  

thực  h iện 

• Thực hiện lệnh  RST trước 

khi bộ đếm quay trở lại 0. 

• Phạm vi cài đặt bộ đếm từ 

K0 đến K32767. (K0 bật 

(đếm tiến) bằng việc thực 

hiện lệnh) 

• Thêm và đó, Có thể sử dụng trực tiếp hằng số K, hoặc gián tiếp sử dụng biến D 

(thanh ghi dữ liệu )   
 

       cài  đặt giá trị     • Bộ đếm C30 đếm 
 

 
Chuyển mạch số

 

 

0 2 4 

D10 24 

X0 

0 
 
 

 
C30 

5 

 

 

C30 
 

 
 
 

 

Y71 

 

nhánh trên của tín hiệu đầu 

vào X0 thành một số 

tương tự  (như 24) được 

ghi bởi thanh ghi dữ liệu 

D10. 

• Cấu hình gián tiếp hữu 

dụng cho các giá trị được 

chỉ rõ bởi một chuyển mạch 

số ngoài đến bộ đếm.

 

 
 
 
 
 

Cuộn  C2 

Tiếp điểm X1 

Tiếp điểm C20, cuộn dây Y72 
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Tên dự án QEX1 

Tên chương trình MAIN 

Ví dụ : Chương trình Ladder  

Khi  băng truyền hoạt động công tắc (X0) được bật, còi (Y70) kêu 3 hồi 2 lần và  

băng truyền (Y71) bắt đầu hoạt động. 

Băng truyền dừng hoạt động khi cảm biến (X1) phát hiện 6 gói hàng đi qua.  

 
 

Tạo chương trình ladder bên dưới và kiểm tra . 
 

 

X0 C0 
M0 0 Trong khi hoạt động 

M0 

M0 Y71 
Y70 

K30 

4 Còi 

M0 
T0 Hẹn giờ 3s 7 

T0 
Băng truyền hoạt động 12 Y71 

K6 X1 
14 C0 Đếm số gói hàng 

Y71 
RST C0 19 

Cảm biến 

(X1) 

Băng truyền 
Mô-tơ 

              Bảng điều khiển 

Bảng hoạt động 

    Chạy           còi 
MC 

(X0) (Y70) 

(Y71) 
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OK 

No 

 

 

(1) Tạo một dự án 

(a) Click   trên thanh công cụ. 
 

 

 
(b) Hộp thoại  New Project xuất hiện. 

Cài đặt  "Project Type" ở chế độ "Simple Project", "PLC Series" ở chế độ 
"QCPU (Q mode)", 

Và "PLC Type" là "Q06UDH". Sau đó click  
 

 
 

(c) Nếu dự án này đã tồn tại, h ộ p  t h o ạ i  x ác  n h ậ n  lư u  d ự  á n  x u ấ t  

h i ệ n .  

Click nút  
 

 
 

(d) Chuyển màn hình sang chế độ lập một dự án mới. 

Click 

Click 

Click 

Trình tự thao tác 
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Click 

Nhập "M0" sau 

khi kích . 

Nhập "C0" sau  

khi kích  . 
Click 

Nhập "X0" sau  

khi kích . 
Click 

OK 

OK 

OK 

(2)     Tạo một chương trình 

[sử dụng bàn phím] 

 
Chuyển 

 

[Sử dụng các thanh công cụ] 
 

 

 

(a) Click   trên thanh công cụ để mở 

cửa sổ Enter Symbol. 
 

 

(b) Nhập "X0" trên bàn phím và click  
nút

  
 

 

 
 

(c) Click   trến thanh công cụ để mở 

cửa sổ Enter Symbol. 
 

 

(d) Nhập  "C0" trên bàn phím và click 

nút . 
 

 

 

(e) Click   trên thanh công cụ để mở 

cửa sổ Enter Symbol. 
 

 

(f) Nhập  "M0" trên bàn phím và click 
 nút  

. 
 

 

 
 

 
 

 
 

 

(g) Khi thiết lập mạch được hoàn 

thành, click [Compile] → [Build]. 

F5 X 0 Shift +   F5 C 0 F7 M 0 

F4 
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Parameter + Program 

Execute 

(3) Ghi một dự án cho bộ điều khiển khả trình 
 

(a) Ghi một ladder được lập đến bộ nhớ trên bộ điều khiển. 
 

 

Click   trên thanh công cụ. 

Hộp thoại Online Data Operation xuất hiện. 
 

 
 

(b) Click . Các hộp kiểm tra chương 

trình đích và tham số đích hiện lên trong một cửa sổ được tự động 

đánh dấu (   ). 

 

(c) Click . 
 

 

Click 

Kích nút này sau khi tên 
chương trình và thông số PLC 
xuất hiện và các hộp kiểm tra 
của chúng được đánh dấu 

Click 

Cài đặt chuyển mạch RUN/STOP 

của CPU sang STOP. 
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Yes 

Yes 

(d) Nếu các tham số đã được ghi sẵn, một hộp thoại xác nhận đè tham số 
xuất hiện. Click 

 
 

 
 

(e) Hộp thoại ghi sang PLC xuất hiện 
 

 
 

 

(f) Nếu chương trình đã được ghi, hộp thoại xác nhận đè chương trình xuất 
hiện. Click  

 
 

 

Click 

Click 
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(g) Ghi một chương trình đến bộ điều khiển được hoàn thành. 
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(4) Giám sát một ladder 

Giám sát một ladder. 
 

 
 

(a) Click   trên thanh công cụ. 
 

 

 
(b) Một màn hình ladder được sử dụng để giám sát ladder. 

 

 
 

 

 
1) Bật công tắc (X0),  bậ t  Y70 và khởi động T0 cùng một lúc. 

2) Khi bộ định thời T0 đếm 3 giây, Y70 tắt và Y71 bật cùng một lúc. 

3) Bật hoặc tắt công tắc (X1). Bộ đếm C0 đếm số ON để tắt Y71 sau khi đếm   

6 lần.

Hoạt động thực tế 

Click 

Giữ công tắc  RESET/STOP/RUN trên CPU ở 

RESET nhiều hơn 1 giây, sau đó chuyển sang 

RUN. 
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1 

2 

 

4.5 PLS Pulse ( Xung sườn lên khi có điều kiện đầu vào ) 

 
PLF Pulf (Xung sườn xuống khi có điều kiện đầu vào) 

 

Tên dựu án QB-5 

Tên chương trình MAIN 

 

 

X0 1 
0 PLS M5 

X1 2 
3 PLF M0 

• Lệnh  PLS cho phép ON biến trong khoảng một chu kỳ quét bắt đầu khi sườn lên 

của biến điều kiện đầu vào.  

[Biểu đồ thời gian] 

X0 

M5 

Một lần quét Một lần quét 

•  Lệnh PLF cho phép ON biến trong khoảng một chu kỳ quét  bắt đầu khi sườn 

xuống của biến điều kiện đầu vào.  

• [Biểu đồ thời gian] 

X1 

M0 

Một lần quét Một lần quét 
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X0 
PLS M0 

M0 
SET M5 

M5 
Y70 

Điều kiện thực hiện K50 

TO 

TO 
RST M5 

5s. 

Thời gian chờ 
điều kiện 

 

 
• Các lệnh có thể được sử dụng trong chương trình dự phòng để chờ điều kiện hoạt 

động. 

Lệnh thực hiện 

 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

[Lược đồ thời gian] 
 

 

X0 

(kích hoạt) 
 

 

M0 
 

 
 

M5 
 

 
 

Y70  

(Hoạt động) 

 
 

  

Điều kiện 
thực hiện 

 

 

 Biến khả dụng 

C
h

ữ
 s

ố
 

S
ố
 b

ư
ớ

c
 n

h
ả
y
 

c
ơ

 b
ả
n
 

Biến trong (hệ 

thống hoặc 

người sử dụng) 

 

Thanh 

ghi tệp 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Mô-đun 

chức năng 

thông minh 

Un\G 

 

Thanh 

ghi chỉ 

số  H
ằ
n

g
 s

ố
 

 
C

o
n

 t
rỏ

 

M
ứ

c
 

Bit Từ R Bit Từ Z K H P I N 

PLS D 

PLF D 

 

 

D 

 


 


 


 


 


 


        
2 

Ứng dụng 
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X0 
PLF M0 

M0 
SET Y70 

Y70 

Các cách sử dụng khác nhau của PLS và PLF 

X0 
PLF M1 

K100 
T16 

M1 T16 

Y76 
Y76 

• Các lệnh có thể được sử dụng cho một chương trình để phát hiện sự chạy qua 

của các sản phẩm hoặc đối tượng. 

Sau khi một sản phẩm chạy qua được phát hiện, quá trình xử lí tiếp theo cho sản 

phẩm được bắt đầu.. 

 

 

 

Sản phẩm 
 

 

Cảm biến 

 

 
 
 

 
 
 

 

Cảm biến 

(Phát hiện đầu vào từ X0) Băng truyền 
 

 

[Lược đồ thời gian] 

 

 
 

 

   Phần 1 

• Các lệnh có thể được sử dụng cho một chương trình mà chương trình đó thực 

hiện hoạt động đầu ra trên một chu kì khi tín hiệu đầu vào chuyển từ bật sang tắt. 

[Lược đồ thời gian] 
 

 

đầu vào 
(X0) 

 

 

đầu ra 
(Y76) thời gian giới hạn 

10sec. 

 

 
 

Thời gian xung 

 

 

[Ví dụ chương trình] 

Tên dự án QB-6 

Tên chương trình MAIN 

 

0 
 

3 

X0 

M0 

Y70 
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Các cách sử dụng khác nhau của PLS và PLF 

X0 
PLS M0 

PLF M1 

M0 Y70 
Y70 

M0 Y70 

M1 Y71 
 

Y71 

Y71 

M1 

Phần 2 

• Một chương trình cho quá trình lặp như các trạng thái chuyển mạch on/off luân phiên 

nhau bởi việc nhấn các nút chuyển mạch có thế được thực hiện bằng các lệnh. 

Nếu các lệnh PLS được sử dụng trong chương trình trên, thì sườn tăng được 

tạo ra khi nút bấm chuyển mạch được nhấn. Nếu lệnh PLF được sử dụng, thì 

sườn xuống được tạo ra khi chuyển mạch được giải phóng. 

[Lược đồ thời gian] 
 

 

X0 
 

 

 

Y70 
 

 
 

Y71 

 

[Ví dụ chương trình] 

Tên dự án QB-7 

Tên chương trình MAIN 

 

0 

 

 

5 

 

 

11 
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PLS 

 

Tên dự án QEX2 

Tên chương trình MAIN 

Ví dụ Ladder 

Thiết lập một ladder bên dưới và kiểm tra hoạt động của nó. 
 

 
 

[Lược đồ thời gian] 
 

 

X2 

 

M0 

 

Y70 

 

X0 
 

 

X3 

 

M1 
 

 
Y71 

 

X1 

 

 

THAM KHẢO  

Dưới đây là biểu đồ thời gian của một ladder lên được lập trình sử dụng lệnh 

OUT. So sánh với một ladder lên sử dụng lệnh PLS. 

 
X2 

Y70 

X0 

 

 

X2 X0 
Y70 

 

Y70 

PLF 

X2 
PLS M0 0 

M0 X0 
3 Y70 

Y70 

X3 
PLF M1 7 

M1 X1 
Y71 10 

Y71 
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Trình tự hoạt động 

 

   Các trình tự hoạt động dưới đây tương tự như                                     

 4.4. 

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Ghi dự án đến bộ điều khiển khả trình 
 

(4) Giám sát một ladder 

trong mục 

 

 

 

• Bật X2, bật Y70 và bật X0, tắt Y70. (Ngay cả khi X2 ở trạng thái bật, vẫn bật X0 và 

tắt Y70.) 

• Bật X3, bật Y71 và bật X1, tắt Y71. 
 

 

Bài tập liên hệ       –––– Bài tập 3 

 

Chú ý  

Xử lí xung đầu vào không được yêu cầu đối với QCPU nó sử dụng một tiếp 

điểm dẫn 

[Đối với A/AnSCPU] 

X0 
PLS M0 

 

 

M0 
SET M5 

 

 

[Đối với QCPU] 

X0 

SET M5 
 

 

Các lệnh hỗ trợ là: LDP, LDF, ANDP, ANDF, ORP và ORF. 

Hoạt động thực tế 

Trình tự hoạt động 
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X7 
MC NO M98 

X2 
Y70 

X3 
Y71 

MCR NO 

MC N M 

 

MC 

MCR 

4.6 Kiểm soát chính (Start) 

Cài đặt lạI kiểm soát chính (End) 

 

Tên dự án QB-8 

Tên chương trình MAIN 
 

 
 

0 
 

 

 

3 
 

 

5 
 

7 

 
 

 

• Chương trình trên là một chương trình cơ bản. 

• sang MCR  N (biểu thị  "MC thành MCR" )  

Số lồng sẵn sàng (N) cho "MC thành MCR" từ N0 đến N14. 

• Chu kỳ quét được nhảy từ "MC sang MCR" hầu như không thay đổi. 

 
 

 

 
• Các lệnh có thể được sử dụng cho một chương trình đối với chuyển mạch hoạt 

động thủ công và tự động. (Xem ví dụ ladder.) 
 

 Biến khả dụng 
C

h
ữ

 s
ố
 

S
ố
 b

ư
ớ

c
 c

ơ
 b

ả
n
 

Biến trong (hệ 

thống hoặc 

người sử dụng) 

 
Thanh 

ghi tệp 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Module 

chức năng 

thông minh 

Un\G 

 
Thanh 

ghi chỉ 

số  
H

ằ
n
g
 s

ố
 

 
C

o
n
 t
rỏ

 

M
ứ

c 

Bit Từ R Bit Từ Z K H P I N 

MC n D 

MCR n 

n             2 

1 D 
     

       

Số bước cơ bản của lệnh  MC là 2 và của MCR là 1. 

 

 

 

 

 

 

 

 

 

 
 

Ứng dụng 

Trạng thái biến của một chương trình được nhảy  "MC thành MCR" trở nên 

như sau: Tất cả các thiết bị trong lệnh OUT được tắt. 

Các biến trong lệnh SET, RST và SFT, bộ đếm và bộ định thời giữ nguyên trạng 

thái. 

Định thời 100ms và 10ms được cài đặt lại về 0. 
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2 

3 

1 

 
 

• Các lệnh MC và MCR có thể được lồng với nhau như dưới đây. 
 

Tên dự án QB-9 

Tên chương trình MAIN 

 
 

 Chương trình “MC với MCR ”         được lồng dưới chương trình “MC với MCR”         . 
Nó được gọi là kiến trúc lồng. 

Trong trường hợp này 

(1) Chỉ định số lồng (N) của lệnh MC khi yêu cầu tăng  

(2) Chỉ định số lồng (N) của lệnh MCR được sử dụng đối với MC khi yêu cầu giảm 

 

 Chương trình “MC với MCR”           có thể không phụ thuộc vào  chương trình           . 

Một số lồng tương tự (N) có thể đưuọc sử dụng trong suốt cả chương  trình. 

Số rơ-le trong (M) phải được thay đổi đối với mỗi lệnh. 
 

 Như được trình bày trong chương trình         . Số rơ-le trong M của MC được sử dụng  

một tiếp điểm. 

Chú ý)   Trong GX Works2, trạng thái on/off của kiểm soát chính được hiển thị trong một thẻ 

trên màn hình. 

 
 

X5 
0 Y70 

X2 
2 MC N0 M6 

N0 M6 

X6 

K5 

5 C0 
X3 

10 MC N1 M7 

1 

N1 M7 

X7 

K100 
N1 
b 

N0 
a 

13 TO 

18 MCR N1 
X8 

19 Y71 

21 MCR N0 
X0 

22 SET  Y72 
X4 

24 

N0 

27 

MC N0  M8 2 

M8 
X1 

N0 
c 

RST  Y72 
 

MCR N0 29 

X9 
30 Y73 

3 
M6 

32 Y74 d 

Ví dụ chương trình được lồng "MC với MCR"  

a b 

a c 

d 



4 - 22 

 

 

 

Tên dự án QEX3 

Tên chương trình MAIN 

Ví dụ Ladder 

Chương trình dưới đây chuyển giữa chế độ hoạt động bằng tay và tự động sử dụng 

lệnh MC và MCR. 

• Khi chế độ hoạt động bằng tay được chọn bằng việc tắt X7; 

1) Điều chỉnh X2 để hệ thống chuyển sang chế độ làm việc tốc độ chậm. 

2) Điều chỉnh X2 để hệ thống chuyển sang chế độ làm việc tốc độ chậm. 

• Khi chế độ hoạt động tự động được chọn bằng việc bật X7, hệ thống hoạt động 

trong chế độ tốc độ thấp trong 3 giây. Sau khi X0 được bật. Hệ thống chuyển sang 

chế chế độ tốc độ cao trong 10 giây rồi dừng. 

Tốc độ cao 

 
 

 

Bằng tay 
X7 

0 MC N0 M10 

N0 M10 

X2 M82 
3 M81 Lệnh cho thủ công tốc độ thấp 

X3 M81 
6 M82 Lệnh cho thủ công tốc độ cao 

9 MCR N0 
Tự động 

X7 
10 MC N0 M11 

N0 M11 

X0 T1 
13 Y70 Khởi động tự động 

Y70 
MC N1 M12 

N1 M12 

Y70 M72 
19 M71 

K30 

Lệnh cho tự động tốc độ thấp 

M71 
T0 

T0 
27 M72 

K100 

Lệnh cho tự động tốc độ cao 

M72 
T1 

34 MCR N0 

M71 
35 Y71 Hoạt động tốc độ thấp 

M81 

M72 
38 Y72 Hoạt động tốc độ cao 

M82 

Chú ý) Trong GX Works2, trạng thái on/off kiểm soát chính được hiển thị trong một thẻ trên 
màn hình. 

 

Tốc độ thấp 

3s. 10s. 
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Operating Procedure 

 

 

Các thủ tục dưới đây tương tự như       trong mục 4.4 
 

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Ghi dự án đến bộ điều khiển chương trình 
 

(4) Giám sát một ladder 

 

 

• Hoạt động thủ công được chọn bằng việc tắt chuyển mạch  X7. 

Khi chuyển mạch X2 được bật, Y71 sáng và chế độ hoạt động tốc độ thấp được 

khởi động. Để chọn hoạt động tốc độ cao, bật chuyển mạch X3. Y72 sáng và 

chế độ hoạt động tốc độc cao khởi động. 

Hoạt động tự động được chọn bằng việc bât chuyển mạch X7. 

Khi chuyển mạch X0 được bật, Y70 sáng biểu thị chế độ hoạt động tự động được 

kích hoạt. 

Cùng thời điểm này, Y71 cũng sang trong 3 giây, biểu thị  hệ thống đang hoạt 

động ở chế độ tốc độ thấp. Sau khi 3 giây trôi qua, Y72 sáng trong 10 giây, biểu 

thị hệ thống hoạt động ở chế độ tốc độc cao. Sau đó dừng lại. (Y70, Y71, và Y72 

dừng sang lúc kết thúc.) 

 

Chú ý  

 

Đối với lệnh MCR trong một khối chương trình lồng, tất cả kiểm soát chính trong 

một chương trình có thể được kết thúc chỉ với số lồng thấp nhất (N). 

Hoạt động thực tiễn 

Trình tự hoạt động 
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FEND 

CALL    P** 

Chương trình PLC 

FEND 

Chương trình con 

Chương trình ngắt 

END 

FEND CJ SCJ CALL RET 

FEND 

4.7 / / / / 

 

Tên dự án QB-10 

Tên chương trình MAIN 

4.7.1 F end 
 

 
 

FEND là lệnh một bước. 
 

 

 

• Sử dụng lệnh FEND như lệnh END dưới điều kiện sau: 

1) Khi mỗi chương trình PLC phải được hoạt động và kết thúc trong mỗi khối 

chương trình. 

Ví dụ: sử dụng lệnh FEND với các lệnh CJ và SCJ. 

2) Khi sử dụng các chương trình con (các lệnh CALL và RET) 

3) Khi sử dụng một chương trình ngắt. 

• Sau mỗi lần thực hiện lệnh FEND, bộ điều khiển chương trình xử lí giá trị hiện 

thời của bộ định thời và bộ đếm và thực hiện kiểm tra tự chuẩn đoán, và khởi 

động lại từ bước 0. 

0 

 
Hoạt động 
khi CJ 

Chương trình PLC 

Không thực thi Nhảy CJ 
CJ    P** 

 

 

 

 

 

P** 

 
Chương trình PLC 

 
FEND 

 

Chương trình PLC 

Hoạt động khi  
CJ được thực thi 

P** 
 

 
I** 

END 
 

(a) Khi hoạt động trong mỗi khối chương 

trình bởi lệnh CJ. 

(b) Khi sử dụng các chương 

trình con và các chương 

trình ngắt 

 

 
• Không có giới hạn số lệnh FEND trong một chương trình PLC, tuy nhiên, chúng 

không thể được sử dụng trong chương trình ngắt hoặc chương trình con. 

• Lệnh FEND không thể được sử dụng để kết thúc một chương trình PLC chính 

hoặc con. 

Sử dụng lệnh END cho việc kết thúc toàn bộ chương trình. 

 

Tham khảo  

Chương trình ngắt dừng quá trình hiện thời và xử lí ngắt trong lúc nhận một 

yêu cầu ngắt trong khi một chương trình thông thường đang được xử lí. 

Chú ý 
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Thủ tục hoạt động 

 

Tên dự án QEX6 

Tên chương trình MAIN 

 Ví dụ Ladder  

Tạo một Ladder bên dưới với  GX  Works2  và ghi nó đến CPU của một máy chứng 

minh. Sau đó kiểm tra lệnh FEND hoạt động chính xác hay không. 
 

 
 

 

 
 
   Thủ tục dưới đây tương tự như                                         trong mục 4.4

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Ghi dự án đến bộ điều khiển chương trình 
 

(4) Giám sát một ladder 

 

Thủ tục hoạt động 

X3 
0 CJ P10 

X4 
3 Y70 

5 FEND 
P10 X5 

6 Y72 
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Xác nhận hoạt động của ladder mà nó được tạo với GX Works2 và được ghi tới 

CPU, bằng việc giám sát ladder trên màn hình . 
 

 
 

(1) Khi X3 tắt 

(a) Hoạt động được thực hiện từ 0 

Hoạt động khi X3 tắt 

đến FEND. 

(b) Bật hoặc tắt X4 ,bật hoặc tắt 

Y70. 

(c) Bật hoặc tắt X5, không thay 

đổi Y72. 

 
(2) Khi X3 bật 

(a) Chương trình nhảy đến con trỏ 

P10 bởi lệnh CJ. 

0   LD X3 

1   CJ P10 

3 LD X4 

4 OUT Y70 

5 FEND 

6   P10 

7 LD X5 

8 OUT Y72 

9 END 

 

 

 

 

 
Nhảy bởi CJ 

(b) Bật hoặc tắt X4, không thay 

đổi Y70. 

(c) Bật hoặc tắt X5, bật hoặc tắt 

Y72. 

Hoạt đông khi X3 bật 

 

 

Bài tập liên hệ         –––– Bài tập 4 

X3 
0 CJ P10 

X4 
3 Y70 

5 FEND 

P10 X5 
6 Y72 

9 END 

Hoạt động thực tế 
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1 

2 

CJ 

SCJ 

4.7.2 (Nhảy có điều kiện: thực hiện ngay lập tức nhảy có điều kiện) 

(Nhảy có điều kiện S: thực hiện nhảy có điều kiện sau môt lần quét) 
 

 

 

1 

X0 
10 CJ P10 

 
 

 

 

3 
 

 

6 
 

 

9 

Con trỏ 
P10 

 

 

X1 
 

 

X0 X1 
 

 

 

 

 

 
X3 

2 

 

SCJ P10 

Y70 

FEND 

10 Y71 

 
 

 

• Lệnh nhảy CJ thực hiện ngay lập tức việc nhảy một chương trình đến một địa chỉ 

được chỉ rõ (Số con trỏ) khi lệnh thực hiện bắt đầu. 

Khi lệnh kết thúc, thì chương trình sẽ không được nhảy. 
 

• Lệnh SCJ không thực hiện nhảy chương trình khi lệnh thực hiện được bật. Từ lần 

quét tiếp theo, lệnh thực hiện nhảy chương trình đến một địa chỉ được chỉ rõ (Số 

con trỏ)  

Khi lệnh kết thúc, thì chương trình sẽ không được nhảy. 

• Lệnh SCJ được sử dụng khi một số hoạt động phải được thực hiện trước khi 

nhảy một chương trình. 

Ví dụ: khi đầu ra cần được bật hoặc cài đặt lại trước 

 [Lược đồ thời gian] 

Điều kiện vào 
(X0, X1) 

 

 
 

 
CJ 

 

 

 

 

 

 

SCJ 

 

Thực hiện với mọi lần quét 
 

 

 

 

 

Thực hiện với 
mọi lần quét 

Thực hiện với mọi 
lần quét 

 

 

 

 

 

Thực hiện vớI 
mọI lần quét 

 

 

Một lần quét Một lần quét 
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Start 

Chương 

trình PLC A 

Điều kiện 

đầu vào bât? 

Y 

NO 

Chương 

trình PLC B 

Chương 

trình PLC C 

0 Chương trình PLC  A 

Điều kiện đầu vào 

CJ P 

Chương trình PLC B 

FEND 

Chương trình PLC C 

END 

 

 

• Số con trỏ khả dụng cho cả lệnh CJ và SCJ là P0 đến P4095. 

• Sử dụng lệnh FEND như bên dưới khi chương trình sử dụng lệnh CJ và SCJ phải 

được bao gồm trong mỗi khối chương trình. (xem mục 4.7.1 cho lệnh FEND.) 
 

khi CJ không 
được thực 
hiện 

Bước 0 
 

 

 

 

 

 
FEND 

 

P 

Khi CJ được 
thực hiện 

Bước 0 

CJP 

 

 
P 

 

 

 

 

 

END 

 

 

 

• Trạng thái của các ladder được bỏ qua nếu lệnh CJ vẫn như cũ. 

(Trước khi thực hiện CJ) (Trong khi thực hiện CJ) 
 

X0 

1100 

X2 

1103 
 

 

 

P10 X1 

1330 

 

 

CJ P10 

Y72 

 

 

 

PLS M1 

X0 

1100 

X2 

1103 
 

 

P10 X1 

1330 

 

 

CJ P10 

Y72 

 

 

 

PLS M1 

 

 

 
Bởi vì X0 bật, tất cả các lệnh 
trong vùng này không được thực 
hiện. Do đó Y72 vẫn bật thậm trí 
sau khi X2 tắt. 

 

 
 

• Sau khi cuộn định thời được bật, nhảy bộ định thời của cuộn cảm mà nó sử dụng 

các lệnh CJ, SCJ hoặc JMP ngắt phép đo chính xác. 

 

 Biến khả dụng 

C
h

ữ
 s

ố
 

S
ố
 b

ư
ớ

c
 c

ơ
 b

ả
n
 

Biến trong (hệ 

thống hoặc 

người sử dụng) 

 
Thanh 

ghi tệp 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Mô-đun 

chức năng 

thông 

minh 

Un\G 

 
Thanh 

ghi chỉ số 

 
H

ằ
n
g
 s

ố
 

 
C

o
n
 t
rỏ

 

M
ứ

c 

Bit Từ R Bit Từ Z K H P I N 

CJ P** 

SCJ P** 

 
P 

          


    
2 

 

 

 

 

 

 

 

 

 

 

 

Chú ý 
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Thủ tục hoạt động 

 

 

Ví dụ ladder 

Tạo một ladder bên dưới với GX Works2 và ghi nó tới CPU. Sau đó kiểm tra sự khác 

nhau của các lệnh CJ và SCJ. 
 

 
 

 

 
 

 
 
   Thủ tục dưới đây tương tự như                                         trong mục 4.4

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Ghi dự án đến bộ điều khiển khả trình 
 

(4) Giám sát một ladder 

 

Tên dự án QEX4 

Tên chương trình MAIN 

Trình tự hoạt động 

X0 
0 CJ P10 

 

P10 
X1 

SCJ 3 

X0 X1 
6 Y70 

9 

10 

FEND 

Y71 
P10 X3 
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(1) Khi X0 và X1 tắt, lệnh CJ and SCJ không 

được thực hiện. 

Vì thế, Y70 bật. 

[Trước khi thực hiện CJ và SCJ ] 
 

 
X0 

CJ P10 

X1 
SCJ P10 

X0   X1 
Y70 

(2) Khi X0 được bật, lệnh CJ được thực hiện 

và chương trình nhảy đến con trỏ P10. Vì 

thế, Y70 vẫn bật. 

[Trong khi thực hiện CJ] lần quét đầu tiên và các 

lần quét tiếp theo. 

X0 
CJ P10 

X1 
SCJ P10 

X0   X1 
Y70 

 

 

 

P10 X3 

FEND 

 

Y71 

 

 

P10 X3 

FEND 
 

 

Y71 
 

(3) Việc tắt X0 và bật X1 thực hiện lệnh SCJ và nhảy chương trình đến con trỏ P10 từ lần quét thứ 2. Vì 

thế, Y70 tắt. 

[Trong khi thực hiện SCJ ] Lần 
quét đầu tiên. 

[Trong khi thực hiện SCJ ] Lần quét thứ 2 

và các lần quét tiếp theo.
 

 
 
 

Lần quét 
đầu tiêm 
sau khi 
ON 

 
 

 

 
P10 

X0 

X1 

X0   X1 
 

 

 
X3 

 

CJ P10 

SCJ P10 

Y70 

FEND 

Y71 

Lần quét thừ 
2 và các lần 
quét tiếp 
theo sau khi 
 ON 

 

 

 

 

 

 

 

 

P10 

X0 

X1 

X0   X1 
 

 

 

 

X3 

 

CJ  P10 

SCJ P10 

Y70 

FEND 

Y71 

(4) Y71 được bật hoặc tắt khi lệnh CJ và SCJ được thực hiện. 

• Danh sách dưới đây chứng minh sự khác nahu giữa lệnh CJ và SCJ. 

Lần quét thứ 2 và 

các lần quét tiếp 
theo sau khi X1 bật 

Chỉ lần quét đầu tiên 
 

  
 

Bài tập liên hệ        –––– Bài tập 4 

0 LD X0  0 LD X0 

1 CJ P10  1 CJ P10 

3 LD X1  3 LD X1 

4 SCJ P10  4 SCJ P10 

6 LDI X0  6 LDI X0 

7 ANI X1  7 ANI X1 

8 OUT Y70  8 OUT Y70 

9 FEND   9 FEND  
10 P10   10 P10  

11 LD X3  11 LD X3 

12 OUT Y71  12 OUT Y71 

13 END   13 END  

 

Hoạt động thực tế 
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CALL(P) 

2 

1 

2 

RET 

4.7.3 Gọi 

Quay 

lại 

 
Thực hiện một chương trình con 

 
M0 

0 CALL P10 
 

 

M5 X2 
50 

 
CALL P10 

Chương 
trình PLC 

 

 

103 

P10 

X1 
104 

FEND 
 

 

 

 

Y70 

 

 

1 
 

 

 

 

Chương 
trình con 

 

157 RET 
 

 

• Chương trình trên là một dạng cơ bản để thực hiện một chương trình con sử dụng 

lệnh CALL và RET. 

Theo kiến trúc này, một lỗi xảy ra và bộ điều khiển chương trình tạm dừng.  

• Một chương trình con bao gồm các ladder cho việc thực hiện cùng một dữ liệu 

nhiều lần trong một chương trình. 

Một chương trình con bắt đầu ở con trỏ P và kết thúc bằng lệnh RET. 

• Số con trỏ P từ 0 đến 4095. (Tương tự như số con trỏ dùng cho lệnh CJ và SCJ) 

• Một chương trình con được thực hiện như giản đồ bên dưới. 
 

 

 
0 

Chương trình PLC 

(Khi CALL P10 không được thực hiện) (khi CALL P10 được thực hiện) 0

 0 

 
Điều kiện đầu vào 

 

 
CALL P10 

 

CALL P10 

 

 
Bước tiếp 
theo sau khi 
CALL 

 

Chương trình PLC 

 
 

 

P10 

 

 

 

 

Chương trình con 

Chương trình PLC 

 

FEND 
 

 

 

 

 

 

RET 

FEND P10 
 

 

 

 

 

 

 

RET 

FEND 
 

 

 

 

 

Thực hiện chương 
trình con 

 

END 
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CALL     P1 

FEND 

CALL P2 

RET 

CALL P3 
 

RET 

CALL P4 

RET 

CALL P5 

RET 

RET 

 

 
• Lệnh CALL (P) có thể đựơc lồng đến 16 cấp. 

 

 
 

Mạch ladder dưới đây trình bày một chương trình được lồng bên trên. 
 

0 
 

 

Chương trình PLC 
 

 

P1 

 

Chương trình con P1 
 

P2 

 

Chương trình con P2 
 

P3 

 

Chương trình con P3 
 

P4 

 

Chương trình con P4 
 

P5 
 

Chương trình con P5 
 

 

 

 Biến khả dụng 

C
h

ữ
 s

ố
 

S
ố
 b

ư
ớ

c
 c

ơ
 b

ả
n
 

Biến trong (hệ 

thống hoặc 

người sử dụng) 

 

 

Thanh 

ghi tệp 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Mô-đun 

chức năng 

thông 

minh 

Un\G 

 

 

Thanh 

ghi chỉ 

số  
H

ằ
n

g
 s

ố
 

 
C

o
n

 t
rỏ

 

M
ứ

c
 

Bit Word R Bit Word Z K H P I N 

CALL(P)   P** 

RET 

P             
2 

1               

Số bước cơ bản của CALL (P) là 2, và của lệnh RET là 1.  

 
 

Chương 
trình con 

P1 

Chương 
trình con 

P2 

Chương 
trình con 

P3 

Chươg 
trình con 

P4 

Chươg 
trình con 

P5 
Chương trình PLC 

0 

CALL P3 
CALL P5 

CALL P1 CALL P4 

CALL P2 RET RET 

RET 

RET 
RET 

FEND 

Lồng 
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Thủ tục hoạt động 

Tên dự án QEX5 

Tên chương trình MAIN 

Ví dụ ladder 

Tạo một ladder bên dưới với GX Works2 và ghi nó đến CPU. Sau đó kiểm tra các 

lênh CALL và RET hoạt động chính xác hay không. 
 

 
 

 

 

 
 
   Thủ tục dưới đây tương tự như                                         trong mục 4.4

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Ghi dự án đến bộ điều khiển khả trình 
 

(4) Giám sát một ladder 
 

 

Trình tự hoạt động 

X2 
0 CALL P10 

Y70 
X3 

3 

5 FEND 
P10 X4 

6 Y71 

9 RET 
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Xác minh hoạt động của một ladder, mà nó được tạo với GX Works2 và được ghi tới 

CPU bằng việc giám sat ladder trên màn hình. 
 

 
 

(1) Khi X2 tắt 

(a) Hoạt động được thực hiện từ 0 đến 

FEND. 

(b) Bật hoặc tắt X3, bật hoặc tắt Y70. 

(c) Bật hoặc tắt X4, dkhôn gthay đổi 

Y71. 

 
(2) Khi  X2 bật 

(a) Sau khi chương trình con của con 

trỏ P10 được thực hiện, hoạt động 

từ bước 3 đến FEND được thực 

thi. 

(b) Bật hoặc tắt X3, bật hoặc tắt Y70. 

(c) Bật boặc tắt X4, bật hoặc tắt Y71. 

 
Bài tập liên hệ        ––––Bài 4 

Hoạt động khi X2 tắt 
 

 

0   LD X2 

1   CALL   P10 

3 LD X3 

4 OUT Y70 

5 FEND 

6   P10 

7 LD X4 

8 OUT   Y71 

9 RET 
 

 

 

Hoạt động khi X2 bật

X2 
0 CALL P10 

X3 
3 Y70 

5 FEND 

P10 X4 
6 Y71 

9 RET 

10 END 

Hoạt động thực tế 
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0.5sec. 0.5sec. 0.5sec. 0.5sec. 

Bài tập 1 

 

Tên dự án QTEST1 

Tên chương trình MAIN 

4.8 Bài tập 

4.8.1 

LD đến NOP 

Khi X0 bật, Y70 tự duy trì, Y74 và Y77 lần lượt nhấp nháy trong 0.5 giây. 

Khi X1 bật, Y70 tắt và Y74, Y77 cũng dừng. 
 

 

[Lược đồ thời gian] 
 

X0 

Y70 

T0 

Y74 

T1 

Y77 

X1 

 

 
 

Tạo một chương trình bên dưới với GX Works2 và điền vào các ô trống . Sau 

đó, kiểm tra hoạt động sử dụng máy xác minh. 
 

 

2) X0 
 

1) 

0 Y70 

3) Y70 

4) 

K5 
4 T0 

K5 
10 T1 

Y74 
5) Y70 

16 Y77 
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Bài tập 2 

 

Tên dự án QTEST2 

Tên chương trình MAIN 

4.8.2 
 

SET, RST 

Khi X0 được bật, Y70 bắt đầu nhấp nháy khoảng 1 giây và dừng khoảng 5 giây tiếp 

sau nhấp nháy 10 lần, sau đó nhâp nháy lại. 

Y70 có thể dừng nếu bật X1. 
 

Tạo một chương trình bên dưới với GX Works2 và điền vào các ô trống . Sau 

đó, sau đó kiểm tra hoạt động bằng máy xác minh. 
 

 
 

1) 5) 
  

2) 6) 
  

3) 7) 
  

4) 8) 
  

X0 
0 1) 

T0 
M0 M1 T1 K10 

 

K10 

2 

T0 
T1 

T0 
Y70 

K10 
C0 

3) 2) 
23 4) 

T2 
K50 

T2 
30 RST M1 

5) 

X1 
36 6) 

7) 

8) 
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Restart 

1sec. 

1sec 
1 lần quét 

1sec. 1sec. 5sec. 

K10 

T0 

T1 

K10 

T1 

T0 

 

 

(1) Dưới đây minh họa lược đồ thời gian của chương trình. 
 

 

X0 
 

 

 

 

M0 
 

 

 

 

X1 
 

 

 

 

Tiếp điểm T0 
 

 

 

 

Tiếp điêm T1 
 

 

 

 

Y70 
 

 

 

 

Tiếp điểm C0 

 

Bộ đếm của C0   1. 2. 10. 1. 2.0. 

 

(2) Dưới đây là một ladder sáng nhấp nháy cơ bản và lược đồ thời gian. 

[Ladder] [Lược đồ thời gian] 

Tiếp điểm 
Bắt đầu

 
T0 

 

 

 

Tiếp điểm 
        T1 

1sec. 
 

 

 

 

1sec. 

 

 

 

 
một lần quét 

 

 

Tham khảo  

• Một ladder sáng nhấp nháy có thể được tạo sử dụng một rơ-le đặc biệt mà nó 

tạo ra xung đồng hồ như bên dưới. 

SM413 (2-sec. clock) Thay thế SM413 (2-sec. clock) bên 
Y70 trái, có thể sử dụng: 

SM409 (0.01-sec. clock) 

SM410 (0.1-sec. clock) 
[Lược đồ thời gian] SM411 (0.2-sec. clock) 

SM412 (1-sec. clock) 
Y70 

1sec. 1sec.1sec. SM414 (2n-sec. clock) 
SM415 (2n-msec. clock) 

Xung đông hồ bắt đầu từ OFF khi bộ điều 

khiển chương trình cài đặt lại hoặc nguồn 

được bật. 

Gợi ý 
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Bài tập 3 

 

Tên dự án QTEST3 

Tên chương trình MAIN 

4.8.3 
 

PLS, PLF 

Y70 bắt đầu chuyển mạch ON và OFF luân phiên nhau khi X0 được bật và việc 

tắt  X0 kích hoạt Y71 hoạt động tương tự như Y70. 

[Lược đồ thời gian] 

 

X0 

Y70 

Y71 

Tạo chương trình bên dưới với GX Works2 và điền vào khoảng trống . Sau 

đó, kiểm tra hoạt động sử dụng máy xác minh. 
 

 
 

1) 
 

2) 
 

X0 
1) 
 

2) 

0 M0 

M1 

M0 Y70 
5 Y70 

M0 Y70 

M1 Y71 
11 Y71 

M1 Y71 
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X7 
1) CJ 

SM401 
RST Y72 

RST Y73 

K5 T11 
T10 

T10 K5 
T11 

Y70 

T10 
Y71 

X0 
2) P10 

3) 

SM401 
RST Y70 

RST Y71 

K10 T20 
T21 

T21 K10 
T20 

Y72 

T21 
Y73 

X0 
4) P10 

5) 
 

RST 
SM401 

Y70 

RST Y71 

RST Y72 
 

Y73 RST 

6) 

Bài tập 4 

 

Tên dự án QTEST4 

Tên chương trình MAIN 

4.8.4 
 

CJ, CALL, RET, FEND 

Y70 và Y71 nhấp nháy 0.5 giây luân phiên nhau khi X7 tắt và X7 bật, Y72 và Y73 

nhấp nháy luân phiên nhau khoảng 1.0 giây. Việc bật X0 sẽ thiết lập lại chế độ nhấp 

nháy hiện thời từ Y70 đến Y73. 

Điền vào ô trống         . Sau đó, kiểm tra hoạt động sử dụng máy xác minh. 
 
 

 
 
 

 
 
 

 
 

 

Ladder 
bập 
bênh 

 

 
 
 

 
 

 

P0 

 

 
 
 

 

Ladder 
bập 
bênh 

 
 
 

 

 

P10 
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START 
 

 

 

 

X7 ON? 

 

N 

Y72,Y73 

Reset 

 

 

 

 
Y <CJ P0> 

 

 

 

P0 
Y70,Y71 

Reset 

1) 
 

2) 
 

3) 
 

4) 
 

5)   

6)   

 
Y70,Y71 

0.5-sec. flickering 
 

 
 

Y 
X0 ON? 

Y72,Y73 

1-sec. flickering 
 

 
Y 

X0 ON? 

 

N 
 

 

 

 

 
<FEND> 

 

N 

P10 

 

 

 

 
Y70Y73 

Reset 

 

 

 

 
Chương 
trình con 

 

 

 

END 

 

<FEND> 

Gợi ý 
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Đáp án cho bài tập chương 4 
 

Bài số.  Đáp án 

 

 

 
1 

1) Y70 

2) X1 

3) T1 

4) T0 

5) Y74 

 

 

 

 

 

 

2 

1) SET M0 

2) C0 

3) Y70 

4) SET M1 

5) RST C0 

6) RST M0 

7) RST C0 

8) RST M1 

 

3 
1) PLS 

2) PLF 

 

 

 

 
4 

1) P0 

2) CALL 

3) FEND 

4) CALL 

5) FEND 

6) RET 
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MEMO 
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1 102+5 101+3 100 

Chương 5 Lệnh cơ bản -Phần 2- 
 

5.1 Kí hiệu của giá trị (dữ liệu) 

 
CPU điều khiển khả trình biến đổi tất cả tín hiệu đầu vào thành tín hiệu ON hoặc 

OFF (logic lần lượt là 1 hoặc 0) để lưu trữ và xử lí chúng. Vì vậy, khối điều khiển 

khả trình thực thi hoạt động số sử dụng giá trị số được lưu với dạng logic 1 hoặc 0 

(số nhị phân = BIN). 

Trong cuộc sống hàng ngày, một số thập phân được sử dụng phổ biến và trong hệ 

thống đơn giản. Vì vậy, biến đổi thập phân sang nhị phân hoặc biến đổi ngược là cần 

thiết khi giá trị được viết hoặc đọc (giám sát) đến hoặc từ khối điều khiển khả trình. 

Hệ thống lập trình và một số lệnh có chức năng chuyển đổi thập phân sang nhị phân 

và từ nhị phân sang thập phân. 

Phần này diễn giải làm thế nào để biểu thị giá trị (dữ liệu) dạng thập phân, nhị phân, 

thập lục phân và kí hiệu BCD, và làm thế nào để biến đổi chúng. 

 

 
 Một hệ thập phân bao gồm 10 kí tự: 0, 1, 2, 3, 4, 5, 6, 7, 8, và 9 được sắp xếp 

theo thứ tự và giá trị (độ lớn). 

Sau khi môt con số đến 9, số đó được đặt lại về 0 và con số bên trái của số đó 

được tăng thêm 1. 

 Hình dưới diễn tả một số hệ thập phân (trong trương hợp này là153) được biểu 
diễn như thế nào. 

153 = 100+50+3 

= 1 100+5 10+3 1 

= 
 

Kí tự thập phân (0 đến 9) 
 

 

 
n : Con số (0, 1, 2...) 

10  : Thập phân 

"Độ lớn của con số" 

 Trong khối điều khiển khả trình MELSEC-Q series, kí tự "K" được dùng 

để diễn tả giá trị dạng thập phân. 

Thập phân 
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7 6 5 4 3 2 1 0 Số bit 

 

 
27 

 

 
26 

 

 
25 

 

 
24 

 

 
23 

 

 
22 

 

 
21 

 

 
20 

Nhị phân 

Số cơ bản với số mũ 
tương ứng  

128 64 32 16 8 4 2 1 ("nhị phân") 

 

…
 

…
 

 

 
 Hệ nhị phân bao gồm hai kí tự: 0 và 1 được sắp xếp theo thứ tự và giá trị (độ 

lớn). Sau khi một con số đến 1, số đó trở về 0 và con số bên cạnh (bên trái) 

được tăng thêm 1. Hai con số 0 và 1 còn được gọi là bit. 
 

Nhị phân Thập phân 

0 0 

1 1 

10 2 

11 3 

100 4 

101 5 

110 6 

111 7 

1000 8 

 

 

 Ví dụ bên dưới diễn giải làm thế nào để biến đổi một số nhị phân thành thập 

phân. 

"10011101" 

Biểu đồ dưới chỉ ra số nhị phân với mũ hai . 

 
 

 

  

= độ lớn bit 
        

 

 

Số nhị phân được chi ra như sau. 

= 1 × 128 + 0 × 64 + 0 × 32 + 1 × 16 + 1 × 8 + 1 × 4 + 0 × 2 + 1 × 1 

= 128 + 16 + 8 + 4 + 1 

= 157 
 

Số nhị phân có thể được tính toán bằng cách thêm vào mỗi bit có mã bằng  

1. 

1 0 0 1 1 1 0 1 

 

Hệ nhị phân (BIN) 
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…
 

…
 

…
 

 

 
 Hệ thập lục phân gồm 16 kí tự: 0 đến 9 và A đến F được sắp xếp theo thứ 

tự và giá trị (độ lớn). Sau khi một con số đến F, số đó được trở về 0 và con 

số bên cạnh (bên trái) tăng thêm một. 
 

Thập phân Thập lục phân  Nhị phân  

0 0  0  

1 1  1  

2 2  10  

3 3  11  

4 4  100  

5 5  101  

6 6  110  

7 7  111  

8 8  1000  

9 9  1001  

10 A  1010  

11 B  1011  

12 C  1100  

13 D  1101  

14 E  1110  

15 F  1111  

16 10  10000  

17 11  10001  

18 12  10010  

 

1 9 1 0 1 
 

4 A 9 D 
 

0 1 0 0 
 

1 0 1 0   1 0 0 1 
 

1 1 0 1 

 
 

 
 

3 2 1 0 Con số 
 

"Số mũ" 
4 A 9 D Hệ 16 

n: con số 

= (4) × 16
3 

+ (A) × 16
2 

+ (9) × 16
1 

+ (D) × 16
0

 

= 4 × 4096 + 10 × 256 + 9 × 16 + 13 × 1 

= 19101 

16: Thập lục phân 

 

 Bốn bit của một số nhị phân bằng với một số của hệ thập lục phân. 

 Trong khối điều khiển khả trình MELSEC-Q series, kí tự "H" dùng để chỉ 

một số hệ thập lục phân. 

 Hệ thập lục phân thường sửdụng để thể hiện biến sau. 

• Đầu vào và đầu ra (X, Y) 

• Chức năng đầu vào và đầu ra (FX, FY) 

• Rơle liên kết (B) 

• Thanh ghi liên kết (W) 

• Rơle liên kết đặc biệt (SB) 

• Thanh ghi liên kết đặc biệt (SW) 

• Biến liên kết trực tiếp (Jn\X, Jn\Y, Jn\B, Jn\SB, Jn\W, Jn\SW) 

Hệ thập lục phân 
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1 5 7 

(100) (10) (1) 

 
8
0
0
0
 

4
0
0
0
 

2
0
0
0
 

1
0
0
0
 

8
0
0
 

4
0
0
 

2
0
0
 

1
0
0
 

8
0
 

4
0
 

2
0
 

1
0
 

8
 

4
 

2
 

1
 

 

 
 Số hệ thập phân mã hóa nhị phân là "một hệ số sử dụng số nhị phân để 

biểu diễn một số thâp phân". 

Một số thập phân 157, để dễ hiểu hơn, được biểu diễn dưỡi đây. 
 

2 1 0 Con số 
 

   
Độ lớn của số 

 

 

0001 0101  0111 BCD 

842 1 8 4 2 1  8 4   2  1 Bit trọng số nhị phân 

 

 

 Trong BCD, số thập phân từ 0 đến 9999 (số có 4 chữ số lớn nhất) có 

thể biểu diễn với 16 bit. 

Biểu đồ dưới chỉ ra độ lớn bit của BCD. 
 

 
 

 
 
 

 BCD được sử dụng cho những tín hiệu sau. 

1) Tín hiệu đầu ra của công tắc số 

2) Tín hiệu của hiển thị bảy thành phần (hiển thị số) 

 

0 1 2 3 4 5 6 7 8 9 

1(0) (1) (0) (1) (0) (1) (0) (1) (0) (1) 
2(0) (0) (1) (1) (0) (0) (1) (1) (0) (0) 
4(0) (0) (0) (0) (1) (1) (1) (1) (0) (0) 
8(0) (0) (0) (0) (0) (0) (0) (0) (1) (1) 

COM 

Mã công tắc sô BCD  

Hàng nghìn 

Hàng trăm 

Hàng chục 

Hàng đơn vị 

0 0 0 0 0 0 0 1 0 1 0 1 0 1 1 1 

Thập phân 

Hệ thập phân mã hóa nhị phân (BCD)   
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Làm thế nào để biến đổi số thập phân sang nhị phân 

Trong ví dụ dưới, một số thập phân là 157 được biến đổi thành số nhị phân. 

1) 

128 64 32 16 8 4 2 1 Bit trọng 
số 157 

128 

29 

16 

13 

8 

5 

4 

1 

1 

0 

2) 

Thương số 

Phần dư 2 

2 

2 

2 

2 

2 

2 

157 

78 

39 

19 

9 

4 

2 

1 

1 

0 

1 

1 

1 

0 

0 

Làm thế nào để biến đổi một số thập phân thành số thập lục phân 

Ở ví dụ dưới đây, một số thập phân là 157 được biến đổi thành một số thập lục phân 1) 

16     157   

9 13(D) 

D 

 

  

 

 

 

 

 

1 0 0 1 1 1 0 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 0 0 1 1 1 0 1 

128 64 32 16 8 4 2 1 

 

 

 

 

 

 

1 0 0 1 1 1 0 1 

 

 9 
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Giá trị số sử dụng bởi khối điều khiển khả trình  MELSEC-Q series 
programmable controller 

● Thông thường, 8 bit được gọi là 1 byte, và 16 bits (2 byte) được gọi là 1 từ 
word. 1 bit 

1 0 0 1 1 1 0 1 

1 byte 

0 0 0 0 0 0 0 0 1 0 0 1 1 1 0 1 

1 từ (2 byte) 

● Thanh ghi của mỗi biến từ trong khối điều khiển khả trình MELSEC-Q series bao gồm 16 bit. 

• 

• 

Thanh ghi D          D0 

Giá trị hiện tại của 

bộ định thời T 

Giá trị hiện tại của 

bộ đếm  C 

Thanh ghi tệp R 

Thanh ghi liên kết W 

Bit trọng số  

• 

• 

• 

● Hai khoảng dưới đây có thể được xử lí trong 16 bit (1 từ).  

1) 0 đến 65535 

2) -32768 đến +32767 

● Khoảng 2) là hoàn toàn khả thi với khối điều khiển khả trình MELSEC-Q. 

Số âm nhận hai phần bù ngược với số dương (1 to +32767). 

● Trong phần hai phần bù, mỗi bit nhị phân bị nghịch đảo, và 1 được thêm vào bit ít quan trọng 

nhất. Ví dụ) 

Làm thế nào để tính hai phần bù ngược với 1 

1 

Nghịc đảo tất cả các bit 

Thêm 1 vào bit ít 
quan trọng nhất. 

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 

-1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 

Bit quan trọng nhất là 1 nghĩa là số âm. 
Bit quan trong nhất tương ứng với dầu của một số nhị phân. 

3
2
7
6
8
 

1
6
3
8
4
 

8
1
9
2
 

4
0
9
6
 

2
0
4
8
 

1
0
2
4
 

5
1
2
 

2
5
6
 

1
2
8
 

6
4
 

3
2
 

1
6
 

8
 

4
 

2
 

1
 

 

 

 

 

 

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 

 

 

  

 

1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0 
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BCD (hệ số BCD) BIN (nhị phân) K (thập phân) H (hệ 16) 

00000000 00000000 00000000 00000000 0 0000 

00000000 00000001 00000000 00000001 1 0001 

00000000 00000010 00000000 00000010 2 0002 

00000000 00000011 00000000 00000011 3 0003 

00000000 00000100 00000000 00000100 4 0004 

00000000 00000101 00000000 00000101 5 0005 

00000000 00000110 00000000 00000110 6 0006 

00000000 00000111 00000000 00000111 7 0007 

00000000 00001000 00000000 00001000 8 0008 

00000000 00001001 00000000 00001001 9 0009 

00000000 00010000 00000000 00001010 10 000A 

00000000 00010001 00000000 00001011 11 000B 

00000000 00010010 00000000 00001100 12 000C 

00000000 00010011 00000000 00001101 13 000D 

00000000 00010100 00000000 00001110 14 000E 

00000000 00010101 00000000 00001111 15 000F 

00000000 00010110 00000000 00010000 16 0010 

00000000 00010111 00000000 00010001 17 0011 

00000000 00011000 00000000 00010010 18 0012 

00000000 00011001 00000000 00010011 19 0013 

00000000 00100000 00000000 00010100 20 0014 

00000000 00100001 00000000 00010101 21 0015 

00000000 00100010 00000000 00010110 22 0016 

00000000 00100011 00000000 00010111 23 0017 

 

00000001 
 

00000000 
 

00000000 
 

01100100 
 

100 
 

0064 

 

00000001 
 

00100111 
 

00000000 
 

01111111 
 

127 
 

007F 

 

00000010 
 

01010101 
 

00000000 
 

11111111 
 

255 
 

00FF 

 

00010000 
 

00000000 
 

00000011 
 

11101000 
 

1000 
 

03E8 

 

00100000 
 

01000111 
 

00000111 
 

11111111 
 

2047 
 

07FF 

 

01000000 
 

10010101 
 

00001111 
 

11111111 
 

4095 
 

0FFF 

 

00100111 
 

00010000 
 

10000 
 

2710 

 

01111111 
 

11111111 
 

32767 
 

7FFF 

 

11111111 
 

11111111 
 

-1 
 

FFFF 

 

11111111 
 

11111110 
 

-2 
 

FFFE 

 

10000000 
 

00000000 
 

-32768 
 

8000 
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Cấu hình hệ thống và số I/O của bộ DEMO 
 

 
Module CPU  Module đầu ra 

 

Module cấp nguồn Module đầu 
vào 

 

 

Đế cắm Q38DB 
 

 
 

Q61P QCPU  Khe 
trống 

QX 

42 

(64 

QY 

42P 

(64 

Q64 

AD 

(16 

Q62 

DAN 

(16 

điểm)   điểm)   điểm)    điểm) 

 

 
 

 

X0 Y40 
Đến đến 

Cáp USB  
 
 

 
 
 

 
 
 

 
 

 
Thiết bị ngoại vi 

X3F Y7F  

 
 
 

 
 
 

 
 
 

 
 

 
cửa sổ I/O

 
 

 

Y77 
 

 
 
 

 

Y7F 

 

 

Y76 
 

 
 
 

 

Y7E 

 

 

Y75 
 

 
 
 

 

Y7D 

 

 

Y74 
 

 
 
 

 

Y7C 

 

 

Y73 
 

 
 
 

 

Y7B 

 

 

Y72 
 

 
 
 

 

Y7A 

 

 

Y71 
 

 
 
 

 

Y79 

 

 

Y70 
 

 
 
 

 

Y78 

Y6F Y60 Y5F Y50 Y4F Y40 

 

 
 
 

 
 

X7 X6 

 

 
 

X5 X4 

 

 
 

X3 X2 

 

 
 

X1 X0 

 

 

 
 
 

ON 

OFF 

X3F X30 X2F X20 
 

 

1   9   4   2 4   1   3   6 MELSEC-Q 

 

XF XE 
 

XD XC XB XA X9 
 

X8 

ON 

OFF 

 

A/D đầu vào 
 

D/A đầu ra 



5 - 9 

 

 

1 

1 

1 

K157 

0 0 0 0 0 0 0 0 0 0 1 0 1 1 0 1 

 

0 0 0 0 0 0 0 0 0 0 1 0 1 1 0 1 

 

0 0 0 0 0 0 0 0 1 0 0 1 1 1 0 1 

 

MOV (P) 

5.2 Lệnh truyền 

 

Tên dự án QB-11 

Tên chương 
trình 

MAIN 
 

5.2.1  Truyền dữ liệu 16 bit 

 
X7 T0 

0 
 

 

T0 

 

 

T0 

 

K1500 

C10 

 

X1 

13 RST 
 

X2 
S

 

 

 
C10 

D 1 

18 MOV T0 D0 

X3 

21 MOVP C10 D1 

X4 

24 MOVP 

2 

K157 D2 

X5 

27 MOVP 

3 

H4A9D D3 

 
 

 
1 ● Khi điều kiện đầu vào bật lên, giá trị hiện tại của bộ định thời T0 được truyền tới 

thanh ghi dữ liệu D0. 

S ... Nguồn,  D ... Đích 

● Giá trị hiện tại của T0 được lưu trong thanh ghi dưới dạng nhị phân (mã BIN). 

Và giá trị đó được truyền vào thanh ghi dữ liệu D0 ở dạng nhị phân (Mã này 

không bị biến đổi khi truyền.) 
 

T0 45 

12864 32 16 8   4   2 

D0 

12864 32 16 8   4   2 

2 ● Khi điều kiện đầu vào bật lên, số thập phân 157 được truyền tới thanh ghi dữ liệu 

D2. Và giá trị được lưu trong trên thanh ghi dưới dạng nhị phân. Số thập phân 

(K) tự động được biến đổi thành nhị phân, và sau đó truyền đi. 

D2 

128 64 32 16 8   4   2 
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0 1 0 0 1 0 1 0 1 0 0 1 1 1 0 1 

 

 MOVP K157 D2  
  
 

MOV 

MOVP 

3
2
7
6
8
 

1
6
3
8
4
 

8
1
9
2
 

4
0
9
6
 

2
0
4
8
 

1
0
2
4
 

5
1
2
 

2
5
6
 

1
2
8
 

6
4

 

3
2

 

1
6

 

8
 

4
 

2
 

1
 

3 ● Khi đièu kiện đầu vào bật lên, số thập lục phân 4A9D được truyền vào thanh ghi 

D3. 

 

 
 

 
(4) (A) (9) (D) Số hệ thập 

D3    
lục phân 

Số nhị phân      

Bit trọng số 

 

 

 

P của MOVP đại diện cho một xung. 
 

 
 

 

 
MOV 

 

 

 

 

MOVP    
 

 
Thực thi chỉ một lần. 

Dữ liệu truyền với mỗi lần quét 
khi điều kiện đầu vào được bật. 

 

 

 
Dữ liệu đầu vào chỉ được quét 
sau khi điều kiện đầu vào bật. 
(Chỉ duy nhất một lần) 

 

● Lệnh 

Lệnh 

dùng để đọc dữ liệu đang thay đổi bất kì lúc nào.              

dùng để truyền dữ liệu ngay lập tức như là cài đặt 

dữ liệu hay đọc dữ liệu tại một điểm lỗi. 

● Cả hai chương trình ladder dưới đây có chức năng tương tự nhau . 

X4 X4 

PLS M1 

 

M1 

MOV 

 

 

K157 D2 

 

 

 Biến khả dụng 

C
o
n

 s
ố
 

S
ố
 b

ư
ớ

c
 c

ơ
 b

ả
n
 

Biến trong 

(hệ thống 

hoặc người 

dùng) 

 

 

Thanh 

ghi tệp 

 

 

MELSECNET/10 

(H) Direct Jn\ 

 

Module 

chức 

năng 

thông 

minh 

Un\G 

 

 

Thanh 

ghi chỉ 

số 

 

 

 

Hằng số 

 

C
o
n

 t
rỏ

 

M
ứ

c
 

Bit Từ R Bit Từ Z K H P I N 

 

MOV S D 
S              

* 
D       

      

*: Số bước thay đổi dựa vào số biến sử dụng. 

Điều kiện đầu vào 

Sự khác nhau giữa MOV và MOVP 

H4A9D 
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Enter 

 

 

 
 

 Giám sát nội dung thanh ghi D0 đến D3. 

• Sau khi viết dữ liệu đến khối điều khiển khả trình, click  [Online]  → 

[Monitor] → [Device/Buffer Memory Batch]. 

Hộp thoại Device/Buffer Memory Batch Monitor hiện ra. 
 

 
 

• Nhập "D0" vào cột Device Name của hộp thoại Device/Buffer  

Memory Batch Monitor và ấn  . 
 

 

Enter "D0". 

Press the Enter key after 
entering the device. 

The CPU đang chạy. 

Đầu vào X2, X3, X4, X5, và X7 được bật. 

Kiểm tra 
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0 1 0 0 1 0 1 0 1 0 0 1 1 1 0 1 

 

1
6
3
8
4
 

8
1
9
2
 

4
0
9
6
 

2
0
4
8
 

1
0
2
4
 

5
1
2
 

2
5
6
 

1
2
8
 

6
4
 

3
2
 

1
6
 

8
 

4
 

2
 

1
 

 

 
 

(4) (A) (9) (D) Số thập lục 
phân 

D3 H4A9D 

Trọng số  
bit nhị 
phân 

 

Bit đầu 
 

 
 

19101 

Giá trị hiện tại của bộ định 
thời và bộ đếm được giám 
sát (Nó đang thay đổi.) 

Chỉ ra số thập phân 157 
(K157) được lưu. 

Đây là một số thập phân tương 
đương vớii một thập lục phân 
4A9D. 

Indicates the word devices in the on/off of the bit units. 
: OFF (0 in binary) 
: ON (1 in binary) 
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Display Format • Click nút . 

• Thay đổi hiển thị. 

• Chọn "HEX" cho trình theo dõi loạt biến. 
 

 
 

[Màn hình Device/Buffer Memory Batch Monitor] 
 

 
 

• Thay đổi hiển thị của giá trị số trong màn hình với kí hiệu nhị phân  

Chọn "Word Multi-point" trong Monitor Format cho trình theo dõi loạt biến. 
 

 
 

[Màn  hình Device/Buffer Memory Batch Monitor] 
 

Giá trị 
của 
D0 

 

Giá trị 
của 
D1 

 

Giá trị 
của 
D2 

 

Giá trị 
của  
D3 
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Operating Procedure 

 

Tên dự án QEX7 

Tên chương 
trình 

MAIN 

Ví dụ ladder 

Tạo ladder sau với GX  Works2  và viết nó lên CPU của bộ DEMO. Sau đó kiểm tra 

hoạt động lệnh MOV. 
 

 
 

 
 

Quy trình hoạt động dưới đây tương tự như trong phần 4.4. 
  

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Viết dự án lên khối điều khiển khả trình. 
 

(4) Giám sát ladder. 

 

 

OK 

Insert 

• Làm thế nào để 
thay đổi lệnh 
truyền 

Để thay đổi lệnh truyền, làm theo hướng dẫn dưới đây. 

Ví dụ: Thay đổi dữ liệu truyền K200 của [MOV K200 D0] thành K100 

1) Click đúp vào lệnh để chỉnh sửa. 

2) Cửa sổ Enter Symbol hiện ra 

3) Viết "1" lên "2" của "MOV K200 D0". 

4) Click nút trên cửa sổ Enter Symbol. 

Dữ liệu ở có thể được chỉnh sửa với phương pháp 
trên. Khi  "Insert" hiện ra, ấn  vào  nút 

trước khi chỉnh sửa. 

để thay đổi nó thành 
"Ovrwrte" 

5) Sau khi kết thúc chỉnh sửa, click [Compile] → [Build]. 

Quy trình hoạt động 

X0 
0 MOV K200 D0 

MOV D0 D1 

X1 
5 RST D0 

RST D1 

Quy trình hoạt động 
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Kiểm tra "200" hiển thị dưới D0 và D1 trên màn hình máy tính khi X0 của cửa sổ điều 
khiển của thiết bị Demo bật lên. 

X0 
0 MOV 

 

 

MOV 

X1 
5 

K200 

D0 
200 

RST 

 

 

D0 
200 

D1 
200 

D0 

 

RST D1 
 

10 END 

 

 

Khi X0 được bật, giá trị hiện tại của 
D0 và D1 trở thành 200. 

 

 

Bài tập liên quan      ---- Bài tập 5 

Luyện tập 
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1 8 4 2 

D 

S 

1 

8    4    2   1) 

2 

8    4   2)   1 

3 

8    4   2)  1) 

4 

8   4)   2    1 

0 0 1 0 0 1 1 1 0 0 0 0 1 1 1 1 

 

0 0 0 1 0 0 1 0 0 0 1 1 0 1 0 0 

 

0 0 0 0 0 1 0 0 1 1 0 1 0 0 1 0 

 

BIN (P) 

X
2
F

 

X
2
E

 

X
2
D

 

X
2
C

 

1
6
3
8
4
 

1
6
3
8
4
 

8
1
9
2
 

8
1
9
2
 

4
0
9
6
 

4
0
9
6
 

2
0
4
8
 

2
0
4
8
 

X
2
B

 

X
2
A

 

X
2
9
 

X
2
8
 

1
0
2
4
 

1
0
2
4
 

5
1
2
 

5
1
2
 

2
5
6
 

2
5
6
 

1
2
8
 

1
2
8
 

X
2
7
 

X
2
6
 

X
2
5
 

X
2
4
 

6
4
 

6
4
 

3
2
 

3
2
 

1
6
 

1
6
 

8
 

8
 

X
2
3
 

X
2
2
 

X
2
1
 

X
2
0
 

4
 

4
 

2
 

2
 

1
 

1
 

 

Tên dự án QB-12 

Tên chương trình MAIN 

5.2.2 BCD → Lệnh biến đổi dữ liệu BIN  

 
Hoạt động để đọc và viết dữ liệu sau bước 35 

K50 
X7 T0 

0 T0 
 

K1500 
T0 

C10 

 

X0 
S D 

30 BINP K4X20 D5 

 

X0 

34 MOV 

 

 

K4X20 D6 

 

Kiểm tra sự khác nhau 
của lệnh BIN. 

• Khi điều kiện đầu vào được bật, dữ liệu biến được xác định trong   được nhận 
diện là mã BCD, biến đổi thành nhị phân (mã BIN), và truyền đến biến xác định 
trong D . 

8000 4000 2000 1000  800  400  200  100    80 40 20 10 8 4 2 1 

 BCD 9999    1 0 0 1 1 0 0 1 1 0 0 1 1 0 0 1 
 

Hàng nghìn Hàng trăm Hàng chục Hàng đơn vị 

Biến đổi thành BIN 
 

 
                                            BIN 

 

 

9999 

16384 8192 4096 2048 1024  512  256   128   64 32 16 

 

Trở thành 0. 
 

• Công tắc số nguyên gốc gạo mã BCD. Dó đó, lệnh BIN là cần thiết để viết dữ liệu 

từ công tắc số đến khối điều khiển khả trình . 
 

 
4096 

512 
Công tắc số 

32 
16 

  4 
  

4660 

 

 

 

K4X20 

 

 

D6 

Khi mã BCD là đầu  
vào không bị biến đổi. 

 

 

1024 
128 

64 
16 

  2 
  

1234 

 

 
D5 

Khi mã BCD là đầu vào sau khi 
biến đổi thành mã nhị phân. 
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1 

8    4    2   1) 

2 

8    4    2)   1 

3 

8    4   2)   1) 

K2X28   

(X2F đến X28)   

( 
K3X20 

(X2B đến X20) 
K4X20 

 

 M 

19 

M 

18 

M 

17 

M 

16 

M 

15 

M 

14 

M 

13 

M 

12 

M 

11 

M 

10 

M 

9 

M 

8 

M 

7 

M 

6 

M 

5 

M 

4 

M 

3 

M 

2 

M 

1 

M 

0 

    
 

X
2
F

 

X
2
E

 

X
2
D

 

X
2
C

 

X
2
B

 

X
2
A

 

X
2
9
 

X
2
8
 

X
2
7
 

X
2
6
 

X
2
5
 

X
2
4
 

X
2
3
 

X
2
2
 

X
2
1
 

X
2
0
 

4 

 

 

 Biến từ D (thanh ghi dữ liệu), T (giá trị hiện tại bộ định thời), and C (giá trị 

hiện tại bộ đếm) gồm 16 bit (1 từ), và dữ liệu cơ bản được truyền giữa những 

đơn vị trong một biến. 

 Thu thập 16 biến bit (như là X, Y, và M) nghĩa là xử lí biến từ. Số hiệu biến 

được cấp cho biến từ phải theo thứ tự liên tiếp. 

 Với biến bit, dữ liệu được xử lí theo bốn đơn vị. 
 

 

Số con 
sô 

 

 
8   4)   2    1 K4 X20 

 

 

 
 

 
Xác đinh thiết bị để đọc 

 

 
K1X20 

Số bắt đầu 

dữ liệu hai chữ số "12". 
 

 

 

 

 

 

 

 

(X2F đến X20) 

 

 

K2X20 

X27 đến X20) 

(X23 đến X20) 
Đọc dữ liệu một chữ số "4". 

 
Đọc dữ liệu hai chữ số "34".  

Đọc dữ liệu ba chữ số"234". 

Đọc dữ liệu bốn chữ 

số"1234". 

Khi mà biến bốn bit vẫn theo thứ tự liên tiếp, bất kì biến bit nào có thể xác định là cái đầu tiên. 
 

 

 

 Biến bit khác có thể được xử lí theo cách tương tự như trên. 
 

 

 

K2M6 K1M0 
 

 
 

* Một chương trình mẫu sử dụng công tắc số để nhập dữ liệu được 

cung cấp trong trang App. - 46. 
 

 Biến có thể áp dụng được 

C
o
n

 s
ố
 

S
ố
 b

ư
ớ

c
 c

ơ
 b

ả
n
 

 

Biến trong (hệ 

thống hoặc 

người dùng) 

 

 

Thanh 

ghi tệp 

 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Module 

chức năng 

thông 

minh Un\G 

 

 

Thanh 

ghi chỉ 

sô 

 

 

 

Hằng số 

 C
o
n

 t
rỏ

 

M
ứ

c
 

Bit Từ R Bit Từ Z K H P I N 

 

 

 

MOV S D 

S        
     K1 

to 

K4 

 

 

3  

D       
     

K3M5 

K4X20 

Xác định biến để 
đọc dữ liệu hai chữ 
số “12” 

Rơle nội M 
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S 

1 8 256 4 2 

8    4    2   1) 8    4   2)    1 8    4    2   1) 8    4   2)   1) 

0 0 1 0 0 1 1 1 0 0 0 0 1 1 1 1 

 

0 0 0 0 0 1 0 0 1 0 1 1 1 1 0 1 

 

0 0 0 1 0 0 1 0 0 0 0 1 0 0 1 1 

 

 1024 
128 
32 
16 

8 
4 

+ 1 

 1213 

 

BCD (P) 

Y
5
F

 

Y
5
E

 

Y
5
D

 

Y
5
C

 

1
6
3
8
4
 

8
1
9
2
 

4
0
9
6
 

2
0
4
8
 

Y
5
B

 

Y
5
A

 

Y
5
9
 

Y
5
8
 

1
0
2
4
 

5
1
2
 

2
5
6
 

1
2
8
 

Y
5
7
 

Y
5
6
 

Y
5
5
 

Y
5
4
 

6
4
 

3
2
 

1
6
 

8
 

Y
5
3
 

Y
5
2
 

Y
5
1
 

Y
5
0
 

4
 

2
 

1
 

 

Tên dự án QB-13 

Tên chương 
trình 

MAIN 

5.2.3 Lệnh biến đổi dữ liệu BIN → BCD 
 

 

X7 T0 

0 

K50 

T0 

T0 
 

 

 

X6 
S

 

K1500 

C10 

D 

37 BCD T0 K2Y40 

 

 

BCD C10 K4Y50 
 

 

 Khi  điều  kiện đầu vào  được bật,  dữ liệu  trong biến xác định  trong

được  nhận dạng là biến nhị phân (mã BIN),  biến đổi thành  thập phân  mã 

hóa nhị phân (mã BCD), và truyền dữ liệu  đến biến        D . 
 

 

 

 S 

 

 

 

BIN 

 

 

 

9999 

163848192 4096 2048 1024  512 128   64 32 16 

 

Phải đặt bằng "0". Biến đổi thành BCD. 
 

8000 4000 2000 1000  800  400  200  100    80 40 20 10 8 4 2 1 

   D  BCD 9999    1 0 0 1 1 0 0 1 1 0 0 1 1 0 0 1 
 

Hàng nghìn Hàng trăm Hàng chục Hàng đơn vị 

 Màn hình số thông thường hiển thị số theo mã BCD. Vì vậy, lệnh BCD là cần 

thiết để hiện thị dữ liệu của khối điều khiển khả trình (giá trị hiện tại của bộ 

định thời và bộ đếm, giá trị thanh ghi dữ liệu của kết quả hoạt động). 

 
 

 
 

C10 

(BIN) 
 

  

(BCD) 
 

K4Y50 

 

 

Màn hình số 
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C
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Y
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Y
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0
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0
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6
 

Y
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Y
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Y
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Y
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Y
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1
 

Y
4
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 Khoảng hiển thị được của dữ liệu với lệnh BCD (biến đổi từ BIN thành BCD) 

nằm giữa 0 và 9999. Bất kì dữ liệu nào nằm ngoài khoảng này sẽ gây lỗi. 

(Error code 4100: OPERATION ERROR) 

 Để hiển thị giá trị hiện tại bộ định thời lớn hơn 9,999, sử dụng lệnh DBCD. 

Lệnh này có thể sử dụng giá trị tới 8 chữ số (lên đến 99,999,999). 
 

 

Module đầu ra khối điều khiển khả trình 
 

 
 

 
 

Nguồn cấp ngoài 
 

 

0 0 0 0 

 

 

0 1 1 0 

 

 

0 1 1 1 

 

 

1 0 0 0 

 

 

0 1 0 1 
 

 
 

 
 

X3 H 
0 T5 

SM400 
(luôn bật) 

2 DBCD T5 K5Y40 
 

 

 

 

 

 Biến khả dụng 

C
o
n

 s
ố
 

S
ó
 b

ư
ớ

c
 c

ầ
 t
n

h
iế

t 

 

Biến trong (hệ 

thống hoặc 

người dùng) 

 

Thanh 

ghi tệp 

 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Module 

chức năng 

thông 

minh Un\G 

Thanh 

ghi chỉ 

số 

 

 

 

Hằng số 
 C

o
n

 t
rỏ

 

M
ứ

c
 

Bit Word R Bit Word Z K H P I N 

 

 

BCD S D 

S       
     K1 

đế

n 

K4 

 

 

3  

D       
     

Lệnh BCD có thể hiển thị được 
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Quy trình hoạt động 

 

Tên dự án QEX8 

Tên chương 
trình 

MAIN 

Ví dụ ladder 

Tạo ladder sau với GX  Works2  và viết nó vào CPU của thiết bị Demo. Sau đó kiểm 

tra lệnh BCD hoạt động tốt.. 
 

 

 

 
Quy trình dưới đây tương tự như                 trong phần 4.4. 

 

(1) Tạo một dự án mới. 
 

(2) Tạo một chương trình  
 

(3) Viết dự án lên khối điều khiển khả trình 
 

(4) Giám sát ladder 
 

 

 
Kiểm tra bật X0 trên cửa sổ điều khiể một vài lần hiển thị giá trị của C0 trên màn 

hình số BCD từ Y40 đến Y47. Bật X1 lên khởi động lại C0. 

 

 
 

Bài tập liên quan       ---- Bài tập 6 

Y5C Y58 Y54 Y50 Y4C Y48 Y44 Y40 

đếnY5F đếnY5B đếnY57 đếnY53 đếnY4F đếnY4B đếnY47 đến Y43 

0 đến 10 

Hiể nthị giá trị của C0 Màn hình số BCD 

Luyện tập 

Quy trình hoạt động 

X0 K10 
C0 0 

BCD C0 K2Y40 

X1 
8 RST C0 
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1 1 0   1   

 

0 0 0 0 0 0 0 0 0 0 0 0 1 1 0   1   

 

1 1 1 0 1 0 1 0 1 0 0 0 1 1 0   1   

 

        1 0 0 0 1 1 0   1   

 

        0 0 1 1 0 1 0   0   

 

1 1 1 0 1 0 1 0 1 0 0 1 1 1 0   1   

 

        0 0 0 0 1 1 0   1   

 

5.2.4 Ví dụ xác định con số cho biến bit và truyền dữ liệu 

 

Ví dụ chương trình Xử lí 

     Khi dữ iiệu đich D   là một biến từ.   

 
X3X2X1X0 

K1X0 
 

 

Trở thành 0. 
 

 

B15 B4 B3 B2 B1 B0 
 

D0 

S D 
 

MOVP    K1X0 D0 
 

 

• Nguồn: biến nguồn 

• Đích: biến đích 

        Khi dữ liệu nguồn  S   là một biến từ  
 

 

 

B15 B8 B7 B0 

D0 
 

 
M115 M108M107 M100 

 

K2M100 
 

 

Không đổi 

 S  D 
 

MOV D0 K2M100 

        Khi dữ liệu nguồn  S   là một hằng số   

 

1 2 3 4 
 

 

H1234  0 0 0 1 0 0 1 0 0 0 1 1 0 1 0  0   
 

 

 

 
M15 M8M7 M0 

K2M0 

Không đổi 3 4 

 S  D 
  

MOV H1234    K2M0 

        Khi dữ liệu nguồn  S   là một biến từ  
 

 

 

M15 M8M7 M4M3 M0 
 

K1M0 

0 
 

 
M115 M108M107   M104M103     M100 

 

K2M100 
 

 

Không đổi Không được    Dữ liệu của M3 
                                                        truyền        đến M0 

được truyền. 

 S  D 
 

MOV K1M0  K2M100 
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365 

365 

365 
365 

365 

n 

D0 

D1 

Ví dụ 

 

Tên dự án QB-14 

Tên chương 
trình 

MAIN 
 

5.2.5 FMOV (P) FMOV (truyền hàng loạt dữ liệu giống nhau) 

  
BMOV (P) 

BMOV (truyền hàng loạt dữ liệu giống nhau) 
 

X3 

0 FMOVP 

 

 

K365 D0 K8 

 

X4 

5 FMOVP 

 

 

K7000 D8 

 

 

K16 

 

X5 

10 BMOVP D0 

 

 

D32 

 

 

K16 

 

X6 

15 FMOVP K0 

 

 

D0 K48 

 

 

 

Điều kiện   
đầu vào

 
 

 

FMOVP 

 

S D n 
 

K365 D0 K8 

 

 

 
 

 Khi điều kiện đầu vào được bật, lệnh FMOV truyền dữ liệu được xác trong 

Biến  đến biến được bắt đầu biến  từ được xác định trong  

(số   hiệu  biến  đích  được   xác  định   bởi     n ).  
 

Lệnh FMOV thực thi hoạt động sau khi X3 được bật lên. 

 

 
 

 
K365  

D2 8 biến (K8) 
 

 
D7 

 

 Lệnh FOMV rất hữu dụng khi xóa một lượng lớn dữ liệu trong batch. 
 

 
 

Điều kiện 
đầu vào 

 

 

 

FMOV K0 

 

 

 

D0 K8 

 

giống
Điều kiện 
đầu vào 
bật 

 

 

 

RST D0 

 

 

RST D1 
 

 

 
 

RST D7 

 

Lệnh FMOV có thể thay thế lệnh RST như hình trên   

Ví dụ 

S 

D 

FMOV 

Giải thích hoat động 
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365 365 

365 

7000 

365 

7000 

7000 7000 

S D 

Ví dụ  

Điều kiện 
đầu vào 

S 
 

BMOVP D0 

D 
 

D32 

n 
 

K16 
 

 

 

 
 

 Khi điều kiện đầu vào được bật, lệnh BMOV truyền dữ liệu trong biến bắt đầu biến 

từ được xác định trong    đến biến  bắt đầu từ biến xác định trong  

the device specified in  D   in batch (the numbers of source devices and 

target devices are specified by  n ). 

Lệnh BMOV thực thi hoạt động dưới đây khi X5 được bật lên. 

 

  
D7 D39 

D8 D40 
 

  

D15 D47 
 

 Lệnh BMOV hữu dụng cho những trường hợp sau: 

• Lưu trữ dữ liệu log 

• Lưu trữ dữ liệuq uan trọng (như dữ liệu tự động hoá và số liệu đo) vào một 

vùng khóa. Nó giúp ngăn ngừa mất mát dữ liệu bởi việc mất nguồn. 
 

 Biến khả dụng 

C
o
n

 s
ố
 

S
ố
 b

ư
ớ

c
 c

ơ
 b

ả
n
 

 

 

biến trong (hệ 

thống hoặc 

người dùng) 

 

 

Thanh 

ghi tệp 

 

 

MELSECNET/10 

(H) Direct Jn\ 

 

Module 

chức năng 

thông mình 

Un\G 

 

 

Thanh 

ghi tệp 

 

 

 

Hằng 
số  C

o
n

 t
rỏ

 

M
ứ

c
 

Bit Từ R Bit Từ Z K H P I N 
 

 

FMOV S D n 

BMOV S D n 

 

S 
 



 



 



 



 



 



(Note) 



(Not
e) 



(Not
e) 



    

K1 

đế

n 

K4 

 

 

 

4 
D             

n 
          

(Note) không khả dụng với lệnh BMOV .

D 

D32 D0 

BMOV 

trong lô (số thiết bị nguồn và thiết bị đích được xác định trong n   ) 
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Enter 

Display Format 

OK 

 

 
 Viết chương trình ở trang trước lên CPU, rồi chạy CPU. 

 Theo hướng dẫn dưới đây để thực thi trình theo dõi lọat biến. Nội dung từ D0 

đến D47 có thể được giám sát. 

Viết chương trình vào khối điều khiển khả trình  Click  [Online]  → 

[Monitor] → [Device/Buffer Memory Batch]. 

Nhập "D0" trong hộp thoại Device/Buffer Memory Batch Monitor sau đó ấn                

. 

 Click nút 

Format. 

→ Click nút 

 
 

 
. 

và chọn "Word Multi-point" để Monitor 

 

[Giám sát màn hình] 
 

1) Bật X3. 

Dữ liệu số 365 được gửi 

đến tám thanh ghi từ D0 

đến D7 trong lô. 

 

 

 

2) Bật X4. 

Dữ liệu số 7000 được gửi 

đến 16 thanh ghi từ D8 đến 

D23 trong lô. 

 

 

 

3) Bật X5. 

Nội dung 16 thanh ghi từ D0 

đến D15 được gửi đến 16 

thanh ghi của D32 đến D47 

trong lô. 
 

 

4) Bật X6. 

"0" được gửi đến tất cả 48 

thanh ghi từ D0 đến D47 

trong lô. Nó nghĩa là 48 

thanh ghi bị xóa. 

Luyện tập 
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n 

đầu 

 

Điều 
đầu 

 
 

0 0 0 0 0 0 0 0 1 1 1 1 1 1 1   1   

 

D1  3  0  5  7 

D2  3  0  5  6 

 

Tham khảo 

 Nếu D   là một biến từ, hoạt động diễn ra như sau;   
 

Lệnh FMOV 

Điều kiện 
đ ầ u  
v à o  

 

 

 
 

S D n 

 

 Vì D  xác định số 
hai chữ số, 
dữ liệu này S 

FMOV D0 K2Y40 K4 

bị lờ đi. 
D0 (Ví dụ: khi nội dung là 365) 

 

 

 

Y4F 

D 
 

 
Y48 

 

 

 

Y47 

D 
 

 
Y40 

0 1 1 0 1 1 0  1   0 1 1 0 1 1 0  1   
 

 
0 0 0 0 0 0 0 1 0 1 1 0 1 1 0  1   

D D 4 biến (K4) 

 

Y5F Y58 Y57 Y50 

0 1 1 0 1 1 0  1   0 1 1 0 1 1 0  1   
 

 
 

 

 

 

 

 

Điêu kiện 
vào 1) 

 Giữa những biến từ Y40 đến Y5F, biến được xác định với "1" là đầu ra đầu tiên. 

 Trong chương trình bên dưới, bật điều kiện đầu vào lên 1) Bật tất cả đầu ra Y40 

đến Y5F và bật điều kiện đầu vào 2)Tắt nó đi. 

 

 

kiện 
vào 2) 

FMOV 
 

 

 

FMOV 

K255 
 

 

 

K0 

K2Y40 K4 
 

 

 

K2Y40 K4 

 

 

Bit mẫu của K255 

 

 Trong đơn vị bốn bit, để tắt đi; 

 biến 16 bit và ít hơn Lệnh MOV  

 biến 32 bit và ít hơn Lệnh DMOV       

biến  nhiều hơn 32 bit Lệnh FMOV  

 

Lệnh BMOV 

 

 

  
 

  
 

  
(tắt thiết bị 64 bit) 

 

 

 

VÌ  D xác định số 
hai chữ số, những 
dữ liêu này bị lờ 
đi.. 

điều kiện 
đầu vào 

 

 

 

BMOV 

 
S D n 

 

D0 K2Y40 K4 
 

 

 
D D 

D0 3 0 5 1 

Y4F Y48 Y47 Y40 

5 7 5 1 

D D 4 biến (K4) 

Y5F Y58 Y57 Y50 

D3 3 0 5 5 5 5 5 6 

 Trong ví dụ trên, biến từ D0 đến D3 lưu tất cả biến (16 bit). Lệnh BMOV rất hữu 

dụng để hiển thị và giám sát hai con số cuối cùng thể hiện loại của nó. 

FMOV K0 K4M0 K4 

 

Ví dụ 

DMOV K0 K8M0 

 

Ví dụ 

MOV K0 K4M0 

 

Ví dụ 

n 
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Tên dự án QEX9 

Tên chương trình MAIN 

Ví dụ ladder 

Tạo ladder dưới đây với GX Works2 và viết nó lên CPU của bộ DEMO. Sau đó kiểm 

tra lệnh FMOV hoạt động đúng. 
 

 

 

 

Quy trình dưới đây cũng giống với 
 

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Viết dự án lên khối khả trình 
 

(4) Giám sát ladder 
 

 

 
Kiểm tra giá trị của biến từ D0 đến D4 trở thành 200 trên màn hình giám sát hàng 

loạt bằng cách bật X0 trên cửa sổ điều khiển của thiết bị Demo. Bật X1 xóa dữ liệu 

trong biến. 

 
 

Thay đổi cài đặt của trình giám sát hàng loạt biến như dưới đây để hiển thị số thập 

phân, thập lục phân, hoặc nhị phân.. 

Giá trị: DEC ·····································hiển thị số theo thập phân.         

Giá trị: HEX ·····································hiển thị số theo thập lục phân.   

Định dạng giám sát: Bit đa điểm ·······hiển thị số theo nhị phân. 

 

Bài tâp liên quan     ---- Bài tập số  7 

Quy trình hoạt động 

Luyện tập 

Quy trình hoạt động 

X0 
0 FMOV  K200 D0 K5 

X1 
5 FMOV  K0 D0 K5 

trong phần 4.4. 



5 - 27 

 

 

Y74 Y74 
 
  K20 C10   
   
 

  K40 C10  
 
 
 

 S1 S2 

 

 S1 S2 

 

 

Tên dự án QB-15 

Tên chương trình MAIN 

5.3 So sánh lệnh hoạt động 
 

 

So sánh kích 
thước 

 

 
 

X3  SM413 (2s đồng hồ) 

0 

X4 

6 

S1 S2 

 

 
 
 

 
 

BCD 

K100 

C10 

 
C10  K4Y40 

10 > K10 C10 Y70 

S1 S2 

15 < = 
 

 

19 = 
 

 

23 < > 
 

 

27 > 

K10 

K20 

K30 

K20 

C10 

C10 

C10 

C10 

Y71 

Y72 

Y73 

Y74 

< K40 C10 

 

34 < = 
 

 

41 < = 

K25 

K10 

C10 

C10 

> =    K35 
 

 

> =    K20 

C10 

C10 

Y75 

Y76 

< =    K40 C10 > K50 C10 

 

55 = K100 

X0 

C10 RST C10 

 

 
● So sánh lệnh hoạt động so sánh dữ liêu từ nguồn 1 (S1) và nguồn 2 (S2), và 

khiến thị bị trở nên dẫn điện khi gặp điều kiện. 

● Lệnh có thể liên quan đến công tăc thường mở (          ) vì nó chỉ dẫn khi điều 

kiện đến. 

 
 

 

 
 

  

 
 

 

● S1 

 

 

 

S2 

 

 

······Dẫn khi nguồn 1 và nguồn 2 giống nhau. 

● S1 S2 ······Dẫn khi nguồn 1 nhỏ hơn nguồn 2. 

● S1 S2 ······Dẫn khi nguồn 1 lớn hơn nguồn 2. 

● S1 S2 ······Dẫn khi nguồn 1 và nguồn 2 giống nhau hoặc 

khi nguồn 1 nhỏ hơn nguồn 2. 

• ······Dẫn khi nguồn 1 và nguồn 2 giống nhau hoặc nguồn 1 lớn 

hơn nguồn 2. 

• ······Dẫn khi nguồn 1 và nguồn 2 không giống nhau. 
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0 1 2 3 4 5 10 15 20 25 30 35 40 45 50 

Đếm (giá trị hiện tại của bộ đếm C10) 

> = 
> K50 C10 

> = K50 C10 

 

> 

Đ
ầ
u
 r

a
 

 

 
● Viết chương trình vào CPU. 

● Bật X3 và X4. 

● C10 bắt đầu đếm. (đếm cứ mỗi 2s.) Giá trị bộ đếm hiện tai được hiển thị trên 

màn hình số (Y40 đến Y4F). 

● Chắc chắn rằng biến Y70 đến Y76 bật như sau. 
 

Khoảng từ Y70 đến Y76 được bật 
 

Y70 

Y71 

Y72 

Y73 

Y74 

Y75 

Y76 

 

 
 

 
Sự khác nhau giữa  và 

 

 

● Bộ đếm được thiết kế để đặt lại mỗi 200s. 

bằng 49. 

bằng 50. 

● Theo cách này, lệnh so sánh không chỉ so sánh không chỉ so sánh một dữ liệu 

và còn một dải cụ thể. Chức năng này được sử dụng khá phổ biến cho chương 

trình để đánh giá độ chấp nhận của sản phẩm. 
 

 Biến khả dụng 

C
o
n

 s
ố
 

C
á
c
 b

ư
ớ

c
 c

ơ
 

b
ả
n
 

 

 

Biến trong (hệ 

thống hoặc 

người dùng 

 

 

Thanh 

ghi tệp 

 

MELSECNET 

/10 (H) Direct 

Jn\ 

 

Module 

chức năng 

thông 

minh Un\G 

 

 

Thanh 

ghi chỉ 

sô 

 

 

 

Hằng số 
 C

o
n

 t
rỏ

 

M
ứ

c
 

Bit Từ R Bit Từ Z K H P I N 

 
Lệnh so sánh   S1 S2 
 

 

S1         
   K1 

đến 

K4 

 

 

3  

S2         
   

Luyện tập 
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Y70:Bật
 
 
 
  

Y71 Bật Y72: Bật 

 

Tên dự án QEX10 

Tên chương trình MAIN 

Ví dụ ladder   

Đọc ladder sau và viết nó lên CPU của bộ DEMO. Sau đó kiểm tra lệnh > and < hoạt 

động đúng. 

0s. ≤ T0 < 3s. → Y70: ON, 2.7s. < T0 < 3.3s. → 

Y71: ON, 3s. < T0 ≤ 6s. → Y72: ON 
 

 
 

T0: 
0 2.8 2.9 3.0 3.1 3.2 6.0 s. 

 

 

 

 
(1) Đọc dữ liệu 

Đọc dữ liệu dự án. 

● Click trên thanh công cụ. 
 

 

Click 

Quy trình hoạt động 

X0 
0 SET M0 

M0 M10 K60 
2 T0 

T0 
8 M10 

10 > K30 T0 Y70 

14 < K27 T0 > K33 T0 Y71 

21 < 

SM400 

K30 T0 Y72 

25 BCD T0 K2Y40 

X1 
29 RST M0 
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Quy trình hoạt động 

Open 

● Hộp thoại Open hiện ra. Xác định đích để lưu. 

● Click đúp vào vùng hoạt động hiện ra "SCHOOL". 
 

 
 

● Click "QEX10" và click nút . 
 

 
 

 

Quy trình hoạt động dưới đây tương tự như trong phần  4.4. 

 

(2) Viết dự án lên khối khả trình 
 

(3) Giám sát ladder 

Click 

Click 

Double-click 
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 Bật X0 và kiểm tra chương trình hoạt động đúng. 

 

 
 

Bài tập liên quan   ---- Bài tập 8 

X0 
0 SET M0 

K60 M0 M10 
2 T0 

30 
T0 

8 M10 

K30 T0 Y70 10 
30 

14 K27 T0 K33 T0 Y71 
30 30 

21 K30 T0 Y72 
30 

SM400 
25 BCD T0 K2Y40 

30 
X1 

29 RST M0 

31 END 

Luyện tập 
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D 

S1 

S2 

 
 +P K5 D0  
 
 

 

 
 PLS M0  
 
0 

 + K5 D0  
 
 
 

 +P K1 D0  
 
 

 -P K1 D2  
 
 

 INCP D0  
 
 

 DECP D2  
 
 

   5.4 Lệnh hoạt động số học 

 

Tên dự án QB-16 

Tên chương trình MAIN 
 

5.4.1 +(P) Cộng dữ liệu BIN 16-bit  

 
-(P) 

Trừ dữ liệu BIN 16-bit  

S D 
X2 

0 +P K5 D0
 1

 

X3 

4 +P D0 K100 D1
 2

 

1 ● Mỗi lần điều kiện đầu vào được bật, giá trị của biến được xác định trong 

được thêm vào nội dung của biến trong       

xác   định   trong            D . 

và nội dung được lưu trữ  

 

   
 

D0 + (5) 
→ 

D0  

(Điều kiện đầu vào)      
Số một ON 0 (ví dụ)  + 5 → 5 

Số hai ON 5  + 5 → 10 

Số ba ON 10  + 5 → 15 

Nội dung của 

D0 bị thay đổi. 

2 ● Khi  điều  kiện  đầu  vào  được  bật,  giá  trị  của biến  được  xác  định  trong 
được thêm vào nội dung biến xác định trong  bị 

xác  định  trong     D . 

và nội dung được lưu ở thiết

 

   
 

D0 + (100) 
→ 

D1  

(Điều kiện đầu vào) 

ON 15 (ví dụ) 
 

+ 
 

100 
 

→ 
 

115 

Nội dung của D0 không đổi. 
 

Lưu ý  

• +P hay -P phải sử dụng cho lệnh cộng hoặc trừ. 

• Khi + hay -  được sử dụng, hoạt động cộng hoặc trừ được thực thi mỗ i  

lần quét. Sử dung      + hay -  , toán hạng phải được chuyển thành xung trước. 

X2 X2 
 

  

 

M 

 

Tham khảo  

• Hai lệnh dưới đây hoạt động tơng tự như hoạt động cộng hoặc trừ. 

 
(Cộng) 

 

 
 

       (Trừ) 

D S2 S1 

D S D 
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S 

D S D 

S2 

 

Tên dự án QB-17 

Tên chương trình MAIN 

 

X4 

0 MOVP 

 

 

K1000 D2 

 

X5 

3 -P K10 D2
 3

 

X6 

7 -P D2 K50 D3
 4

 

3 ● Mỗi khi điều kiện đầu vào được bật, giá trị của biến được xác đinh trong 

bị trừ đi biến từ xác định trong         và kết quả được lưu trữ ở trong  

(Điều kiện đầu vào) 

D2- (10) → D2 

Số một ON 

Số hai ON 

Số ba ON 

1000 (ví dụ) - 10 → 

990 - 10 → 

980 - 10 → 

990 

980 

970 

Nội dung của 

D2 bị thay đổi. 

4 ● Kh i điều kiện  đầu vào được bật,  nội dung  của  biến  được  xác  định trong bị 

trừ nội dung biến được xác định trong   và kết quả được lưu ở nội dung biến 

được  xác  định  trong       D  .    

   
 

 

(Điều kiện đầu vào) 

D2 - (50) → D3 

ON 970 

(Giả sử) 
- 50 → 920 

 Nội dung của D2 không đổi. 

 
 Biến khả dụng 

C
o
n

 s
ố
 

S
ố
 b

ư
ớ

c
 t
h

ự
c
 h

iệ
n
 

Biến trong 

(hệ thống 

hoặc người 

dùng) 

 

 

Thanh 

ghi tệp 

 

MELSECNET/ 

10 (H) Direct 

Jn\ 

 

Module 

chức năg 

n thông 

minh 

Un\G 

 

 

Thanh 

ghi chỉ 

số 

 

 

 

Hằng số 

 C
o
n

 t
rỏ

 

M
ứ

c
 

Bit Word R Bit Word Z K H P I N 

 
Lệnh cộng/ trừ          S     D 

 

Lệnh cộng trừ     S1   S2    D 
 

S 

S1  S2 
        

   K1 

đến 

K4 

 
3 

4  

D 
 



 



 



 



 



 



 



     

           Số bước cơ bản là bốn cho S1   S2    D  . 

D D 

D S2 S1 
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Quy trình hoạt động 

 

Tên dự án QEX11 

Tên chương trình MAIN 

Ví dụ ladder 

Tạo ladder dưới đây với GX Works2 và viết nó lên CPU của bộ DEMO. Sau đó 

kiểm tra lệnh trừ và cộng hoạt động bình thường. 

 
 

 
 

 

Quy trình hoạt động dưới đây tương tự như  trong phần 4.4. 
 

(1) Tạo một dự án mới 
 

(2) Tạo mọt chương trình mới 
 

(3) Viết dự án lên khối điều khiển khả trình 
 

(4) Giám sát ladder 

Quy trình hoạt động 

X0 
0 BINP K4X30  D0 

BINP K4X20  D1 

+P D0 D1 

X1 
10 BINP K4X30  D0 

BINP K4X20  D1 

-P D0 D1 

20 D1 K0 DBCDD1 K5Y40 

26 D1 K0 Y70 

DMOVK0 K5Y40 
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X0 
0 BINP K4X30 D0 

300 

BINP K4X20 D1 
400 

+P D0 D1 
300 400 

X1 
10 BINP K4X30    D0 

300 

BINP K4X20    D1 
400 

D1 
300 400 

K5Y40 

-P D0 

20 > = D1 K0 DBCD D1 
400 400 

26 < D1 K0 Y70 
400 

DMOV K0 K5Y40 

34 END 

= D1+D0 D1 
100+30   400 

 

 
(1) Khi X0 được bật, dữ liệu từ X30 đến 3F và X20 đến 2F được thêm vào, và 

kết quả đầu ra từ Y40 đến Y53. 

(2) Khi X1 được bật, dữ liệu từ X30 đến 3F bị trừ đi từ dữ liệu trong X20 đến 2F, 

và kết quả đầu ra từ Y40 đến Y53. Khi kết quả là gá trị âm, Y70 được bật và Y40 

đến Y53 bị xóa về 0. 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

  

 

 

 

Bài tập liên quan    ----Bài tập 9 

+ D0 D1 

 

Quy trình hoạt động 
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S1 

30 2000 60000 

 

Tên dự án QB-18 

Tên chương trình MAIN 
 

5.4.2 * (P) Nhân dữ liệu BIN 16-bit  

 
/ (P) Chia dữ liệu BIN 16-bit  

 

X0 

0 MOVP 

 

 

K2000 D0 

 

X2 

3 *P 

 

 

K30 

1 

D0 D10 

 

X3 

7 /P 

 

 

D0 K600 

2 

D20 
 

 
 

1 ● Khi  điều  kiện  đầu  vào được  bật, nội  dung  của biến  được xác định  trong   

được nhân lên với nội dung của biến xác định  và kết quả được lưu trong biến 

được xác định trong      D .   
 

   
K30 D0 D11 D10 

= 
 

 
 

 

Lệnh này tương tự như 32 bit để lập trình với tính toán kết quả của lệnh 

*(P)   . (như lệnh DMOV và lệnh DBCD ) 

Để lưu kết quả của 16-bit dữ liệu × 16-bit dữ 
liệu.  
16 bit (1 từ) là không đủ. 
Vì vậy, D10 được xác đinh trong chương 
trình và số kế tiếp D11 tạo thành kết quả . 

Biến này đượi  coi như thanh ghi 32-bit để 
giữ kết quả. Hầu hết các bit còn lại của D10 
(B15) không phải là bit quyết định âm hay 
dương. Đó cũng là một phần của dữ liệu. 

D S2 S1 
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S1 

S2 

S1 

K30 

S2 

D0 

D 

D11 D10 

S1 

D0 

S2 

K600 

D 

D21 D20 

Ví dụ 

Ví dụ 

D11 D10 

2 ● Khi  điều kiện đầu  vào  được bật,  nội dung  của biến  được xác định  trong bị 

chia bởi nội dung của biến được xác định ở biến  

xác     định    là        D . 

và kết quả được lưu ở trong 

 

   
D0 K600 D20 D21 

 
 

Giá trị sau điểm thập phân của kết quả hoạt động bị lờ đi. 

● Khi  một  biến  bit  xác định  trong   D , thương được lưu, nhưng phần dư thì 

không được lưu. 

● Dưới đây là ví dụ để xử lí giá trị âm. 

-5 / (-3) = 1, dư: -2 

5 / (-3)   = -1, dư: 2 

● Dưới đây là ví dụ của chia bởi số 0, hoặc chia cho 0 bởi một số. 

0 / 0 

1 / 0 

 

Lỗi "OPERATION ERROR" 

0 / 1, Cả thương và phần dư đều bằng 0. 
 

 
● Viết chương trình lên CPU và chạy nó. 

● Bật X0 và lưu "2000" (giá trịnh BIN) trong D0. 

● Bật X2. Hoạt động dưới đây được thực thi. 

Nếu  "60000"(kết quả hoạt động và được hiểu là số nội 16-bit 

và chỉ D10 được giám sát, "-5536" được hiện ra. Để tránh điều này, làm theo 

hướng dẫn trong trang dưới đây. 

 
 

 

(30) 
 

● Bật X3. 

= 

(2000) 

 

 

(60000) 

 

 
 

 

(2000) 

 

 

(600) 

= 

(200) 

Thương

 

 

(3) 

Phần dư 
 

 Biến khả dụng 

C
o
n

 s
ố
 

C
c
a
c
s
 b

ư
ớ

c
 c

ơ
 

b
ả
n
 

Biến trong (hê 

thống hay 

người dùng) 

 

Thanh 

ghi tệp 

MELSECNET/ 

10 (H) Direct 

Jn\ 

Module 

chức năng 

thông 

minhUn\G 

 

Thanh 

ghi chỉ 

số 

 

 

Hằng số 

 C
o
n

 t
rỏ

 

M
ứ

c
 

Bit Word R Bit Word Z K H P I N 
 

 
Lệnh nhân/chia    S1   S2   D 

 

S1            K1 

đến 

K4 

 

* 

4 
S2            

D             

Số bước cơ bản cho lệnh nhân là ba hoặc bốn, và cho chia là bốn. 

*: Lệnh nhân thay đổi dựa trên số biến được sử dụng

Luyện tập 

2000 600 3 

Thương
  

200 

Phần dư 

= 

và 
Thương được lưu trong D20, được 
xád định trong chương trình . 

Phần dư được lưu trong D21, là số 
hiệu thiết bị tiếp theo. 

D S2 S1 
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Display Format 

OK 

● Làm thế nào để giám sát dữ liệu số nguyên 32-bit 

Khi kết quả hoạt động của lệnh nhân nằm ngoài khoảng 0 đến 32,767, kết quả không thể hiện ra 

chính xác ngay cả khi số đó là số nguyên 16-bit và nội dung của thanh ghi thấp nhất được giám sát 

trong ladder. 

Để giám sát những số đó chính xác, làm theo hướng dẫn dưới đây. 

• Click nút         ở trong hộp thoại Device/Buffer 
Memory 

Batch Monitor và chọn 

 "32bit Integer" của "Display". 

Click nút . 

• Dữ liêu được giám sát 
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Quy trình hoạt đông 

 

Tên dự án QEX12 

Tên chương trình MAIN 

Ví dụ ladder 

Tạo ladder dưới đây với GX Works2 và viết nó lên CPU của bộ DEMO. Sau đó kiểm 

tra lệnh nhân và chia hoạt động đúng. 

 
 

 
 

 

 

 

Quy trình hoạt động cũng tương tự như        trong phần 4.4. 
 

(1) Tạo một dự án mới 
 

(2) Tạo một chương trình 
 

(3) Viết dự án lên bộ điều khiển khả trình 
 

(4) Giám sát ladder 

Quy trình hoạt động 

X0 
0 BINP K4X30 D0 

BINP K4X20 D1 

*P D0 D1 D10 

DBCDP D10 K8Y40 

X1 
13 D0 BINP K4X30 

BINP K4X20 D1 

/P D0 D1 D20 

BCDP D20 K4Y50 

BCDP D21 K4Y40 
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(1) Khi X0 được bật, dữ liệu từ X20 đến X2F được nhân với dữ liệu từ X30 đến 

3F, và kết quả đầu ra từ Y40 đến 5F. 

(2) Khi X1 được bật, dữ liệu từ X30 đến X3F bị chia bởi dữ liệu từ X20 đến 2F. 

Thương số đầu ra từ Y50 đến 5F, và phần dư đầu ra từ Y40 đến 4F. 

 

 
 

 

Bài tập liên quan   ---- Bài tập 10, Bài tập 11 

X0 
0 BINP K4X30 D0 

6 

BINP K4X20 D1 
3 

*P D0 D1 D10 
6 3 18 

DBCDP D10 K8Y40 
18 

X1 
13 BINP K4X30 D0 

6 

BINP K4X20 D1 
3 

/P D0 D1 D20 
6 3 0 

BCDP D20 K4Y50 
0 

BCDP D21 K4Y40 
0 

30 END 

D0  D1=D10 
6  3=18 

Luyện tập 
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B0 

   

   

 
Bit quan trọng nhất 

W
 

 

-2
1

4
7

4
8
3

6
4
8
 

1
0

7
3
7

4
1
8

2
4
 

5
3

6
8
7

0
9
1

2
 

2
6

8
4
3

5
4
5

6
 

1
3

4
2
1

7
7
2

8
 

6
7

1
0
8

8
6
4
 

3
3

5
5
4

4
3
2
 

1
6

7
7
7

2
1
6
 

8
3

8
8
6

0
8
 

4
1

9
4
3

0
4
 

2
0

9
7
1

5
2
 

1
0

4
8
5

7
6
 

5
2

4
2
8

8
 

2
6

2
1
4

4
 

1
3

1
0
7

2
 

6
5

5
3
6
 

3
2

7
6
8
 

1
6

3
8
4
 

8
1

9
2
 

4
0

9
6
 

2
0

4
8
 

1
0

2
4
 

5
1

2
 

2
5

6
 

1
2

8
 

6
4
 

3
2
 

1
6
 

8
 

4
 

2
 

1
 

5.4.3 Lệnh dữ liệu 32 bit và sự cần thiết của nó 

 
 Đơn vị nhỏ nhất của bộ nhớ dữ liệu của khối điều khiển khả trình Q-series là 1 

từ gồm 16 bit. Vì thế, thông thường, dữ liệu được xử lí trong 1 từ cơ bản trong 

hoạt động truyền, so sánh, và số học. 

 Bộ điều khiển khả trình Q-series.có thể xử lí dữ liệu trong 2 từ cơ bản (32 bit). 

Trong trường hợp này, “D” được thêm vào đầu mỗi lệnh để chỉ ra lệnh này gồm 

2 từ. Dưới đây là ví dụ. 
 

                  Dữ liệu 

Lệnh 

1 từ 

16 bit 

2 từ 

32 bit 

 

 

Truyền 

MOV(P) DMOV(P) 

BIN(P) DBIN(P) 

BCD(P) DBCD(P) 

 

So sánh 
<, >, <= 

>=, =, <> 

D<, D>, D<= 

D>=, D=, D<> 

 

 

Hoạt động  

số học 

+ (P) D + (P) 

- (P) D - (P) 

* (P) D * (P) 

/(P) D/(P) 
 

 

 

 

 

Khoảng khả dụng 

cho giá trị 

-32,768 0 

đến đến 

32,767 9,999 

Giá trị trong ngoặc là cho lệnh 

BIN(P), BCD(P). 

-2,147,483,648 

đến 

2,147,483,647 

0 

đến 

99,999,999 

Giá trị trong ngoặc là cho lệnh 

DBIN(P), DBCD(P). 

Khoảng khả dụng 
cho con số 

 

K1 đến K4 
 

K1 đến K8 

 

 Trọng số của cấu hình 32 bit như dưới đây:: 
 

B31 
 

B16 B15 B0 
 

                                

 
 

 
 

 

Trong trường hợp xử lí 16 bit dữ liệu, khối điều khiển khả trình xử lí 32 bit giá trị âm 

trong phần bù. Vì thế, bit quan trọng nhất B31 (B15 cho 16 bit dữ liệu)  là một bit dấu

B31 Khoảng khả dụng cho số 
-2147483648 đến 0 đến 2147483647 

 

 

 
 

 

(Bit dấu) 

      Khi bit bằng 0, số được hiểu là số dương.  

   Khi bit bằng 1, số này được hiểu là số âm.. 



5 - 42 

 

 

DBCD D10 K8Y40 

D11 D10 

DBCD D40 K8Y40 

DBCD D42 K8Y60 

        

 

 Dù dữ liệu được xử lí trong 2 từ cơ bản (32 bit) hoặc không dựa vào kích thước 

của biến. 

Trong hai trường hợp dưới đây, lệnh 2 từ phải được sử dụng. 

1) Khi kích thước dữ liệu vượt khoảng (-32768 đến 32767) thì dữ liệu có thể 

được xử lí như 1 từ. 
 

  

D1 D0 

50,000 50000 

Truyền. 

Lưu trong hai thiết 
bị liền kề. 

 

2) Khi kết quả của lệnh nhân 16 bit (1 tập lệnh) được truyền. 

 
 

  

D0 D1 D11 D10 Kết quả nhân 
được lưu trong  
hai biến liền kề.. 

 

 

 
Hiển thị 8 con số 0 đến 99,999,999) 

 
 

Biến đổi 
thành BCD. 

*: Kết quả của dữ liệu nhân 32 bit là 64 bit. 
 

3) Khi kết quả của lệnh chia 32 bit được sử dụng. 
 

  

D21 D20 D31 D30 D41 D40 
 

 
(Thương) 

 

D43 D42 

 

 

 

(Phần dư) 
 

Hiển thị phần thương. 

 

 

Hiển thị phần dư.. 

D/ D20 D30 D40 

S1 S2 D 

* D0 D1 D10 

S D 

DMOV   K50000 D0 
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Ví dụ 1 

Ví dụ 2 

D31  D30   D33  D32 

D22  D21 

Giá trị số Phần nguyên 

Giá trị số Thương 

 

Tên dự án QB-19 

Tên chương trình MAIN 

5.4.4 Ví dụ tính toán cho phép nhân và chia bao gồm số sau dấu phẩy (khi nhân hoặc chia được sử dụng)  

 

Ví dụ tính toán để quyết định trường hợp 
 

 

 
(K4X30) 

× 3.14 → 

(Làm tròn) 

 

 
(K8Y50) 

  và 
 

 

(K2Y48) 
 

• Phương pháp lập trình 

Xử lí sốl làm tròn như 314 (3.14 × 100), và sau đó chia kết quả cho 100. 

 

Ví dụ tính toán để xử lí giá trị sau dấu phẩy (ví dụ là chia) 

 
 

 

 

(K4X30) 

/ 0.006 → 
 

 

 

(K8Y50) 

và  
 

 

(K4Y40) 
 

• Phương pháp lập trình 

Để xử lí 0.006 như là phần nguyên  6, nhân cả số chia và số bị chia cho 1000. 
 

Tính toán của 

 VÍ dụ 1     

dưới đây 

 

X0 X1 
 

 
BINP 

 

 
K4X30 D0 

 

 
Nhập giá trị của thiết bị chuyển mạch số vào    D0. 

*P D0 K314 D1 D0 314 D2    D1 

 
D/P D1 

 

 
 

DBCD 
 

 
 

BCD 

K100 
 

 
 

D10 
 

 
 

D12 

D10 
 

 
 

K8Y50 
 

 
 

K2Y48 

D2    D1 100 D11  D10   D13  D12 
Thương    Phần dư 

-(Phần thập phân) 

Hiển thị phần nguyên (thương). 
 

 
Hiển thị phần thập phân (phần dư). 

 
MOV K0 K2Y40 

 

Tính toán của 

Ví dụ 2       
dưới đây. 

 

X1 X0 

 

 

 

BINP 

 

 

 

K4X30 

 

 

 

D20 

 

 
 

Nhập giá trị của thiết bị chuyển mạch số vào    D20. 

 

*P D20 K1000 D21 D20 1000 

 

D/P D21 K6 D30 D22  D21 6 

Thương   Phần dư 

DBCD 

BCD 

D30 

D32 

K8Y50 

K4Y40 

Hiển thị thương. 

Hiển thị phần dư. 

 

 

Chú ý  

QCPU có những lệnh có thể xử lí hoạt động dữ liệu số thực (dấu phẩy động) 

cho độ chính xác cao hơn 

Khi nào lệnh còn được dùng, chú ý cẩn thận với điểm đặt của dấu phẩy thập 

phân như trên là không cần thiết 

Phần dư 

Phần thập phân 
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Thiết bị Mô tả Ví dụ ứng dụng 

 

 

T 

• Chỉ Z0 và Z1 là khả dụng cho một 

công tắc và cuộn dây của bộ định 

thơi. 

T0Z 0 
K100 

T1Z1 

 

 

C 

• Chỉ Z0 và Z1 là khả dụng cho một 

công tắc và cuộn dây của bộ định 

thời. 

C0Z1 
K100 

C1Z0 

 

5.5 Thanh ghi chỉ số và thanh ghi tệp 

 
5.5.1 Làm thế nào để sử dụng thanh ghi chỉ số Z 

 
 Thanh ghi chỉ số (Zn) được sử dụng để nhận dạng số hiệu biến gián tiếp. Dữ 

liệu bổ sung ở thanh ghi chỉ số và nhận dạng số hiệu biến trực tiếp có thể được 

xem như là số hiệu biến. 
 

 
 

D0Z0 → có thể hiểu như D (0+Z0) 

              Số hiệu biến 

Ví dụ, khi Z0 bằng 0, số hiệu biến trở thành D0.                           

khi Z0 bằng 0, số hiệu biến trở thành D50. 

 
 Z0 đến Z19 có thể sử dụng như thanh ghi chỉ số. 

 Thanh ghi chỉ số (Zn) là một biến từ bao gồm 16 bit.Vì thế, khoảng kích thước 

dữ liệu khả dụng là -32768 đến +32767. 

 Biến dưới đây có thể sử dụng cho chỉ số. 

Biến bit ········ X, Y, M, L, S, B, F, Jn\X, Jn\Y, Jn\B, Jn\SB (như K4Y40Z0)   

Biến từ···· T 
(Note)

, C 
(Note)

, D, R, W, Jn\W, Jn\SW, Jn\G (như  D0Z0)  

Hằng số········· K, H (như K100Z0) 

Con trỏ ············ P 

(Lưu ý)  Chỉ những giá trị hiện tại có thể sử dụng cho bộ định thời và bộ đếm. 

Những luật dưới đây được đưa ra để sử dụng thanh ghi chỉ số cho công tắc 

hoặc cuộn dây 

 

 

  
 

 
 

 
 

 

Chú ý  

Khi thanh ghi chỉ số được sử dụng với lệnh dữ liệu 32 bit 

Zn và Zn+1 là mục tiêu để xử lí. 

16 bit thấp tương ứng với thanh ghi chỉ số được xác định (Zn), và 16 bit cao tương 
ứng với thanh ghi chỉ số được xác định +1 

Chỉ số 32 bit 

(chỉ áp dụng với mô hình phổ biến QCPU (trừ Q00UJCPU)) 

Với phương pháp để xác định thanh ghi chỉ số cho chỉ số 32 bit có thể được chọn 

từ hai phương pháp sau. 

● Xác định khoảng chỉ số sử dụng cho chỉ số 32 bit 

● Xác định chỉ số 32 bit cho đặc tính “ZZ” 

Xem phụ lục 8 để biết thêm chi tiết về chỉ số. 

Ví dụ 
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T2 

T2 

X0 

BINP K2X20 Z0 

MOVP T2 D0Z0 

 

 
• Viết dữ liệu lên thanh ghi dữ liệu với số được xác định trong chuyển mạch số. 

 

Tên dự án Thanh ghi chỉ số 

Tên chương trình MAIN 
 

K3000 
 

0 

 

 

5 
 

 

 
 
 

 

• Kiểm tra hoạt động của ladder thực thi trình theo dõi lô biến.   

• Quy trình hoạt động tương tự như trong phần 5.2.1. 

Đặt số 2 con số bất kí ở cột chuyển mạch số (X27 đến X20) và bật X0. 
 

 

 
X27 to X20 
Z0= 50 
D0Z0=D50 

 

Giá trị hiện tại của T2 được 
truyền đến D50. 

5 0 

Ví dụ ứng dụng 
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Card bộ nhớ 

1) Double-click! 

2) Double-click! 

 

Bộ nhớ chương trinh 

 

RAM tiêu chuẩn 

 

ROM tiêu chuẩn 

 

5.5.2 Làm thế nào để sử dụng thanh ghi tệp R 

 
 Thanh ghi tệp (R) gồm 16 bit cũng như thanh ghi dữ liệu (D). 

 Đặt thanh ghi tệp trong RAM tiêu chuẩn của QCPU hoặc một thẻ nhớ (card 

SRAM và card Flash). Thanh ghi tệp được lưu trên card Flash chỉ có thể đọc từ 

chương trình. 
 

Lưu tham số, chương trình, ghi chú 
thiết bị, và giá trị thiết bị ban đầu. 
(Thanh ghi tệp không thể lưu.) 

 

Lưu thanh ghi tệp từ 1K đến 640K 
(dung lượng dựa trên loại CPU). 

 

Lưu tham số, chương trình, ghi chú 
thiết bị, và giá trị thiết bị ban đầu. 
(Thanh ghi tệp không thể lưu.) 

 
Lưu thanh ghi tệp từ 1K đến 4086K. 
(Số tệp thanh ghi tối đa lưu được dựa 
vào thẻ nhớ sử dụng.) 

 

 Dữ liệu của thanh ghi tệp vẫn còn sau khi khởi động lại hoạt động hoặc sau khi 

nguồn bị tắt. 

 Để xóa dữ liệu, viết 0 vào thanh ghi tệp với lệnh MOV(P) hoặc GX Works2. 

 Sử dụng [Write to PLC] của GX Works2 hoặc một chương trình tuần tự để viết 

chương trình. 

 Sử dụng [Export to ROM Format] của GX Works 2 để sao chép dữ liệu trong 

ROM tiêu chuẩn hoặc card Flash. 

 Xác định vùng của thanh ghi 1K cơ bản (1024 điểm) với tham số. 
 

 

 
• Đặt 32K điểm của thanh ghi tệp R0 đến R3267 để sử dụng trong chương 

trình. 

1) Click đúp "Parameter" trong danh mục dự án. 
 
 

 
 
 

 
 
 

 
 

 

2) "PLC Parameter", "Network Parameter", và 

"Remote Mật khẩu" hiện ra. 

Click đúp “PLC Parameter" 
 

 

 
 
 

 
 
 

 

(Đến trang sau) 

Ví dụ ứng dụng 
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6) Click! 

4) Select! 

5) Click! 

3) Click! 

End 

Yes 

(Từ trang trước) 
 

 

3) Hộp thoại Q Parameter Setting hiện ra. 

Click vào thanh PLC Tệp. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

4) Kiểm tra hộp thoại "Use the following tệp" và  

chọn "Memory Card (RAM) (Drive 1)" cho 

"Corresponding Memory". 

Nhập tham số dưới đây vào "Tệp Name" và 

"Capacity". 

[Setting contents] 

Tệp Name : R 

Capacity 32 

5) Sau khi phần cài đặt hoàn thành,  click  nút. 

 
 
 

 

 

6) Thông báo bên trái hiện ra. Click vào nút 

 . 
 

 

 
 
 

 

 
 

(Đến trang sau) 
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7) Select! 

8) Click! 

Execute 

(Từ trang trước) 
 

 
 

7) Click [Online] → [Write to PLC] để hiển thị 

hộp thoại Online Data Operatioọa. Chọn 

"Parameter" trong thanh PLC Module. 

 

8) Click  nút  

 

để viết dữ liệu. 

 
 

 
 
 

 
 
 

 
 

 

• Để xóa thanh ghi tệp dữ liệu với chương trình. viết chương trình sau. 

Cho quy trình hoạt động, xem phần 4.4 

Bật X0 để viết dữ liệu, và bật X1 để xóa dữ liệu. 

 

Tên dự án Thanh ghi tệp 

Tên chương trình MAIN 
 

X0 

0 MOV 

 

 

K173 R5 
 

X1 

3 MOV K0 R5 

Thanh ghi dữ liệu của RAM tiêu chuẩn 
được giữ bởi pin. 
Khởi động lại hay tắt không thể xóa dữ liệu.  

 

X0 

6 MOV 

 

 
K173 D5 

 

 

 

Dùng để so sánh

Để xóa dữ liệu, viết “0” 
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T10 

Quy trình hoạt động 

     

 

5.6 Cài đặt mở rộng của giá trị đặt cho bộ định thời/bộ đếm và hiển thị mở rộng của giá trị hiện tại 

 
Bộ định thời và bộ đếm có thể được xác định bởi K (hằng số thập phân) trực tiếp 

hoặc bởi D (thanh ghi dữ liệu) gián tiếp. Trong chương trình bên dưới, bộ chuyển 

mạch số mở rộng có thể thay đổi giá trị đặt. 
 

Tên dự án QTC 

Tên chương trình MAIN 

 

X0 

0 BINP 

 

 

K4X20 D5 

 

Chuyển mạch số 
X2F đến X20 

 

X4 

4 T10 

 

T10 

9 
 

 

SM400 

11 

 

 

 

 

 

 

BCD 

 

 

 

 

 

 

T10 

 

 

Y70 
 

 

 

K4Y40 

D5 1 2 3 4 

D5 

 

X1 

15 BINP 
 

 

X5 

19 
 

 

C10 

24 

 

 

K4X30 D6 
 

 

 

C10 
 

 

 

Y71 

 
Chuyển mạch số 

Y4F đến Y40 
 

    

Hiển thị giá trị hiện 
tại của T10 

 

X6 

26 RST 

 

 

C10 

 

SM400 

31 BCD 

 

 

C10 

 

 

K4Y50 
 

 

• Sau khi đọc chương trình vào GX Works2, viết nó vào khối điều khiển khả trình để 

kiểm tra nó hoạt động đúng. 
 

 

Bước (1)  của quy trình dưới đây cũng giống với                                    trong phần 

5.3. 

Bước  (2) đến (4) của quy trinh dưới đây cũng giống với             

trong phần 4.4. 

(1) Đọc dữ liệu 
 

(2) Tạo một chương trình 
 

(3) Viết một chương trình lên khối điều khiển khả trình 
 

(4) Giám sát ladder 

Quy trình hoạt động 

Quy trình hoạt động 
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1 2 3 4 

 

 

 
(1) Cài đặt mở rộng với giá trị đặt bộ định thời  và hiển thị của giá trị hiện tại 

• Đặt giá trị thiết lập của bộ định thời trong chuyển mạch số (X20 đến 2F), và 

bật chuyển mạch X0 . 

• Khi chuyển mạch X4 được bật, Y70 được bật lên sau khi thời gian được 

xác định với chuyển mạch số. (Ví dụ, Y70 bật lên sau 123.4s 

khi được đặt.) 

• Màn hình số (Y40 đến 4F) hiển thị giá trị hiện tại của bộ định thời T10. 
 

 

(2) Cài đặt mở rộng của giá trị thiết lập bộ đếm và hiển thị của giá trị hiện tại 

• Đặt giá trị thiết lập trong chuyển mạch số (X30 đến 3F), và bật chuyển 

mạch X1. 

• Bật vaf tắt chuyển mạch X5 lặp đi lặp lại. Khi X5 được bật cho thời gian 

được xác định với bộ chuyể nmạch số (đếm lên), Y71 được bật. 

• Màn hình số (Y70 đến 5F) hiển thị giá trị hiện tại của bộ đếm C10 (thời gian 

X5 được bật lên). 

• Bật chuyển mạch X6 xóa bộ đếm C10 đến 0. Khi công tắc C10 đã được bật 

(đếm lên), công tắc được  giải phóng.

Luyện tập 
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X0 
Y70 

X1 
Y71 

X2 
Y72 

X3 
Y73 

X4 
Y74 

X5 
Y75 

X6 
Y76 

X7 
Y77 

Hint  

 CPU 

 

Bài tập  1 

 

Tên dự án QTEST5 

Tên chương trình MAIN 

5.7 Bài tập 
 

5.7.1 MOV 

 
Truyền 8 trạng thái đầu vào (X0 đến X7) đến D0 khi đầu ra của chúng đến Y70 đến 

Y77.) 

X0 Y70 

X1 Y71 

X2 Y72 

X3 Y73 

X4 Y74 

X5 Y75 

X6 Y76 

X7 Y77 

Tạo chương trình sau với GX Works2 bằng cách điền vào                   

Sau đó, kiểm tra hoạt động sử dụng thiết bị Demo. 
 

 

 

  
 

(Module đầu vào) 
D0 

(Module đầu ra) 1)   
2)   

 

 

 

 

K2X0 

X0    0/1 

X1    0/1 

X2    0/1 

X3    0/1 

X4    0/1 

X5    0/1 

X6    0/1 

X7    0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

0/1 

Y70 

Y71 

Y72 

Y73 

Y74 

Y75 

Y76 

Y77 

 

 

 

 

K2Y70 

MOV MOV CPU nhập tín hiệu đầu vào là “1” khi nó bật, và nhập là 0 khi 
nó tắt. 
Module đầu ra bật khi đầu ra CPU là "1", và tắt đi khi 
đầu ra CPU là “0”.. 

 

 
Hình dưới đây cho thất một chương trình được tạo với lệnh tuần tự, không phải với 

lệnh MOV. 
 

0 
 

2 
 

4 
 

6 
 

8 
 

10 
 

12 
 

14 

So sánh 

SM401 
0 MOV 1) D0 

MOV D0 2) 

Gợi ý 
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BCD 

    

 

  Giá trị BCD 

D0 

Giá 
trị 

thiết 
lập 

C0 

Giá trị BCD 

 

Tên dự án QTEST6 

Tên chương trình MAIN 
 

5.7.2 Bài tập 2 Chuyển đổi BIN và BCD 

   
Đầu ra là số lần X1 được bật trên màn hình kết nối với Y40 đến Y4F trên BCD. Như là 

một điều kiện trước hết, giá trị thiết lập của bộ đếm (C0) có thể làm đầu vào với chuyển 

mạch số (X20 đến X2F) và cài đặt này sẽ có giá trị khi bật X0. 

Tạo chương trình sau với GX Works2 bằng cách điền vào   . 

Sau đó, kiểm tra hoạt động sử dụng thiết bị Demo. 
 

 

 

 
 

CPU 

 

Giá trị BCD  
 

  
Chuyển mạch số BCD 
X20 đến X2F (K4X20) 

 

 

Giá trị BCD 

 
 

 

  

X1:ON/OFF  

 

Màn hình số BCD 
Y4 đến Y4F (K4Y40) 

 

 

1) 
 

2) 
 

3) 
 

4) 
 

BIN 

Gợi ý 

1) 

C0 
X1 

0 

X0 
5 BINP 2) D0 

SM401 
9 3) C0 4) 

X2 
13 RST C0 

C0 
18 Y70 
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X0 
Y40 

Y41 

Y42 

Y7F 

1 1 1 1 1 1 1 1 

 

Bài tập 3 

 

Tên dự án QTEST7 

Tên chương trình MAIN 

5.7.3 FMOV 

 
Tạo một chương trình mà khi bật X0 lên sẽ bật 64 bit đầu ra từ Y40 đến Y7F và tắt X0 

đi sẽ tắt 64 bit đầu ra Y40 đến Y7F. 

Tạo chương trình sau với GX Works2 bằng cách điền vào   . 

Sau đó, kiểm tra hoạt động sử dụng thiết bị Demo. 
 

 
 

 

CPU 

255 

1 
1 

 

(Card đầu ra) 

Y40 

Y41 

Đầu ra từ CPU trong kí hiệu nhị phân là hằng số. 
 

 

Khi 255 là đầu ra từ Y40, 

1 

1 Y42 
1 Y43 

128 64   32   16 8 4 2 1 

=1+2+4+8+16+32+64+128=255 

1 

1 

1 
 

 

 
MOV 

 

Y44 

Y45 

Y46 

Y47 

Y47 Y46 Y45 Y44 Y43 Y42 Y41 Y40 
 

 

Trong bài này, một module đầu ra 64 điểm được sử dụng (Y40 
đến Y7F). Có bao nhiêu khối cần thiết cho 255 ở đầu ra cơ bản ? 

 

1) 
 

2) 
 

3) 
 

 

 

Hình dưới đây chỉ ra một chương trình được tạo ra với lệnh tuần tự, không phải với 

lệnh FMOV. 130 bước được sử dụng. 
 

0 

So sánh 

Hint 

X0 
0 FMOV K255 1) 2) 

X0 
5 FMOV 3) K2Y40 K8 

 128   64    32   16     8      4      2     1 
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Bài tập 4 

 

Tên dự án QTEST8 

Tên chương trình MAIN 

5.7.4 Lệnh so sánh 

 
Sử dụng chuyển mạch số BCD, thực thi tính toán của (A - B) và hiển thị kết quả trên 

màn hình số BCD (Y40 đến Y4F). 

 

    

(X30 đến X3F) 

A 

(X20 đến X2F) 

B 

(Y40 đến Y4F) 

Hiển thị kết quả tính toán từ A - B trên 
màn hình BCD từ Y40 to Y4F. 
Khi kết quả là mọt số âm, đảm bảo ằng mà hình 
hiển thị 0 và LED của Y70 được bật. 

 

Điền vào chỗ trống . 

Sau đó, kiểm tra hoạt động sử dụng thiết bị Demo. 

 
 

 

Kết quả hoạt động luôn là đâu ra từ CPU dạng nhạ phân. 
 

 

1) 
 

2) 
 

3) 
 

4) 
 

- D0 D1 =D1-D0   D1 

Gợi ý 

X0 
0 1) K4X20 D0 

2) K4X30 D1 

-P D0 D1 

3) K0   D1 SET Y70 

MOV K0 K4Y40 

4) K0   D1 BCD D1 K4Y40 

RST Y70 
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1 1 1 0 1 1 0 0 1 0 

0 0 0 1 0 0 1 1 0 1 

0 0 0 1 0 0 1 1 1 0 

Bài tập 5 

 

Tên dự án QTEST9 

Tên chương trình MAIN 

5.7.5 Lệnh cộng và trừ 

 
Tạo một chương trình: 

1) Nhập giá trị xác định bởI chuyển mạch số (X20 đến X2F) đến D3 và D2 (dữ liệu 

32 bit) khi X0 được bật, thêm nó vào D1 và D0, và hiển thị kết quả trên màn hình 

(Y40 đến Y5F). 

2) Nhập giá trị xác định bởI chuyển mạch số (X20 đến X2F) đến D5 và D4 khi X1 

được bật, lấy D1 và D0 trừ nó đi, và hiển thị kết quả. 

3) Khi kết quả là số âm, Y77 được bật, hai phần bù được quyết định từ kết quả để 

lấy giá trị tuyệt đốI, và hiển thị. 

Điền vào chỗ trống dưới đây. 

Sau đó, kiểm tra hoạt động sử dụng thiết bị Demo. 

 
 

1) 
 

2) 
 

 

 

 
 

Phần bù (bỏ truyền) 

M1 

 

 

D1 D0 

D> K0 D0 DCML 

D+P 

D0 D8 
 

 

K1 D8 

Trước thực thi 
DCML (số âm) 

B31 B30 B18 B17 B16 B15 B14 B2   B1   B0 
 

 
D9 D8 

Giá trị tuyệt đối được quyết định vởi 
tính toán hai phầnb ù của D0 và D1 
(dữ liệu 32 bit). 

Sau khi 
thực thi DCML 

 

 
 

Sau khi thực thi D + 
P (giá trị tuyệt đối) 

 

 

 

D9 D8 

 

Ghi nhớ  

 Lệnh CML dùng để đảo ngược bit mẫu của   S   và truyền dữ liệu này đến D 

Khi điều kện đầu vào được bật.. 

Điều kiện đầu vào     S    D 

CML D0 D10 

Tham khảo 

X0 
0 DBIN K4X20 D2 Thêm giá trị mở 

rộng cho D0 
1) D2 D0 

Hiển thị kết quả khi nó là 
giá trị dương 

9 D<= 

X1 

K0 D0 DBCD D0 K8Y40 

17 DBIN K4X20 D4 
Trừ giá trị mở rộng từ 
D0 

2) D4 D0 

X0 
26 PLS M1 

X1 

Khi kết quả là một số 
âm, nó biến đổi thành 
một số dương và hiện ra 
(giá trị tuyệt đối của số 
âm được tính). 

 

Đầu ra là só âm. 

Xóa D0 và D1. 

M1 
30 D> K0 D0 DCML D0 D8 

D+P K1 D8 

DBCD D8 K8Y40 

Y77 

X7 
50 DMOV K0 D0 
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X0 
0 K1X34 1) K2X30 D0 >= H9 K1X30 >= H9 

H9 K1X20 2) K2X20 D1 >= 

X3 

>= H9 K1X24 

X2 
21 3) D0 D1 D2 

X3 X2 
K0 26 <> D1 4) D0 D1 D2 

= D1 K0 DMOVP K0 D2 

SM401 
43 5) D2 K4Y40 >= K9999 D2 

K99 D3 >= 6) D3 K2Y60 

Giá trị BIN 0 Giá trị BIN 

Giá trá BIN Giá trị BIN Giá trị BIN Giá trị BIN 

Bài tập 6 

 

Tên dự án QTEST10 

Tên chương trình MAIN 

5.7.6 Lệnh nhân và chia 

 
Tạo một chương trình mà: 

1) Đặt dữ liệu cho nhân và chia khi X0 được bật. 

2) Nhân giá trị được xác định bởI chuyển mạch số X20 đến X27 bởI giá trị xác định 

bởI chuyển mạch số X30 đến X37 ở dạng nhị phân khi X2 được bật. 

3) Chia giá trị xác định bởI chuyển mạch số X30 đến X37 bởI giá trị xác định bởI 

chuyển mạch số X20 đến X27 ở dạng nhị phân khi X3 được bật. 

4) Đầu ra là kết quả của phép nhân hoặc chia cho ra màn hình BCD hiểnth ị Y40 

đến Y4F và phần dư cho ra màn hình BCD Y60 đến Y67. 

(X30 đên X37) × (X20 đến X27) (Y40 đến Y4F) 

(X30 đến X37) / (X20 đến X27) (Y40 đến Y4F) ... (Y60 đến Y67) 
 

Tạo một chương trình với GX Works2 điền vào ô trống dướI đây.        

Sau đó, kiểm tra hoạt động sử dụng máy trình diến. 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
 

Phép  
D0 D1 D3 D2 

nhân BIN          Giá trị BIN 
 

D0 D1 

                                    Phép chia BIN 

D2 D3 

 

1) 
 

2) 
 

3) 
 

4) 
 

5) 
 

6) 
 

Gợi ý 
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Bài tập 7 

 

Tên dự án QTEST11 

Tên chương trình MAIN 

5.7.7 D- nhân và D-chia 

 
Tạo chương trình mà: 

1) Nhân giá trị thiết lập bởI chuyển mạch số 5 chữ số (X20 đến X33) bằng 1.100 

dạng nhị phân khi X2 được bật. Khi kết quả là 99,999,999 hoặc ít hơn, nó được 

hiện trên màn hình (Y40 đến Y5F). 

2) Chia giá trị thiết lập bởi chuyển mạch sô 8 chữ số (Y40 đến Y5F) . 

(X20 đến X33) × 1100 (Y40 đến Y5F) 
 

(X20 đến X3F) / 40000 
Thương (Y40 đến Y5F) ... X4: ON  

Phần dư (Y40 đến Y5F) ... X4: OFF 

Tạo chương trình với GX Works2 điền vào chỗ trống dưới đây. Sau đó, 

kiểm tra hoạt động sử dụng thiết bị Demo. 
 

 
 

1) 
 

2) 
 

3) 
 

4) 
 

5) 
 

6)

X2 X3 
0 DBINP K5X20 D0 

1) K1100 D2 

2) D0 D2 D4 

D< 

Y77 

K99999999 D4 Y77 

DBCDP D4 K8Y40 

X3 X2 
24 3) K8X20 D10 

4) K40000 D12 

5) D10 D12 D14 

X4 
DBCD 6) K8Y40 

X4 
DBCD 7) K8Y40 

  6)_____________________________ 

  7)_____________________________ 
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Đáp án cho bài tập chương 5 
 

Bài tập 

Số. 

  

Đáp án 

 

1 
1) K2X0 

2) K2Y70 
 

 

 

2 

1) D0 

2) K4X20 

3) BCD 

4) K4Y40 
 

 

3 

1) K2Y40 

2) K8 

3) K0 
 

 

 

4 

1) BINP 

2) BINP 

3) > 

4) <= 

 

5 
1) D + P 

2) D - P 

 

 

 

 
6 

1) BINP 

2) BINP 

3) *P 

4) /P 

5) BCD 

6) BCD 

 

 

 

 

 

7 

1) DMOVP 

2) D*P 

3) DBINP 

4) DMOVP 

5) D/P 

6) D14 

7) D16 
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X6 X1 
0 Y70 

Y70 

K1500 
TO 

0 

K4Y50 

X4 M10 
4 

BCD TO 
0 

X6 T1 
13 Y74 

Y74 

Y74 X6 K30 
17 T1 

0 

23 END 

Chương 6 Làm thế nào để sử dụng các chức năng khác 
 

 
6.1 Kiểm tra chức năng trực tuyến 

 
Để chuẩn bị, làm theo hướng dẫn dưới đây. 

 

Tên dự án QEX14 

Tên chương trình MAIN 

 

 
 

1) Đọc một dự án với Works2. 
 

 

2) Viết tham số và chương trình của dự án đang 

đọc vào CPU (bộ điều khiển khả trình). 

(CPU phải dừng lại.) 

 
3) Đặt GX Works2 vào chế độ giám sát. 

 

 

4) Xác nhận chương trình hiện trên mà hình. 

Chi tiết về phương pháp hoạt động, xem lại 
chương 2. 
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2) Enter "Y70"! 

3) Click! 

1) Click! 

ON OFF 

ON OFF 

6.1.1  Bật và tắt biến “Y” bằng cưỡng bức 

 
 

 
 

1) Click [Debug] → [Modify Value]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 

 

2) Hộp thoại Modify Value hiện ra. Nhập 

"Y70" vào hộp "Device/Label. 

 

3) Click nút  để bật hoặc 

tắt "Y70" bằng cưỡng bức. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

1) Xác nhận trạng thái bật và tắt trên vùng Execution Result để biến đổi theo như 

click nút              hoặc               . Thêm nữa, xác nhận LED của Y70 của thiết bị 
Demo bật và tắt theo hoạt động. 

 

Lưu ý  

Khi CPU ở trạng thái RUN, kết quả hoạt động của chương trình được hiển thị 

theo độ ưu tiên. VÌ thế, dừng CPU đầu tiên trước khi xác nhận với thiết bị 

Demo. 

Kiểm tra với bộ DEMO 
 

Dừng CPU trước khi làm theo. 
 

hoặc 
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Gợi ý  

Chức năng kiểm tra trong suốt quá trình giám sát ladder của GX Works2 cũng 

khả dụng cho cài đặt và khởi động lại công tắc, thay đổi giá trị hiện tại ,và biến 

đầu ra bằng cưỡng bức. 

Click đúp vào một công tắc (nhấn vào nút Enter     ) v à  giữ  phím Shift  

ở trong màn hình giám sát GX Works2 biến đổi công tắc mở và đóng bằng 

cưỡng bức. 

Để hiển thị hộp thoại Modify Value, click đúp vào một biến từ  ( giữ phím    

Enter )  và  giữ  phím  Shift ở trong màn hình giám sát ladder của 

GXWorks2. 
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2) Enter "M10"! 

3) Click! 

1) Click! 

K1500 

T0 

K4 

BCD T0 Y50 

X4  M10 
4 

ON OFF 

6.1.2 Đặt và khởi động lại biến "M" 
 

 
 

 
 

1) Click [Debug] → [Modify Value]. 
 

 
 

 
 
 

 
 
 

 
 
 

 

2) Hộp thoại Modify hiện ra. Nhập "M10" 

trong hộp danh sách "Device/Label". 

 

3) Click nút             hay             để đặt hoặc khởi 

                                                                                                      động lại “M10”. 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

 

Tắt X4 và kiêm tra dưới đây. 
M10 

1) Khi M10 được đặt trở thành không dẫn và giá trị hiện tại của bộ định 
 

 

 

 

 

 

 

 

 

(Màn hình giám sát khi  M10 
đươc đặt) 

thời T0 được xóa về 0. 

Kiểm tra giá trị trên màn hình số (Y50 đến Y5F) không đổi. 
M10 

2) Khi M10 được đặt,             dẫn và bộ định thời T0 bắt đầu đếm từ  0. Giá 
trị đếm tăng mỗi 10s. 

Xác nhận giá trị hiện trên màn hình (Y50-Y5F) tăng mỗi 10s . 

 

Gợi ý  

Với quy trình tương tự, thiết bị bit khác rơ le nội (M) có thể được đặt hoặc khởi 

động lại về 0. 

Kiểm tra bộ DEMO 

Kichs hoạt CPU trước hoạt động này 
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2) Enter "T0"! 

3) Select! 

4) Enter "1000"! 

5) Click! 

1) Click! 

6.1.3 Đổi giá trị hiện tại của biến “T” 
 

 
 

 
 

1) Click [Debug] → [Modify Value]. 
 
 
 

 
 
 

 
 
 

 

 

 

2) Hộp thoại Modify Value hiện ra. Nhập 

"T0" vào hộp "Device/Label”. 

 
3) Chọn "Word[Signed]" từ danh sách "Data 

Type". 

 
4) Nhập "1000" vào cột "Value”.. 

 

 

5) Sau khi cài đặt hoàn thành, click vào nút        

 để thay đổi giá trị hiện tại của T0 

đến 1000 bằng cưỡng bức. 
 
 
 

 
 
 

 

 

1) Xác định giá trị trên màn hình số  (Y50-Y5F) là 1000 khi khi            khóa  

được nhấn. 

 

Gợi ý  

Với quy trình tương đương, giá trị hiện tại của biến từ khác bộ định thời (T) cũng 

có thể thay đổi. 

Kiểm tra với thiết bị Demo 

Kích hoạt CPU trước khi hoạt động 
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2) Jump to the step number 
with the error! 

1) Click! 

Error JUMP 

6.1.4 Đọc các bước lỗi 
 

 
 

 
 

1) Click [Diagnostics] → [PLC Diagnostics]. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 
2) Hộp thoại The PLC Diagnostics hiện ra. 

Click nút để nhảy đến  số bước 

chương trình tuần tự được đánh dấu ở nơi 

xảy ra lỗi được chọn 

 

 

• Số thự tự lỗi hiện ra nếu có lỗi xuất hiện. 
 

• "No Error" hiện ra nếu không có lỗi. 

Kích hoạt CPU trước hoạt động này 



6 - 7 

 

 

4) Click! 

   2) Select! 

3) Click! 

1) Click! 

Execute 

Yes 

6.1.5 STOP và RUN từ xa 
 

 
 

 
 

1) Click [Online] → [Remote Operation]. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

2) Hộp thoại Remote Operation hiện ra. Chọn 

"STOP" trong danh mục trong vùng 

Operation. 

 
3) Sau khi cài đặt được hoàn thành, click nút 

    . 
 
 

 
 
 

 
 

 

 

4) Tin nhắn "Do you want to execute the 

operation(STOP)?" hiện ra. Click nút 

. 

 

 
 

5) Chọn "RUN" trong bước 2), và thực hiện lại 
bước 2) đến 4) . 

 

 

CPU, được dừng lại ở hoạt động trên, bắt 
đầu hoạt động lại 

Hoạt động của CPU dừng lại 

Kích hoạt CPU trước hoạt động này. 
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4) Select! 6) Select! 

5) Enter "QX42"! 7) Enter "0000"! 

8) Click! 

3) Click! 

2) Double-click! 

1) Double-click! 

End 

6.2 Cưỡng bức chỉ định I/O bằng cài đặt Parameter  

 

1) Click đúp  "Parameter" ở danh mục dự án. 
 

 
 

 
 
 

 
 
 

 
 
 

2) "PLC Parameter", thư mục "Network 

Parameter", và"Remote Mật khẩu" hiện ra. 

Click đúp vapf "PLC Parameter". 

 
 

 

 
 
 

 

 
 

 

3) Hộp thoại Q Parameter Setting hiện ra. 

Click vào thanh "I/O Assignment". 
 

 
 
 

 
 
 

 
 
 

 

4) Chọn "Input" từ danh sách trong cột "Type". 

 

5) Nhập "QX42" vào cột "Model Name". 

6) Chọn "32Điểm" từ danh mục của cột "Điểm". 

7) Nhập "0000" trong cột "Start XY". 

8) Sau khi cài đặt được hoàn thành, click 

. 
 

 

Sau khi bài tập này được hoàn thành, khởi 

động cài đăt bằng quy trình dưới đây. 

1) Click nút Default trong hộp thoại  Q 

Parameter Setting để khởi động cài đặt 

tham số. 

2) Click trên thanh công cụ và chỉ viết 

tham số lên CPU. 
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Màn hình số 
QX42 

Địa chỉ 
0 

Địa chỉ 
1 

Địa chỉ 
2 

Địa chỉ 
3 

QY42P 

Địa chỉ 
4 

Địa chỉ 
5 

Q61P 

Module 
cấp 

nguồn 

Q06    Khe 
UD(E)H  trống  

CPU [BCD T0 K4Y50] 
Y5F-Y50 

Địa chỉ 
6 

Địa chỉ 
7 

Tên đĩa 

Y77  Y76  Y75  Y74  Y73  Y72  Y71  Y70 

Tên đĩa 

Execute 

 

 

Dừng CPU và click   trên thanh công cụ. 

Hộp thoại Online Data Operation hiện ra. Click vào tham số của dữ liệu bị 

chỉnh  sửa  hiện tại, và  click  nút  để chỉ viết tham số lên CPU.  

Sau đó, kích hoạt CPU và kiểm tra dưới đây. 
 

 

1) Giá trị hiện tại của biến mất từ màn hình số (Y50 đến Y5F). Sau đó, LED của 

Y70 đến Y77 bắt đầu nháy sáng cho đến khi giá trị thiết lập của Y70 đến Y77 

đến mỗi giá trị biến được đặt. 

2) Bật X6 để đưa tín hiệu đến Y70 và Y74 không làm tắt LED của Y70 và Y74. 

 
[Số I/O trước khi cưỡng bức chỉ định] 

[Khe 0] [Khe 1] 
Địa chỉ 0, Địa chỉ 2,  Địa chỉ 4, Địa chỉ 6, Mưới sáu điểm chiếm một địa chỉ. 

Địa chỉ 1, Địa chỉ 3 Địa chỉ 5, Địa chỉ 7 Sáu tư điểm chiếm bốn địa chỉ. 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

[Số I/O sau khi cưỡng bức chỉ định] 
 

 

 

Gợi ý  

• Địa chỉ số 7 được thay thế bằng địa chỉ số 5. Vì thế, giá trị hiện tại của bộ 

định thời dượcđưa đến đầu ra địa chỉ vừa chỉ định 5, và LED của Y70 

đến Y77 được kết nối đến đèn địa chỉ số 5. 

• Kết quả của đưa tín hiệu đầu ra đến Y70 hoặc Y74 không được hiển thị trên 

bất cứ màn hình nào vì địa chỉ số 7 của module đầu ra không còn tồn tại. 

• Để hiển thị số biến địa chỉ thông thường, thay đổi số biến K4Y50 K4Y30, và  

Y70 đến Y77 Y50 đến Y57. 

X được đặt thành 32 điểm, vì thế chỉ có hai địa chỉ khả dụng. 
Sau đó, địa chỉ bé đi còn hai. 

Địa chỉ 4, Địa chỉ 6, Địa chỉ 0 
Địa chỉ 1 

QX42 

Địa chỉ 
0 

Địa chỉ 5, Địa chỉ 7 

QY42P 

Địa chỉ 
2 

Địa chỉ 
3 

Địa chỉ 
4 

Địa chỉ 
5 

Màn hình số 

Q61P 

Module 
cấp 

nguồn 

Q06     Khe 
trống    Địa chỉ 

1 
UD(E)H 

CPU Y5F-Y50 
Tên đĩa 

[BCD T0 K4Y50] 

Y77  Y76  Y75  Y74  Y73  Y72  Y71  Y70 

Tên đĩa 

Kiểm tra với thiết bị Demo 

Y70 đến Y77 Y50 đến Y57. 
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2) Double-click! 

1) Double-click! 

Tên dự án Bộ đếm thời gian tích hợp lưu trữ 

Tên chương trình MAIN 

 

6.3 Làm thế nào để sử dụng bộ định thời có nhớ 

 
Khi điều kiện đầu vào được bật, cuộn dây được cấp điện. Sau đó giá trị của bộ định 

thời có nhớ bắt đầu tăng lên. Khi giá trị hiện tại đến giá trị đặt, bộ định thời có nhớ 

không đếm nữa và công tắc bật lên. Khi điều kiện đầu vào bị tắt trong quá trình tăng 

lên, cuộn dây bị ngắt điện nhưng giá trị hiện tại vẫn được giữ. Sau đó điều kiện đầu 

vào được bật trở lại, cuộn dây được nạp lại được cấp điện và giá trị hiện tại được 

tích lũy. 

 

 
 
 

 
 

X6 
 

 
ST1 

K50 

ST1 
 

 
 

Y73 

 

 

 

Cuộn dây ST1 

 

 

 

 

 

 

3.1 s   . 2.0s. 
 

X7 

RST ST1 

Tiếp điểm thường mở ST1 
 

 

Công tắc X7 (cho lệnh đầu vào RST) 

 

Giá trị hiện 

tại của ST1   
0 3   3 5 5   0

 
 

Khi sử dụng chương trình như 
bộ đếm thời gian tích hợp lưu 
trữ, xác định điểm của tham số 
trước. 

Chỉ có lệnh RST là có thể tắt công tắc và xóa giá trị hiện tại sau 

khi bộ đếm thời gian tích hợp lưu trữ dừng lại. 

 

 

Trong ví dụ dưới đây, bộ đếm thời gian tích hợp lưu trữ được đặt từ ST0 đến ST31. 
 

 

1) Click đúp "Parameter" trong danh sách dự án. 
 

 
 

 
 
 

 
 
 

 

2) "PLC Parameter", "Network Parameter" 

folder, và "Remote Mật khẩu” hiện ra. 

Click đúp "PLC Parameter". 
 

 
 

 
 
 

 
 

 

(Đến trang sau) 

0 3 3 5 5 0 
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4) Enter "32"! 

5) Click! 

3) Click! 

End 

(Từ trang trước) 
 

 

3) Hộp thoại Q Parameter Setting hiện 

ra. Click thanh "Device". 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
4) Click "Device Point" trong hàng "Retentive 

Timer" , và nhập "32". 

 
5) Sau khi cài đặt hoàn tất, click nút  

       . 
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2) Enter "Y40"! 3) Enter "Y20"!      4) Enter "64"! 

5) Click! 

1) Click! 

(Trước) 

X1 X6 
 

Y70 

0 Y70 

K1500 

T0 

BCD TO K4Y50 
 

Y74 

X4 M10 
4 

X6 

Y74 

Y74 

T1 
13 

K30 

T1 
X6 

17 

(Saur) 

0   
X6 

Y50 

X1 
Y50 

K1500 

T0 
 

BCD TO K4Y30 
 

Y54 

X4 M10 
4 

X6 
 

Y54 

T1 
13 

K30 

T1 
Y54 X6 

17 

Execute 

6.4 Thay thế loạt biến 

 
6.4.1 Thay thế loạt biến 

 
Phần này diễn giải làm thế nào để thay thế Y40 đến Y7F (64 biến) với Y20 đến 

Y5F (64 biến) theo lô. 

 
1) Click [Find/Replace] → [Device Batch Replace]. 

 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

2) Hộp thoại Find/Replace hiện ra. Nhập 

"Y40" ở cột "Find Device". 

 
3) Nhập "Y20" ở cột "Replace Device”.. 

 

 

4) Nhập "64" vào cột "Point". 
 

 

5) Sau khi cài đặt hoàn tất, click nút 

   . 
 

 
 

 
 

 

6) Xác nhận rằng số biến mục tiêu được thay 

thế. 
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2) Enter "X4"! 

3) Click! 

1) Click! 

  (Trước)   

X6 
 

Y50 

X1 
0 Y50 

K1500 

T0 

BCD TO K4Y30 

X4 M10 
4 

X6 
 

Y54 

T1 
13 Y54 

K30 

T1 
X6 Y54 

17 

  (Sau)   

X6 
 

Y50 

X1 
0 Y50 

K1500 

T0 

BCD TO K4Y30 

X4 M10 
4 

X6 
 

Y54 

T1 
13 Y54 

K30 

T1 
Y54 X6 

17 

All Replace 

6.4.2 Thay đổi loạt biến được xác định giữa tiếp điểm thường mở và tiếp điểm thường đóng 

 
Phần này diễn giải làm thế nào để thay đổi tiếp điểm thường mở của biến xác định 

thành tiếp điểm thường đóng và ngược lại. 

 
1) Click [Find/Replace] → [Change Open/Close 

Contact]. 

 

 
 

 
 
 

 
 
 

 
 
 

 
 

 

2) Hộp thoại Find/Replace hiện ra. Nhập "X4" 

trong danh mục "Replace Device". 

 
3) Sau khi cài đặt hoàn tất, click nút 

        . 
 

 
 
 

 
 
 

 
 
 

 

 
4) Xác nhận tiếp điểm thường mở được 

chuyển thành tiếp điểm thường đóng và 

ngược lại. 

 
 
 

 
 

 

Ghi chú  

Trước khi luyện tập phần 6.5 sau phần này, viết chương trình trong máy tính 

cá nhân lên CPU. 

Đối với hoạt động viết, xem lại phần 2.7. 
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4) Click! 

3) Click! 

2) Click! 

1) Change the ladder! 

Yes 

OK 

6.5 Thay đổi chương trình trực tuyến 

 
Chức năng này dùng để viết chương trình lên CPU đang chạy.  

 

 
 

1) Thay đổi ladder. 

(Trong ví dụ, thay đổi"X1" thành "X0".) 
 
 

 
 

 

 

 

 
 

2) Sau khi thay đổi, click [Compile] 

→ [Online Program Change]. 
 

 
 

 
 
 

 

3) Hộp thoại "Caution" hiện ra. 

Click nút  

 

để chấp nhận thay đổi.

 

 
 

 

 
 

4) Tin nhắn "Online change has 

completed." hiện ra. Click nút  

 

 

 
 
 

 

 

Ghi chú  

Thay đổi chương trình trực tuyến không thể thực thi khi chương trình trong 

CPU điều khiển khả trình và chương trình trong GX Works2 trước khi thay đổi 

không giống nhau. Vì thế, khi không biết chương trình giống hoặc không giống, 

kiểm tra chúng trước khi thay đổi với GX Works2, và thực thi thay đổi chương 

trình trực tuyến. 

Kích hoạt CPU trước hoạt động này 
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1) Click! 

2) Enter "T0"! 

4) Displayed! 

6.6 Đăng kí biến 

 
Phần này diễn giải làm thế nào để đăng kí nhiều biến hoặc nhãn trong một màn hình 

và giám sát chúng cùng lúc.. 

 

1) Click [View] → [Docking Window] 

→ [Watch(1 to 4)]. 
 

 

* Trong ví dụ này, chọn "1". 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
 

2) Cửa sổ Watch 1 hiện ra.                            

Chọn một hàng để chỉnh sửa. Nhập "T0" 

trong cột Device Label. 
 

 

 

 
 

3)  Biến đầu vào hoặc nhãn được đăng kí. 
 

 
 
 

 
 

 
 

4) Click [Online] → [Watch] → [Start Watching]. 
 

 

Giá trị hiện tại của biến đăng kí hoặc nhãn 

được hiện ra trên cửa sổ. 
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6.7 Làm thế nào để tạo chú thích 

 

Tên dự án QEX15 

Tên chương trình MAIN 

 

Dưới đây là ví dụ của việc in ra ladder với chú thích. 
 

 
 

Sử dụng bàn phím để nhập chương trình trên hoặc đọc nó từ một thư mục trên màn hình máy 
tính. 



6 - 17 

 

 

(1) Biểu đồ hoạt động khi tạo chú thích 

 

Đặt phạm vi biến ở khoảng chú thích được đính vào* 
 

 

 

 
Click đúp vào tệp comment ở vùng làm việc. 

 

 

 

 

 

Tạo chú thích. 

 

Khi đính chú thích vào biến khác 
 

Lưu dự án. 
 

 

 

 

 

Đọc và xác nhận ladder với chú thích 

 

*: Quy trình này cần thiết cho việc xác định phạm vi ghi chú thiết bị. 

 
 

 

Gợi ý  

Chú thích được sử dụng để hiển thị chức năng hoặc ứng dụng của mỗi biến 

Cho phép lên đên 32 kí tự 
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1) Double-click! 

2) Enter chú thích! 

3) Enter "Y70"! 

5) Enter chú thích! 

Enter 

(2) Tạo chú thích 

 

1) Click đúp vào "Global Device Comment" 

trong danh sách dự án. Màn hình Device 

Comment hiện ra. 

 

 
 
 

 

 

2) Click vào vùng chú thích và nhập một chú 

thích như bên trái. 
 

 

 
 
 

 
 
 

 
 

 

3) Nhập "Y70" vào danh sách "Device Name" . 

 

4) Nhấn nút . 

 

5) Click vào vùng chú thích và nhập một chú 

thích như bên trái. 

 

 
 
 

 

 

(Đến trang sau) 
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6) Enter "M1"! 

8) Enter comments! 

9) Enter "T0"! 

11) Enter comments! 

12) Enter "C2"! 

14) Enter comments! 

Enter 

Enter 

Enter 

(Từ trang trước) 
  

 
 

6) Nhập "M1” vào dánh sách "Device Name". 

 

7) Nhấn nút . 

 

8) Click vào vùng chú thích và nhập một chú 

thích như bên trái. 

 

 
 
 

 

 

9) Enter "T0" in the "Device Name" list box. 

 

10) Nhấn nút . 

 

11) Click vào vùng chú thích và nhập một chú 

thích như bên trái. 

 
 
 

 
 

 

12) Nhập "C2" vào danh sách "Device name". 

 

13) Nhấn nút . 

 

14) Click vào vùng chú thích và nhập một chú 

thích như bên trái. 
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1) Click! 

2) Click! 

Save 

(3) Lưu chú thích 

 

1) Click [Project] → [Save As]. 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

2) Hộp thoại Save As hiện ra. Xác định   

(hoặc chọn) một tên vùng làm việc và 

click nút . 
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1) Click! 

(4) Hiển thị một ladder với chú thích trên màn hình GX Works2 

1) Click [View] → [Comment]. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

2) Chú thích được hiển thị trên màn hình ladder. 
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Gợi ý  

Cùng với ghi chú thiết bị, thông báo và ghi nhớ có thể tạo trên màn hình ladder. 

• Thông báo  : Chú thích để diễn giải chức năng hoặc ứng dụng cho khối ladder. Có thể lên 

đến 64 kí tự. 

• Ghi nhớ : Chú thích để diễn giải chức năng hoặc ứng dụng cho đầu ra và lệnh. Cho phép lên 

đến 32. 

Thông báo 
 

 

Ghi nhớ 
 

 

 

 

 

 

 

 

 

 

 

 

 

• Tạo thông báo 

Click   và click đúp vào một biểu tượng nơi một chú thích được đính vào. 

Hộp thoại Enter Line Statements hiện ra. Nhập vào một chú thích sau đó click nút OK . 
 

 
 

• Tạo ghi nhớ 

Click   và click đúp vào một biểu tượng nơi một chú thích được đính vào.  

Hộp thoại Enter Symbol hiện ra. Nhập vào một chú thích sau đó click nút OK . 
 

 
 

• Chọn "In PLC" hoặc "In Peripheral" cho thông báo và ghi nhớ. 

"In PLC" : Dữ liệu của thông báo và ghi nhớ được lưu như một phần của chương trình. Nó 

cho phép dữ liệu được lưu trong CPU ở nhà máy. Tuy nhiên, cần rất nhiều dung 

lượng bộ nhớ chương trình của khối điều khiển khả trình. 

"In Peripheral" : Dữ liệu của thông báo và ghi nhớ được lưu trong thiết bị ngoại vị (máy tính cá 

nhân) tách biệt từ chương trình. Vì mổt chương trình cần một bước bổ sung với mỗi 

địa điểm, cần ít dung lượng bộ nh chương trình trên khối điều khiển khả trình CPU. 

Tuy nhiên, khi chương trình được chỉnh sửa ở nhà máy, chương trình trên GX 

Works2 trong thiết bị ngoại vị (máy tính cá nhân) và chương trình trong khối điều 

khiển khả trình không giống nhau. Cẩn thận khi làm việc dữ liệu này. 
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Access level Operating authority 

Higher 
 

 
 
 

 
 
 

 
 
 

 
Lower 

Administrators 
<Administrator level> 

All operations are possible. 

Developers (Level 3)  

<Developer level> 

Security setting, data access, and a part of operations are restricted. 
Developers (Level 2) 

Developers (Level 1) 

 

 

Users 

<Operator level> 

Only access to project data is possible. 

Data cannot be read from the programmable controller CPU. 

 

6.8 Cài đặt bảo mật cho dự án 

 
Phần này diễn giải làm thế nào để đặt bảo mật cho dự án để bảo vệ dự án và 

những dữ liệu trong dự án. 

Đặt bảo mật hạn chế truy nhập cho dự án. 

Thêm nữa, cài đặt bảo mật cấm những dữ liệu như POUs, ghi chú thiết bị, và tham 

số, được tạo ra bởi người dùng, từ sự chỉnh sửa hoặc tiết lộ lỗi cho những người 

dùng không có thẩm quyển. 

 

Gợi ý  

 

Cấp truy nhập và có quyền truy nhập 

Đặt cấp truy nhập cho mỗi người dùng để hạn chế truy nhập vào từng dữ liệu. 

Cấp truy nhập là một hoạt động trao quyền cho mỗi người dùng xem dự án. 

Năm cấp dưới đây khả dụng cho mỗi câp truy nhập. Dữ liệu có thể được chỉnh sửa 

bởi một người dùng có quyền truy nhập thấp thì cũng sẽ có thể được chỉnh sửa bởi 

người dùng có mức truy nhập vao hơn. 
 
 

 

 
 

 

 

<Ví dụ> 

Dữ liệu với quyền truy cập của người phát triển (cấp 2) có thể được chỉnh sửa bởi 

người dùng với nhà phát triển (cấp 2) hoặc cao hơn (Administrators, nhà phát triển 

(cấp 3), hoặc nhà phát triển (cấp 2)). 

Cao 

Thấp 

<Cấp Administrator> 
Tất cả hoạt động đều được 

<Cấp người phát triền> 
Cài đặt bảo mật, truy nhập dữ liệu và một phần hoạt động bị giới hạn 

<Cấp điều hành> 
Chỉ truy nhập được vào dữ liệu dự án 
Dữ liệu không được đọc từ CPU điều khiển  khả trình 
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1) Click! 

2) Enter items! 

3) Click! OK 

6.8.1 Cài đặt và đặt lại bảo mật cho dự án 

 
Phần này diễn giải làm thế nào để đặt bảo mật cho một dự án mở và làm thế nào để 

đặt lại bảo mật. 

 
(1) Đặt bảo mật cho dư án     

Đặt bảo mật cho một dự án. 

Khi bảo mật được đặt cho dự án, cần có quyền người dùng khi dự án được mở 

lại . 

 

1) Click [Project] → [Security] → [User 

Management]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

2) Hộp thoại Use Addition hiện ra. Nhập 

những thứ dưới đây. 

 
User Name : MITSUBISHI 

Mật khẩu : MITSUBISHI 

Re-enter Mật khẩu : MITSUBISHI 

 
* Khi người dùng hoặc mật khẩu đăng nhập bị 

mất, đăng nhập vào dự án là không thể. 

Không đưc nhập tên người dùng hoặc mật 

khẩu khác những cái trên. 

 

3) Sau khi nhập chúng,click nút . 

 

Bảo mật được đặt cho dự án. 
 

 

(2) Đặt lại bảo mật cho dự án 

Xóa tất cả người dùng đặt lại bảo mật của một dự án và quay trở lại dự án mà 

không cần bảo mật (xem lại phần 6.8.2.) 
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1) Click! 

6.8.2 Quản lí  (thêm, xóa, và thay đổi) người dùng 

 
Phần này diễn giải làm thế nào để quản lí trạng thái đã được đăng kí của người dùng 

cho một dự án với bảo mật và làm thế nào để thêm, xóa và thay đôi người dùng. 

Chức năng này chỉ khả dụng khi người dùng đăng nhập vào một dự án với quyền truy 

nhập "Administrators" hoặc "Developers". 

 
[Hiển thị màn hình User Management ] 

 

1) Click [Project] → [Security] → [User 

Management]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

2) Hộp thoại User Management hiện 

ra. 

 
Phương pháp cho thêm người dùng, thay đổi 

thông tin người dùng, thay đổi mật khẩu, và 

xóa người dùng được diễn giải ở trang sau. 

. 
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1) Click! 

2) Enter items! 

3) Click! 

Add... 

OK 

[Thêm người dùng] 

Thêm một người dùng vào một dự án với bảo mật. 

Một người dùng có quyền truy nhập cao hơn người dùng đang truy nhập không thể thêm vào. 

 

1) Click nút Trên màn hình User 

Management. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

2) Hộp thoại User Addition hiện ra. Nhập 

vào thông tin dưới đây. 

 
User Name : Developers 

Access Level : Developers(Level3) 

Mật khẩu : Developers 

Re-enter Mật khẩu : Developers 

 

3) Sau khi nhập chúng,click nút . 
 

 

 
 
 

 
 

4) Người dùng (Developers(Level3)) được 
thêm. 
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1) Select! 

2) Click! 

3) Select! 

4) Click! 

Change 

OK 

[Thay đổi thông tin người dùng] 

Thay đổi cấp truy nhập của người dùng được thêm vào từ trang trước 

"Developers(Level3)" vào "Users". 

Thông tin của người dùng đăng nhập và của một người dùng có quyền truy nhập 

cao hơn người dùng đăng nhập là không thể thay đổi. 

 

1) Chọn tên người dùng "Developers". 

 

2) Click nút       . 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

3) Hộp thoại Change User Data hiện ra. 

Chọn "Users" từ danh sách "Access 

Level". 

 

4) Sau khi chọn nó, click nút . 
 
 
 

 
 
 

 
 

 

5) Cấp truy nhập của người dùng 

"Developers" bị thay đổi. 
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1) Select! 

2) Click! 

3) Enter mật khẩu! 

4) Click! 

Password Setup 

OK 

[Đổi mật khẩu] 

Thay đổi mật khẩu của một người dùng chọn trong danh sách trên màn hình User 

Management Mật khẩu của người dùng đăng nhập và của một người dùng có cấp 

truy nhập cao hơn người dùng đăng nhập là không thể thay đổi. 

Để thay đổi mật khẩu của người dùng đăng nhập, click [Project] → [Security] → 

[Change Password]. 

 

1) Chọn tên người dùng "Developers". 

 

2) Click nút . 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

3) Hộp thoại Change Password hiện 

ra. Nhập những thông tin dưới đây. 

 
New Password : Users1 

Re-enter Password : Users1 

 

4) Sau khi nhập chúng,click nút . 

 

Mật khẩu của người dùng "Developers" bị 

thay đổi. 
 

 
 

[Xóa người dùng] 

Xóa một người dùng được chọn trong danh sách với nút     trên hộp thoại 

User Management. 

Người dùng đăng nhập hiện tại không thể xóa. 

Tuy nhiên, khi người dùng đăng kí chỉ là "Administrators" và không có người dùng 

khác chuẩn bị xóa còn tồn tại, người dùng đăng nhập hiện tại có thể bị xóa. 

Khi tất cả người dùng bị xóa, bảo mật được đặt lại. 
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1) Enter items! 

1) Click! 

OK 

6.8.3 Đăng nhập vào dự án 

 
Xác thực người dùng là cần thiết cho mở một dự án với bảo mật. 

 

1) Khi một dự án với bảo mật được mở, màn 

hình User Authentication hiện ra.               

Nhập người dùng và mật khẩu đăng nhập , 

và click nút . 

 

Nhập người dùng và mật khẩu dưới đây, 

được đặt trong phần 6.8.1. 

 
User Name : MITSUBISHI 

Password : MITSUBISHI 

 
2) Dự án hiện ra. 
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1) Click! 

4) Set! 

3) Select! 

5) Click! 

OK 

6.8.4 Thay đổi xác thực truy nhập cho mỗi cấp truy nhập 

 
Phần này diễn giải làm thế nào để đặt một xác thực cho việc hiển thị và lưu dữ liệu 

cho mỗi cấp truy nhâp. 

Xác thực truy nhập của cấp cao hơn cấp của người dùng đăng nhập là không thể 

thay đổi. 

Khi cấp truy nhập của người dùng đăng nhập hiện tại là “Users”, xác thực truy nhập 

không thể thay đổi. 

 

1) Click [Project] → [Security] → [Data Security 

Setting]. 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

2) Hộp thoại Data Security Setting hiện 

ra. 

 
3) Chọn mục tiêu từ Access Object. 

 

 

4) Đặt "Enable" hoặc "Disable" để đọc và viêt 

từ Access Authority cho mỗi cấp truy nhập 

bằng cách di chuyển con trượt. 

 

5) Click nút . 
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1) Click! 

2) Change! 

3) Click! 

End 

6.9 Chức năng lấy mẫu truy dấu 

 
Chức năng này được sử dụng để lấy dữ liệu ở một thời điểm nhất định để tìm xem 

giá trị biến thay đổi như thế náo trong suốt quá trình chương trình hoạt động và truy 

dấu sự thay đổi hiện ra theo thời gian. Chi tiết của chức năng lấy mẫu truy dấu, xem 

lại hướng dẫn của mỗi mudule CPU.  

 
Trong ví dụ này, giá trị biến tại điểm lỗi xãy ra được lấy. 

 

Tên dự án TRACE 

Tên chương trình MAIN 

 

 
 

Để chuẩn bị, làm theo hướng dẫn dưới đây. 

 

1) Click thanh "PLC RAS trên hộp thoại Q 

Parameter Setting. 

 
2) Chọn "Continue" từ danh sách 

Computation Error trong Operating Mode 

When There is an Error area. 

 

3) Click nút . 

 

4) Viết tham số và chương trình lên CPU. 



6 - 32 

 

 

1) Click! 

3) Click! 

(1) Cài đặt lẫy mẫu truy dấu 

 

1) Click [Debug] → [Sampling Trace] → 

[Open Sampling Trace]. 
 

 
 

 
 
 

 
 
 

 

2) Màn hình Sampling Trace hiện ra. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

3) Click [Debug] → [Sampling Trace] → 

[Trace Setting]. 
 

 
 
 

 
 
 

 

 

(Đến trang sau) 
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5) Click! 

4) Select! 

6) Check! 

6) Click! 

Setting Change 

(Từ trang trước) 
 

 
 

4) Hộp thoại Trace Setting hiện ra. Chọn 

"Standard RAM" từ danh sách "Target 

Memory". 

 
5) Click vào thanh Condition Setting. 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

6) Kiểm tra "Detail Setting" ở trong vùng 

Trigger Condition Settin và click the 

. 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

(Đến trang sau) 
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7) Enter item and set! 

8) Click! 

11) Check! 

End Setting 

End Setting 

    (Từ trang trước) 
 

 
 

7) Hộp thoại Detail Setting - Trigger Condition 

hiện ra. Cài đặt những phần dưới đây 

Trong ví dụ này, đặt xuất hiện lỗi là điều 

kiện bắt đầu. 

 
Device/Label : SM0 

Condition : -P- 

 

8) Click nút . 

 

9) Hộp thoại Detail Setting - Trigger Condition 

biến mất. Click vào nút 

để đóng hộp thoại Trace Setting. 
 

 
 

10) Đặt biến để truy dấu trên màn hình 

Sampling Trace như bên trái. 

 
11) Kiểm tra hộp thoại hiện ra đồ thị xu 

hướng của SD0. 

 

 
 
 

 
 
 

 

 

12) "SD0” hiện ra trên vùng đồ thị xu hướng trên màn hình Sampling Trace. 
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1) Click! 

Yes 

(2) Bắt đầu lấy mẫu truy dấu 

 

1) Click [Debug] → [Sampling Trace] → [Start 

Trace]. 
 

 
 

 
 
 

 
 

2) Tin nhắn xuất hiện ở bên trái hiện ra . 

Click nút . 
 

 
 
 

 
 
 

3) Màn hình Trace Data Storage Status hiện ra 

khi lấy mẫu truy dấu bắt đầu. 

 
Sau khi xác nhận tổng dữ liệu lên đến 

100%, thao tác công tắc số để tạo ra lỗi. 

 

 

4) Kết quả truy dấu được hiện lên trên màn 

hình Sampling Trace. 
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(3) Kiểm tra kết quả truy dấu  

 

 

1) Kéo xuống màn hình đồ thị xu hướng đến 

điểm bắt đầu để kiểm tra giá trị biến tại 

điểm xảy ra lỗi. 

 
 
 

 
 
 

 
 

 

 
 
 

 
 

 

Gợi ý  

Lưu dữ liệu truy dấu đến một máy tính cá nhân 

Click [Debug] → [Sampling Trace] → [Export CSV Data]. Hộp thoại dưới đây hiện ra. 
 

 

Sau khi nhập tên tệp, click vào nút Save . 
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CHƯƠNG 7 CHƯƠNG TRÌNH MODULE CHỨC NĂNG THÔNG MINH  
 

7.1 Module chức năng thông minh 

 
(1) Module chức năng thông minh có dạng: 

Trên bộ điều khiển lập trình CPU (sau này được gọi tắt là QCPU), một vài chức 

năng không được hỗ trợ hoặc bị giới hạn trong quá trình sử dụng. Module chức 

năng thông minh hỗ trợ những chức năng này thay cho QCPU. 

Do đó người sử dụng cần phải chọn một module chức năng thông minh để đáp 

ứng được các mục đích sử dụng. 

QCPU phù hợp với module QCPU có chức năng thông minh. Bảng dưới đây sẽ 

đưa ra những ví dụ những module chức năng thông minh. 

 
Bảng 7.1 Ví dụ về module chức năng thông minh 

 

Tên module 
Số lượng điểm I/O 

có thể quản lý 

 

Chức năng 
Điện áp và dòng 

điện tiêu thụ  

 

 

 

Module chuyển đổi 

tương tự sang số 

(Q64AD) 

 

 

 
16 điểm 

Module chuyển đổi ở đầu vào;  

0 đến 20mA → 0 đến 4000 

(Ở chế độ phân giải tiêu chuẩn)  

0 đến ±10V → 0 đến ±4000 

(Ở chế độ phân giải tiêu chuẩn)  

 

 

5VDC 
 

 

0.63A 

 

 

 
Module chuyển đổi số 

sang tương tự 

(Q62DAN) 

 

 

 

 

16 điểm 

 

Module chuyển đổi ở đầu ra;  

0 đến 4000 → 0 đến 20mA 

(Ở chế độ phân giải tiêu chuẩn)  

0 đến ±4000 → 0 đến ±10V 

(Ở chế độ phân giải tiêu chuẩn)  

5VDC 
 

 

0.33A 

24VDC 
 

 

0.12A 

 

(2) Cách sử dụng module chức năng thông minh với các CPU 

Với một module chức năng thông minh có thể được cài đặt trên bất kỳ khe I/O nào 
trên  một đế cắm và phần mở rộng của nó. 

 
Hình 7.1. Lắp đặt module chức năng thông minh

Số khe I/O 3  4 

0  1  2 

 
 
 

 
Module chức năng thông minh 

Nguồn QCPU 
[Số đã được sử dụng] 

hỗ trọ 16 điểm với  X/Y80 với 8F, 
16 điểm với X/Y90 với 9F 

16 điểm với  X/Y80 với 8F, 
16 điểm với X/Y90 với 9F 
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(Bộ điều khiển lập trình CPU) 

X/Y 

 
   CPU 
Chức năng  

Đầu vào X 

Đầu ra Y (Dữ liệu 
bit) 

Bộ nhớ đệm Đọc dữ liệu 

Ghi dữ liệu (Dữ liệu ký 

tự) 

QCPU Cấu hình bên trong của module chức năng thông minh 

C
h
ư

ơ
n
g
 t
rì

n
h
  

T
h
iế

t 
b
ị 
n
h
ớ

, 
v
í 
d
ụ
 X

, 
Y

, 

M
, 
T

, 
C

, 
D

 I/
F

 b
ê
n
 

n
g
o

à
i 

7.2 Giao tiếp dữ liệu giữa module chức năng thông minh và CPU 

 
Một module chức năng thông minh và CPU sẽ trao đổi hai dạng dữ liệu chính 

Dữ liệu bit: Tín hiệu được sử dụng có đầu vào là X và đầu ra là Y 

Dữ liệu ký tự: 16 bit hoặc 32 bit dữ liệu 
 
 

 
 
 

 
 
 

 

 
 

 
 
 

 
 
 

 

Hình 7.2 Cấu hình bên trong của module chức năng thông minh
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Module 
 thông minh QCPU 

X 

X 

X 

X 

Tín hiệu sẵn sàng 

Thiết lập hoàn tất điều 
kiện hoạt động 

Hoàn tất chuyển đổi A/D 

Lỗi 

Hình 7.3 

Module chức 
năng thông 

minh 
QCPU 

Y 

Y 

Y 

Y 

Cho phép đầu 
ra 

Phạm vi ghi 

Thay đổi kênh 
đồng bộ đầu ra 

7.2.1 Các tín hiệu I/O đến CPU 

 
Với 1 bít tín hiệu được chuyển đổi giữa QCPU và module chức năng thông minh sử 

dụng đầu vào là X và đầu ra là Y.  

X và Y không mang ý nghĩa giống như bên trong các I/O nhưng các ký hiệu ở đây 

có thể sử dụng chương trình tuần tự để đại diện một cách độc quyền cho các tín 

hiệu I/O của module chức năng thông minh. Lưu ý rằng, số I/O được ấn định theo vị 

trí của khe mà module chức năng thông minh được lắp đặt. 

[X] 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

Tín hiệu X của module chức năng 
thông minh 

 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

[Y] 
 

 
 

 
 
 

 
 
 

 
 
 

 

Hình 7.4 Tín hiệu Y của CPU 

 

 
 

X trong chương trình tuần tự đại diện cho 

các tín hiệu này được chuyển đến QCPU từ 

module chức năng thông minh. Những tín 

hiệu này được tạo ra trên module chức 

năng thông minh. Chú ý, X được sử dụng 

như một cách để liên lạc với chương trình 

này. Một số tín hiệu được ví dụ cụ thể dưới 

đây: 

(1) Tín hiệu READY 

Tín hiệu này thông báo tới QCPU 

rằng một module chức năng thông 

minh có thể khởi động bình thường 

bật nguồn và sẵn sàng hoạt động.  

(2) Thiết lập điều kiện hoạt động đã hoàn 

tất 

Đây là tín hiệu được sử dụng như là 

điều kiện khóa liên động để chuyển đổi 

thiết lập điều kiện hoạt động theo yêu 

cầu (Y9) mở/tắt khi chế độ cài đặt được 

thay đổi 

• Thiết lập chuyển đổi A/D hoạt 

động/không hoạt động (địa chỉ bộ 

nhớ đệm 0: Un/G0) 

• CH thời gian trung bình/số lần trung 

bình (địa chỉ bộ nhớ đệm 1 đến 8: 

Un\G1 đến Un\G8) 

• Thiết lập quá trình trung bình  

(địa chỉ bộ nhớ đệm 9: Un\G0) 

 
SET, RST, hoặc OUT-Y yêu cầu tín hiệu ra 

xuất phát từ một QCPU đến module chức 

năng thông minh. Những tín hiệu này được 

tạo ra trên một QCPU. Chú ý rằng, chúng 

được sử dụng như những sợi dây hoặc 

dùng để liên lạc trong các chương trình,  
(Ví dụ) Đầu ra của module bộ chuyên đổi D/A 

đưa ra một hướng dẫn cho biết giá trị 

tương tự đã được chuyển đổi sang giá 

trị số. 
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Module chức năng thông minh Địa chỉ bộ nhớ đệm 0 

1 

2 

3 

Đọc và ghi bởi 
CPU 

10 

11 

12 

Ví dụ về thành phần của bộ nhớ: Module chuyển đổi D/A 

Q62DAN  

B15 B14 B13 B12 B11 B10 B9  B8  B7  B6  B5  B4  B3  B2  B1  B0 

Data part 

Bit tín hiệu 

1: Âm 
0: Dương 

Cho biết ở đây là +276. 
(Giá trị số âm được biểu diễn trong hai 
lần bổ sung.) 

7.2.2 Giao tiếp dữ liệu trong module chức năng thông minh 

 
Dữ liệu được phát hoặc thu với 16 bit hoặc 32 bit. Những module chức năng thông 

minh có đều có một bộ nhớ đệm để lưu trữ những dữ liệu này  

 

 

 

 

 
 

 

Hình 7.5 Bộ nhớ đệm 
 

 

(1) QCPU có thể đọc và ghi dữ liệu từ bộ nhớ đệm. Chú ý rằng, một vài module có 

thể ghi dữ liệu bộ nhớ đệm từ thiết bị ngoại vi thông qua một giao diện.  

(2) Trong bộ nhớ đệm, khoảng trống của một ký tự (16bit) được dự trữ cho mỗi địa 

chỉ của module chức năng thông minh duy nhất.   

Địa chỉ nhó nhất là 0, và những địa chỉ này được sử dụng riêng mới một 

module đích để đọc hoặc ghi. Đơn vị nhỏ nhất là một ký tự. Dữ liệu từ 17 bit 

đến 32 bit tương đương như 2 (32 bit) ký tự dữ liệu  

 

 

0     0 0 1 0 0 0 1 0 1 0 0 

 

  
 

 
 

 

Hình 7.6 Hình ảnh ví dụ của bộ nhớ đệm (module chuyển đổi D/A) 
 

 

Hình 7.6 cho thấy 16 bit bộ nhớ đệm của một module chuyển đổi D/A, nơi mà 

giá trị số được ghi ra. Con số này thu được từ số lượng giá trị số của một 

QCPU ghi vào bộ nhớ đệm trong khoảng -4096 đến +4095 trong hệ nhị phân 

(dài 16 bit) 
 

 

(3) Bộ nhớ đệm là RAM. 

Chuyển đổi D/A hoạt động/không hoạt 
động 
CH1 Giá trị số 

CH2 Giá trị số 

 

Khu vực hệ thống (cấm sử dụng) 

CH1 Đặt giá trị mã kiểm tra 

 CH2 Đặt giá trị mã kiểm tra  

 

to 

QCPU 

Dữ liệu đọc  Dữ 

liệu 
Bộ nhớ 
đệm 

Dữ liệu ghi 
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7.3 Giao tiếp trong module chức năng thông minh 

 
7.3.1 Phương thức giao tiếp trong module chức năng thông minh  

 
Bảng dưới đây cho biết các phương thức liên lạc giữa QCPU với một module chức 

năng thông minh. 

 
Bảng 7.2 Phương thức giao tiếp dữ liệu chức năng thông minh 

 

Phương thức 
liên lạc 

 

Chức năng 
Phương thức  

thiết lập 

Thiết lập ban 

đầu, Tự động 

làm mới thiết lập  

Thực hiện các cài đặt ban đầu và tự động làm mới thiết lập của các module chức năng 

thông minh. Những cài đặt này cho phép ghi/đọc dữ liệu từ những module chức năng 

thông minh không phân biệt các chương trình truyền thông thông minh hoặc địa chỉ bộ 

nhớ đệm. 
 

 

Ví dụ: Q64AD được sử dụng trong module chuyển đổi A/D. 

• Cài đặt ban đầu: : • Thiết lập kích hoạt chuyển đổi A/D: hoạt động/không       

hoạt động 

• Xử lý đặc điểm kỹ thuật lấy mẫu/trung bình. 

• Trung bình thời gian /số lần cấu hình trung bình 

• Thời gian trung bình/số lần cấu hình trung bình (Dữ 

liệu tự động làm mới thiết lập được lưu trữ trong các 

tham số của module chức năng thông minh trên một 

QCPU) 

• Làm mới thiết lập tự động : Một biến trên QCPU lưu trữ những dữ liệu sau: 

• Đầu ra số từ Q64AD 

• Giá trị lớn nhất và nhỏ nhất của Q64AD 

• Mã lỗi 

(Đặt dữ liệu tự động làm mới thiết lập được lưu trữ trong 

tham số của module chức năng thông minh trên một 

QCPU) 

 

 

 

 

 

 

 

 

 

 

 

 
Sử dụng GX 
Works2. 

Biến địa chỉ giá 

trị ban đầu 

Việc ghi dữ liệu trong cài đặt ban đầu của biến địa chỉ trên module chức năng thông 

minh đến module chức năng thông minh ở những thời điểm sau: 

• Tại thời điểm bật nguồn của một QCPU  

• Tại thời điểm reset 

• Tại thời điểm chuyển từ chế độ STOP sang RUN 

Sử dụng  GX 

Works2 để xác 

định phạm vi của 

các thiết bị module 

chức năng thông 

minh (U\G). 

Chỉ dẫn FROM/TO 

 

 

 

Đọc hoặc ghi dữ liệu đi hoặc đến bộ nhớ đệm trên module chức năng thông minh 

Sử dụng chỉ dẫn 
này trong một 
chương trình tuần 
tự. 

Biến địa chỉ 

module chức 

năng thông minh 

(U\G) 

Trực tiếp xử lý bộ nhớ đêm trên một module chức năng thông minh như một Biến địa 

chỉ của QCPU 

Không giống như chỉ dẫn FROM/TO, yêu cầu này chỉ là một chỉ dẫn củaa quá trình xử lý 
dữ liệu được đọc từ module chức năng thông minh 

Chỉ định biến địa chỉ 
này như một biến 
trong chương trình 
tuần tự 

Lệnh chuyên dụng 
của module chức 
năng thông minh 

 

 

Được sử dụng để đơn giản hóa các chương trình của module chức năng thông minh để 
dễ tiếp cận với người sử dụng.  

 

Sử dụng chỉ dẫn 

này trong một 

chương trình tuần 

tự. 
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F

 

X
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8
0
 t
o
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F
 

X
/Y

9
0
 to

 X
/Y

9
F
 

Module chuyển đổi D/A  

Module chuyển đổi A/D 

7.4 Hệ thống module chức năng thông minh trong thiết bị DEMO 

 
Sử dụng module chuyển đổi A/D hoặc D/A để chuyển đổi từ tín hiệu tương tự sang tín 

hiệu số, được nhập với âm lượng hoặc chuyển đổi số trên bộ DEMO. 
 

 
 

 
 
 

 

 

Q61P 

 

 

QCPU 

 

 

 

QX QY Q64 Q62 

42 42P AD DAN 
Khe 
trống 

(64 (64 (16 (16 
điểm) điểm) điểm) điểm) 

(Kênh 1) 

V 

(Kênh1) V 

 

Vôn kế đo điện áp vào  Vôn kế đo điện áp ra      
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1  
2  
3  
4  
5  
6  
7  
8  
9  

10  
11  
12  
13  
14  
15  
16  
17  
18  
 

7.5 Module chuyển đổi Q64AD Tương tự/Số 

 
7.5.1 Tên các bộ phận  

 
Dưới đây sẽ giải thích về các bộ phận của 

Q64AD. Chi tiết về Q64AD, hãy xem qua 

hướng dẫn sử dụng. 

Q64AD 
 

 

Q64AD 

1) 

2) 

 

 

 

RUN 

ERROR 

 

 
 

V+ 

 

C    V- 
H 

1 
I+ 

SLD 

V+ 

 

C    V- 
H 

2 
I+ 

 

SLD 

V+ 

 

C    V- 
H 

3 
I+ 

 

SLD 

 

V+ 

 

C    V- 
H 

4 
I+ 

 

SLD 

A.G. 

(FG) 

A/D 
0-±10V 
0-20mA 

 

 
 

 

TT Tên và hình dạng 
 

Mô tả 

 

 

 

1) 

 

 

 

  RUN LED 

Cho biết tình trạng hoạt động của các module chuyển đổi A/D 

Bật :  Hoạt động bình thường 

Nhấp nháy    :  Chế độ cài đặt Ngưỡng/Độ lợi 

Tắt :  Mất nguồn điện hoặc thiết bị giám sát lỗi hẹn giờ 

 

 

 

 

2) 

 

 

 

 

ERROR LED  

Cho biết lỗi và tình trạng hiện tại của module chuyển đổi A/D 

Bật        :  Đã xuất hiện lỗi 

Tắt        :  Hoạt động bình thường 

Nhấp nháy   :  Hệ thống chuyển đổi có lỗi 

Các giá trị khác 0 được thiết lập để chuyển đổi 

thành 5 trên module chức năng thông minh. 
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4000 
2004 

2003 

2002 

2001 0 

2000 

2.5mV 

-4000 
-10V 0 

Điên áp đầu vào (tương 

tự) 

10V 
Điện áp vào  

5  A 

4000 

2005 
2004 
2003 
2002 
2001 
2000 0 

-4000 
-20mA 

Dòng điện vào 
0 

Dòng điện (tương 
tự) 

20mA 

G
iá

 t
rị
 s

ố
 ở

 đ
ầ
u
 r

a
 

G
iá

 t
rị
 s

ố
 ở

 đ
ầ
u
 r

a
  

G
iá

 t
rị
 s

ố
 ở

 đ
ầ
u
 

ra
 

G
iá

 t
rị
 s

ố
 ở

 đ
ầ
u
 r

a
 

1
0
.0

0
0
m

A
 

1
0
.0

0
5
m

A
 

5
.0

0
0
0
V

 

5
.0

0
2
5
V

 

7.5.2 Đặc điểm của chuyển đổi A/D 

 
(1) Đặc điểm của điện áp đầu vào 

(Trong chế độ phân giản tiêu chuẩn, tín hiệu tương tự có điện áp vào khoảng -10 đến 10V) 
 

 
 

 
 

 

 
 

 

 

Hình 7.12  Đặc điểm của chuyển đổi A/D (Điện áp vào) 
 

 

Module chuyển đổi A/D chuyển đổi các giá trị tương tự được nhập từ 

những thiết bị khác sang các giá trị số, vì vậy các CPU có thể xử lý những 

giá trị này. Trên điện áp đầu vào, ví dụ, module chuyển đổi A/D chuyển đổi 

từ -10V sang -4000 và từ 10V sang 4000. Điều này có nghĩa các module 

chuyển đổi từ điện áp vào là 2.5mV sang giá trị số là 1, và loại bỏ các giá 

trị nhỏ hơn 2.5mV. 

 
(2) Đặc điểm dòng điện đầu vào của bộ chuyển đổi A/D  

(Ở độ phân giải tiêu chuẩn, tín hiệu analog có dòng điện vào khoảng 0 
đến 20mA) 

 

 

 
 
 

 
 
 

 
 
 

 
 
 

 

 

 
 

Hình 7.13 Đặc điểm của chuyển đổi A/D (Dòng điện vào) 
 

Các module chuyển đổi dòng điện 0mA ở đầu vào chuyển thành 0 ở đầu ra và 

20mA đến 4000. Điều này có nghĩa là các module này chuyển đổi một cường độ 

5 μA sang giá trị số là 1, và loại bỏ các giá trị nhỏ hơn 5μA. 

 

LƯU Ý  

Giá trị điện áp và dòng điện tương đương với giá trị số là 1 do chuyển đổi A/D 

(ở độ phân giải tối đa) khác nhau tùy thuộc vào các thiết lập của chế độ phân 

giải (1/4000, 1/12000, 1/16000) hoặc sự quy định khoảng đầu ra. 
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7.5.3 Danh sách các tín hiệu I/O và phân vùng bộ nhớ đệm  

 
(1) Danh sách các tín hiệu I/O 

Bảng dưới đây cho thấy một danh sách các tín hiệu I/O cho các module chuyển 
đổi A/D. Chú ý rằng số lượng I/O (X/Y) xuất hiện trong phần này và về sau là 
những giá trị khởi đầu số I/O cho module chuyển đổi A/D được đặt là 0. 

 

Hướng tín hiệu: CPU ← module chuyển đổi A/D Hướng tín hiệu: CPU → module chuyển đổi A/D 

Thứ tự biến (vào) Tên tín hiệu Thứ tự biến (ra) Tên tín hiệu 

X0 Module đã sẵn sàng Y0  

 
 
 
 

Cấm sử dụng
*1

 

X1 Cờ bù nhiệt độ bị hao hụt  Y1 

X2  
 

 

Cấm sử dụng
*1

 

Y2 

X3 Y3 

X4 Y4 

X5 Y5 

X6 Y6 

X7 Y7 

X8 Cờ đánh dấu ở chế độ phân giải cao Y8 

 

X9 
Cờ đánh dấu thiết lập hoàn tất điều 
kiện hoạt động 

 

Y9 
Yêu cầu điều kiện hoạt động 

XA Cờ đánh dầu chế độ thiết lập 
ngưỡng/độ lợi 

YA Yêu cầu phạm vi sử dụng  

XB Cờ đánh dấu thay đổi kênh hoàn tất YB Yêu cầu thay đổi kênh 

XC Cấm sử dụng
*1

 YC Cấm sử dụng
*1

 

 

XD 
Cờ hoàn tất làm mới giá trị lớn 
nhất/nhỏ nhất 

 

YD 
Yêu cầu làm mới giá trị lớn 
nhất/nhỏ nhất 

XE Cờ hoàn tất chuyển đổi A/D YE Cấm sử dụng
*1

 

XF Cờ báo lỗi YF Yêu cầu xóa sạch lỗi 

 

Chú thích  

*1: Những tín hiệu không cho phép hoạt động bởi chúng chỉ được hoạt động 

dưới sự cho phép của hệ thống. Nếu chúng được bật/tắt bởi chương trình tuần 

tự sẽ dẫn đến hoạt động của module chuyển đổi A/D không được đảm bảo. 
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(2) Phân vùng bộ nhớ đệm (Q64AD) 

Trong mục này sẽ giải thích sự phân vùng bộ nhớ đệm của Q64AD 
 

Chú ý  

Không ghi dữ liệu vào vùng hệ thống hoặc vô hiệu hóa vùng ghi dữ liệu từ 

các chương trình tuần tự. Làm như vậy có thể gây ra sự cố.  

 

Phân vùng bộ nhớ đệm (Q64AD) (1/2) 
 

Địa chỉ  
Mô tả 

 
Giá trị mặc 

định 

Read/write 
*1

 
 Hệ 16 Hệ 10 

0H 0 Thiết lập chuyển đổi A/D hoạt động/không hoạt 
động 

0 R/W 

1H 1 CH1 Thời gian trung bình/số lần trung bình 0 R/W 

2H 2 CH2 Thời gian trung bình/số lần trung bình 0 R/W 

3H 3 CH3 Thời gian trung bình/số lần trung bình 0 R/W 

4H 4 CH4 Thời gian trung bình/số lần trung bình 0 R/W 

5H 5 
 

 
Khu vực hệ thống 

 

 
- 

 

 
- 

   

... 

  

... 
8H 8 

9H 9 Quá trình thiết lập trung bình 0 R/W 

A
H 

10 Cờ chuyển đổi A/D hoàn tất 0 R 

B
H 

11 CH1 Xuất ra giá trị số 0 R 

CH 12 CH2 Xuất ra giá trị số 0 R 

DH 13 CH3 Xuất ra giá trị số 0 R 

E
H 

14 CH4 Xuất ra giá trị số 0 R 

FH 15 
 

 
Khu vực hệ thống 

 

 
- 

 

 
- 

   

... 

  

... 

12H 18 

13H 19 Mã lỗi 0 R 

14H 20 Phạm vi cài đặt (CH1 to CH4) 0 R 

15H 21 Khu vực hệ thống - - 

16H 22 Chế độ thiết lập Ngưỡng/Độ lợi: Đặc tính Ngưỡng 0 R/W 

17H 23 Chế độ thiết lập Ngưỡng/Độ lợi: Đặc tính Độ lợi 0 R/W 

*1: Cho biết đọc và ghi các chương trình tuần tự được kích hoạt. 

R: Chế độ Đọc  

W: Chế độ Ghi
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Phân vùng bộ nhớ đệm (Q64AD) (2/2) 
 

Địa chỉ  
Mô tả 

 
Giá trị 

mặc định 

Read/writ

e 
*1

 
 

Hệ 16 Hệ 10 

18H 24 
 

 

Khu vực hệ thống 

 

 

- 

 

 

- 

   

... 

  

... 

1DH 29 

1EH 30 CH1 Giá trị lớn nhất 0 R/W 

1FH 31 CH1 Giá trị lớn nhất 0 R/W 

20H 32 CH2 Giá trị lớn nhất 0 R/W 

21H 33 CH2 Giá trị lớn nhất 0 R/W 

22H 34 CH3 Giá trị lớn nhất 0 R/W 

23H 35 CH3 Giá trị lớn nhất 0 R/W 

24H 36 CH4 Giá trị lớn nhất 0 R/W 

25H 37 CH4 Giá trị lớn nhất 0 R/W 

26H 38 
 

 
Khu vực hệ thống 

 

 
- 

 

 
- 

   

... 

  

... 

9DH 157 

9EH 158  
Cài đặt chế độ chuyển đổi 

 
0 

 
R/W 

9FH 159 

A0H 160 
 

 
Khu vực hệ thống 

 

 
- 

 

 
- 

   

... 

  

... 

C7H 199 

C8H 200 Vượt qua thiết lập phân loại dữ liệu
*2

 0 R/W 

C9H 201 Khu vực hệ thống - - 

CAH 202  CH1 Thiết lập giá trị ngưỡng vận chuyển công nghiệp*2

  
 

0 R/W 

CBH 203 CH1 Thiết lập giá trị độ lợi vận chuyển công nghiệp*2

  

value 

0 R/W 

CCH 204 CH2 Thiết lập giá trị ngưỡng vận chuyển công nghiệp*2 0 R/W 

CDH 205 CH2 Thiết lập giá trị độ lợi vận chuyển công nghiệp*2

  
0 R/W 

CEH 206 CH3 Thiết lập giá trị ngưỡng vận chuyển công nghiệp*2

  
0 R/W 

CFH 207 CH3 Thiết lập giá trị độ lợi vận chuyển công nghiệp*2 0 R/W 

D0H 208 CH4 Thiết lập giá trị ngưỡng vận chuyển công nghiệp*2 0 R/W 

D1H 209 CH4 Thiết lập giá trị độ lợi vận chuyển công nghiệp*2

  
0 R/W 

D2H 210 CH1 Thiết lập phạm vi người sử dụng giá trị ngưỡng
*2

 0 R/W 

D3H 211 CH1 Thiết lập phạm vi người sử dụng giá trị độ lợi
*2

 0 R/W 

D4H 212 CH2 Thiết lập phạm vi người sử dụng giá trị ngưỡng
*2

 0 R/W 

D5H 213 CH2 Thiết lập phạm vi người sử dụng giá trị độ lợi
*2

 0 R/W 

D6H 214 CH3 Thiết lập phạm vi người sử dụng giá trị ngưỡng
*2

 0 R/W 

D7H 215 CH3 Thiết lập phạm vi người sử dụng giá trị độ lợi
 *2

 0 R/W 

D8H 216 CH4 Thiết lập phạm vi người sử dụng giá trị ngưỡng
*2

 0 R/W 

D9H 217 CH4 Thiết lập phạm vi người sử dụng giá trị độ lợi
 *2

 0 R/W 

*1: Cho biết đọc và ghi các chương trình tuần tự được kích hoạt. 

R: Chế độ đọc  

W: Chế độ ghi 

*2:. Khu vực sử dụng để khôi phục các cài đặt phạm vi sử dụng ngưỡng/độ lợi khi các thay đổi 

module trực tuyến được thi hành.



7 - 12 

 

 

1) Click! 

4) Click! 

3) Đặt 

5) 
Thêm 

OK 

7.5.4 Bổ sung hoặc cài đặt dữ liệu cho module chức năng thông minh  

 

Phần này sẽ giải thích làm thế nào để thiết lập dữ liệu cho module chức năng 

thông minh. Sau khi các module được thêm vào, thiết lập các cài đặt dữ liệu (tham 

số và cài đặt chuyển đổi) của module chức năng thông minh. 

 

1) Click [Project] → [Intelligent Function Modulee] 

→ [New Modulee]. 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
 

2) Hộp thoại New Module được hiển thị. 
 

 

3) Thiết lập tham số module chuyển đổi A/D 

Modulee Type : Analog Modulee 

Modulee Name : Q64AD 

Mounted Slot No. : 3 

(Specify start XY address: 0080) 

 

4) Click nút    
 

 

 

 
 

5)  Các dữ liệu module chức năng thông minh định 

được thêm vào cửa sổ Project. 

 

 

 
 
 

 
 
 

 
 
 

(Đến trang sau) 
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6) Click đúp! 

7) Đặt 

8) Click! 

9) Click đúp 

10) Đặt 

OK 

(Từ trang trước) 
 

 
 

6) Click đúp vào Switch Setting. 
 

 
 
 

 
 
 

 
 
 

 

 

7) Hộp thoại Switch Setting được hiển thị. 

Thiết lập phạm vi đầu vào cho CH1 là  

"0 đến 10V". 

 

8) Click nút    
 
 

 
 
 

 
 
 

 
 
 

 

 

9) Click đúp Parameter. 
 
 

 
 
 

 
 
 

 

 

 

10) Hộp thoại Parameter được hiển thị. 

Chọn "A/D conversion enable/disable setting" cho 

CH2 đến CH4 chọn "1:Disable". (Chỉ CH1 được sử 

dụng.) 

 
 

 

 

 

(Đến trang sau) 



7 - 14 

 

 

11) Click đúp 

12) Đặt 

13) Click! 

(Từ trang trước) 
 

 
 

11) Click đúp Auto_Refresh. 
 

 
 
 

 
 
 

 
 
 

 

 
 

12) Màn hình Auto_Refresh được hiển thị. 

Giá trị đầu ra Set Digital của CH1 là 

"D10". 
 

 

 
 
 

 
 

 

13) Click [Project] → [Intelligent Function Modulee] 

→ [Intelligent Function Modulee Parameter List]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

(Đến trang sau) 
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15) Click! 

Close 

(Từ trang trước) 
 

 
 

14) Kiểm tra xem “Setting Exits” được chọn trong 

Initialization (Count) và Auto Refresh (Count) cho 

Q64AD trong hộp thoại Intelligent Function Modulee 

Parameter List 

 

15) Click nút   
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0 >= D10 K0 BCD D10 K4Y50 

9     END 

 

Parameter + Program Execute 

7.5.5 Bài tập với thiết bị Demo 

 
(1) Chương trình tuần tự 

Một chương trình tuần tự thực việc xử lý lấy mẫu điện áp đầu vào là tín hiệu 

tương tự thông qua CH1 của Q64AD, sau đó bộ chuyển đổi các giá trị 

tương tự sang giá trị số.  

Đặt XY ban đầu của Q64AD là 80 như giải thích trước.   
 

Tên dự án Q64AD 

Tên chương trình MAIN 

 

Module A/D sẵn sàng 
 

 

 

X3   X80 

 

 

 

X8E 

 

Cờ chuyển đổi A/D hoàn tất 
 

 

 

 Hiển thị giá trị chuyển đổi số 
CH1 trên đèn LED 

 

 

 

X80: Module tín hiệu sẵn sàng  

X8E: Hoàn tất cờ chuyển đổi A/D  

Tại thời điểm bật nguồn hoặc reset của bộ điều khiển lập trình CPU, cờ này 

được đánh dấu nếu bộ chuyển đổi A/D sẵn sàng hoạt động. Chuyển đổi A/D 

được thực hiện một lần khi cờ này được đánh dấu. 

 
(2) Hoạt động của thiết bị Demo              Dừng 

CPU và click   trên thanh công cụ 

Hộp thoại Online Data Operation đươc hiển thị. Click nút 

         , sau đó click nút             để ghi dữ liệu đến CPU

.  Sau đó, kích hoạt các CPU và kiểm tra các mục dưới đây  
(a) Bật X3 và thay đổi điện áp đầu vào cho một module chuyển đổi A/D cùng 

với âm lượng trên thiết bị Demo 

Các giá trị tương tự được nhập vào trên kênh 1 (CH1) của Q64AD được 

lưu trữ trong bộ nhớ đệm (với giá trị số). Với các thiết lập tự động làm mới, 

QCPU sẽ đọc các giá trị số đã lưu trữ và lưu trữ chúng trong dữ liệu đăng 

ký D10.  

(b) Bất kể khi nào giá trị tương tự là “-1” hoặc nhỏ hơn, 0 sẽ được đặt 

(c) Các giá trị số được hiển thị trên màn hình hiển thị (Y50 đến Y5F)
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7.6 Module chuyển đổi Số/Tương tự Q62DAN 

 
7.6.1 Tên của các bộ phận 

 
Dưới đây sẽ giải thích về các bộ phận của 

Q62DAN. Chi tiết về Q64AD, hãy xem qua 

hướng dẫn sử dụng. 
 

Q62DAN 

 

 

1) 

2) 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

3) 

 

 

 
 
 

 
 

 

TT 
Tên và  

hình dạng 

 

Mô tả 

 

 

 

1) 

 

 

 

RUN LED 

Cho biết tình trạng hoạt động của các module chuyển đổi D/A 

Bật            : Hoạt động bình thường 

Nhấp nháy      : Chế độ cài đặt Ngưỡng/Độ lợi 

Tắt            : Mất nguồn điện hoặc thiết bị giám sát lỗi hẹn giờ 

 

 

 

 

2) 

 

 

 

 

ERROR LED 

Cho biết lỗi và tình trạng hiện tại của module chuyển đổi D/A 

Bật        : Đã xuất hiện lỗi 

Tắt       : Hoạt động bình thường 

Nhấp nháy  : Hệ thống chuyển đổi có lỗi 

Các giá trị khác 0 được thiết lập để chuyển đổi 

thành 5 trên module chức năng thông minh 

 

3) 
Nguồn cung cấp hỗ 

trợ thiết bị đầu cuối 

 

Thiết bị đầu cuối kết nối với một nguồn hỗ trợ bên ngoài 24VDC  
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10V 

0 

5.0025V 

5.0000V 

2000 20012002 2003 2004 

  Giá trị số ở đầu vào 

-10V 
- 4000 0 

Giá trị số ở đầu 
vào 

4000 

20mA 

0 
10.005mA 

10.000mA 

200020012002 2003 

    Đầu vào 

-20mA 
-4000 0 

Giá trị số ở đầu 
vào 

4000 
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ầ
u
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7.6.2 Đặc điểm của chuyển đổi D/A 

 
(1) Đặc điểm của điện áp đầu vào 

(Trong chế độ phân giản tiêu chuẩn, tín hiệu tương tự có điện áp vào khoảng -10 đến 10V) 
 
 

 

 

 

 
 

 
 

 

 

Hình 7.14 Đặc điểm của chuyển đổi D/A (Điện áp ra) 
 

 

Module chuyển đổi D/A sẽ chuyển đổi các giá trị số được nhập từ một QCPU 

thành những giá trị tương tự và sau đó xuất chúng. Ví dụ, những module chuyển 

đổi giá trị số -4000 sang giá trị tương tự là -10V và 4000 sang 10V sau đó xuất 

ra. Điều này có nghĩa rằng các module chuyển đổi các giá trị đầu vào số là 1 

sang giá trị tương tự là 2.5mV, và loại bỏ các giá trị số đầu vào trong hệ thập 

phân. 

 
(2) Đặc điểm dòng điện đầu vào của bộ chuyển đổi D/A 

(Ở độ phân giải tiêu chuẩn, tín hiệu tương tự có dòng điện vào khoảng 0 đến 20mA) 
 

 

 

 
 

 
  

 

 

Hình 7.15 Đặc điểm của chuyển đổi D/A (Dòng điện ra) 
 

Với dòng ở đầu ra, các module chuyển đổi giá trị số từ 0 sang 0mA và từ 4000 

thành 20mA. Điều này có nghĩa các module chuyển đổi giá trị số đầu vào là 1 thành 

tín hiệu tương tự là 5 μA, và loại bỏ các giá trị số đầu vào thuộc hệ thập phân.  

 

Chú thích  

Giá trị điện áp và dòng điện tương đương với giá trị số là 1 do chuyển đổi D/A (ở 

độ phân giải tối đa) khác nhau tùy thuộc vào các thiết lập của chế độ phân giải 

(1/4000, 1/12000, 1/16000) hoặc sự quy định khoảng đầu ra. 

  

  

 
5  A 

 

  
 

  

  

  

2.5mV  
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7.6.3 Danh sách các tín hiệu I/O và sự phân vùng bộ nhớ đệm  

 
(1) Danh sách các tín hiệu I/O 

Bảng dưới đây cho thấy danh sách các tín hiệu I/O cho các module chuyển đổi 

D/A. Những lời giải thích này được dựa trên Q68DAVN, Q68DAIN, Q68DAV và 

Q68DAI với 8 kênh đầu ra tương tự (CH1 đến CH8). 

Chú ý rằng số lượng I/O (X/Y) xuất hiện trong phần này và về sau là những giá 

trị khởi đầu số I/O cho module chuyển đổi D/A được đặt là 0. 
 

Hướng tín hiệu 
 
 Module chuyển đổil D/A → Module CPU  Hướng tín hiệu Module CPU → Module chuyển đổi D/A 

Thứ tụ biến Tên tín hiệu Thứ tự biến Tên tín hiệu 

X0 Module đã sẵn sàng Y0 Cấm sử dụng
*1

 

X1 
 

 

 

 

Cấm sử dụng
*1

 

Y1 CH1 Cờ đầu ra hoạt động/không hoạt động  

X2 Y2 CH2 Cờ đầu ra hoạt động/không hoạt động 

X3 Y 
*2 

3 CH3 Cờ đầu ra hoạt động/không hoạt động 

X4 Y 
*2 

4 CH4 Cờ đầu ra hoạt động/không hoạt động 

X5 Y 
*2 

5 CH5 Cờ đầu ra hoạt động/không hoạt động 

X6 Y 
*2 

6 CH6 Cờ đầu ra hoạt động/không hoạt động 

X7 Y7
*2 

CH7 Cờ đầu ra hoạt động/không hoạt động 

X8 Cờ đánh dấu ở chế độ phân giải cao Y8
*2 

CH8 Cờ đầu ra hoạt động/không hoạt động 

X9 
Cờ đánh dấu thiết lập hoàn tất điều kiện 
hoạt động  

Y9 Yêu cầu điều kiện hoạt động 

XA Cờ đánh dầu chế độ thiết lập ngưỡng/độ 
lợi 

YA Người sử dụng yêu cầu phạm vi ghi 

XB Cờ đánh dấu thay đổi kênh hoàn tất YB Yêu cầu thay đổi kênh 

XC    Cờ đánh dấu hoàn tất thay đổi giá trị YC Yêu cầu đặt giá trị thay đổi 

XD Cờ đánh dấu chế độ đồng bộ đầu ra YD Yêu cầu đồng bộ đầu ra 

XE Cấm sử dụng
*1

 YE Cấm sử dụng
*1

 

XF Cờ lỗi YF Yêu cầu xóa sạch lỗi 

 

Chú thích  

*1: Những tín hiệu không cho phép hoạt động bởi chúng chỉ được hoạt động dưới 

sự cho phép của hệ thống. Nếu chúng được bật/tắt bởi chương trình tuần tự sẽ 

dẫn đến hoạt động của module chuyển đổi D/A không được đảm bảo. 

*2: Đối với Q62DAN và Q62DA, Y3 đến Y8 bị cấm sử dụng.       

Đối với Q64DAN và Q64DA, Y5 đến Y8 bị cấm sử dụng. 
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(2) Phân vùng bộ nhớ đệm (Q62DAN) 

Trong mục này sẽ giải thích sự phân vùng bộ nhớ đệm của Q62DAN 
 

Chú ý  

Không ghi dữ liệu vào vùng hệ thống hoặc vô hiệu hóa vùng ghi dữ liệu từ 
các chương trình tuần tự.  
Làm như vậy có thể gây ra sự cố. 

 

Địa chỉ  

Mô tả Giá trị mặc 

định
 *1

 

Read/ 

write
*2

 Hệ 16 Hệ 10 

0H 0 Chuyển đổi D/A hoạt động/không hoạt động 3H R/W 

1H 1 CH1 Giá trị số  0 R/W 

2H 2 CH2 Giá trị số 0 R/W 

3H 3  

 

Khu vực hệ thống 

 

 

- 

 

 

- 

   
... 

  

... 

AH 10 

BH 11 CH1 Đặt giá trị mã kiểm tra 0 R 

CH 12 CH2 Đặt giá trị mã kiểm tra 0 R 

DH 13  

 

Khu vực hệ thống 

 

 

- 

 

 

- 

   
... 

  

... 

12H 18 

13H 19 Mã lỗi 0 R 

14H 20 Phạm vi cài đặt (CH1 to CH2) 0H R 

15H 21 Khu vực hệ thống - - 

16H 22 Chế độ thiết lập Ngưỡng/Độ lợi: Đặc tính Ngưỡng 0 R/W 

17H 23 Chế độ thiết lập Ngưỡng/Độ lợi: Đặc tính Độ lợi 0 R/W 

18H 24 Điều chỉnh đặc giả giá trị Ngưỡng/Độ lợi 0 R/W 

19H 25  

 

Khu vực hệ thống 

 

 

- 

 

 

- 

   
... 

  

... 

9DH 157 

9EH 158  

Chế độ cài đặt chuyển đổi 
0 R/W 

9FH 159 0 R/W 

A0H 160  

 

Khu vực hệ thống 

 

 

- 

 

 

- 

   
... 

  

... 

C7H 199 

C8H 200 Vượt qua thiết lập phân loại dữ liệu
 *3

 0 R/W 

C9H 201 Khu vực hệ thống - - 

CAH 202 CH1 Thiết lập giá trị ngưỡng vận chuyển công nghiệp
 *3

 0 R/W 

CBH 203 CH1 Thiết lập giá trị độ lợi vận chuyển công nghiệp
 *3

 0 R/W 

CCH 204 CH2 Thiết lập giá trị ngưỡng vận chuyển công nghiệp
 *3

 0 R/W 

CDH 205 CH2 Thiết lập giá trị độ lợi vận chuyển công nghiệp
 *3

 0 R/W 

CEH 206 CH1 Thiết lập phạm vi người sử dụng giá trị ngưỡng
 *3

 0 R/W 

CFH 207 CH1 Thiết lập phạm vi người sử dụng giá trị độ lợi
 *3

 0 R/W 

D0H 208 CH2 Thiết lập phạm vi người sử dụng giá trị ngưỡng
 *3

 0 R/W 

D1H 209 CH2 Thiết lập phạm vi người sử dụng giá trị độ lợi
 *3

 0 R/W 

*1: Đây là các giá trị thiết lập ban đầu sau khi nguồn được bật hoặc hoặc bộ điều khiển lập trình 

CPU được reset. 

*2: Cho biết đọc và ghi các chương trình tuần tự được kích hoạt                              

R: Chế độ đọc 

W: Chế độ ghi 

*3: Khu vực sử dụng để khôi phục các cài đặt phạm vi sử dụng ngưỡng/độ lợi khi các thay đổi 

module trực tuyến được thi hành. 
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1) Click! 

4) Click! 

3) Đặt 

5) 
Thêm 

OK 

7.6.4 Bổ sung hoặc cài đặt dữ liệu cho module chức năng thông minh 
 

1) Click [Project] → [Intelligent Function Modulee] 

→ [New Modulee]. 
 

 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

 
 

2)  Hộp thoại New Modulee được hiển thị. 
 

 

3) Thiết lập tham số module chuyển đổi A/D. 

Modulee Type : Analog Modulee 

Modulee Name : Q62DAN 

Mounted Slot No. : 4 

(Đặt địa chỉ khởi tạo XY: 0090) 

 

4) Click nút   
 

 
 

 
 

5)  Các dữ liệu module chức năng thông minh định 

được thêm vào cửa sổ Project. 

 

 

 
 
 

 
 
 

 

 

(Đến trang sau) 
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6) Click đúp 

7) Đặt 

8) Click! 

9) Click đúp 

10) Đặt 

OK 

(Từ trang trước) 
 

 
 

6)  Click đúp Switch Setting. 
 
 

 
 
 

 
 
 

 

 

 
 

7)  Hộp thoại Switch Setting được hiển 

thị. Thiết lập phạm vi đầu vào cho CH1   

"0 đến 5V". 

 

8) Click nút   
 

 
 
 

 
 
 

 
 
 

 

 

9)  Click đúp Parameter. 
 
 

 
 
 

 
 
 

 

 

 

10)  Hộp thoại Parameter được hiển thị. 

Chọn "D/A conversion enable/disable setting" cho 

CH1 chọn "0:Enable". (chỉ CH1 được sử dụng.) 

 

 

 

(Đến trang sau) 
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11) Click đúp 

12) Đặt 

13) Click! 

(Từ trang trước) 
 

 
 

11)  Click đúp Auto_Refresh. 
 
 

 
 
 

 
 
 

 
 

 

 
 

12)  Màn hình Auto_Refresh được hiển 

thị. Giá trị đầu ra Set Digital của CH1 

là "D30". 
 

 

 
 
 

 
 
 

13) Click [Project] → [Intelligent Function Modulee] 

→ [Intelligent Function Modulee Parameter List]. 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

(Đến trang sau) 
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15) Click! 

Close 

(Từ trang trước) 
 

 

 

14)  Kiểm tra xem “Setting Exits” được chọn trong 

Initialization (Count) và Auto Refresh (Count) cho 

Q64AD trong hộp thoại Intelligent Function Modulee 

Parameter List. 

 

15) Click nút   
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X2 
Y91 

X90 X3 
MOVP K0 D30 

X4 
MOVP K2000 D30 

X5 
MOVP K4000 D30 

END 

Parameter + Program Execute 

7.6.5 Bài tập với thiết bị Demo 
 
 

(1) Chương trình tuần tự 

Một chương trình tuần tự thực hiện chuyển đổi các giá trị số sang giá trị tương 

tự. 

Đặt XY ban đầu của Q62DAN là 90 và giá trị số của CH1 là D30 như giải thích 

trước. 
 

Tên dự án Q62DAN 

Tên chương 
trình 

MAIN 

 

0 

 

2 

 

 

 
 

15 
 

 

X90: Module tín hiệu sẵn sàng 

Tại thời điểm bật nguồn hoặc reset của bộ điều khiển lập trình CPU, tín 

hiệu này được bật nếu bộ chuyển đổi D/A sẵn sàng hoạt động. Bộ 

chuyển đổi D/A được thực hiện một lần khi tín hiệu được bật lên. 

Y91: CH1 Cờ đánh dấu đầu ra hoạt động/không hoạt động 

Lựa chọn cờ này được đánh dấu hay không trên mỗi kênh khi có giá trị 

đầu ra ở bộ chuyển đổi D/A hoặc có các giá trị ngưỡng. 

ON: giá trị chuyển đổi D/A, OFF: giá trị ngưỡng 
 

 

(2) Hoạt động của cá thiết bị Demo           

Dừng CPU và click   trên thanh công cụ. 

Hộp thoại Online Data Operation đươc hiển thị. Click nút 

, sau đó click nút để  ghi dữ liệu đến CPU

Sau đó, kích hoạt các CPU và kiểm tra các mục dưới đây. 
 

(a) Bật X2 để cho phép kết quả đầu ra D/A của CH1 

(b) Điện áp đầu ra theo X3 đến X5 

(c) Màn hình OUTPUT của Vôn kế  của D/A hiển thị các giá trị điện áp  chính 

là kết quả đầu ra của module chuyển đổi D/A.
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1) Click! 

  Chương 8 Chức năng mô phỏng 
 

8.1 Chức năng mô phỏng 

 
Chức năng mô phỏng dùng để gỡ lỗi một chương trình tuần tự sử dụng bộ điều 

khiển khả trình ảo trên máy tính cá nhân. 

Chương trình tuần tự tạo ra có thể ngay lập tức Gỡ lỗi mà không cần kết nối đến 

CPU điều khiển khả trình. 

 

Ghi nhớ  

An toàn và phòng tránh lỗi của chức năng mô phỏng 

 
1) Chức năng mô phỏng mô phỏng CPU điều khiển khả trình thật sự để Gỡ lỗi 

một chương trình tuần tự tạo ra. Tuy nhiên, chức năng này không đảm bảo 

hoạt động của chương trình tuân tự bị debug. 

2) Chức năng mô phỏng sử dụng bộ nhớ để mô phỏng dữ liệu đầu vào và ra 

đến/từ module I/O và module chức năng thông minh. Một vài lệnh, chức 

năng, và bộ nhớ thiết bị không được hỗ trợ. Vì thế, kết quả hoạt động được 

lấy từ khối điều khiển khả trình ảo có thể khác với những cái lấy ra từ CPU 

điều khiển khả trình thật sự. 

 

8.2 Chức năng chạy /dừng 
 

1) Click [Debug] → [Start/Stop Simulation]. 
 
 

 
 
 

 
 
 

 
 
 

 

 

 
 

2) Màn hình GX Simulator2 hiện ra và mô phỏng bắt 

đầu. 

 
3) Để dừng mô phỏng lại, click lại [Debug] → 

[Start/Stop Simulation] . 
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X0 X1 
Y70 

Y70 

M0 
Y71 

K9999 SM412 
C0 

SM400 
MOV C0 K4Y80 

END 

8.3 Gỡ lỗi với chương trình ví dụ 

 
Sử dụng ví dụ dưới đây để luyện tập. 

 

 

<<Chương trình ví dụ>> 
 

0 

 

 

4 

6 
 

11 
 

14 
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1) Click! 

2) Enter "X0"! 

3) Click! 

4) Reflected! 

ON 

8.3.1 Giám sát và kiểm tra trạng thái biến 

 
Phần này diễn giải làm thế nào để quan sát trạng thái biến, bật biến bit bật/tắt bằng 

cưỡng bức và thay đổi giá trị biến từ. 

 
(1) Bật biến bit bật/tắt bằng cưỡng bức 

Ở ví dụ dưới đây, “X0” bị cưỡng bức bât lên. 
 

1) Click [Debug] → [Modify Value]. 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

2) Hộp thoại  Modify  Value hiện ra. Nhập đầu 

vào "X0" vào danh sách"Device/Label". 

 

3) Click nút 

. 

để bật "X0" lên bằng cưỡng 
bức 

 

 
 

 
 
 

 
 
 

 
 
 

 

 
 

 

4) Kết quả của biến được bật lên được phản 

ánh trên màn hình giám sát ladder. 
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1) Click! 

2) Enter "C0"! 

3) Select! 

4) Enter "5"! 

5) Click! 

6) Reflected! 

Set 

 

(2) Thay đổi giá trị biến từ 

Ở ví dụ dưới đây, giá trị biến từ "C0" được đổi thành "5". 
 

1) Click [Debug] → [Modify Value]. 
 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 

2) Hộp thoại  Modify  Value  hiện ra. Nhập đầu 

vào "C0" vào danh sách "Device/Label". 

 
3) Chọn  "Word[Signed]"  từ danh sách  "Data 

Type". 

 
4) Nhập "5" vào cột "Value". 

 

 

5) Sau khi cài đặt hoàn tất, click vào nút  

để thay đổi giá trị hiện tại bằng 

cưỡng bức của C0 thành 5. 

 

 

 

 
 

6) Thay đổi giá trị của "C0" thành "5" được 

phản ánh trên màn hình giám sát ladder. 

vũ lực của C0 thành 5 
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Chương 9 Bảo dưỡng 
 

9.1 Lỗi phổ biến 

 
Biểu đồ cột dưới đây chỉ ra tỉ lệ của thành phần lỗi và nguyên nhân của lỗi bộ điều 

khiển khả trình. 

[Nguồn: điều tra tạo bởi JEMA (The Japan Electrical Manufacture's 

Association)] 

 
Hình 9.1 Thành phần lỗi trên khối điều khiển khả trình (cho phép nhiêu đáp án) 

 

(%) 
 

 

 

73.1 

 

 

Thu thập từ 223 nhà máy 

 

 

60 

 

 

40 34.1 

 

20 
20.6 19.3 

 

 

14.3 

 

 

 

9.4 

 

 

 
2.7 

0.9
 

 
 
 

  
 
 

 

 

Hình 9.2 Nguyên nhân lỗi của khối điều khiển khả trình (cho phép nhiều đáp án) 

(%) 

50 
Thu thập từ 223 nhà máy 

 

40.4 
40 

 

 

30 

26.0 24.7 24.2
 

 

20 19.3 
 

12.6 12.1 

10 
 

 

 
0 

 

 

 

 

6.3 

 

 

 

 

 

 

1.3 



9 - 2 

 

 

9.2 Bảo dưỡng 
 

Để giữ khối điều khiển khả trình trong điều kiện hoạt động tốt nhất, làm theo kiểm 

tra dưới đây hàng ngày và theo chu kì. 

(1) Kiểm tra hàng ngày 

Bảng danh sách dưới đây liệt kê những mục cần được kiểm tra hàng ngày. 
 

Bảng 9.1 Kiểm tra hàng ngày 
 

Mục Mục kiểm tra Nội dung kiểm tra Tiêu chí đánh giá Thang đo 

 

 

1 

 
Lắp đặt của đế cắm 

Kiểm tra vít cố định 
không bị lỏng và bảo 
vệ không bị rơi ra 

Vít và bảo vệ phải 
được gắn vào an 
toàn 

 

Vặn chặt lại ví. 

 

 
2 

 

 

Lắp đặt module I/O  

Kiểm tra modul 
không bị sai vị trí và 
móc cố định module 
được gắn an toàn 

Móc cố định module 
phải được gắn và 
lắp đặt an toàn. 

 
Gắn móc cố định 
module an toàn. Vặn 
chặt vít 

 

 

 

 

 

 

3 

 

 

 

 

 

Điều kiện kết nối 

Kiểm tra độ lỏng của 
vít tiếp điểm. 

Vít không bị lỏng. Vặn chặt lại vít tiếp 
điểm 

Kiểm tra khoảng 
cách giữa những loại 
đầu nối không hàn 

Khoảng cách chính 
xác phải được cung 
cấp giữa những đầu 
nối không hàn. 

 
Đặt khoảng cách 
chính xác. 
 

Kiểm tra phần kết 
nối của cáp 

Kết nối không bị lỏng 
Vặn chặt lại ví cố 
định bộ kết nối 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
4 

M
o

d
u
le

 c
h
ỉ 
L
E

D
 

Module cấp 
nguồn "POWER" 
LED 

Kiểm tra LED được 
bật. 

LED phải được bật. 
(Lỗi nếu LED bị tắt) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Xem lại QCPU (Q 
mode) User's 
Manual. 

 
CPU "RUN" LED 

Kiểm tra LED đươc 
bật ở trạng thái RUN 

LED phải được bật. 
(Lỗi nếu LED bị tắt) 

CPU "ERROR" 
LED 

Kiểm tra LED bị tắt 
LED phải được tắt 
(Lỗi nếu LED được 
bật hoặc nháy) 

CPU "BAT.ARM" 
LED 

Kiểm tra LED bị tắt 
LED phải được tắt 
(Lỗi nếu LED được 
bật) 

 

 

 

 

 

LED đầu vào 

 

 

 

 

 

Kiểm tra LED được 
bật và tắt 

LED phải được bật 
khi nguồn đầu vào 
được bật 

LED phải được tắt 
khi nguồn đầu vào 
được tắt 
(Lỗi nếu LED không 
bật hoặc tắt như chỉ 
thị bên triên) 

 

 

 

 

 

LED đầu ra 

 

 

 

 

 

Kiểm tra LED được 
bật và tắt. 

LED phải được bật 
khi nguồn đầu ra 
được bật 

LED phải được tắt 
khi nguồn đầu ra 
được tắt 

(Lỗi nếu LED không 
bật hoặc tắt như chỉ 
thị bên triên) 
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(2) Kiểm tra định kì 

Bảng danh sách dưới đây liệt kê các mục phải dược kiểm tra một hoặc hai lần 

mỗi nửa năm cho đến một năm. Khi biến được đặt lại vị trí hoặc chỉnh sửa, hoặc 

bố trí đi dây bị thay đổi, thực hiện kiểm tra này. 

Bảng 9.2 Kiểm tra định kì 
 

Mục Mục kiểm tra Nội dung kiểm tra Tiêu chí đánh giá Thang đo 
 

 

 

 

 

1 

M
ô

i 
tr

ư
ờ

n
g
 b

ê
n
 n

g
o
à
i 

Nhiệt độ môi 

trường 

 
Đo nhiệt độ và độ ẩm 

với nhiệt kế và ẩm kế 

Đo nồng độ khí ắn mòn. 

 

0 đến 55 °C 
 
Khi khối điều khiển khả 

trình được sử dụng 

trên bảng mạch, độ ẩm 

trên bảng mạch là độ 

ẩm môi trường. 

 
Độ ẩm môi trường 5 đến 95% RH

*1
 

 

Môi trường 
Khí ăn mòn không 

được phép có 

 
2 

 
Điện áp cấp nguồn 

Đo điện áp xuyên suốt 

các đầu cuối của 

100/200VAC. 

85 đến 132VAC Thay đổi  khối cấp  

nguồn. 170 đến 264VAC 

 

 

 

 

3 

C
h
ỉ 
th

ị 

 

 

Lỏng, làm sạch 

Di chuyển module ra để 

kiểm tra độ lỏng và làm 

sạch  

 
Module phải được lắp 

đặt an toàn. 

 

Vặn chặt ví nếu CPU, 

I/O hoặc module cấp 

nguồn bị lỏng, cố định 

nó bằng đinh. 

Sự dính vào của bụi 

và vật liệu ngoài 

 
Kiểm tra bằng mắt 

Bụi và vật liệu ngoài 

không được phép có 

Loại bỏ và làm sạch 

vụi và vật liệu ngoại 

 

 

 

 

 

 

4 

Đ
iề

 u
k
iệ

n
 k

ế
t 

n
ố
i 

Lỏng vít đấu nối Vặn chặt vít với một 

tuốc-nơ-vít 

Vít phải chặt Vặn chặt vít kết nối 

 

Khoảng cách giữa 

những loại đầu nối 

không hàn 

 

 

Kiểm tra bằng mắt 

Khoảng cách chính 

xác phải được đặt giữa 

những đầu nối không 

hàn 

 

 

Đặt khoảng cách chính 
xác. 
 

Lỏng bộ kết nối 
 
Kiểm tra bằng mắt. 

Bộ kết nối không được 

lỏng 

Vặn chặt vít cố định bộ 

kết nối. 

 

 

 

 

5 

 

 

 

 

Pin 

 

 

 

Kiểm tra SM51 hoặc 

SM52 bị tắt với GX 

Works2. 

 

 

 

(Bảo dưỡng phòng 

ngừa) 

Ngay cả khi dung lượng 

pin thấp không hiển thị, 

thay thế pin bằng một 

pin mới nếu vòng đời 

hoạt động của pin bị hết 

hạn. 

 

 

 

6 

 

 

 

Sản phẩm phụ tùng 

Cài đặt sản phẩn trên 

một khối điều khiển khả 

trình thật sự và kiểm tra 

hoạt động  

 

Hoạt động phải đúng 

với đặc điểm kĩ thuật. 

Sử dụng sản phẩm 

thông thường trên khối 

điều khiển khả trình 

như một sản phẩm phụ 

tùng 

 
7 

Kiểm tra chương trình 

được lưu 

So sánh chương trình 

được lưu với chương 

trình đang chạy 

Hai chương trình phải 

giống nhau 

Đúng nếu tìm thấy bất 

cứ sự khác nhau nào. 

 

 

 

8 

 

 

Quạt (bộ trao đổi nhiệt)  

 
Trạng thái vòng quay 

Tiêng vòng quay    

Tắc 

Quạt phải quay mà 

không có âm thanh bất 

thường náo 

Quạt phải quay mà 

không bị tắc. 

 
Thay thế nếu có bất kì 
lỗi nào tìm thấy. 
Sạch 

 

 

9 

 

 

I/O tương tự 

 

Kiểm tra giá trị 

offset/gain (ngưỡng/độ 

lợi) 

Giá trị phải giống với 

tham số kĩ thuật (giá trị 

thiết kễ) 

 

Đúng nếu tìm thấy bất 

cứ sự khác nhau nào 

*1: Khi module AnS Series được sử dụng trong hệ thống, tiêu chí đánh giá sẽ từ10 đến 90% RH. 
 

 

9.3 Sản phẩm tiêu hao 

Pin dự phòng trên khối điều khiển khả trình là Sản phẩm tiêu hao. 
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9.4 Vòng đời của rơle đầu ra 

Rơle đầu ra của module bị tiêu tốn bở hoạt động chuyển mạch. 

Một rơle được lắp trực tiếp lên bảng in của module đầu ra là cần thiết để thay thế 

module đầu ra của chính nó sau khi tiêu thụ. 

1000 

 

 
 

 

500 

 
 

 
 

 

 

 

200 

 
 
 

 

100 
 

 

 
 

50 
 

 
 

 
 
 

 

20 
 

 
 

 
 

10 

 

 
 

 

 
5 DC100V 

t=7ms 

DC30V 

t=0ms 

 

AC100V COS    =0.7 
 

 
 

 
 

DC24V 

2 t=7ms 

 
AC200V COS    =0.7 

AC100V COS    =0.35 
 

 

AC200V COS    =0.35 

 
 

 

 

1 
0.1 

 
0.2 

 
0.5 1 2 5 10 

             Dòng điện chuyển mạch (đơn vị: A) 
 

Hình 9.3 Đặc tính tuổi thọ của công tắc rơle đầu ra (QY10, QY18A) 
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9.5 Sản phẩm dự phòng 
 

Sản phẩm dự phòng rất dễ đặt mua qua trung tâm dịch vụ Mitshubitshi hoặc đại diện 

Mitshubitshi ở Nhật Bản. Do đó, sản phẩm dự phòng có thể được chuẩn bị ngay cả 

sau khi có sự cố. Tuy nhiên, lưu ý rằng sản phẩm liên quan đến bên ngoài như xuất 

sản phẩm, sản phẩm dự phòng phải được gửi trước. 

 
 

 

(1) Loại dễ thay thế 

Thay thế module loại khối block rất dễ. Chỉ cần thay thế module khi nó có lỗi  

 
(2) Loại bộ nhớ 

Để sử dụng thẻ nhớ RAM cơ bản hoặc SRAM cơ bản, cần có pin dự phòng. 

ROMs tiêu chuẩn, card Flash, và card ATA không cần pin để sử dụng, bên cạnh 

đó, bộ nhớ này ngăn cản chương trình thay đổi do lỗi liên quan đến con người. 

Bộ nhớ này nên được sử dụng trên sản phẩm để xuất 

 
(3) Giảm số loại module 

Giảm số loại module rất hiệu quả cho việc giảm số lượng loại sản phẩm dự 

phòng. 

 
(4) Đặt trước điểm I/O  

Bằng việc không sử dụng hết điểm I/O trên 16-, 32-, và 64-điểm module I/O 

nhưng đặt trước 10% đến 20% của chúng, có thể chỉ cần thay đổi đi dây và 

chương trình (tín hiệu I/O) thay vì thay thế module lỗi với một module dự phòng 

khi mà module dự phòng không có. 

 
(5) Tạo tài liệu 

Bởi vì chương trình tuần tự rất dễ chỉnh sửa, sự không nhất quán giữa một 
chương trình đang hoạt động và tài liệu có thể xảy ra (ví dụ biểu đồ ladder, danh 
sách chương trình). 
TIếp tục cập nhật tài liệu. 
Để làm điều đó, sử dụng máy in sẽ rất hiệu quả. 

 

 

(6) Am hiểu thiết bị ngoại vi 

Thuần thục thiết bị ngoại vi như một máy tính cá nhân, GX Works2 giúp phục 

hồi nhanh từ một sự cố. 
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(7) Sản phẩm dự phòng 
 

Table 9.3 Spare products 
 

 Tên sản phẩm Số lượng Điểm 
 

 

 

1 

 

 

 

Pin 

 
 
Một hoặc hai 

Vòng đời của pin lithium là khoảng 5 năm. 

Vì thế, không nên lưu trữ trong kho thường xuyên nhưng 

khi cần thiết thì phải đặt mua. Tuy nhiên, giữ trong kho 

một hoặc hai phòng trừ sự cố. 
 

 

 

2 

 

 

 

Module I/O 

 

 

Một với mỗi 

loại module 

Lưu ý rằng module I/O thường gặp lỗi trong quá trình 

kiểm tra.. 

Cũng lưu ý rằng công tắc module đầu ra được sử dụng 

trong thời gian dài. 

 
3 

 
Module CPU  

Một với mỗi 

loại model 

 
Module CPU và thẻ nhớ là những thành phần cốt lõi của 

một bộ điều khiển khả trình, nghĩa là một lỗi của nó sẽ 

khiến cả hệ thống ngừng trệ. 
 

4 

 
Thẻ nhớ 

Một với mỗi 

loại model 

 

 

5 

 
Module cấp 

nguồn 

 
Một với mỗi 

loại model 

Tương tự như trên. Khi nhiệt độ của module cấp nguồn 

tăng nhanh, và nhiệt độ môi trường tăng cao có thể làm 

ngắn đi thời gian sông của nó. 
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Hiển thị lỗi sử dụng đèn thông thường 

Hiển thị mã lỗi trên màn hình số thông thường 

9.6 Sử dụng sản phẩm hỗ trợ 

 
Dưới đây là ví dụ của sản phẩm hỗ trợ trong trường hợp hệ thống hoặc thiết bị sử 

dụng khối điều khiển khả trình thông báo một lỗi tìm thây hoặc trạng thái hoạt động  

đến người điều hoành hoặc người bảo dưỡng trong suốt quá trình điều khiển tự 

động. 
 

1.  

Kết nối đèn lỗi đến module đầu ra của khối điều khiển khả trình thế nên đèn 

nháy khi phát hiện một lỗi. 
 

 
 

 
 

2.  

Kết nối màn hình số đến module đầu ra của khối điều khiển khả trình vì thế 

neen số mã lỗi của lỗi phát hiện được sẽ được chỉ ra trên màn hình kĩ thuật    

số. 
 

 
 

 
 

 

Lưu ý  

Chương trình trên không thể thực thi khi có một lỗi báo dừng.. 

Module đầu ra(Y70 đên Y8F) 

Đèn báo lỗi 

Mã lỗi       Mã lỗi 

0 0 3     2 

Điều khiển 

SM1 Số hiệu mã lỗi được hiển thị 

trên màn hình số khi phát hiện 

lỗi 
BCD SD0 K2Y70 

(Mã lôi) Phát hiện lỗi 

Hiển thị số học 

Module đầu ra(Y50 đến Y6F) 

Đèn hiển thị lỗi 

Điều khiển 

SM412 SM1 
Đèn (Y50) nháy khi phát 

hiện lỗi. 
Y50 

Phát hiện lỗi (1-sec. clock) 

Đèn nháy 
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Hiển thị nội dung của lỗi phát hiện trên màn hình 

 

3. 

Thông tin chi tiết lỗi của khối điều khiển khả trình có thể được hiển thị trên một 

màn hình CRT, plasma, và tinh thể lỏng.. 
 

 
 

 

 
 

MELSEC-Q trợ giúp rất nhiều loại GOTs (Màn hình hiển thị đồ họa). 

Cùng với chức năng hiển thị lỗi, GOTs có rất nhiều chức năng hữu dụng như giám 

sát đồ họa, giám sát ladder, giám sát thiết bị, công tắc bảng chạm, và chức năng   

in . 

(Xem lại mục lục để biết thêm chi tiết.) 

Bắt đầu bước 1 phát triển 

Tay  

Lỗi xảy ra! 00070 

Màn hình hiển thị 

Băng chuyền 
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Phụ lục 
 

Phụ lục 1    Chế độ điều khiển I/O 

 
 CPU hỗ trợ hai loại chế độ điều khiển: Chế độ điều khiển trực tiếp và chế độ điều 

 khiển tự động làm mới. 

 

  Phụ lục 1.1 Chế độ điều khiển trực tiếp 

 
 Trong chế độ trực tiếp, tín hiệu đầu vào được nhập đến thiết bị điều khiển khả trình 

 mỗi khi chúng được nhập vào và được xử lý như thông tin nhập vào.  

 Kết quả hoạt động của chương trình được xuất ra bộ nhớ ngoài và module đầu ra.  

 Đồ thị sau đây cho thấy luồng của I / O dữ liệu trong chế độ trực tiếp. 
 

Thiết bị khả trình 
 

 
 

                                       •  Khi câu lệnh công tắc dữ liệu đầu vào được thi hành: 
                                          Hoạt động OR được thi hành ở thông tin đầu vào 1), từ input module và thông tin  
                                          đầu vào 2) trong bộ nhớ dữ liệu. Sau đó kết quả được dùng làm thông tin đầu vào  
                                          3) thực hiện tại chương trình tuần tự. 
                                       •  Khi  câu lệnh công tắc dữ liệu đầu ra được thi hành: 
                                          Đầu ra thông tin 4) được đọc từ bộ nhớ dữ liệu cho đầu ra (Y), và  chương trình 
                                          tuần tự được thi hành. 
                                       •  Khi câu lệnh đầu ra OUT được thi hành: 
                                          Kết quả hoạt động 5) của chương trình tuần tự được xuất đến output module, và 
                                          được lưu trữ trong bộ nhớ dữ liệu cho đầu ra (). 
                                       •  Khi QCPU thực hiện I/O trong chế độ trực tiếp, chương trình tuần tự sử dụng DX  
                                          cho đầu vào và DY cho đầu ra. 
                                       •  Khi QCPU thi hành I / O trong chế độ trực tiếp, chương trình tuần tự sử dụng  
                                          Sự truyền vô tuyến tầm xa cho dữ liệu nhập vào DX và cho đầu ra DY.   

CPU 

(thao tác xử lý) 

Bộ nhớ dữ liệu của đầu 
vào(X) 
 

2) 1) Kiểm tra hoạt động thiết bị ngoại vi           

Liên kết làm tươi của MELSECNET/H 

Ghi  từ modules giao tiếp  tuần tự, etc 

Module 
đầu vào 

3) 

X0 

Bộ nhớ dữ liệucủa đầu ra 
(Y) 
 

4) 

Y75 
Thi hành lệnh OUT trong chương trình 
tuần tự                                                   
Kiểm tra hoạt động thiết bị ngoại vi           
Ghi  từ modules giao tiếp  tuần tự, etc. 

Module  
đầu ra 
 

Y70 

5) 
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Phụ lục 1.2 Chế độ tự động làm mới 

 
  Ở chế độ tự động làm mới, tất cả các thay đổi xảy ra trong module đầu vào được        

  xuất đến đầu vào của bộ nhớ dữ liệu trong thiết bị khả trình CPU trước  

  mỗi lần quét. Dữ liệu trong bộ nhớ dữ liệu được bộ nhớ dữ liệu được dùng cho  

  hoạt động này. 

  Kết quả hoạt động của chương trình cho đầu ra (Y) được lưu đến đầu ra bộ nhớ  
  dữ liệu ở mọi hoạt động. Tất cả dữ liệu lưu trữ trong đầu ra bộ nhớ dữ liệu là một  
  khối - dữ liệu ra đến module đầu ra sau khi triển khai hướng dẫn END.  
  Đồ thị sau đây cho thấy luồng của I / O dữ liệu trong chế độ tự động làm mới. 

 

 

Thiết bị khả trình 
 

 
 

 

• Đầu vào chế độ tự động làm mới 
Dữ liệu đầu vào trong module đầu vào là khối - đọc 1 ) trước khi thi hành của bước 
0, và lưu trữ đến bộ nhớ dữ liệu cho đầu vào ( X ).   

• Đầu ra làm tươi 
Dữ liệu 2 ) trong bộ nhớ dữ liệu cho đầu ra ( Y ) là khối - đầu ra đến module đầu ra 
trước khi thi hành của bước 0. 

• Khi lệnh địa chỉ công tắc đầu vào được thi hành : 
Dữ liệu đầu vào được đọc từ bộ nhớ dữ liệu cho đầu vào ( X ) 3 ), và chương trình 
tuần tự được thi hành. 

• Khi lệnh địa chỉ công tắc đầu ra được thi hành : 
Dữ liệu đầu ra 4 ) được đọc từ bộ nhớ dữ liệu cho đầu ra ( Y ), và chương trình tuần 
tự được thi hành. 

                                        •  Khi đầu ra lệnh OUT được thi hành : 

Kết quả thao tác của chương trình tuần tự 5 ) được lưu trữ trong bộ nhớ dữ liệu 

cho đầu ra ( Y ).

CPU 

(thao tác xử lý) 

Khi đầu vào  
được làm 
tươi 1) 

3) Bộ nhớ dữ liệu  
 

  

X0 

4) 

Khi đầu ra 
được làm 

tươi 2) 

Y75 Bộ nhớ dữ liệu 
cho đầu ra  (Y) 
 

Output 
module Y70 

5) 

1) 

Module 
đầu vào 

Module 
đầu ra 
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Phụ lục 1.3 So sánh giữa chế độ trực tiếp và chế độ tự động làm mới cho đầu ra ( Y ). 

 
                              Ở  ví dụ sơ đồ bậc ladder cho dưới, bật đầu vào X0 bật đầu ra Y70. 

 
 

Mục                        Chế độ trực tiếp Chế độ tự động làm mới 
 

 

1. Ví dụ  ladder 

 
DX0 

Y70 

 
X0 

Y70 

 

 

 

 

 

 

 

 

 

2.  Độ trễ phản hồi  

từ lúc đầu vào 

được  thay đổi 

đến khi đầu ra 

thay đổi theo. 

 

Thực thi chương trình 

Lệnh đầu vào (LD X0)  

Lệnh đầu ra (OUT Y70) 

0 END    0 0 0 END 
 

 

Độ trễ tối thiểu 

X0 

Y70 
Rơ le 

(thời gian thực hiện lệnh) 
 

 

Độ trễ tối thiểu 

 X0 

Y70 
Rơ le 

(quét lân 1) 
 
 

 

 

• Thời gian trễ khoảng từ 0 (chỉ trong thời gian 
thực hiện của lệnh) đến 1 quét. 

• Thời gian trễ là từ 0 đến 1 quét. 

 

Thực thi chương trình 

 
Lệnh đầu vào (LD X0)  
Lệnh đầu ra (OUT Y70) 

 
0 END 0 END 0 

Làm tươi đầu vào 

Độ trễ tối thiẻu 
làm tươi đầu ra 

X0 

Đầu vào bên trong 

 
Y70 

Rơ le (quét 

lần 1) 
Độ trễ tối thiểu 

 

 

X0 

Đầu vào trong 

 
Y70 

Rơ le 

(quét lần 2) 
 

 
 

• Thời gian trễ khoảng từ 1 đến 2 quét. 

• Thời gian trễ là từ 1 đến 2 quét. 

3. Thời gian 
thực hiện lệnh  
I / O 

• . Chế độ trực tiếp cần thời gian dài hơn chế độ 
làm tươi vì một thiết bị khả trình truy cập 
module I / O  

• Nói chung, chỉ cần thời gian ngắn vì thiết bị khả 
trình  truy cập bộ nhớ dữ liệu. 

 

 

 
4. thời gian quét 

• Thời gian quét là dài hơn thời gian thực hiện 

của lệnh I / O.  

• Thời gian quét thực tế là thời gian thực hiện 

chương trình. 

• Thời gian quét ngắn hơn thời gian thực hiện 
lệnh I / O. 

Thời gian quét thực tế là tổng thời gian của 

thực hiện chương trình, chuyển giao dữ liệu 

nhập vào, và chuyển giao dữ liệu đầu ra. 
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Phụ lục 2 Rơ le đặc biệt 

Mạch Rơ le đặc biệt ( SM ) là mạch rơ le bên trong có tác dụng là cố định ở bộ điều 
khiển khả trình. Vì lý do này, thanh ghi đặc biệt không thể sử dụng giống như những 
thanh ghi bên trong khác được dùng trong chương trình tuần tự.  Tuy nhiên, bit của 
rơ le đặc biệt có thể bật hoặc tắt khi cần thiết để điều khiển module CPU.   

Sau đây là cách để đọc khoản mục trong danh sách. 

Để biết thêm chi tiết của mạch rơ le đặc biệt, tham khảo bản hướng dẫn sử dụng 

Phần cứng QCPU, Bảo trì và kiểm duyệt. 
 
 

F
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r
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t
e
m
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,
 
T
h
TTham khảo tài liệu hướng dẫn của này: 

• Đối với các mục liên quan đến mạng -> Tài liệu hướng dẫn sử dụng đối với mỗi 
module mạng 

• Đối với chương trình SFC Hướng dẫn lập trình MELSEC-Q/L/QnA (SFC). 

 

GỢI Ý  

Không thay đổi giá trị của rơ le đặc biệt thiêt lập bởi hệ thống sử dụng chương 
trình hoặc bằng thao tác kiểm tra.   
Làm vậy rất có thể dẫn đến kết quả hệ thống xuống hay gặp sự cố giao tiếp. 

Mục Mô tả 

Số  • Biểu thị các số rơ le đặc biệt . 

Tên  • Biểu thị các tên rơ le đặc biệt 

Ý nghĩa • Biểu thị nội dung của rơ le đặc biệt. 

Giải thích • Giải thích nội dung đặc điểm của rơ le đặc biệt 

 

 

 

 

 

 

 

 

 

 

Thiết lập bởi 

(khi thiết 

lập) 

• Biểu thị các thiết lập bên và thiết lập thời gian cho thanh ghi đặc biệt 

<thiết lập bởi> 

S :  thiết lập bởi hệ thống 

U :  thiết lập  bởi  người sử dụng (trong chương trình tuần tự hoặc 

kiểm tra quá trình hoạt động  của các thiết bị ngoại vi) 

S/U : thiết lập bởi hệ thống và người dùng. 

<thiết lập khi> Chỉ biểu thị khi hệ thống đã thiết lập xong.  

Mọi xử lý  END     :  Thiết lập trong mỗi xử lý END  

Ban đầu  :  Thiết lập trong xử lý ban đầu (sau khi nguồn 

bật hoặc trạng thái chuyển từ Stop sang Run ) 

Trạng thái thay đổi :  Thiết lập khi trạng thái hoạt động được 

thay đổi 

Lỗi  : thiết lập nếu lỗi xảy ra 

Thực thi lệnh  :  Thiết lập khi lệnh được thi hành   

      Yêu cầu  :  Thiết lập khi được yêu cầu bởi người dùng ( sử dụng rơ 
le đặc biệt ) 

      Khi hệ thống được chuyển mạch :  Thiết lập khi hệ thống được chuyển 
mạch ( giữa hệ thống kiểm soát và hệ thống dự phòng) 

ACPU 

M9□□□ 
tương ứng 

• Biểu thị rơ le đặc biệt (M9□□□) Được hỗ trợ bởi ACPU. 

("M9□□□ định dạng thay đổi "  biêu thị cho 1 ứng dụng đã thay đổi. 

Không tương thích với Q00J/Q00/Q01, và QnPRH.) 

•   "New" biểu thị thêm một Q - chuỗi CPU. 

 

 

 

 

CPU tương 

ứng 

Biểu thị CPU module hỗ trợ  rơ le đặc biệt  

.QCPU :  tất cả Q-chuỗi CPU modules 
Q00J/Q00/Q01 :  Mô hình cơ bản  
QCPU Qn(H) :  Mô hình hiệu suất cao QCPU 

QnPH :  Quy trình CPU 

QnPRH :  Dư thừa CPU 

QnU :  Mô hình phổ biến QCPU 

Tên module CPU    :  Chỉ mô hình CPU xác định (Ví dụ: Q02U) 
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Phụ lục  3 Thanh ghi đặc biệt 

 
Thanh ghi đặc biệt ( SD ) là thanh ghi bên trong có ứng dụng là cố định ở  thiết bị 

khả trình. Vì lý do này, thanh ghi đặc biệt không thể sử dụng giống như thanh ghi 

bên trong khác được dùng trong chương trình trình tuần tự. Tuy nhiên, dữ liệu có 

thể được ghi cho thanh ghi đặc biệt để điều khiển module CPU khi cần. 

Dữ liệu được lưu trữ trong dạng nhị phân nếu chưa xác định. 

Sau đây là cách để đọc khoản mục trong danh sách. 

Để biết thêm chi tiết của mạch rơ le đặc biệt, tham khảo bản hướng dẫn sử dụng 

Phần cứng QCPU, Bảo trì và kiểm duyệt. 

 
 
 

F
o
r
 
d
e
t
a
i
l
s
 
o
n
 
t
h
e
 
f
o
l
l
o
w
i
n
g
 
i
t
e
m
s
,
 
T
Tham khảo tài liệu hướng dẫn tại đây 

• Đối với các mục liên quan đến mạng -> Tài liệu hướng dẫn sử dụng đối với mỗi 
module mạng 

• Đối với chương trình SFC Hướng dẫn lập trình MELSEC-Q/L/QnA (SFC). 

GỢI Ý  

Không thay đổi giá trị của rơ le đặc biệt được thiêt lập bởi hệ thống sử dụng 
chương trình hoặc bằng thao tác kiểm tra.   
Làm thế  rất có thể dẫn đến kết quả hệ thống dừng hay gặp sự cố giao tiếp. 

Mục Mô tả 

Số  • Biểu thị các số rơ le đặc biệt . 

Tên  • Biểu thị các tên rơ le đặc biệt 

Ý nghĩa • Biểu thị nội dung của rơ le đặc biệt. 

Giải thích • Giải thích nội dung đặc điểm của rơ le đặc biệt 

 

 

 

 

 

 

 

 

 

 

Thiết lập bởi 

(khi thiết 

lập) 

• Biểu thị các thiết lập bên và thiết lập thời gian cho thanh ghi đặc biệt 

<thiết lập bởi> 

S :  thiết lập bởi hệ thống 

U :  thiết lập  bởi  người sử dụng (trong chương trình tuần tự hoặc 

kiểm tra quá trình hoạt động  của các thiết bị ngoại vi) 

S/U : thiết lập bởi hệ thống và người dùng. 

<thiết lập khi> Chỉ biểu thị khi hệ thống đã thiết lập xong.  

Mọi xử lý  END     :  Thiết lập trong mỗi xử lý END  

Ban đầu  :  Thiết lập trong xử lý ban đầu (sau khi nguồn 

bật hoặc trạng thái chuyển từ Stop sang Run ) 

Trạng thái thay đổi :  Thiết lập khi trạng thái hoạt động được 

thay đổi 

Lỗi  : thiết lập nếu lỗi xảy ra 

Thực thi lệnh  :  Thiết lập khi lệnh được thi hành   

      Yêu cầu  :  Thiết lập khi được yêu cầu bởi người dùng ( sử dụng rơ 
le đặc biệt ) 

      Khi hệ thống được chuyển mạch :  Thiết lập khi hệ thống được chuyển 
mạch ( giữa hệ thống kiểm soát và hệ thống dự phòng) 

ACPU 

M9□□□ 
tương ứng 

• Biểu thị rơ le đặc biệt (M9□□□) Được hỗ trợ bởi ACPU. 

("M9□□□ định dạng thay đổi "  biêu thị cho 1 ứng dụng đã thay đổi. 

Không tương thích với Q00J/Q00/Q01, và QnPRH.) 

•  "New" biểu thị thêm một Q - chuỗi CPU. 

 

 

 

 

CPU tương 

ứng 

Biểu thị CPU module hỗ trợ  rơ le đặc biệt  

QCPU :  tất cả Q-chuỗi CPU modules 
Q00J/Q00/Q01 :  Mô hình cơ bản  
QCPU Qn(H) :  Mô hình hiệu suất cao QCPU 

QnPH :  Quy trình CPU 

QnPRH :  Dư thừa CPU 

QnU :  Mô hình phổ biến QCPU 

Tên module CPU    :  Chỉ mô hình CPU xác định (Ví dụ: Q02U) 
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X0 

X1 

X2 T1 K5 
T0 

T0 K5 
T1 

Y70 

T0 
Y71 

Phụ lục 4 Ví dụ trình ứng dụng  

Phụ lục 4.1  Flip-flop ladder 

(1) Y70 bật khi X0 được bật, và tắt khi X1 được bật. 

 

0 SET 

 

2 RST 

Y70 

Y70 

 

(2) Khi X2 được bật, Y71 tắt nếu Y70 đang mở, và bật nếu Y70 không làm việc.  

Thao tác mạch Flip-flop này được lặp lại. 
 

Tên dự án QA-16 

Tên chương trình MAIN 
 

 

0 

 

6 

 

 

12 

 

 

X02 

C ô n g  
tắ c  T0 

C ô n g  
tắ c  T1 

Y70 
Y71 
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X2 T1 K50 
T0 

T1 

T0 
PLS M0 

Y70 

M0 
RST T1 

T0 K50 
T1 

T1 

T1 
Y71 

PLS M1 

M1 
RST T0 

(3) Hoạt động  Flip -flop bắt đầu khi X2 được bật. Trong hoạt động này, Y70 bật 

nếu T0 đang mở, và Y71 bật nếu T1 đang mở. ( Chu kỳ : 10s. ). 
 

Tên dự án QA-17 

Tên chương trình MAIN 

 

 

0 

 

 

7 

 

 

11 

 

16 

 

 

22 

 

 

26 

 
 

 

X2 

Công  tắc 
T0 

Công tắc 
T1 

Y70 
 

Y71 
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X1 K70 
T15 

T15 
Y75 

Thời gian cài 
đặt 10s 

7sec. 

X0 T16 K100 
T16 

Y76 

Y76 

X0 
PLF M1 

M1 T16 K100 
T16 

Y76 
Y76 

Phụ lục 4.2    Bật thời gian ngắn (one shot). 

 
(1) Sau khi đầu vào X1 được bật, đầu ra cũng khởi động và tiếp tục trong một 

khoảng thời gian xác định. ( Thời gian cho đầu vào phải dài hơn thời hạn ấn 

định.) 

 

0 
 

 
 
 

X1 
Tiếp điểm thường 
đóng T15 

 

 

Y75 

 
 

 

(2) Ngay khi đầu vào X0 được bật, thì Y76 được bật trong thời gian nhất định. 

 

0 

 

 
 
 

(3) Đầu ra chắc chắn bắt đầu và tiếp tục khi X0 đầu vào được chuyển từ bật sang 

tắt. 

 

0 

 

3 

 

 
 
 

X0 

Y76 

 

 

 
Thời gian tối 

đa 10s 

 

 

 

 
Khoảng thời gian tồn tại xung nhịp
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X2 K30000 
T9 

K20000 
T10 

T9 

T10 
Y72 

3000s 2000s. 

5000s. 

X2 M56 Y73 K9000 
T14 

X2 C7 
Y73 

Y73 

T14 K4 
C7 

M56 

C7 
RST C7 

900s × 4 = 3600s = 1 giờ 

Phụ lục 4.3 Bộ định thời gian dài 

 
(1) Thời gian cần đạt được bằng cách kết nối các bộ định thời  nối tiếp. 

 

0 3000.0s. 
 

5 2000.0s. 
 

10 Bật sau khi thời   

11 gian tối đa trôi qua                                
 

 

X2 

Công tắc 
thường T9 mở  

Công tắc 
thường T10 
Y72 mở  

Y72 

 
 

 

(2) Thời gian cần đạt được bằng cách sử dụng bộ định thời và bộ đếm. 

Thời gian giới hạn của bộ định tuyến × giá trị thiết lập của bộ đếm= Bộ định thời 

gian lớn( lưu ý rằng độ chính xác của bộ định thời được tích luỹ. ) 
 

Tên dự án QA-18 

Tên chương trình MAIN 
 

 

0 

7 Bật sau khi thời  

12 gian giới hạn trôi 

                                                                                                                                                                        qua 

 

 

18 
 

 
 

X2 
 

Cuộn T14 

Công tắc thường  
mở  (M56) 

C7 

Y73 

 
                                    (Chú ý)   Thời gian đủ được thu với bộ đếm C7, nó đếm số lần tạm ngưng của bộ định 

                                                thời T14. 

M56 thiết lập lại T14 sau khi thời gian tạm ngưng. Với C7, đầu ra Y73 là tự - 

tiếp năng lượng trong khi bộ đếm đang được hoạt động. Với Y73, T14 thiết 

lập lại và bộ đếm thời gian sau bị tạm dừng. 
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Y70 X5 K8 
T6 

X5 T6 
Y70 

Y70 

Thời gian tối 
đa 0.8s. 

0.8s. 

X5 T8 
Y71 

Y71 

X6 Y71 K41 
T8 

M45 
M45 

Thời gian tối 
đa 10s 

4.1sec 

Phụ lục 4.4 Bộ định thời tắt trễ ( off-delay) 

 
                                      MELSEC - Q không quản lý bộ định thời tắt trễ. Cấu hình bộ định thời tắt trễ ra như   

sau: 

 
                                     (1)  Bộ định thời T6 bắt đầu vận hành khi X5 tắt. 

0 

 

6 

 
 
 

 

X5 

CuộnT6 

Tiếp điểm thường 
đóngT6 

 

Y70 
 

 

 

 

 

                                      (2)  Bật X5 ngay khi thiết lập hoạt động sẵn sàng.  
     Bộ định thời T8 bắt đầu hoạt động ngay khi X6 bật. 

 

0 

 

 

4 

 

 
 
 

X5 
 

X6 
 

Cuộn T8, M45 

Tiếp điểm thường 
đóng T8 

 

Y71 

 
 

 
                                    
                                    (Chú ý)  Ladder bên trên sử dụng như một ladder trễ quá trình đóng khi bật đầu 
                                                  vào X5 và X6. 
                                                  M45 tương đương với địa chỉ công tắc tạm thời của T8.
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X1 X2 K62 
T4 

M50 
M50 

T4 
Y70 

T4 
Y71 

Phụ lục 4.5 Bộ định thời bật trể (On-delay ) 

 
Bộ định thời bật trễ của bộ điều khiển khả trình hoạt động dễ dàng với đầu vào liên 

tiếp nhau. Rơ le M được sử dụng với đầu vào tạm thời. 
 

Tên dự án QA-19 

Tên chuong trình MAIN 
 

 

0  Bộ định thời bắt đầu sau      
. khi x1 bật và tiếp tục 
được kích hoạt 

8 Bật 6.2s.  

10 Tắt sau 6.2s.  

 

 

X1 
X2 

 

 

T4,M50 
 

Y70 
Y71 

 

Thời gian tối 

đa 6.2s. 
 

(Chú ý ) Ladder bên trên sử dụng như ladder on delay ngay khi đầu vào X1 và X2 

được bật. 
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X1 

K2 X0 
T1 

T1 
M1 

Phụ lục 4.6 Ladder lặp ON-OFF 

 
Ở ladder On - OFF, Y70 bật khi X1 được bật, và tắt khi X1 được bật lại. 

 

0 FF Y70 

 

 
 

 

Phụ lục  4.7 Chống lặp đầu vào 

 
Bộ định thời thiết lập sao cho nó bắt đầu ở đầu ra khi đầu vào giữ được trên cho 0.2s. 
 

 

0 

 

5 
 

 

 

M1 bật khi X0 giữ được trên cho 0.2s, hoặc dài hơn. Do đó, sử dụng M1 thay cho 

X0 khi tạo ra chương trình.
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Phụ lục 4.8 Ladder với tuyến chung 

 
Ladder sau không thể hoạt động như bình thường. Để ladder dễ điểu khiển, thì sử 

dụng lệnh điều khiển chính ( MC, MCR ) trong chương trình. 
 

  
 

Tên dự án QA-1 

Tên chương trình MAIN 
 

Chương trình tuần tự với lệnh điều khiển chính 

X0 X1 
0 MC N0 

 

 
X2 

4 
X6 X7 

 

 

 

 

M1 
 

 

 

M10 

 

 

 

 

 

 

 

 

Mạch thủ công 

6 M11 
 

9 
X1 X0 

10 
 

 
X4 X3 

14 
X7 Y79 

 

MCR 
 

MC N0 

 

N0 

M2 

 

 

M20 

 

 

 

 

 

 

 
Mạch tự động 

17 M21 
 

20 
M10 

 

 
Y71 

 

MCR N0 

21 Y70 

M20 
 

M11 X2 
25 Y71 

M21 

Mạch chung 

 

Y71 
 

 

Chú thích ) Trong GX Works2, trạng thái bật / tắt của bộ điều khiển chính được hiển thị trong thẻ tiêu đề đi cùng màn 
hình thiết bị hiển thị. 

Ladder lặp 

Hướng dẫn tự 
động 

X0 X1 X4 X3 Y71 
Y70 

X2 

X7 Y79 X2 
Y71 

X6 
X7 

Y71 
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Y70 

Y71 

5 9 

Phụ lục 4.9 Chương trình điều khiển thời gian 

 
Giá trị thời gian được thiết lập bởi hai chữ số của bộ chuyển mạch kỹ thuật số. Hiện 

tại khoảng thời gian đã qua được hiển thị trên Y40 đến Y47 trong khi đầu ra Y70 

đến Y72 bật sau khi thời gian giới hạn đã trôi qua. 

Thao tác này cứ thế được lặp lại. 

 
                Bộ chuyển mạch kỹ thuật số cho thời gian 

thiết lập 

Hiển thị cho thời gian hiện hành 

 

 

 

 

 
                               

        

 

0.1s đơn vị    Thiết bị điều            
                          khiển lập trình      

X20 đến 27         đươc 

 
X3 

2 6 
Y40 đến 47 

 

0.1s đơn vị 

                Nút nhấn cho thời gian đọc 

 Công tắc thời gian    X4      

             Công tắc hoạt  động X5 

                                       

Bật khi giá trị hiện thời 
nhỏ hơn 2s 

 Bật khi giá trị hiện thời 
chỉ là 3. 

Y72 Bật khi giá trị hiện thời là 
4 hoặc hơn. 

 

 

Tên dự án QA-2 

Tên chương trình MAIN 

 
X3 

0 
M5 

3 
X4 T4 

7 
T3 

 

 

 

 

 

 

<> K0 D1 

 

 

 
BIN 

 
PLS 

K2X20 

M5 

D1 
D1 

T3 
K10 

 

 

 

Thời gian đã định 2 chữ số 
trong 0.1 s đơn vị 

Bắt đầu bộ 
định thời, lặp 
lại on/off 

16 T4 
X5 

21 
 

> K20 T3 
 

= K30 T3 
 

< K40 T3 

BCD T3 K2Y40 
 

Y70 

Y71 

Y72 

Giá trị thời gian tại đầu ra 
Bật khi T3 từ 0.1s đén 1.9s 

Bật khi T3=1.9s. 

Bật khi T3 =4.1s hoặc hơn. 
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4 7 

1 8 

6 4 

Phụ lục 4.10 Đồng hồ ladder 

 
Dữ liệu đồng hồ như là giờ, phút, và giây là đầu ra đến màn hình kỹ thuật số. 

 

Tên dự án QA-3 

Tên chương trình MAIN 

 

T1 
0 T0 

T0 
5 T1 

T1 

K5 

K5 

K60 

 

 
0.5-s. chập chờn 

10 C11 
C11 

Bộ đếm giây 

15 
 

 
C12 

24 
 

 
C13 

33 
SM400 

38 

 

 

 

 

 

 

 

 

 

 
BCD 

RST 
 

 

 

RST 
 

 

 

RST 

C11 

C11 

K60 
C12 

 

C12 

K99 
C13 

 

C13 

K2Y40 

 

 

Bộ đếm phút 
 

 

 

Bộ đếm giờ 

BCD C12 K2Y48 
 

BCD 
 

C13 
 

K2Y50 

 

 
 

 

 

Giây 
 

 

 

 

 

 

 

 

 

Phút 

 

 

 

 

 

K2Y40 
 

 

 

 

 

 

 

 

 

K2Y48 

0 
Một 1 

số 2 

3 

4 

Mười  5 
Chữ số 6 

7 

8 
Một 9 

số A 

B 

Mười 
C

 

Số 
D

 
E 

F 

 

 

Một 

chữ 

số 

 

 
Mườ
i 
chữ 
số 

 

 

 

 

 

K2Y50 

 

 

 

Giờ 

 

LED của module đầu ra 

 

 

 
8 4 2 1 8 4 2 1 8 4 2 1 8 4 2 1 8 4 2 1 8 4 2 1 

Mười chữ 
số 

Một chữ 
số 

Mười 
chữ số 

Một chữ 
số 

Mười 
chữ số 

Một chữ số 

K2Y50 giờ, đầu ra K2Y48 phút, đầu ra K2Y40 giây, đầu ra

Bật   Bật Bật Bật   Bật Bật Bật   Bật   Bật 

Y57  Y56  Y55  Y54  Y53  Y52  Y51  Y50  Y4F  Y4E  Y4D Y4C Y4B  Y4A  Y49 Y48  Y47  Y46  Y45  Y44  Y43  Y42  Y41  Y40 
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Tên dự án QEX13 

Phụ lục 4.10.1 Chức năng clock (Bổ sung) 

 
 Ladder sau đây hiển thị thời gian thiết lập GX Works2 đến máy chứng minh Q. 
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X0 X1 
Y70 

K20 Y70 Y72 
T5 

Y70 T5 Y72 
Y71 

K5 T5 
T6 

T6 Y70 Y71 
Y72 

Y72 

Phụ lục 4.11 Khởi động sao /Tam giác: 

 
Bật công tắc khởi động hoạt đông           . Sau họat động             đã trôi qua, chế 

độ hoạt động 6 được kích hoạt thông qua trạng thái cung đồng bộ hóa. 

 

Tên dự án QA-20 

Tên chương trình MAIN 

 

 

0 hoạt dộng nội bộ 
 

                                                                                 Chu kỳ định thời             
 

9 hoạt động 
  

13 cung đồng bộ hóa 
 

18 hoạt động 

 

 

 
 
 

Bắt đầu X0 

dừng X1 

 

Hoạt động 
Y70 

 

 

Y71 

Y72 

 

 
Hoạt 

động 
 

 

 

T5 = 2s. 

 

 

 

 

 

Hoạt động 

 

 
 

T6 = 0.5s.  Cung đồng bộ hóa 
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K6000 
T53 

X2 

BCD T53 K4Y60 

= 

Y76 

K500 T53 Y76 

> K120 T53 Y77 

X2 K3000 
T4 

BCD T4 K4Y60 

> K300 T4 Y70 

< K299 T4 > K320 T4 Y71 

< K319 T4 > K340 T4 Y72 

< K339 T4 Y73 

<= K600 T4 Y74 

<= K800 T4 Y75 

Phụ lục 4.12 Hiển thị khoảng thời gian đã qua và đầu ra trước thời gian giới hạn 

 
    Các đầu ra Ladder sau đây, thời gian trôi qua trong bộ định thời trên màn hình 

LED, và cho thấy thiết lập thời gian đã được đạt đến. Hệ thống này cũng có thể 

được đưa vào trong các bộ đếm. 
 

Hiện thị khoảng thời gian 
đã qua (4 con số BCD) 

 

 
Module đầu ra 

 
 

X2 Y6C to 6F 

1 2 3 4 

 

 

Bắt đầu khi bật 
 Dừng khi  tắt  

Y68 to 6B 

Y64 to 67 

Y60 to 63 

× 100 

× 10 

× 1 

× 0.1 

 

 
          Bộ đinh thời bật khi 

0 X2 được bật 

Đầu ra hiện 
hành của bộ 
định thời 

Bật khi giá trị 
hiện tại là 50 
hoặc hơn 

 

Bật khi giá trị 
hiện tại là 12 
hoặc nhỏ hơn 

 

 

   Bộ định thời bật khi 
0 X2 được bật 

     Đầu ra hiện hành của 

        bộ định thời 

 Bật khi giá trị hiện tại là 

30s hoặc nhỏ hơn 

Bật khi giá trị hiệ tại từ 30s 
đến 31.9s 

Bật khi giá trị hiện tại từ 
32s đến 33.9s 

Bật khi giá trị hiệ là 34s 
hoặc hơn 

Bật khi giá trị hiện tại là 
60s hoặc hơn 

Bật khi giá trị hiện tại là 
80s hoặc hơn 
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X2 
M0 

M0 
PLS M1 

K600 
T195 

M1 
MOV D7 T195 

M0 
MOV T195 D7 

T195 
MOV K0 D7 

Y72 

X2 K600 
ST195 

ST195 
Y72 

X1 
RST ST195 

9 

12 

Phụ lục 4.13 Bộ định thời có nhớ 

 

                                   Đầu vào X2 chuyển đổi liên tục giữa bật và tắt. Số lần bật của X2 được tích luỹ và Y72 

                                   bật theo giá trị tích luỹ n. 

(1) Cho ladder tích luỹ giá trị không có bộ định thời có nhớ 

Tên dự án QA-21 

Tên chương trình MAIN 

 

 

0 Bộ định thời bắt đầu khi 

2 X2 được bật 
 

                                                                                                                                                                         Ghi D7 vào bộ định 

                                                                                                                                                                                                    thời khi X 2n được bật 

Lưu giá trị hiện hành 
cảu bộ địnhthời vào 
D7 

15 Xóa D7 trong thời gian chờ 
 

      
                                                                                             Bật Y72 trong thời gian chờ 

 
 
 

 

(2)   Khi bộ định thời có nhớ được gán trong điều chỉnh thiết bị của bộ định thời 

       lưu giữ tham biến PLC (ST) : 224 điểm ( ST0 đến ST223 ) 

 

Tên dự án QA-8 

Tên chương trình MAIN 
 

 

0 Bộ định thời bật khi X2 được 

1 bật 

5 Không thể xóa khi tăt 

7 Có thể xóa khi X1 được bật 
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X0 
MOV K10 D0 

X1 
MOV K100 D0 

X2 
MOV K1000 D0 

X3 
SET M0 

X4 
RST M0 

M0 D0 
T8 

Y70 

T8 
Y71 

Y72 

Phụ lục 4.14 Bộ định thời chuyển đổi thiết lập thời gian bên ngoài 

 
(1) Với công - tắc ngoài, giá trị để được thiết lập bởi một bộ định thời có thể được 

chọn lựa từ ba loại ; 1s. , 10s. , và 100s. 

Thiết bị tính giờ được kích hoạt và thiết lập lại với công tắc ấn. 
 
 

1s. 

SC  10s. 

100s. 

PB Starts timer 

 

X0   Y70 

X1 
Y70 

X2 

OL 
Do bộ đinh thời khi 
hoạt động. 

RL 
Đo bộ định thời 
trong thời gian chờ. 

 
PB Đặt lại bộ 
định thời 

X3   Y70 MC 

X4 

Chạy 

 

 

Bộ nguồn ra Bộ nguồn vào 

 

Tên dự án QA-22 

Tên chương trình MAIN 

 

 

0 Thiết đặt giá trị 1s 
 

3 Thiết đặt giá trị 10s. 
 

6 Thiết đặt giá trị 100s 
 

9 Bắt đầu bộ định thời 
 

11 Dừng bộ định thời 
 

12 
 

Bật khi bộ đinh thời 
hoạt động 

19 Bật trong thời gian 

                                                                                                                                                                     chờ 
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Phụ lục 4.15 Thiết lập bộ đếm ngoài 

 
Với bộ chuyển mạch kỹ thuật số ngoài có 4 số, bộ đếm có thể thiết lập từ xa và giá 

trị hiện hành của chúng được hiển thị trong 4 chữ số. Ngoài ra mỗi lần đếm - lên, dữ 

liệu đầu ra của bộ định thời khi nó đạt đến giá trị mức 100 giá trị thiết lập và giá trị 

mức 50 giá trị thiết lập. 

Lưu ý rằng thiết lập lỗi xảy ra nếu giá trị thiết lập của bộ đếm nhỏ hơn 100. 

 
 

 

 

Chuyển đổi kĩ thuật số (BCD 
× 4 chữ số) 

 
1 2 3 4 

I/O 

UNIT1 
 

 

X20 to 2F 

I/O 

UNIT0 
 

 

X0 to 1F 

I/O 

UNIT3 
 

 

Y60 to 6F 

I/O 

UNIT4 
 

 

Y70 to 74 

 

DC12V 
 
 

 

PB 
Cài đặt tín hiệu X0                                                                                                                                                                                                                                                                                            

PB 
Bắt đầu X5 

PB 
Cài lại hoặc dừng lại X1 

 

 

                                                              

 

 

 

 

 

 

 

 
DC12V 

 

 

Y70 

Y71 

Y72 

AC100V 
 

                            Thiết lập lỗi 

                       

               Trong 

                        hoạt động  ON 

RL Bật giá trị cài 

                đặt mức 100 

Bộ đếm sung  X3 
 

 
DC24V 

Hiện thị giá trị hiện 
thời BCD × 4 
chữ số 

 

 
Y73 

R2 
 

 
Y74 

R3 

Bật giá trị thiết lập 
mức 50  
 
Bật khi bộ đém 
dừng 

 

 

Thiết lập giá trị 
 

 
Băt đầu 
bạt X5 
Y71 ON 

Giá trị mức 100 

 Y72 ON 

Giá trị mức 50   
Y73 ON 

Đếm lên 
Y74 ON 

Thiết lập giá trị lớn nhát 9999 

Vùng cài đặt lỗi 
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X0 
SET M0 

X1 
RST M0 

M0 
BIN K4X20 D0 

> 

Y70 

K100 D0 Y70 

M0 
MOV D0 D1 

- K100 D1 

MOV D0 D2 

- K50 D2 

X5 C0 
Y71 

Y71 

Y71 
MC N0 M3 

X3 D0 
C0 

D1 
C1 

D2 
C2 

MCR N0 

X1 
RST C0 

RST C1 

RST C2 

M0 
BCD C0 K4Y60 

C1 
Y72 

C2 
Y73 

C0 
Y74 

 

Tên dự án QA-4 

Tên chương trình MAIN 

 

 

0 Cài đặt 
 

2 
 

4 Đặt lại giá trị cài đặt 
 

Đầu ra lỗi khi giá trị thiết l 

12                                                                                                                                                             là 100 hoặc nhỏ hơn 

                                                        
                                                                                                                                                                                                                                Thiết lập giá trị -100 
         

(giá trị cài đặt mức 100) 
 

          Thiết lập giá  
 

 trị -50(giá trị cài đặt 50) 
     24    

   Hoạt động nội bộ ON 

 

 

28 

 

31 Bộ đếm bật tại điểm  

 dừng 

    Bộ đếm bật giá trị  

     cài đặt mức 100 

   Bộ đếm bật giá trị 

    cài đặt mức 100 

     41 

 45 Đặt lại bộ đếm khi X1 

 được bật 

  

     
 Hiện thị giá trị bộ đếm  

58 ngoài 

 Bật giá trị ở 100 trước 

62                                                                                                                                                                                 khi cài đặt giá trị                                  
 Bật giá trị ở 50 trước khi  
64 cài đặ giá trị 

  Bật bởi bộ đếm lên 
     66 

  

 
 

 

 

  

  
  

  
 

 

 

(Lưu ý ) Trong GX Works2, trạng thái bật/tắt của bộ điều khiển chính được hiện thị qua các thẻ tiêu đề 

trên màn hình.
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Phụ lục 4.16 Đo thời gian hoạt động 

 
Thiết lập thời gian hoạt động cho một bộ điều khiển đích là hữu ích cho việc  phán 

đoán thời gian của bộ phận thay thế và bôi trơn. Các bộ đếm thời gian ST và thanh 

ghi D phải có nguồn điện dự phòng để có thể tiếp tục hoạt động khi mất điện. Với 

các nội dung của D31 (trong một giờ) được hiển thị ra bên ngoài, chương trình có 

thể hoạt động như một bộ đếm thời gian. 

 

Tên dự án QA-23 

Tên chương trình MAIN 

 
X2 

0 
ST250 

5 

 

 

 

 

RST 

K3600 
ST250 

 

ST250 

 

 

Bộ định thời -6 phút 

 

 

 

= K10 

 

 

 

D30 

 

+ K1 
 

MOV K0 

 

D30 

D30 

 

 
Bộ định thời -1 
tiếng 

 
SM400 (always ON) 

21 

+ 

BCD 

K1 

D31 

D31 

K4Y60 

Đo trong 1 
đơn vị giờ 
đồng hồ 

Thời gian hoạt động 
bên ngoài đầu ra 

25 <= K1000 D31 Y70 Biểu thị thời gian 
làm việc 

Bộ điề khiển thời gian cho 100 giờ đồng hồ. 

 

 

 

Phụ lục 4.17   Đo chu trình 
Đo thời gian hoạt động của một bộ điều khiển đích (từ lúc bắt đầu đến kết thúc) cho 

phép hiển thị chu kỳ chờ và quản lý thời gian trễ. 

                                        Ladder sau với các lệnh <,>, và = được sử dụng để xác định trạng thái của và 

. T200 chỉ ra  chu kỳ chờ và đo khoảng thời gian trễ bằng các bộ đếm. 

Tên dự án QA-24 

Tên chương trình MAIN 
 

 

X0 X1 
0 

M56 

 
M56 

 

 

Trong chu kỳ 

 

M56 
4 

 

10 < 
 

14 < 
X7 

24 

 

T200 
 

 

K400 

K300 

 

 

 

 

T200 

T200 

 

 

 

 

 

 

>= K400 

 

 

 

 

 

 

T200 

 

 

 

 

SET 
 

 

 

RST 

RST 

 
K32760 

T200 
 

Y70 

K32760 
C10 

 

Y70 

C10 

 

 

Đo chu kỳ thời gian  

Chu kỳ chạy ngoài 

Chu kỳ thời gian từ  
3.01 đến 4.00s. 

Xóa thời gian chờ hiện thị 
và bộ đếm tích lũy 
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DCML   D0 D20 

D+ K1 D20 

Phần bù 

Phụ lục 4.18 Ví dụ ứng dụng của (D)  C M L (P) 
 

Hình sau đây sẽ giải thích làm thế nào để có được giá trị tuyệt đối của giá trị âm -

32.768 hoặc nhỏ hơn ( -2147483648, 32 bit dữ liệu). 
 

D1 D0 

B  B B  B  B  B B  B 
15 14 1   0  15 14 1   0 

Trước DCML 
thực hiện 

 

 

 

 

Sau khi 
thực hiện 

DCML 
 

 

 

 

Sau khi thực hiện D+ 

1   0   1   1 0   1   0   0   0   1   1 1   0   0   1   0 

(số âm) 

 

 
 

 
 

 
(giá trị tuyệt đối) 

 

(Ví dụ) 

Mỗi lần X1 được bật, 999 trừ một giá trị và kết quả được hiển thị. 

                                       Khi các giá trị kết quả là âm, đầu ra Y70 được bật, và các giá trị tuyệt đối của được  

 hiển thị. 
 

Đọc giá trị 
 

 

 
Trừ (-999) 

 

 

 

Thu được 
 số âm? 

Bật X0 
 

 

 
Bật X1 

 

 

 

Sai 

 

đúng 

Thiết lập Y70  

Thực thi DCML 

+1 
 

 

 
Hiện thị kết quả 

 

 
 

X0 
0 DBIN 

X1 
4 D-P 

 
K4X20 D0 

 

K999 D0 

 

 

Đầu ra dữ 

liệu Trừ 999 

 

 

 
M0 

18 
 

 

 

 
Y70 

31 

D> K0 D0  

 

 

 

DCML 
 

D+ D20 

DBCD 

DBCD 

SET 

PLS 

D0 

K1 

D30 

D0 

Y70 

M0 

D20 

D30 

K8Y40 

K8Y40 

Bật Y70 khi thu được số âm 
 

 
Khi D0 là số âm thêm dấu giá trị tuyệt 

dồi thành số dương) 

Đầu ra giá trị tuyệt đối 

Đầu ra số dương 

D21 D20 

0   1   0   0 1   0   1   1 1   0   0 0   1   1   0   1 

D21 D20 

0   1   0   0 1   0   1   1 1   0   0 0   1   1   1   0 
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Cuối-  Cuối-  Cuối-  
Cuối- Y

4
C

 đ
ế
n
 

4
F
 

Y
4
8
 đ

é
n
 

4
B

 

Y
4
4
 đ

ế
n
 

4
7
 

Y
4
0
 đ

ế
n
 

4
3
 

Phụ lục 4.19  Chương trình hiển thị chia giá trị của 4 chữ số BIN đến 4 hàng chữ số thập phân. 

 

                                      (1)  Ví dụ 1 

                                           Chương trình sẽ hiển thị các kết quả bằng cách sử dụng số bị chia và số chia 

                                           được xác định riêng trong hai thiết bị chuyển mạch kỹ thuật số 4 chữ số trên hai 

                                           màn hình có 4-chữ số (một phần không thể tách rời và phần thập phân). 

Màn hình kĩ thuật số 
 

 
 

 
 

Nhập số bị chia và số chia 

Chia 

Hiện thị thuong số 
 

 

Xóa chỉ số trong thanh ghi z0 
và z1 và dữ lieuj trong z10 

 

Lặp 

 

Thiết lập địa chỉ hiện thị sau 
dấu thập phân 

 

 

Nhân số dư với 10 chia kết quả 
và lấy thương thấp hơn 1 

 

Hiện thị thấp hơn 1 số 

 Số lần đếm 
(thanh ghi Z1) 

Số bị chia chuyển kĩ thuật số  X30 đến 

X3F → D0  

Số chia chuyển kĩ thuật số  X20 đến  

X2F → D1 

 
(D0) / (D1) = (D2) ...... (D3) 

Thương   Số dư 
 
 

 

4 × (Z1) → (D10) HC-(D10) → (Z0) 

1st time 4 × 0 → 0 HC-K0 → HC 

2nd time 4 × 1 → 4 HC-K4 → H8 

3rd time 4 × 2 → 8 HC-K8 → H4 

4th time 4 × 3 → 12 HC-K12 → H0 

(D3) × 10 → (D3) 

(D3) / (D1) = (D2) ...... (D3) 

 

 

 

Sai 

Tiếp 

 

 

 

 

         Thu được 4 ? 
 

 

               Đúng  

INC Z1 

 

 
 

 
 

số 
đầu 
tiên 

 

 

 
 
 

Số 
thứ 
hai 

 

 

 
 
 

Số 
thứ 
ba 

 

 

 
 
 

Số thứ 
tư 

                                                                                     Kết thúc

Chuyển đổi 
kĩ thuật số Y5F đếnY50 Y4F đến 

Y40 
QCPU QX 

42 
QY 
42P 

X3F đến 
X30 

X2F đến 
X20 

X0 
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INC Z1 

Chương trình tuần tự của ví dụ 1  

Câu lệnh For-Next được thực hiện để phân chia mỗi chữ số thập phân riêng và 4 

chữ số thập phân được hiển thị Print K4Y40. 
 

Tên dự án QA-5 

Tên chuong trình MAIN 
 

 

X0 
0 BINP 

 
K4X30 D0 

 
Đọc dữ liệu 

 

BINP 
 

K4X20 D1 
 

/P      D0 D1 

BCDP D2 

DMOVPK0 

MOVP  K0 

 

D2 

K4Y50 

Z0 

D10 

 

Chia 
 

BCD-đầu ra thương số 

Xóa chỉ số thanh ghi Z0 

Xóa D10 

PLS M0 
 

22 
M0 

24 * K4 

 

FOR 

Z1 

 

K4 

D10 

- H0C D10 Z0 
 

* D3 
 

/ D3 

 

K10 D3 
 

D1 D2 

 

 

Lặp 

 

BCD D2 
 

K1Y40Z0 
 

INC Z1 
 

45 NEXT 

 

 

                           Thực hiện lệnh bổ sung thêm Z1. 
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K4Y60 

                             (2)  Ví dụ 2 

Trong ví dụ 2, D0 được chia D1 lấy D5 trong 4 chữ số thập phân. 

Các số bị chia D0 được nhân với 10000. Kết quả của phép chia sử được 

chuyển đổi thành một giá trị BCD và đầu ra với màn hình kỹ thuật số ngoại vi. 

 

K4Y50 K4Y40 

  
D7, phần dư của 
số thập phân 

D6, phần nguyên 
gồm 4 chữ số 

D5, phần thập phân 
gồm 4 chữ số 

 

 

Tên dự án QA-6 

Ten chương 
trình 

MAIN 

 

X0 
0 BINP 

 
K4X30 D0 

 

BINP 
 

K4X20 D1 
 

MOVP  K0 D2 
 

Xóa D2 
 

*P D0 
 

K10000 D3 
 

10000-nếp gập 
 

D/P    D3 D1 D5 
 

DBCDP D5 D5 
 

DBCDP D7 D7 
 

MOVP D6 

MOVP D5 

MOVP  D7 

 

K4Y50 

K4Y40 

K4Y60 

 

Phần nguyên 

Phần thập phân 

Phần dư của phần 
thập phân 
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Phụ lục 4.20  Kiểm soát điều khiển tuyến 

 
Sau đây là một ví dụ về quá trinh điều khiển tuần tự sử dụng một bàn trượt để chở 

sản phẩm (nguyên liệu). 

Chuỗi các thao tác thực hiện trong một chu kỳ như sau; sản phẩm được đặt lên 

băng trượt, băng trượt tiến lên, băng trượt dừng lại ở giới hạn chuyển tiếp, cánh tay 

đẩy công việc đến phía băng chuyền khác, và băng trượt quay lại đến giới hạn về 

phía sau. 
 
 

 

 

Mở khi hoàn thành LS 
(X4) 

        Container sản phẩm   

Sản phẩm LS hiện tại (X1) 

 

 

 

 

 

 

 

 

Đẩy trở lại 
(Y74) 

 

 

 

Đẩy (Y73) 

 Bàn trượt di 
chuyển về 
phía trước 
(Y71) 

 

 

 

 

 

 

 

 

Bàn trượt di 
chuyển trở 
lại (Y72) 

Giới hạn 
phía sau 
LS(X3) 

Bàn trượt 

Bảng điều khiẻn 
 

 

Giới hạn 
phía 
trước LS 
(X2) 

 

 

 
Bộ chỉ thị hoạt 
động(Y70) 

 

 

 
Nút bật (X0) 

 

 

MELSEC-Q 

 

Đầu vào Đầu ra 
 

Nút bật 

X0 
Công tắc (LS hiện tại) 

X1  
                                                 Công tắc (giới hạn trước LS)                        

X2 
                                                    Công tắc (giới hạn sau LS) 

                                                                       X3                

                                                 
                               Công tắc (mở khi hoàn  thành LS)                                 

                                                                                     X4

 

 

Y70 
 

 

Y71 M 
 

 

Y72 M 
 

 

Y73 

Y74 

 

 

Bộ chỉ thị hoạt động  

Xe di chuyển về trước  

Xe di chuyển về sau  

Đẩy vào 

                     Đẩy ra 
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X0    M2 
Y70 

Y70 X1 X3 
M1 PLS 

M1 
Y71 SET 

Y71 X2 
Y71 RST 

Y73 

K30 

SET 

Y73 
T0 

T0 
Y73 RST 

Y74 SET 

Y74 X4 
Y74 RST 

Y72 SET 

Y72 X3 
Y72 RST 

M2 

3s 

 

Tên dự án QA-10 

Tên chương trình MAIN 
 

 

0 Bộ chỉ thị hoạt động 
 

 

 

Xe di chuyển về trước. 
 

 
 

 

Đẩy vào 
 
 

 
 
 

 

     Đẩy về sau 
 

 

 
 

                                                                                                                                                                                       Xe di chuyển trở lại. 
 

 

 
 

Cờ hoàn thành 

 

 

 
 

                                Nút bật X0 

                    Công tắc(LS công việc hoàn thành) X1 

                    Công tắc (LS giới hạn trước) X2                                                                                                                                                                                                                                                                           

                                  Công tắc (LS giới hạn sau) X3 

                        Công tắc (LS mở khi hoàn thành) X4 

      Bộ chỉ thị hoạt động Y70 

  Xe di chuyển về trước. Y71          

                   Xe lùi. Y72 

                                                              Đẩy vào Y73       

          Đẩy ra Y7 

Biểu đồ thời gian 
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Bật Đầu 

vào 

X0 

PB0 

Dừn
g PB1 

X1 

Công tức áp 
suất 
PX1 X2 

PX2 
X3 

PX3 
X4 

Đầu ra 

Y70 
MC 
A 

MC 
B 

Y71 

MC 
C 

Y72 

Y73 

Y74 

Y75 

Y76 

Phụ lục 4.21   Nén chương trình tuần tự sử dụng bộ đếm vòng 

 
Hệ thống này điều khiển và quản lý áp lực với  ba máy nén. 

Số lượng máy nén hoạt động cùng lúc phụ thuộc vào mức độ thiếu hụt áp. Để cân 

bằng số lượng của mỗi máy nén khí, máy nén được kích hoạt theo thứ tự đã thiết 

lập. 
 

 
 

 

MELSEC-Q 

 

                                                                                                                                                              Máy nén A 
 

 
 

 

                                                                                                                                                              Máy nén B 
 

 
 

 

Máy nén C 
 

 
 

 

Đủ áp lực  

Thiếu áp "Nhỏ" 

Thiếu áp "Thường"  

Thiếu áp "Lớn" 

 

Cấu hình hệ thống điều khiển máy 
 

 
MELSEC-Q 

 

 

 

 

Máy nén A B

 C Công tắc áp suất 

 
PX1 PX2 PX3 

Bảng điêu khiển 
 

 

 
Thiếu áp "Lớn" 

Áp lực đủ Thiếu áp "Thường"  

                                                Thiếu áp "Nhỏ" 

Nút bật          Nút tắ t  
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Giải thích hoạt động 

(1) Các công tắc áp suất (X2, X3, và X4) ban đầu ở trạng thái tắt. Trong trạng thái 

này, bật công tắc khởi động (X0) kích hoạt ba máy nén hoạt động cùng với 

nhau, và khi áp lực thu được đã đủ (X2, X3, và X4 bật), ba máy nén dừng lại. 

Đây là hoạt động cơ bản của hệ thống này. 

       Nếu tất cả các máy nén dừng lại với đủ áp lực hoặc thiếu áp lực "nhỏ" được 

       phát hiện (X4 tắt), một máy nén sẽ được kích hoạt để cung cấp áp lực cho đến 

       khi đủ áp lực thu được. 

.      Trong phản ứng với tình trạng thiếu áp lực, các máy nén kích hoạt tại thời điểm 

       này được bật theo thứ tự từ A đến. 

Lưu ý rằng việc chuyển (X1) sang dừng lại luôn sẵn sàng cho việc dừng máy 
nén bất cứ lúc nào. 

 

(2) Nếu một máy nén không cung cấp đủ áp lực và mức độ thiếu hụt áp sẽ tăng lên 

đến "Thường" (X3 tắt), máy nén thứ hai sẽ được kích hoạt để hỗ trợ các máy 

nén đầu tiên. Máy nén thứ hai này sẽ là máy nén C nếu máy nén A đã đi vào 

hoạt động, A nếu B đã đi vào hoạt động, và B nếu C đã đi vào hoạt động. 

(3) Nếu cả hai máy nén không cung cấp đủ áp lực thì mức độ thiếu hụt áp sẽ tăng 

lên để "Lớn" (X2 tắt), máy nén cuối cùng cũng sẽ được kích hoạt. Khi chỉ có 

một máy nén hoạt động và áp lực thiếu ngay lập tức sẽ tăng từ "Nhỏ" đến 

"Lớn", thì hai máy nén còn lại sẽ được kích hoạt cùng lúc. 

(4) Khi hai hoặc ba máy nén hoạt động, chúng sẽ tiếp tục hoạt động cùng nhau cho 

đến khi đủ áp lực thu được. Sau đó, chúng sẽ dừng lại (X4 lượt về). 

 

 

 
 

Bật - (X0) 

PX3 - (X4) 

Công tắc áp lực PX2 - (X3) 

PX1 - (X2) 
 

 

A - (Y70) 

    Máy nén   B - (Y71) 

C - (Y72) 
 

 
 

Thiếu áp Lớn Nhỏ Nhỏ Thường     Lớn Nhỏ Nhỏ   Nhỏ Thường 

 Máy nén A,B,C B C A,C A,B,C A B C A,C 

Biểu đồ thời gian 
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Tên dự án QA-11 

Tên chương trình MAIN 

 

X0 X1 
0 

M0 

 
M0 Hoạt động nội bộ 

 

X4 
4 

X4 X3 
6 

Y74 
 

X3 X2 
13 

Y75 
 

X2 X4 
19 

Y76 
 

M0 
23 

Y74 
26 

M1 
29 

M0 
31 

 

 

 

X4   Y76 
 

 

 

X4   Y76 

 

 

 

Y75 

 

 
 
 

 
 

Thiếu áp  "Nhỏ" được biểu thị khi X4 tắt. 
 

 
Thiếu áp "Thường" được biểu thị khi X3 
(Thường) tắt. 

 

 
Thiếu áp "Lớn" được chỉ thị khi X2 (Nhỏ) tắt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PLS 

PLS 

SET 

RST 

RST 

RST 

 

 

Y73 

Y74 

 

 

Y75 
 

 

 

Y76 
 

 

 

M1 

M2 

M9 

M9 

M12 

M11 

 

 

Trạng thái áp lực 

Thiếu áp "Nhỏ" 

 

 

Thiếu áp "Thường" 
 

 

 

Thiếu áp "Lớn" 
 

 

 

Bật M9 lúc khởi động 
 

Thay đổi do mức áp "Nhỏ" 
 

 

 

 

 

Đặt lại khi X1 bật 

RST 
M2 

36 SFT 

M10 

M13 

SFT 

SFT 

M12 

M11 

 

Chuyển thanh ghi 

 
M10 

45 

M0 

SFT 

RST 

M10 

M13 

 

M13 
48 

X4    M0 
50 

 

 

 

M10 
 

Y75  M11 

 

 

SET 

 

 

M10 

Y70 

 

 

Trả lại cho M10 

 Máy né n A 

 

Y76 
 

M11 
 

Y75  M12 

 

 

Y71 

 

 

Máy né n  B 

 

Y76 
 

M12 
 

Y75  M10 

 
Y72 

 
Máy né n C 

 

Y76 



App. - 34 

 

 

Sau thao tác cơ bản, một bộ nén được kích hoạt trong phản ứng khi thiếu hụt áp lực 

phát hiện. Để sử dụng ba bộ nén đều nhau, chúng được kích hoạt theo thiết lập thứ 

tự. Điều khiển này được kích hoạt bằng 3 - giai đoạn cung bộ đếm ( thanh ghi cung 

dịch chuyển) M10 đến M12. 

Tín hiệu chuyển được tạo ra khi thiếu áp lực được tìm ra ( X04 các khóa chuyển từ 

bật sang tắt. 

Máy nén 

A B C 
 

 

 

X0, bật 

X1, dừng 

 

X4, (PX3) 
tắt 

Cài 

đặt 

M9 

RST 

 

 

M10 M11 M12 
 

 

 

 

 

 
Chuyển thao tác 

 

X4 

M10 

M11 

M12 
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X0 M2 
M0 

M0 
Y72 

BINP K4X20 D15 

< D15 D16 Y70 

> 

X1 

D15 D16 Y71 

M0 Y70 
-P K1 D16 

Y71 
+P K1 D16 

= D15 D16 M2 

X2 
MOV K0 D16 

SM400 (always ON) 
BCD D16 K4Y40 

Phụ lục 4.22   Ví dụ ứng dụng điều khiển vị trí 

 
Sau đây là ví dụ của hệ thống định vị với máy phát xung đầu ra xung nhịp mỗi động 

cơ, thắng, và đơn vị của khoảng cách. 

Trong hệ thống này, giá trị lệnh là thiết lập với bộ chuyển mạch kỹ thuật số, và giá trị 

lệnh thiết lập này được so sánh với giá trị hiện hành vào lúc khởi động để xác định 

hướng chỉ định, chuyển tiếp hoặc đảo ngược, xoay động cơ. Giá trị hiện hành ở 

thanh ghi D16 trừ 1 trong hướng chuyển tiếp, và tăng lên 1 trong hướng đảo ngược. 

Định vị hoàn tất khi giá trị lệnh trùng khớp giá trị hiện hành. Giá trị hiện hành được 

chuyển thành giá trị BCD sao cho vị trí hiện hành được biểu diễn trong 4 - chữ số 

các số thập phân. 

 

Nguyên điêm 
 

Xouay Xoay 

Máy 
phát 
xung 

Chuyển tiếp Đảo ngược Động cơ Thắng 

 

 

Nguyê
n điêm 

 

 

MELSEC-Q 
 

X2 
Start 

X0 
 

 
X1 

 

 
 

 

Y70 

Y71 

Y72 

 

 

Xoay  
chuyển tiếp       xoay 

nghich 
đảo 

 

 
 
 

 

Thắng 

Giá trị lệnh thiết lập công tắc Hiện thị giá trị hiện thời 

 

5 4 0 0 3 6 2 8 

mm mm 
 

 

X1 

X10 

X100 

X1000 

 

X20 to 23 

X24 to 27 

X28 to 2B 

X2C to 2F 

 

Y4C to 4F 

Y48 to 4B 

Y44 to 47 

Y40 to 43 

 

 

X1000 

X100 

X10 

X1 

 

 

Tên dự án QA-26 

Tên chương trình MAIN 
 

 

0                                                                                                                                                                Hoạt động nội bộ 
 

                                                                                                                                                                Ngắt thắng 
 

                                                                                                                                                             Lệnh đọc giá trị 
 

  Xoay chuyển tiếp 
 

                                                                                                                                                                Xoay ngược 
 

20 -1 trong oãy chuyển tiếp 
 

+1 trong xoay ngược 
 

Kiểm tra tính nhất quán với giá 
trị lệnh 

38 Thi hành gửi trả nguyên điêm 

41 Hiện thị giá trị hiện tại 
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K2X20 
3 0 

K4X30 Module 
đầu ra 0 1 8 0 

X02 

K2Y58 
3 0 

K4Y40 Module 
đầu 
vào 

0 1 8 0 

K4Y60 
3 7 8 2 

Phụ lục 4.23   Ví dụ ứng dụng sử dụng chỉ số Z 

 
(1) Số sản phẩm được sản xuất được đếm mỗi ngày trong một tháng, và số kết 

quả được lưu trữ đến các thanh ghi tương ứng của ngày ( D1 đến D31 ). 

(2) Số lập kế hoạch để sản xuất sản phẩm là đầu vào của bộ chuyển mạch kỹ thuật 

số ngoài. Sản xuất ngừng lại khi số này được hoàn thành. 

(3) Ngày cũng được xác định với bộ chuyển mạch kỹ thuật số ngoài. 

(4)  Số tích luỹ sản phẩm được sản xuất trong tháng này cũng như số sản phẩm 

được sản xuất vào ngày lưu hành được hiển thị ngoài. 

 

 

Ngày 
 
 

 

 

Số kế hoạch lập 
cho sản phẩm 

 

 

 

Giá trị đếm 

Hiện thị ngày 
 
 

 
 
Số lượng đã sản xuất 
vào ngày lưu hành 

 

 

 
 

Số tích lũy 

 

 

Số sản phẩm được sản xuất vào ngày lưu hành được đếm bằng C5. Số sản 

phẩm  tích luỹ được sản xuất được đếm bằng C6. 

Ngày được nhập vào thanh ghi chỉ số  Z để gián tiếp xác định dữ liệu thanh ghi phù 

hợp với ngày sử dụng D0Z0. 

Khi Z0 bằng 30, D0Z0 trở thành 0 + 30, xác định D30.  

[Thiết bị / Vùng đệm Bộ nhớ Bó Thiết bị hiển thị màn hình] 

 

 
Lưu số kết quả mỗi 
ngày từ 1 đến 31 ở 
D1 đến D31. 

 
 
 

 
 
 

 Số tích lũy 
  

            Ngày 

Kết quả sản xuất của mỗi ngày từ 1 đến 31 được lưu trữ trong D1 đến D31, có sẵn 
trong dữ liệu sản xuất. 

 

Số kế hoạch của sản 
phẩm 
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FMOV K0 D0 K32 

 

FMOV K0 K4Y40 K3 

 

 

Tên dự án QA-7 

Tên chương trình MAIN 

 

 

0 = K0 K4X20 MOV K32760 D35 Chuyển đổi kĩ thuật số 

SM410 X2 
5 

(0.1-sec. clock) 

D35 
C5 

Ghi từ  32760 đến  D35 và đếm 
sản phẩm cxj sản xuát 
khi X20 đến 2F là 0 

Thiết lập giá trị  C5 
mẫu 

X0 
16 <> K0 

 

 

 

K4X20 

 

 

 

BIN 

BIN 

 

 

 

K4X20 

K2X30 

K32760 
C6 

 

D35 

D36 

 

 

 
Lệnh sản xuát owrddaauf ra 

Đầu ra ngày 

<= K32 D36 SET M2 
 

<= 
 

 
M2 SM411 

43 
M3 

46 <> 
 

 
SM400 (luôn  ON) 

57 
 

 

 

 

 

 

 

 

 

X6 
71 

 

 
X7 

79 

 

K1 
 

 

 

 

 

D36 

 

D36 
 

 

 

 

 

Z0 

 

>= K31 
 

D36 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FMOV 

FMOV 

 

 

 

 

 

 

 

 

 
MOV 

MOV 

BCD 

BCD 

BCD 

MOV 

-P 
 

 

 

 

 

 

 
K0 

K0 

 

RST 

PLS 

 

 

RST 

D36 

C5 Z0 

D0Z0 

C6 

C6 

C5 

RST 

RST 

RST 

D0 

K4Y40 

 

M2 

M3 

Y070 

C5 

Z0 

D0Z0 

K2Y58 

K4Y40 

K4Y60 

D33 

C6 

C5 

C5 

C6 

K32 

K3 

 

 
Flash Y70 nháy khi 31 

 

 
 

 
 
 

 

Xác định ngày gián tiếp 

 
Lưu trữ số sản phẩm được sản 
xuất đến thanh ghi 

Hiện thị ngày tháng sản 
xuất 

Hiện thị só sản phẩm sản xuất 
trong ngày lưu hành 

Hiện thị số sản phẩm sản 
xuất trong 1 tháng 

 

 

 
Xóa số sản phẩm sản xuất 
trong ngày bất cứ lúc nào nếu 
cần 

 

 
 

 
 

Xóa tất cả ở cuối tháng 

 
 

Chuyển giao dữ liệu cùng 1 lúc từ 0 đến D0 đến D31. 
 

 

Chuyển giao dữ liệu cùng 1 lúc 0 to K4Y40, K4Y50, và 

K4Y60. 
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Left 

X01 

Right 

X00 

In automatic 
operation 

Y73 

Cleaning 

X02 

Recording 

X03 

Automatic 

X06 

Reading 

X05 

Stop 

X07 

6 

1 

2 

8 

4 

16 
   

32 

0 

0 

0 

6 

135 

150 

  120   

100 

  20 

135 

0 

0 

Phụ lục  4.24  Ví dụ ứng dụng lệnh FIFO 
 

Hướng dẫn các gói công việc và thời gian làm việc của nó có thể được 

lưu trữ và lặp lại bởi máy móc sau này. 
 

 
 

MELSEC-Q Trái (Y71)   (Y70) Phải 

Hệ thống băng truyền 
 

Làm 
sạch 
(Y72) 

1) 2) 

 

 

3) 5) 

 
4) 

 

 
6) 

Bước  

 

  Bảng công việc giảng dạy 
 

X   20 21 22  23 24 25 

Đếm bình 

 

 
Phóng lớn góc hình của bảng 
công việc giảng dạy 

Vị trí tìm được bởi bộ cảm biến từ 
X20 đến 25 

 

 
 

 

 

Con trỏ 

Bước 1) 

2) 

 

 
 

D10 

11 

12 

Bảng 
FIFO  

 

 

6 
 

1Đọc sử dụng FIFRP 

2 

 

 

 

K2 Y74 

 

 

 

D30 

 

1 31 

32 

3) 13 8 Dữ liệu được sao lưu khi X03 được bật 33 
Đếm bể    

 

 

 

 

 

 

 

 

 

 

K2X20 

4) 14 

 
5) 15 

 
6) 16 

 

 

 

 

32 

4 

 
16 

 
32 

 

 

 

 
Ghi sử dụng 

FIFWP 

34 

Sao lưu dữ liệ đọc 35 
khi X05 được bật 

36 

 
37 

 
38 

 

 

 

 

Con trỏ 

 
 
 

 

D20 

 
Bảng 
FIFO 

 

 

 

 

6 
Đọc sử dụng 
FIFRP 

 

39 

 

D0 (Hằng số bộ định thời của T0) 40 

Bước 1) 21 

 
2) 22 

135 

 
150 

135 41 

42 
 

 

Dữ liệu được sao lưukhi X03 is tđược bật 

Số lần 
3) 23 120 43 

xóa 
4) 24 

 
5) 25 

 
6) 26 

100 

 
20 

 
135 

44 

Sao lưu dữ liệu được đọc  45 
khi X05 được bật 

46 
   

                        Giá trị hiện tại của T1 

                 D0 

135      Ghi sử dụng  FIFWP 

Xóa Hoạt động 
tự động 

Bản 
ghi 

Đọc 

Tự 
động 

Dừn
g 

Trá
i 

Phả
i 
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Mẫu các thao tác từ hướng dẫn cho thao tác tự động 

 
Thao tác tương tự lặp lại từ  (A). 

Đếm bình Bảng công việc 

X00 = nút chỉ dẫn dịch phải            
X01 = nút chỉ dẫn dịch trái              
X02 = nút chỉ dẫn xóa                       
X03 = nút chỉ dẫn ghi dữ liệu 
X05 = nút đọc dữ liệu 
X06 = nút tự động hoạt động          
X07 = nút dừng hoạt động 
Y73 = dấu hiệu hoạt động 

tự động của đèn 
LED 

Làm sạch máy 

Y70 = Vận chuyển, sang phải   
Y71 = Vận chuyển, sang trái     
Y72 = Vận chuyển, xóa 

X20 = Đếm bình -1 (K2X20 = K1) 
X21 = Đếm bình -2 (K2X20 = K2) 
X22 = Đếm bình -3 (K2X20 = K4) 
X23 = Đếm bình -4 (K2X20 = K8) 
X24 = Đếm bình -5 (K2X20 = K16) 
X25 = Đếm bình -6 (K2X20 = K32) 

Bắt đầu dịch phải(X00 = On              

Dừng dịch phải(X00 = OFF)                                     

bắt đầu xóa (X02 = ON) 

Xóa xong(X02 = OFF)               

Bắt đầu dịch phải (X00 = ON)     

Bắt đầu dịch phải (X00 = OFF)        

Bắt đầu xóa (X02 = ON) 

Kết thúc xóa (X02 = OFF)                 

Bắt đầu dịch phải (X00 = ON)       

Dừng dịch phải (X00 = OFF)        

Bắt đầu xóa(X02 = ON) 

Xóa kết thúc (X02 = OFF)               

Bắt đầu dịch trái (X01 = ON)     

Dừng dịch trái (X01 = OFF)        

Bắt đầu xóa (X02 = ON)                  

Kết thúc xóa (X02 = OFF)               

Bắt đầu dịch phải(X00 = ON) 

Dừng dịch phải (X00 = OFF)                  

Bắt đầu xóa(X02 = ON) 

Kết thúc xóa (X02 = OFF)                 

Bắt đầu dịch phải(X00 = ON)       

Dừng dịch phải(X00 = OFF)              

Bắt đầu xóa (X02 = ON) 

Dừng xóa (X02 = OFF) 
 

Bắt đầu hoạt động tự động 
(X6 (X06 = ON ? OFF) 
Chỉ số hoạt động tự động LED 
(Y73 = ON) 

1) 
Dịch phải (Y70 = ON)         

Dừng dịch chuyển(Y70 = 

OFF) Xóa (Y72 = ON) 

Dừng xóa (Y72 = OFF)          

Dịch phải (Y70 = ON)               

Dừng dịch chuyển (Y70 = 

OFF) Xóa (Y72 = ON) 

Dừng xóa (Y72 = OFF)          

Dịch phải (Y70 = On                

Dừng dịch chuyển(Y70 = 

OFF) Xóa (Y72 = ON) 

Dừng xóa (Y72 = OFF)         

Dịch trái (Y71 = ON)                

Dừng dịch chuyển (Y71 = 

OFF) Xóa (Y72 = ON) 

Dừng xóa (Y72 = OFF)          

Dịch phải (Y70 = ON)               

Dừng dịch chuyển (Y70 = 

OFF) Xóa(Y72 = ON) 

Dùng xóa (Y72 = OFF)              

Dịch phải (Y70 = ON)               

Dừng dịch chuyển (Y70 = 

OFF) Xóa (Y72 = ON Dừng 

xóa (Y72 = OFF) dịch trái 

(Y71 = ON) 

(Bắt đầu quá trình hoạt động tự 
động) 

Vị trí dừng (K2X20 = 0)        
Đếm bình -1 (K2X20 = 1) 

A 

2) 

Đếm bình -2 (K2X20 = 2) 

3) 

Đếm bình 4 (K2X20 = 8) 

4) 

Đếm bình 3 (K2X20 = 4) 

5) 

Đếm bình 5 (K2X20 = 16) 

6) 

Đếm bình -6 (K2X20 = 32) 

Đếm bình -1 (K2X20 = 1) 

A 
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Tên dự án QA-9 

Tên chương trình MAIN 

 

SM403 

0 

X6 

5 

Y73 

 

 

 

 

 

> D10 K0 

 

 

 

 

X7 M2 SM403 

 

 

FMOV     K0 D0 K50 

Y73 

 

 

Đặt lại dữ liệu về 0 chỉ RUN 1 lần 
 

 

Đầu ra biểu thị cho thao táo tự đông của LED 
(chế độ tự động cũng được hiển thị 

 

Y73 T0 

14 

M1 

 

 

PLS M1 

 

 

FIFO đọc xung trong thao tác tự động 

18 >= KO D10 M2 

M1 M2 

23 FIFRP    K2Y74  D10 

Kết thúc hoạt động tự động nếu hiện tại không có 
dữ liệu 

 

 

 

M1 M2 

31 

M3 

 

 

 

T2 Y73 

 

FIFRP     D1 D20 

M3 

   Đọc thời gian xóa                                    
 
     Đọc cờ đã hoàn thành 

 

 

 

37     >  K2Y74  

K2X20 M4 

 

 

44     >  K2X20  

K2Y74 M5 

M5 M3 
 

 

 

 

 

M4 M3 

 
Dịch chuyển băng chuyền  

M4 sang phải từ bên trái 

 

 
        Dịch chuyển băng chuyền từ 

M5 trái sang phải 

 
M3 

51  = K2Y74  

K2X20 T2 

 
T0 Y73 

 

 

T2 

 

K10 

T2 

D1 
T0 

 

 

Hoàn thành chuyển động và bắt đầu hoạt động 
(preventing chattering) 

 
Tự động xóa bộ đinh thời 

X0 X1 Y73 Y71 

67 

M4 
 

 

X1 X0 Y73 Y70 

73 

M5 

 

 

Y70 
 

 

 

 

 

Y71 

 

 

Dịch băng chuyền sang phải 
 

 

 

 

 

Dịch băng chuyền sang trái 

 

 

 

79     >  K2X20 KO 

M6 

X2 Y73 SM403  
M6 Tự động xóa 

 
T2 

87 Y72 

M6 

 

M6 K3200 

90 T1 

 
M0V T1 DO 

 

 

PLF M7 

M7 

99 > K6 D10 FIFWP  K2X20  D10 

 

 
Làm sạch từ  băng chuyền 

 

 

 

 

 

Chu kỳ xóa các số đo thời gian 

xóa bản ghi thủ công           

Auto-cleaning end pulse        

vị trí bản ghi lớp đếm bình 

 

 

 

109 
 

 

115 
 

 

121 

 

 

X3 Y73 
 

 

X5 Y73 

SM400 

FIFWP D0 D20 

BM0V   D10    D30    K20 

BM0V      D30       D10       K20 

BCD D10 K1Y60 

Thời gian xóa bản ghi lưu 

Bản ghi dữ liệu               

Đọc dữ liệu đã lưu 

Hiện thị số của bản ghi dữ liệu 

 

125 END 
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D30 D31 D32 D33 D34 D35 

Mã số thay đổi Mã số đầu vào  

Phụ Lục 4.25 Ví dụ ứng dụng về bù dữ liệu 
Công việc được truyền tải cùng với mã số của chúng, và dữ liệu đăng ký của máy 

móc chế biến được phân tích để máy làm việc theo mã số của chúng. 
 

 

 

 

 

 

Mã số từ 1 
đến 8 

X0 
Bật 

X1 
        Dừng 
 

 

Loại  phát hiện 
 

X2 

 

 

 

 

 

 
K1X20 

 

 

 

 

 
Module 
đầu ra 

 

 

 

 

 
Module 
đầu 
vào 

 

 

 

 

Y70 

 

 

Hoạt động nội 
bộ 

Di chuyển công việc 
công tắc

 
lệnh 

 

Máy 
Thanh 

ghi dữ 

liệu 

Mã 1 Mã 2 Mã 3 Mã 4 Mã 5 Mã 6 Mã 7 Mã 8 

A D30 M1 M2 M3 M4 M5 M6 M7 M8 

B D31 M11 M12 M13 M14 M15 M16 M17 M18 

C D32 M21 M22 M23 M24 M25 M26 M27 M28 

D D33 M31 M32 M33 M34 M35 M36 M37 M38 

E D34 M41 M42 M43 M44 M45 M46 M47 M48 

F D35 M51 M52 M53 M54 M55 M56 M57 M58 
 

Một mã số được lưu trong thanh ghi, và M tương ứng với số lượng lưu trữ được 

kích hoạt để máy làm việc. 
 

      
 

 
 
 

                                                                                                                 

                                                      của K1X20. Khi X2 được bật. 

Máy A Máy B Máy C Máy D Máy E Máy F 
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= 
 

= 

 

 

 

K1 

K2 

 

 

 

D30 

D30 

MOV K1X20 
 

DSFLP D30 

D30 

K6 

M1 

M2 

Má số nhập vào 
 

Chuyển mã số 

= K3 D30  M3 

= K4 D30  M4  
Máy  A 

= K5 D30  M5  

= K6 D30  M6  

= K7 D30  M7  

= K8 D30  M8  

= K1 D31  M11  

= K2 D31  M12  

= K3 D31  M13  

= K4 D31  M14  
Máy  B 

= K5 D31  M15  

= K6 D31  M16  

= K7 D31  M17  

= K8 D31  M18  

= K1 D32  M21  

= K2 D32  M22  

= K3 D32  M23  

= K4 D32  M24  
Máy  C 

= K5 D32  M25  

= K6 D32  M26  

= K7 D32  M27  

= K8 D32  M28  

 

 

Tên dự án QA-12 

Tên chương trình MAIN 
 

 

X0 X1 
0 

Y70 

 
Y70 

 
Hoạt động nội bộ 

 

SM400 (luôn ON) 
4 

X2 
8 

Y70 
12 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Y70 
53 

 

 

 
 
 

 
 
 

 
 
 

 

Y70 
94 
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Y70 
135 

 
= 

 
K1 

 
D33 

 
M31 

 

 = K2 D33 M32  

 = K3 D33 M33  

 = K4 D33 M34  

     Máy  D 

 = K5 D33 M35  

 = K6 D33 M36  

 = K7 D33 M37  

 = K8 D33 M38  
Y70 

176 
 

= 
 

K1 
 

D34 
 

M41 
 

 = K2 D34 M42  

 = K3 D34 M43  

 = K4 D34 M44  

     Máy  E 

 = K5 D34 M45  

 = K6 D34 M46  

 = K7 D34 M47  

 = K8 D34 M48  
Y70 

217 
 

= 
 

K1 
 

D35 
 

M51 
 

 = K2 D35 M52  

 = K3 D35 M53  

 = K4 D35 M54  

     Máy  F 

 = K5 D35 M55  

 = K6 D35 M56  

 = K7 D35 M57  

 = K8 D35 M58  
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X0 

Phần nguyên   phần thập 
phân 

 

Tên dự án QA-14 

Tên chương trình MAIN 

 

Phụ Lục 4.26 Ví dụ về chương trình hoạt động tính căn bậc 2 của số liệu 

 
Các dữ liệu được lưu trữ trông D5 được tính toán thành căn bậc 2 và kết quả được 

lưu trữ trong D6 và D7. 
 

 

0 MOVP 
 

BSQR 

MOVP 

MOVP 

K4X20 

D5 

D7 

D6 

D5 

D6 

K4Y50 

K4Y60 

     Thiết đặt dữ liệu 

       Nghiệm căn bậc 

        hai 

       Ngiêm căn bậc 

       hai(phần nguyên) 

       Nghiệm căn bậc  

       hai (phần thập 

       phân) 

 

kết quả việc tính căn bậc hai được lưu trữ như sau: . 
 

 
  D5    

=      
D6 D7   

   Làm tròn đến số thập phân thứ 5. 
Như vậy, số thập phân thứ 4 

0 to 9999 
(BCD giá trị) 

0 to 9999 
(BCD giá trị) 

0 to 9999 
(BCD giá trị) 

được làm tròn ±1. 

 

 

 

Lưu ý:  

QCPUs cung cấp hướng dẫn hoạt động căn bậc hai cho dữ liệu trong một số 

thực (dấu chấm) định dạng. 
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X1 
FMOVP K0 
 

BINP 

MOVP 

BINP 

- P 

D10 

K4X30 

D10 

K2X20 

K1 

SCJ 

CJ 

FOR 

X1 

X1 
D* D10 D15 

X1 
D/ D10 K10000 

DBCD  D16 

DBCD  D18 

 

Tên dự án QA-15 

Tên chương trình MAIN 

 

Phụ lục 4.27 Ví dụ về chương trình hoạt động tính toán năng lượng của dữ liệu 
Một giá trị được lưu trữ trong D10 và được tính năng lượng n-th của nó ("n" là 1 giá 

trị được lưu trữ trong D14) và kết quả được lưu trong D10. 

 

 

0 K10 
 

D10 

Xóa dữ liệu 

Cài dữ liệu 

D15 
 

D14 

D14 

 

 

Thiết đặt n 

P0 
 

18 P0 
 

21 D14 
 

23 D10 
 

28 NEXT 
P0 

29 D16 
 

K6Y50 

K4Y40 

 

 
Nhân giá trị n 

lần 
 

 

 

 

BCD-giá trị đầu ra 
cho 10 chữ số 

 

 
 

 

 
Một hoạt động lỗi xảy ra khi một giá trị trong D10 vượt quá 2147483647.. 

CHÚ 
Ý 
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SM400 

SM400 
RST Z0 

FOR K8 

<= K0 K1X20Z0 >= K9 K1X20Z0 MOV K1X20Z K1M100Z 

+ K4 Z0 
 

NEXT 

SM400 
DBIN K8M100 D10 

DBCD   D10 K8Y40 

0 <= K0 K1X20 >= K9 K1X20 MOV K1X20 K1M20 

 <= K0 K1X24 >= K9 K1X24 MOV K1X24 K1M24 

 <= K0 K1X28 >= K9 K1X28 MOV K1X28 K1M28 

 <= K0 K1X2C >= K9 K1X2C MOV K1X2C K1M32 

       BIN K4M20 D10 

 

Phụ lục 4.28 Chương trình sử dụng chuyển đổi kỹ thuật để nhập dữ liệu 
Khi 1 giá trị của bộ chuyển đổi kỹ thuật số luôn luôn là đầu vào và được lưu trữ ở 

D10 của bộ điều khiển khả trình. 
 

Chuyển đổi kĩ thuật số Module đầu vào CPU 
 

 
 
 

 
 

 

Cấu hình sai 

SM400 (luôn ON) 
 

 

BIN K4X20 D10 
 

 

 Trong chương trình trên, việc thay đổi giá trị của bộ chuyển đổi kỹ thuật số trong khi 

 bộ điều khiển khả trình đang RUN có thể gây ra các mã khác từ 0-9 tùy thuộc vào 

 thời gian của sự thay đổi mà có thể gây ra một lỗi hoạt động của CPU. 

 Để tránh điều này, viết chương trình như sau:  

(Ví dụ 1) Đối với 4 chữ số từ X20 đến X2F 

 
 

 
 

 

 
 

 

 
 

 

 

(Ví dụ 2)  Đối với  8 chữ số từ X20 đến X3F 
 

0 
 

4 
 

7 
 

 

 

31 
 

32 

1 2 3 4 

X20 

to 

X2F 

Thanh 
ghi dữ 
liệu 
D10 
D10 

Chuyển đổi vào 
BIN 



App. - 47 

 

 

Điều kiện của 
chương trình 

Tổng số mạch 
hỏng là 50. 

Phụ Lục 4.29 Hiển thị số lỗi và số lỗi sử dụng chương trình phát hiện lỗi. 

 
Chương trình tuần tự sau đây sẽ hiển thị số lượng bit thiết bị được bật (như X, M, 

và F) trong số rất nhiều các bit thiết bị được sử dụng liên tục, cùng với số thiết bị 

của chúng. 

 

[Ví dụ ứng dụng] 

Khi M hay F được sử dụng như một thiết bị đầu ra của một chương trình phát hiện 

lỗi, sử dụng các chương trình sau đây để có được một số lỗi nhất định từ các lỗi. 

 
[Chuỗi dòng chảy chương trình] 

 (Phương thức hoạt động) 

 
 

Ladder phát hiện lỗi 
Thiết bị F trong 
chương trình ví dụ. 

 

 

 

X2 ON OFF 
 

Màn hình B màn hình A 

1) Tìm kiếm lỗi (ON) 
trên thiết bị 

2) Hiện thị số thiết bị 
hỏng 

 

 

 

 

 
X0 ON OFF 

Hiện thị lỗi đầu tiên 

 

 

Hiện thị các thiết bị bị lỗi 
trên màn hình  A. 

 

 

 

 

 

 

 

 

Lỗi hiện thị trên màn 
hình  C. 

 

  
 

Màn hình C 

 
(Y60 đến 

Y6F) 

 

 
 

 
 
 

X1 ON OFF 

Hiện thị số lượng các 
thiết bị còn lại bị lỗi bao 
gồm cả số đang hiện thị 
và số lỗi tiếp theo 

 

 

 

 

 
sai  

 

 

 

Hiện thị số lỗi còn lại trên màn 
hình A. 

Hiện thị số lỗi tiếp theo trên màn hình C. 
 

 

 

 

 
Đúng 

                                                        Hiện thị số cuối cùng Kết thúc 

(Y50 đến 
Y5F) 

(Y40 đến 
Y4F) 
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X20 
F3 

X24 
F5 

X28 
F8 

X2C 
F13 

X30 
F33 

X34 
F35 

X38 
F37 

X3C 
F39 

X4 
F1 

X5 
F11 

X6 
F16 

X7 
F40 

X2 M200 
DSUMP K8F1 D0 

MOVP D0 D10 

DSUMP K8F33 D0 

+P D0 D10 

BCDP D10 K4Y40 

SET M400 

RST M700 

X000 M200 M400 
PLS M500 

SET M700 

M500 
SET M200 

RST M600 

K0 MOV Z0 

K8F1 DMOV D0 

M600 
K8F33 DMOVP D0 

 

Tên dự án QA-31 

Tên chương trình MAIN 

 

 

0 
 

4 
 

8 
 

12 
 

16 
 

20 
Mạch hỏng 

24 
 

28 
 

32 
 

36 
 

40 
 

44 
 

48 

 
Tìm kiếm thiết 
bị Bật 

 

 

 

 

 

 

 

 

 

 

73 
 

 

 

80 
 

 

Xác định số bắt đầu 
của mạch hỏng 

(F1 đến 0) 
 

 

95 
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0 0  0 0  0 0  0 0  0 0 0 1  0 0  0 0 

   
MOVP 

  

 

 

103 
M100 M200 

 

 

 

SM700 

 
DROR 

 
D0 

 

SET 

INC 

 
K1 

M100 

Z0 

 

 

Tìm các thiết bị 
ON chuyển dữ 
liệu  32 bit sang 
phải 

 

 

120 
 

125 

 
X1 

M300 

 
M700 
 

 

 

 

< K0 

 

 

 

 

 

 
D10 

BCD 
 

 

 

 

 

- 

Z0 
 

PLS 

RST 

K1 

K4Y60 

M300 

M100 

D10 

 

 

 

 

 

Tìm thiết bị ON 
tiếp theo 

 

 

144 
 

150 
 

 

 

 

 

164 

 

 
= 

 

= 
 

 

 

 
M800 

 

 

K32 Z0 
 

K50 Z0 

BCD D10 
 

SET 

RST 

K0 
 

PLS 

RST 

K4Y40 

M600 

M200 

K4Y60 

M800 

M400 

 

 

 

 

 

 

 

Đặt lại khi tìm 
kiếm kết thúc 

 

(1) Tìm các thiết bị Bật 
 

DSUMP K8F1 D0 

 

DSUMP K8F33 D0 

 

32 bits 
 

 

 
S trước thi 

 
F F     
3231 

 

  F F F F 
4 3  2 1 

Hành        (K8F1) 1 1  1 0  0 1  0 0  1 0 0 1  0 0  0 1 1 1  0 0  0 0  1 1 1  1 1  1 0  0 0  1 
 

 
 
 

 

A0 sau 
khi thi 
hành 

B15 B0 

 

Tổng các bit 1 được lưu trong  BIN. 

(trong ví dụ , 16) 
 

 

 

Bật X2 lưu trữ số của các bit được bật trong số F1 đến F64 đến D10 và hiển thị 

nó.
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DMOV K8F1 D0 

DMOV K8F33   D0 

DROR D0 K1 

 

F F 
Chuyển giao bằng lệnh  MOVP  

16 1 

1 1 0 0 0 0 1 1 1 1 1 1 0 0 0 1 
D0

 
D10 

 

1 1 1 0 0 1 0 0 1 0 0 1 0 0 0 1 

F F 

16 16 

32 17 
F F 
48 33 

D0 
0 0 0 1 1 1 0 0 0 0 1 1 0 0 0 1 

 

0 0 0 0 1 1 0 0 0 0 0 0 0 0 1 0 

F F F 

Thêm bởi lệnh +P 
7 

 

64 5049 

 
 

 

Số đầu vào ON trong số X20 đến 5B 

D10 

23 

 

 

(2) Tìm kiếm thiết bị bật chuyển dữ liệu sang phải 
 

F    F 
32  31 

F    F    F    F 
3    2    1    0 

 
 

 

32 bit 

 

Lệnh DMOV  

D1,D0   1    1    1    0 
 

 

D1 

(16 bit) 

0    0    1 
 

 

D0 

(16 bit) 

 

 

DROR D0 K1 

 
 

 

 

 

Trước 

D1 

 
B31B30B29 B28B27 B17B16B15 B14B13 

D0 

 
B5  B4  B3 

 

 

 

B2  B1  B0 

thi hành 

Nội dung 
BO trước 
thi hành 

1 1    1    0    0 0    1    1    1    0 1    1    1    0    0    1  

 

Đến B31 

Cờ nhớ 
(SM700) 

 

Sau thi 
hành 

1 1    1    1    0    0 0    1    1    1    0 1    1    1    0    0 1 

Đến B31 

 

 
(a) Bật X0 thiết lập chuyển dữ liệu (D0 và D1). Sau đó, dữ liệu được thay đổi 1 

bit tại mỗi lần scan cho đến khi bit được bật được phát hiện. 

       Khi bit được bật được tìm ra, dịch chuyển dừng lại vì scan ( SM700 bật ), 

       và số tích luỹ của chuyển đổi ( tương đương số hiệu thiết bị ) được hiển thị. 

(b) Mỗi lần X1 được bật, bit tiếp theo được bật được tìm ra và số hiệu thiết bị 

phát hiện được hiển thị. Đồng thời, 1 bị trừ bởi bit được bật đã được thu 

trước để hiển thị các số còn lại của bit được bật. 

1    1 0    0    1 
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Phụ lục 5 Bộ nhớ và tập tin được xử lý bởi CPU module 
 Dữ liệu được lưu trữ trong bộ nhớ. 

Bảng dưới đây liệt kê các dữ liệu và số ổ đĩa có thể được lưu trữ trong bộ 

nhớ chương trình, bộ nhớ RAM tiêu chuẩn, ROM tiêu chuẩn, và thẻ nhớ. 
 

 

 
 

 
 

Mục 

 

 

Bộ nhớ gắn liền với module CPU 
Bộ nhớ 
(RAM) 

 

 

Bộ nhớ (ROM) 

 
 

 
 

 
 

Nhận xét 

 Tên tập tin và 

phần mở 

rộng 

 Bộ nhớ 
chương 
trình 

RAM chuẩn ROM 
chuẩ

n 

 

 

Thẻ SRAM 

 

 

Thẻ Flash 

 

  

  Thẻ ÂTA 

 *1 
Ô đĩa 0 

*1 
Ổ đĩa 3 

*1 
Ổ đĩa 4 

*1 
Ổ đĩa 1 

*1 
Ổ đĩa 2 

Tham biên O × O O O O PARAM.QPA 1 data/ Ổ đĩa 

Module chức năng 
thông minh 

 

O 

 

× 

 

O 

 

O 

 

O 

 

O 

 
IPARAM.QPA 

 
1 data/ Ổ đĩa 

Chương trình ◉ × 
*3 

O 
*4 

O 
*4 

O 
*4 

O ***.QPG - 

Chú thích thiết bị 
*5 

O × 
*6 

O 
*6 

O 
*6 

O 
*6 

O ***.QCD - 

Giá trị thiết bị O × O O O O ***.QDI - 

Dữ liệu thiết bị × × O × × × ***.QST - 

Thnah ghi tập tin × 
*7*8 

O × O 
*9 

O × ***.QDR - 

Thiết bị nội bộ × 
*7 

O × O × × ***.QDL 
1 data/CPU 

module 

Lấy mẫu tập tin × 
*7 

O × O × × ***.QTD - 

Dữ liệu lỗi × × × × × × ***.QFD - 

Tập tin lưu 

trữ dữ liẹu × × O × × × 
DEVSTORE. 

QST 

 

- 

Module lưu 

trữ lỗi file × O × × × × 
IERRLOG. 

QIE 

 

- 

Sao lưu file × × × O O O 
MEMBKUP0. 

QBP 

 

- 

Dữ liệu người 

dùng thiết bị tự 

động lập trình 

đuọcw 

 

× 

 

× 

 

O 

 

× 

 

× 

 
*10 

O 

 

 

***.*** 

 

 

- 

Thiết lập người 
dùng O × × × × × 

 

- 
 

- 

◉: Yêu cầu, O: Cất giữ, ×: Không thể cất giữ 

 
*1:  Một số ổ đĩa được sử dụng để xác định một bộ nhớ được viết / đọc bởi các thiết bị bên ngoài bằng cách sử dụng một chương trình tuần tự hoặc giao 
thức MC. 
Kể từ khi tên bộ nhớ được sử dụng để xác định các mục tiêu bộ nhớ trong GX Works2, số lượng ổ đĩa cần phải được xem xét. 

*2:  Lưu trữ các thông số chức năng Module thông minh trong các ổ đĩa cùng với các thông số. 

Khi chúng được lưu trữ trong các ổ đĩa khác nhau, các thông số chức năng Module thông minh không có hiệu lực. 

*3 Một chương trình được lưu trữ trong ROM tiêu chuẩn không thể 

được thực thi. Lưu trữ các chương trình vào bộ nhớ chương 

trình trước khi thực hiện. 

*4:  : Để thực hiện một chương trình được lưu trữ trong thẻ nhớ, làm cho các thiết lập trong Boot tab File của cửa sổ Thiết lập thông số Q 

*5:  : Các ý kiến thiết bị không thể được đọc bởi một chương trình hướng dẫn trong chuỗi   

*6 Đọc từ một chương trình đòi hỏi nhiều trình tự quét.. 

*7:  Chỉ có mỗi một trong những tập tin đăng ký, một thiết bị địa phương, và lấy mẫu dấu vết tập tin có thể được lưu trữ trong bộ nhớ RAM tiêu chuẩn 

*8:  Đối với số lượng đăng ký có thể lưu trữ tập tin, hãy tham khảo hướng dẫn sử dụng chức năng Giải thích QnUCPU của người sử dụng, chương trình cơ 
bản. 

*9:  : Một chương trình tuần tự chỉ cho phép đọc. Không có dữ liệu có thể được viết từ các chương trình tuần tự. 

*10: Dữ liệu có thể được viết hoặc đọc các hướng dẫn sau đây. 

• SP.FREAD (batch-đọc dữ liệu từ các tập tin chỉ định trong thẻ nhớ.) 

• SP.FWRITE (batch-ghi dữ liệu vào tập tin chỉ định trong thẻ nhớ.) 

*11: Thiết lập một khu vực được sử dụng bởi hệ thống. 
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 Khả năng bộ nhớ và sự cần thiết của việc định dạng. 

 Các bảng dưới đây liệt kê các khả năng bộ nhớ và sự cần thiết của định 
dạng của mỗi bộ nhớ. 

. 
 

 Q00UJCPU Q00UCPU Q01UCPU Q02UCPU Q03UD(E)CPU Định dạng 

Bộ nhớ chương trình 
10K bước 

(40K byte) 

15K bước 

(60K byte) 

20K bước 

(80K byte) 

30K bước 

(120K byte) 
*1 

ROM tiêu chuẩn 256K byte 512K byte 1024K byte Không cần 

RAM tiêu chuẩn - 128K byte 192K byte *1 
 

 
 
 

 
 
 

Thẻ nhớ 

 
Thẻ  
SRAM 

 

 

 

- 

Q2MEM-1MBS: 1M byte 

Q2MEM-2MBS: 2M byte 

Q3MEM-4MBS: 4M byte 

Q3MEM-8MBS: 8M byte 

 
Cần (sử dụng GX 

Works2.) 

Thẻ 

Flash  
- 

Q2MEM-2MBF: 2M byte Q2MEM-

4MBF: 4M byte 
Không cần 

 

 

 

Thẻ  
ATA 

 

 
 

 
- 

 

 

Q2MEM-8MBA: 8M byte Q2MEM-

16MBA: 16M byte Q2MEM-32MBA: 

32M byte 

 

 

 

Cần (sử dụng GX 

Works2.) 

 

 Q04UD(E)H 

CPU 

Q06UD(E)H 

CPU 

Q010UD(E)H 

CPU 

Q13UD(E)H 

CPU 

Q20UD(E)H 

CPU 

Q26UD(E)H 

CPU 
Định dạng 

Bộ nhớ chương trình 
40K bước 

(160K byte) 

60K bước 

(240K byte) 

100K bước 

(400K byte) 

130K bước 

(520K byte) 

200K bước 

(800K byte) 

260K bước 

(1040K byte) 
*1 

ROM tiêu chuẩn 1024K byte 2048K byte 4096K byte Không cần 

RAM tiêu chuẩn 256K byte 768K byte 1024K byte 1280K byte *1 
 

 

 
 
 

Thẻ nhớ  

 
Thẻ 
SRAM 

 

Q2MEM-1MBS: 1M byte 

Q2MEM-2MBS: 2M byte 

Q3MEM-4MBS: 4M byte 

Q3MEM-8MBS: 8M byte 

 
Cần sử dụng GX 

Works2.) 

Thẻ 

Flash 

Q2MEM-2MBF: 2M byte Q2MEM-

4MBF: 4M byte 
Không cần 

Thẻ 

ATA 

 

Q2MEM-8MBA: 8M byte Q2MEM-

16MBA: 16M byte Q2MEM-32MBA: 

32M byte 

Cần(sử dụng GX 

Works2.) 

 

*1:  Khi nội dung bộ nhớ trở nên không xác định trong tình trạng ban đầu hoặc do sự kết thúc vòng đời của pin, bộ nhớ sẽ tự động định dạng sau khi các 

bộ lập trình điều khiển được tắt nguồn và sau đó thiết lập lại. Hãy chắc chắn để định dạng bộ nhớ trong GX Works2 trước khi sử dụng. 
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Phụ lục 6. So sánh với GX Developer (thay đổi) 
(1) Hỗ trợ CPU modules 

Bảng sau đây liệt kê các module CPU được hỗ trợ trong GX Works2 

. 
 

Chuỗi thiết bị khả trình  

Loại thiết bị khả trình 

QCPU (Mô hình Q) Mô hình hiệu suất cao QCPU (Q02, Q02H, Q06H, Q12H, 
Q25H) 

Universal  Q-CPU 

(Q00UJ, Q00U, Q01U, Q02U, Q03UD, Q03UDE, 

Q04UDH, Q04UDEH, Q06UDH, Q06UDEH, Q10UDH, 

Q10UDEH, Q13UDH, Q13UDEH, Q20UDH, Q20UDEH, 

Q26UDH, Q26UDEH, Q50UDEH, Q100UDEH) 
 

Bảng sau đây liệt kê các module CPU mà không được hỗ trợ trong GX Works2. 

Sử dụng GX Developer cho module CPU sau. 

 

Chuỗi thiết bị khả trình  
Loại thiết bị khả trình 

QCPU (Mô hình Q) Mô hình cơ bản QCPU (Q00J, Q00, Q01) 

Quy trình CPU (Q02PH, Q06PH, Q12PH, Q25PH) 

Dư thừa CPU (Q12PRH, Q25PRH) 

Nhập / xuất từ xa(QJ71LP21, QJ71BR11) 

QCPU (chuyển động) Tất cả loại thiết bị khả trình 

QCPU (mô hinh A) Tất cả loại thiết bị khả trình 

QSCPU Tất cả loại thiết bị khả trình 

QnACPU Tất cả loại thiết bị khả trình 

ACPU Tất cả loại thiết bị khả trình 

Bộ điều khiển chuyển động 
(SCPU) 

Tất cả loại thiết bị khả trình 

CNC (M6, M7) Tất cả loại thiết bị khả trình 
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(2) Các tính năng không được hỗ trợ 

 Bảng sau đây liệt kê các tính năng mà không được hỗ trợ trong GX Works2. 

 Sử dụng GX Developer, GX Simulator, hoặc GX Configurator cho các tính năng  

 sau đây. 
 

                                              Chức năng không được hỗ trợ     Thay thế S/W 

           Chức năng trực tuyến                      Chức năng TEL GX Developer GX 
Simulator 
 Chức năng khắc phục lỗi cho 

chương trình ladder 

 

Chức năng Điều kiện hiển thị / thiết lập điều kiện Thiết 
bị hiển thị ngừng  

Chức năng đo thời gian quét 

thi hành chức năng bỏ qua / Các linh kiện / Bước  

Chức năng khắc phục lỗi cho 
chương trình ST 

 

Chức năng khắc phục lỗi 

Chức năng điểm dừng 

  Chức năng thông minh lập trình 
module  

Chức năng hỗ trợ FB giao thức GX Configurator-SC 
 

Chức năng thông minh khắc phục lỗi 
module  

Chức năng hỗ trợ khắc phục lỗi 

 Chức năng trực tuyến để định vị 
module 
 

Chức năng tìm vết GX Configurator-QP 
 

Chức năng trình giám sát hệ thống 

Chức năng chế độ kiểm tra 

Chức năng khởi tạo giá trị thiết bị 
 

  Chức năng đăng kí bộ nhớ thiết bị GX Developer 
 

Chức năng in 

Chức năng mật khẩu Chức năng việc đăng kí mật khẩu cho dữ liệu trong dự 
án 

GX Developer 

Tương tác với GX Explorer Khởi động bằng GX Explorer GX Developer 

Tương tác với Nhà phát triển PX   PX Developer GX Developer 

Tương tác với GX Converter I/O chức năng với  GX Converter GX Developer 

Nhập vào định dạng in MEDOC Nhập vào trong định dạng in MEDOC GX Developer 

Chức năng trực tuyến Chẩn đoán sự cố module thông minh từ trình giám sát hệ 
thống 

GX Developer 
GX Configurator 

Thống kê chức năng tìm vết Thống kê chức năng lần tìm ra có điều kiện trên số bước GX Developer 
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(3) Các loại dự án được hỗ trợ 

 Bảng sau đây liệt kê các loại dự ánđược hỗ trợ trong GX Works2. 

. 
 

Loại dự án Mô tả 

Dự án đơn giản ( 

không có nhãn ) 

     Tương đương với dự án" không sử dụng  sử dụng nhãn" của Nhà phát triển  GX.  

1)  Khi Dự ánđược  tạo ra trong" không sử dụng nhãn" của Nhà phát triển GX được đọc với 

GX Works2, dự ántrở thành Simple dự án( không có nhãn ).  

2) Khi Dự ánđược tạo ra trong Simple dự án( không có nhãn ) của GX Works2 được đọc với 

Nhà phát triển GX, dự ántrở thành dự án "  không sử dụng nhãn". 

Dự ánđơn giản ( 

với nhãn ) 

        Tương đương với dự án " Sử dụng nhãn" của Nhà phát triển GX.  
1) Khi dự ánđược tạo ra trong" Sử dụng nhãn" của GX Nhà phát triển được đọc với GX 

Works2, dự án trở thành Simple dự án( với nhãn ).  

2) Khi dự ánđược tạo ra trong dự ánĐơn giản ( với nhãn ) của GX Works2 được đọc với Nhà 

phát triển GX, dự ántrở thành dự án " Sử dụng nhãn". 

Dự án dự án 
Ở GX Works2," lập trình có cấu trúc" luôn  sẵn sàng. Lập trình có cấu trúc thu được trong 

khi tạo ra POUs và tổ hợp chúng ( thanh ghi tác vụ trong tập tin chương trình ).  

1) Khi dự ánđược tạo ra trong" Sử dụng nhãn" với ST của Nhà phát triển GX được đọc với 

GX Works2, dự ántrở thành" Structured Dự án”. 

2) Dự ánđược tạo ra trong" Cấu trúc Dự án" của GX Works2 không thể đọc với Nhà phát 

triển GX.  

 

(a) Sử dụng chức năng dự án 

Trước khi sử dụng các chức năng trong dự ánGX Works2, xem xét các biện 
pháp phòng ngừa sau đây. 

. 
 

Chức năng Mô tả ( sự khác biệt giữa Nhà phát triển GX và GX Works2 ) 

GX Developer GX Works2 

Bảo vệ dự án Bằng cách cài đặt các dự ánnhư "chỉ theo 
dõi", các dự áncó thể được bảo vệ trên 
mỗi máy tính cá nhân. 

Bằng cách thiết lập dự án như" chỉ - đọc với 

chức năng " Security ", dự án–bởi - dự ánsự 

bảo vệ là hiện đang có sẵn. 

Thay đổi loại dự án Loại dự ánkhông thể thay đổi từ" không 

sử dụng nhãn" thành " Sử dụng nhãn". 
Những thay đổi loại hình dự ánsau đây 

đang có sẵn. 

1) Từ "Dự án cơ bản(không  nhãn)" đến " 

Dự án cơ bản (có nhãn)" 

2) Từ  "Dự án cơ bản (với nhãn)"  

đến” C ấ u  t r ú c  dự án". 

* Loại dự án không thể thay đổi trực tiếp từ " dự 

án cơ bản (với nhãn )" đến  "Cấu trúc dự án” 

 

Đọc  định dạng dự 
ánNhà phát triển GX 

Chọn [Dự án] → [Open Other Dự án] có thể đọc định dạng protect Nhà phát triển GX. 

Đọc dự áns cấu hình GX 

- định dạng QP. 

Chọn  [Dự án] → [Intelligent Function Module] → [Import GX Configurator-QP Data] có thể 

đọc dự án cấu hình GX - định dạng QP.. 

Sao chép dữ liệu dự 
ánnày sang dự ánkhác 

Nó được kích hoạt trên các dự án hộp 
thoại copy 

Sao chép và dán những thứ hiện có trong cửa sổ 
window. 
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(4) Ngôn ngữ lập trình được hỗ trợ bởi mỗi loại dự án. 

 Bảng sau đây liệt kê ngôn ngữ lập trình được hỗ trợ bởi mỗi dự ánloại  

 GX Works2. 
 

Kiểu dự án Hỗ trợ ngôn ngữ lập trình 

Simple dự án 

 (không có nhãn) 

Ladder, SFC (MELSAP3) 

Simple dự án 

 (có nhãn) 

Ladder, SFC (MELSAP3) 

* Chương trình hỗ trợ phần tử : nhãn, cấu trúc, khối chức năng 

Cấu trúc dự án Ladder, SFC (MELSAP3), cấu trúc ladder, ST 

* Chương trình hỗ trợ phần tử : nhãn, cấu trúc, khối chức năng, block hàm, thư viện 
 

Ngôn ngữ lập trình sau không được hỗ trợ đưa vào GX Works2. Nhà 

phát triển GX sử dụng cho ngôn ngữ lập trình sau. 
 

Kiểu dự án Hỗ trợ ngôn ngữ lập trình 

Danh sách 1) Khi GX Works2 đọc chương trình tạo ra với danh sách đưa vào nhà phát triển GX, nó có 

thể được hiển thị hay hiệu chỉnh đưa vào ladder.  

2) Khi nhà phát triển GX đọc chương trình tạo ra với ladder đưa vào GX Works2, nó có thể 

được hiển thị hay hiệu chỉnh đưa vào danh sách 

MELSAP-L 1) Khi GX Works2 đọc chương trình tạo ra với MELSAP-L đưa vào nhà phát triển GX, nó 

có thể được hiển thị hay hiệu chỉnh đưa vào ladder. 

2 ) Khi nhà phát triển GX đọc chương trình tạo ra với SFC ( MELSAP3 ) đưa vào GX 

Works2, nó có thể được hiển thị hay hiệu chỉnh đưa vào MELSAP-L. 

 

(a)   Sử dụng ngôn ngữ ladder  

Trước khi sử dụng ngôn ngữ ladder đưa vào GX Works2, xem xét phòng 

ngừa sau. 
 

Chức năng Mô tả ( khác nhau giữa nhà phát triển GX và GX Works2 

GX Developer GX Works2 

Chương trình tính đàn 
hồi thiết bị biệt hiệu 

Nó được cho phép bằng" Biệt hiệu" hàm Sử dụng" Nhãn". 

Đoạn một phần chương 
trình vào POUs 
( marcos) 

Nó được cho phép bằng" định nghĩa 

macro / nhập"  chức năng 

Sử dụng" khối chức năng” 

Phát hiện / Thay thế câu 

lệnh / thiết bị / phòng thí 

nghiệm chữ L 

Phát hiện được cho phép bằng trực tiếp 

gõ câu lệnh / thiết bị / nhãn đưa vào" Đọc 

phương thức". 

Nhấn phím Space trên bộ lắp ladder cho phép 

phát hiện đơn. 

Kiểm tra sử dụng trạng 

thái của thiết bị / nhãn 

Nó được kích hoạt bằng chức năng" 

Danh sách Tham chiếu chéo" và" chức 

năng" Danh sách Thiết bị Đã sử dụng" 

Thiết bị Sử dụng" hàm. 

Chọn [Find/Replace] → [Cross Reference], or 

[Find/Replace] → [Device List]. 

Hợp nhất chương trình Được cho phép bằng" Hợp nhất vào Số 
liệu" 

hàm. 

Sử dụng sao chép và dán trên bộ lắp nhãn 

Kiểm tra Khối không tương ứng Cửa sổ Kết quả Kiểm tra thể hiện rõ những thứ 

sau đây:" không gì có thể sánh bằng vùng 

chương trình"," nguồn kiểm tra chỉ chứa đựng 

chương trình" và" dự định kiểm tra chỉ chứa đựng 

chương trình ". 
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(b)   Sử dụng SFC ( MELSAP3 ) ngôn ngữ  

Trước khi dùng SFC ( MELSAP3 ) ngôn ngữ đưa vào GX Works2, xem 

xét phòng ngừa sau. 
 

Chức 
năng 

Mô tả ( khác nhau giữa nhà phát triển GX và GX Works2 ) 

GX Developer GX Works2 

Thay đổi số khối Nó được cho phép bằng" sao chép và dán" 

chức năng đưa vào danh sách khối 
Mỗi số liệu khối được hiển thị đưa vào cửa 

sổ Dự án, và số khối có thể được thay đổi 

đưa vào quyền sở hữu của số liệu mỗi 

khối. 

* Chọn [ Nhìn ] → [ Mở SFC Blocklist ] có thể 

biểu lộ danh sách block đương lượng để 

của nhà phát triển GX. Tự động cuộn Sơ đồ khối tin có thể mở bằng khởi hành 

khối 

Chọn lọc [View] → [Open Zoom/Start 

Destination Block] có thể mở nó. 

Thay đổi số khối Nó được cho phép bằng" sao chép và dán" 

chức năng đưa vào danh sách khối 
Mỗi số liệu khối được hiển thị đưa vào cửa 

sổ Đề án, và số khối có thể được thay đổi 

đưa vào quyền sở hữu của số liệu mỗi 

khối. 

* Chọn [ Nhìn ] → [ Mở SFC Blocklist ] có thể 

biểu lộ danh sách block đương lượng để 

của nhà phát triển GX. 

Vận hành mở / chuyển 

tiếp điều kiện chương 

trình 

Di chuyển con trỏ trên biểu đồ SFC có 

thể hiển thị thu phóng ( vận hành tại đầu 

ra / điều kiện chuyển tiếp ). 

Chọn  [View] → [Mở Zoom/Start Destination 

Block] có thể mở. Hoặc nhấn đúp trong khi 

ấn phím Crt cũng có thể mở nó 

Multiple zooms ( thao tác tại đầu ra /điều kiện chuyển tiếp ) có thể hiển thị cùng một lúc . 

* Thay đổi" Thiết lập của Zoom Display" tùy chọn có thể chuyển đổi hiển thị trong cửa 

sổ giống như phương pháp của Nhà phát triển GX 

 
(c) Sử dụng nhãn 

Trước khi dùng nhãn đưa vào GX Works2, xem xét biện pháp phòng ngừa 
sau.. 

 

Chức 
năng 

Mô tả ( khác nhau giữa nhà phát triển GX và GX Works2 ) 

GX Developer GX Works2 

Thiết bị kiểm tra tự động 

được phân công cho 

nhãn 

Nó được cho phép bằng" Biểu diễn áp 

đặt thiết bị" chức năng của bộ lắp nhãn 

Kiểm tra bộ lắp ladder bằng cách chọn [View] 

→ [Device Display]. 

Import/Export thiết bị chú 

thích đến nhãn 

Nó được cho phép bằng" thiết bị chú thích 

đầu vào  " chức năng và" thiết bị chú thích 

đẩu ra" chức năng. 

Sử dụng sao chép và dán trên nhãn 

người biên tập và thiết bị chú thích của 

người biên tập 

Sử dụng trỏ - loại nhãn Con trỏ cục bộ được gán. Cho dự ánvới kí hiệu, 2048 trỏ được xác 

lập mặc định trong" Con trỏ thông thường 

NO." trong"Hệ thống PLC " cữ đích của 

Tham biến PLC . 

Không thể dùng được từ 

riêng cho tên nhãn 

Định nghĩa của các từ riêng là khác giữa GX Nhà phát triển và GX Works2 
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(d) Sử dụng khối chức năng  

                                                    Trước khi dùng khối chức năng đưa vào GX Works2, xem xét biện  

                                                    pháp phòng ngừa sau. 
 

Chức năng Mô tả 

Sử dụng khối chức năng tạo ra 

ladder. 

Khối chức năng tạo ra với ladder có thể được dùng trong chương trình ladder, 

chương trình ST, và đầu ra thao tác chương trình SFC. 

 
*Khi sử dụng khối chức năng đã tạo với ladder cho chương trình ST, chọn [ Công 

cụ ] → [ Tùy chọn ] → [ Biên dịch ] → [ thiết lập cơ bản ] →" gọi khối chức năng 

Enable ' từ ladder đến Structured Ladder / FBD ' và ' từ Structured Ladder / FBD 

hoặc ST đến ladder". 

Sử dụng khối chức năng tạo ra 

cấu trúc ladder. 

Khối chức năng tạo ra với cấu trúc ladder có thể được dùng cho chương trình 

ladder, cấu trúc chương trình ladder và chương trình ST. 

Sử dụng khối chức năng tạo ra 

ST. 

Hàm block tạo ra với ST có thể được dùng cho chương trình ladder,  cấu trúc 
chương trình ladder, và chương trình ST.  

 
* Khi sử dụng Hàm block tạo ra với ST cho chương trình ladder , chọn lọc [Tool] 

→ [ Options] → [Compile] → [Basic Setting] →" cho phép hàm block gọi ' từ 

ladder đến Cấu trúc ladder / FBD ' và ' từ Cấu trúc ladder / FBD hoặc ST tới 

ladder ". 

Khi quyền lựa chọn" Cho phép 

khối chức năng kết nối ' từ 

ladder đến Cấu trúc sơ đồ 

ladder/ FBD ' và ' từ Cấu trúc 

ladder/ FBD hoặc ST tới sơ đồ 

thang" là tập hợp 

Khi  VAR_IN_OUT đầu vào biến số và đầu ra biến số có nhãn khác nhau / thiết 

bị, giá trị biến số đàu vào luôn bằng giá trị biến số đầu ra. 

 

(5) Sử dụng chú giải biến địa chỉ 

 Trước khi dùng chú giải biến địa chỉ đưa vào GX Works2, xem xét phòng ngừa 
sau. 

 

Chức 
năng 

Mô tả ( khác nhau giữa nhà phát triển GX và GX Works2 ) 

GX Developer GX Works2 

Xóa biến địa chỉ của thiết 

bị chưa được sử dụng 

Nó được kích hoạt bằng cách xóa chú 

thích chức năng. 

Sau khi kiểm tra các thiết bị không sử dụng 

bằng cách chọn  Find/Replace] → [Device List], 

xóa chú giải biến địa chỉ trực tiếp. 

. Mẫu chú thích Nhận xét mẫu của relay / đăng ký đặc 

biệt đặc biệt được cung cấp theo 

dạng dự án. 

Chú thích của rơ le đặc biệt / thanh ghi đặc biệt 

và module chức năng thông minh có thể được 

nhập bởi chức năng " Nhập vào Sample 

Comment  " trên trình soạn thảo. 

 

(6) Sử dụng bộ nhớ biến địa chỉ 

Trước khi sử dụng các bộ nhớ biến địa chỉ trong GX Works2, xem xét các 

biện pháp phòng ngừa sau đây. 
 

            Chức năng Mô tả 

Hiển thị bộ nhớ biến biến 

địa chỉ 

Nhiều dãy thiết bị có thể được hiển thị trong một cửa sổ. 

* Bằng cách chọn "All Range" khi thiết bị này là đầu vào, tất cả các phạm vi biến địa chỉ 

có thể được hiển thị trong một cửa sổ trong cùng một cách như của GX Developer. 

Copy and past device 

memory data to Excel 

Để sao chép và bộ nhớ thiết bị nhập dữ liệu vào Excel, chọn [Tool] → [đọc từ Excel 

File] / [Viết cho Excel File]. 
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(7) Sử dụng thiết bị giá trị ban đầu 

Trước khi sử dụng thiết bị giá trị ban đầu trong GX Works2, xem xét các 

biện pháp phòng ngừa sau đây. 
 

Chức 
năng 

Mô tả ( khác nhau giữa nhà phát triển GX và GX Works2 ) 

GX Developer GX Works2 

Số lượng tối đa của dữ 

liệu giá trị khởi đầu của 

thiết bị  đã được tạo lập 

Chỉ có một tập hợp các dữ liệu có thể 

được tạo ra. 

Lên đến 800 bộ dữ liệu có thể được tạo ra. 

Hạn chế số lượng thiết bị Số thiết bị phải có trong những điểm 

tối đa của mỗi bộ điều khiển lập trình 

của thiết bị. 

Số lượng thiết bị phải nằm trong phạm vi thiết 

lập thiết bị của các thông số PLC. 

Viết cho PLC / đọc từ 
PLC 
IC thẻ nhớ ghi / đọc 

Chỉ có 1 dữ liệu có thể được đọc và 

viết. 

Nhiều dữ liệu được lựa chọn có thể được đọc và 

viết. 

 

(8) Sử dụng chức năng trực tuyến 

 Trước khi sử dụng các chức năng trực tuyến tại GX Works2, xem  

 xét các biện pháp phòng ngừa sau đây. 
 

Chức 
năng 

Mô tả ( khác nhau giữa nhà phát triển GX và GX Works2 ) 

GX Developer GX Works2 

Thiết lập điểm đến kết nối Một đề án có thể chỉ chứa một tập 

hợp các "điểm đến kết nối" thông tin. 

Một đề án có thể chứa nhiều bộ "đích kết nối" 
thông tin. Để thay đổi các "điểm kết nối" 
thông tin, chọn "Connecting  Destination" trong 

cửa sổ đề án. 

Viết / đọc dữ liệu đến / từ 

các module chức năng 

thông minh 

Dữ liệu có thể được viết hoặc đọc đến 

/ từ các module CPU và các chức 

năng module thông minh cùng một lúc. 

Chọn [online] → [write to PLC] ghi dữ liệu vào 
module CPU và các chức năng module thông 
minh cùng một lúc. 
Cách chọn [online] → [Read from PLC] đọc dữ 

liệu từ module CPU và các chức năng module 

thông minh cùng một lúc. 

Ghi dữ liệu vào ROM 

Flash của module CPU 

Nó được kích hoạt bởi các chức năng 

"PLC write (Flash ROM)". 

Các chức năng  "PLC write (Flash ROM)" được 
tích hợp trong chức năng “ write to PLC"  
Chọn [online] → [write to PLC]. 

Vận hành từ xa cửa sổ 

PLC đê dự đoán Hệ 

thống cửa sổ màn hình. 

Chọn [online] → [Operation Remote ] và [Diagnostics] → [System Monitor] / [PLC 
Diagnostics] bây giờ có thể hiển thị các hình ảnh Module và các trạng thái vận hành bộ 
điều khiển lập trình CPU là dễ dàng nhận thấy. 
Các hoạt động từ xa, hoạt động bộ nhớ, và thiết lập đồng hồ có thể được bắt đầu từ 

cửa sổ PLC Diagnostics. 

 

          Chức năng Mô tả 

Đọc từ PLC Thông tin mang tính biểu tượng trong định dạng Developer GX không bao gồm các 

chương trình SFC. Đọc thông tin mang tính biểu tượng về "đề án đơn giản (không có 

nhãn)". Nếu các thông tin mang tính biểu tượng của GX Developer hoặc GX IEC Developer 

được đọc ra, đề án sẽ không được soạn thảo. 
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(9) Sử dụng màn hình / chức năng debug 

 Trước khi sử dụng các chức năng theo dõi / debug trong GX Works2, xem        

xét các biện pháp phòng ngừa sau đây. 
 

Chức năng Mô tả 

Nhập màn hình thiết bị Các chức năng "nhập màn hình thịết bị " bây giờ là một cửa sổ hạn chế như một chức năng 

"xem" để nó có thể được hiển thị mà không chồng chéo với các chương trình soạn thảo, 

Device / nhãn đã được kích hoạt để được nhập bằng cách kéo và thả từ trình soạn thảo 

chương trình và bật / tắt tình trạng của thiết bị và giá trị hiện tại của các thiết bị có thể 

được sửa đổi trên cửa sổ màn hình. 

Thiết bị giám sát hàng 
loạt 
Đệm giám sát hàng loạt 

Các chức năng "thiết bị giám sát hàng loạt " và "đệm theo dõi hàng loạt bộ nhớ"  đang 

tích hợp để nhận ra khả năng hoạt động tương tự. 

Bật / tắt tình trạng của thiết bị và giá trị hiện tại của các thiết bị có thể được sửa đổi trên 

cửa sổ màn hình. 

Giám sát và kiểm 

tra các chức năng 

Module thông 

minh 

Để sử dụng các chức năng giám sát hoặc kiểm tra cho FL-net (OPCN-2) giao diện đơn vị 

và AS-i đơn vị làm chủ, thực hiện chức năng "watch" và "Device / Buffer màn hình hàng 

loạt bộ nhớ" . 
 

(10) Sử dụng chức năng in ấn 

 Trước khi sử dụng các chức năng in ấn trong GX Works2, xem xét các  

 biện pháp phòng ngừa sau đây. 
 

           Chức  năng Mô tả 

Thêm in các thông tin 

như báo cáo và chú thích 

thiết bị  

Hình ảnh hiển thị được in hoặc xem trước. 

Để in thêm các thông tin như một bản tường trình và nhận xét thiết bị, đưa các mục 

thông tin  trên màn hình và sau đó chọn [Dự án] → [Print Window] / [Print Preview 

Window]. 

(11) Sao chép lưu dữ liệu đề án 

 Trước khi sao chép dữ liệu dự ánđược lưu trong GX Works2, xem xét các 

 biện pháp phòng ngừa sau đây.. 
 

Chức 

năng 

Mô tả  (khác nhau giữa GX Developer và GX Works2) 

GX Developer GX Works2 

Sao chép dữ liệu dự 

ánđược lưu 

Dữ liệu dự ánđược lưu có thể được 

sao chép bằng cách sao chép các 

tập tin trong thư mục tên dự án. 

Sao chép tất cả các thư mục tên workspace và 

"workspacelist.xml"được  tạo ra trong hệ thống 

cấp bậc giống như các thư mục tên workspace. 
 

(12) Tính tương thích với GX Nhà phát triển 

 Cho tính tương thích giữa GX Nhà phát triển và GX Works2, xem xét  

 biện pháp phòng ngừa sau.. 
 

            Chức năng Mô tả 

Mở dự ántrong các định 

dạng khác 

Trước khi mở một dự án GX Developer "Sử dụng nhãn"  trong đó có một chương trình 

và khối chức năng có cùng tên,thì thay đổi tên dữ liệu trong GX Developer. 

Tên chức năng của ngôn ngữ ST khác nhau giữa GX Developer và GX Works2. Biên 

dịch chương trình và sửa lỗi. 

Dự án xuất  đến tập tin 

định dạng GX Dveloper 

Dự áncó thể áp dụng được là sau đây;  

1) Simple dự án(không nhãn) 

2) Compiled Simple dự án(có nhãn) 

dự ánsử dụng nhãn trong ngôn ngữ SFC được thi hành. 

Dự áncó thể được lưu trong định dạng Developer GX khi không có trường hợp nàotrong 
số các trường dưới đây được áp dụng. 

1) Không có thiết được thiết lập. 

2) Chiều dài của tên nhãn vượt quá 16 ký tự. 

3)  Tên Nhãn chứa tên thiết bị hoặc từ dành riêng.  

4) Ký tự không hợp lệ được sử dụng.  

5) Kiểu dữ liệu không được hỗ trợ bởi Nhà phát triển GX được sử dụng. 

6) Giá trị không phải là hằng số được dùng trong hằng số. 

Dữ liệu thanh ghi đến nhãn toàn cục  là thiết lập như" Auto External" với mọi nhãn cục bộ. 
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(13) Tính tương thích với GX IEC Dveloper 

Cho tính tương thích giữa GX IEC Developer và GX Works2, xem xét biện 

pháp phòng ngừa sau.. 
 

            Chức năng Mô tả 

Mở dự ántrong các định 

dạng khác 

Tên chức năng của ngôn ngữ ST khác giữa GX IEC Nhà phát triển và GX Works2. Biên 

dịch chương trình và sửa lỗi. 

Thư viện người dùng Trước khi dùng thư viện người dùng GX IEC Dveloper mà mật khẩu là ấn định thành, huỷ 

bỏ mật khẩu trong GX IEC Developer. 
 

(14 ) Thao tác then chốt 

  Phần này giải thích sự khác biệt của thao tác then chốt giữa Nhà  

  phát triển GX và GX Works2. 
 

Chức năng Mô tảm 
Phím tắt 

GX Developer GX Works2 

S
ử

a
 

Chế độ đọc Kích hoạt chế độ đọc Shift + F2 - (*1) 

Chế độ ghi Kích hoạt chế độ ghi F2 - (*1) 

T
ìm

 /
 T

h
a
y
 t
h

ế
 

Tham chiếu chéo Hiện thị tham chiếu chéo -  
 

 
Danh sách thiết bị 

 

 
Hiện thị danh sách thiết bị 

 

 
- 

 

C
h
u
y
ể
n
 

đ
ổ
i 

 

 

Chuyển đổi ( tất cả chương trình 

được chỉnh sửa ) 

 

 

Chuyển đổi tất cả chương trình được 

chỉnh sửa. 

 

 

Ctrl + Alt + F4 

 

 

- 

V
ie

w
 

Danh sách dữ liệu Dự án 
Thiết bị chuyển mạch hiển thị / không 

hiển thị danh sách dữ liệu dự án. 
Alt + O - 

Chuyển đổi giữa Dự ándanh sách 

dữ liệu và cửa sổ 

Thiết bị chuyển mạch giữa  Dự ándanh 

sách dữ liệu và mỗi cửa sổ. 
Alt + 7 - 

Chuyển đổi giữa ladded và list 
Thiết bị chuyển mạch giữa cửa sổ 

ladder và cửa sổ danh sách. 
Alt + F1 - 

T
rự

c
 t
u
y
ế

n
 G

iá
m

 s
á

t 

Giám sát ( tất cả cửa sổ ) 
Các ladder giám sát của tất cả chương 

trình mở. 
Ctrl + F3 - 

Giám sát ( ghi chế độ ) 
Kích hoạt chế độ ghi trong thiết bị 

ladder giám sát. 
Shift + F3 - (*2) 

Ngừng  Giám sát ( tất cả cửa sổ 

) 

Ngừng ladder giám sát với mọi chương 

trình mở. 
Ctrl + Alt + F3 - 

K
h
ắ
c
 p

h
ụ
c
 l
ỗ
i 

Thử nghiệm thiết bị 
Bật hoặc tắt các thiết bị thủ công hoặc 

thay đổi giá trị hiện tại. 
Alt + 1 - 

Bỏ thi hành 
Thi hành chương trình tuần tự chọn 

lọc trong bỏ qua thi hành. 
Alt + 2 - 

Thi hành từng phần 
Chương trình trình tuần tự thi hành 

từng phần. 
Alt + 3 - 

bước thi hành 
Thi hành bộ điều khiển lập trình được 

Cpu trong bước thi hành. 
Alt + 4 - 

Thao tác từ xa Thi hành thao tác từ xa. Thi hành thao 

tác từ xa. 

- 
 

*1:  Trong GX Works2, chuyển mạch trình soạn thảo ladder đến đọc chế độ / ghi chế 

độ là không cần thiết. Ladder có thể chỉnh sửa bất kỳ lúc nào.. 

*2:  : Trong GX Works2, chuyển mạch trình soạn thảo ladder đến thiết bị hiển thị ( ghi chế độ ) 

trong thiết bị hiển thị ladder là không cần thiết.. 

Ngay cả trong việc giám sát  ladder, ladder có thể được chỉnh sửa và ghi vào bộ điều khiển lập 

trình được trong trạng thái RUN. 
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Phụ lục 7   Tùy chỉnh phím tắt 

Các phím tắt của mỗi chức năng có thể được tùy chỉnh. 

Phím tắt tùy chỉnh có thể được đăng ký như là một khuôn mẫu và sử dụng. 

Màn hình hiện thị 
 

 

Chọn [Tool] → [Key Customize]. 
 

 
 

Mục  Mô tả 

Phím tắt - 

 Mục  Chọn mục từ danh sách nhóm phân loại bằng cửa sổ. 

Lệnh Chọn tên chức năng phím tắt được thay đổi. 

Phím hiện hành Hiển thị phím tắt được gán cho chỉ lệnh được lựa chọn. 
 

 

Nhấn phím để gán 

Xác định phím tắt mới để được gán. Nhấn một phím ( s ) trên bàn phím gán 
phím ( s ).  

 Ví dụ)   

 

 

Hiện hành 

Hiển thị tên menu mà phím tắt nhập được gán.  

Khi phím đã được gán cho chức năng khác, tên chức năng được hiển thị. 

 

 

 

 

Khuôn mẫu 

• Chọn khuôn mẫu của phím tắt từ hộp danh sách.  

• Thiết lập mặc định 

• Thiết lập mặc định được thiết lập .  

• Thiết lập Định dạng  GPPA  

• Thiết lập phím tắt tại lập trình ladder là thay đổi cùng thiết lập với ở 

GPPA.  
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Nút màn hình 

 

Gán phím tắt. Phím tắt gán được hiển thị trong" Current Key". 

 

Xoá bỏ phím tắt đã chọn ở" Current Key ". 

 

Màn hình Enter Template Name được hiển thị 

 Thanh ghi phím tắt gán như là một khuôn mẫu với tên. 

 Khuôn mẫu thanh ghi được hiển thị trong" Template ". ". 
 

 
 

 
 

 

Khuôn mẫu của phím tắt chọn lọc được áp dụng. 

 

 

Xoá bỏ khuôn mẫu được chọn trong " Template ". 

 

 

Nhập vào tập tin mẫu đã được lưu ( *. gks ) và thêm nó vào" Template ". 

 
Lưu khuôn mẫu được chọn trong " Khuôn mẫu" như tập tin mẫu ( *. gks ). 
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SM400 

DM0V K1042431    Z0 

M0V    ZR0Z0 D0 

To index the serial number access format file 

register (ZR) with 32-bit, use the index register (Z). C
o
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Phụ lục 8   Chỉ mục 

 Với QCPU Universal (không bao gồm Q00UJCPU), mở rộng thanh ghi 

 chỉ số đến 32 bit cho phép việc lập chỉ số cho tất cả thanh ghi vùng nhớ file. 

số se-ri truy cập thanh ghi 

định dạng tập tin 

ZR0 

ZR1 

 

ZR32767 

ZR32768 

 

ZR4184063 

 

Phương pháp để xác định thanh ghi chỉ mục 32 bit có thể được chọn lựa theo hai 

phương pháp sau: 

 

• Xác định phạm vi chỉ số được dùng chi 32 bit.  

• Xác định chỉ mục 32 bit sử dụng" ZZ" . 
 

(1)  Khi xác định phạm vi số được dùng cho chỉ số 32 bit 
 

                                               (a)  Mỗi thanh ghi chỉ số có thể thiết lập giữa - 2147483648 và 

      2147483647.  

      Sau đây cho thấy ví dụ chỉ số. 

X0 

DMOV  K40000    Z0 

 

 

Lưu trữ 40000 in Z0. 

 

X0 

ZR10Z0 = ZR{10+40000} 

= ZR40010 in D0. 
 

Chữ số 
 

 

                                            (b)  Phương pháp kỹ thuật 

Cho chỉ số với thanh ghi chỉ số 32 bit, xác định số bắt đầu của thanh ghi 

chỉ số để có thể sử dụng trên các tab Device của màn hình cài đặt thông 

                                                  số PLC trong GX Works2. 

 

GỢI Ý  

Khi số bắt đầu của thanh ghi chỉ số đã được sử dụng được thay đổi trên tab 

Device của màn hình cài đặt thông số PLC, không thay đổi  hoặc không viết 

các thông số vào bộ điều khiển lập khả trình, Chắc chắn chương trình sẽ ghi 

tham biến và bộ điều khiển lập trình được. 

Khi tham biến bị buộc phải ghi vào bộ điều khiển khả trình, xảy ra.  Lỗi CAN’T 

EXE. PRG. ( Mã lỗi : 2500 ) 

ChỈ số số thứ tự truy cập thanh ghi định dạnh file ( ZR 
) với 32 -bit, sử dụng thanh ghi chỉ số ( Z ) 
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                                   (c)   Biến địa chỉ mà chỉ mục có thể được sử dụng 

Chỉ số có thể chỉ được sử dụng cho các biens địa chỉ hiển thị dưới đây. 

• ZR : số sê – ri của thanh ghi tập tin định dạng truy cập  

• D: Mở rộng dữ liệu thanh ghi 

• W: Mở rộng đường dẫn thanh ghi 
 

                                   (d)   Phạm vi Sử dụng của thanh ghi chỉ mục  

Bảng dưới đây cho thấy phạm vi sử dụng của các thanh ghi chỉ số cho lập 

chỉ số với các chỉ số thanh ghi 32-bit. 

Đối với chỉ số của thanh ghi chỉ số 32 bit, thanh ghi chỉ số này  xác định 

( Zn ) và thanh ghi chỉ số tiếp theo của thanh ghi xác định ( Zn + 1 ) 

được sử dụng. Chắc chắn thanh ghi chỉ số này không chồng lấp thanh 

ghi chỉ số đã được sử dụng. 
 

Giá trị thiết lập Thanh ghi chỉ số đã sử dụng Giá trị thiết lập Thanh ghi chỉ số đã sử dụng 

Z0 Z0, Z1 Z10 Z10, Z11 

Z1 Z1, Z2 Z11 Z11, Z12 

Z2 Z2, Z3 Z12 Z12, Z13 

Z3 Z3, Z4 Z13 Z13, Z14 

Z4 Z4, Z5 Z14 Z14, Z15 

Z5 Z5, Z6 Z15 Z15, Z16 

Z6 Z6, Z7 Z16 Z16, Z17 

Z7 Z7, Z8 Z17 Z17, Z18 

Z8 Z8, Z9 Z18 Z18, Z19 

Z9 Z9, Z10 Z19 Không thể được xác định. 
 

                                      (e)   Ví dụ sau đây cho thấy chỉ số và  quy trình thực tế. ( Khi Z0 ( 32 -bit ) là 

                                         100000 và Z2 ( 16 -bit ) là - 20) 
 

Ví dụ ladder Thiết bị xử lý thực tế 

 

X0 
 

 

 

 

 

 

 

 

 

X1 

 

 

DMOV K100000    Z0 
 

 

 

MOV    K-20 Z2 
 

 

 

MOV    ZR1000Z0 D30Z2 

 

 

 

X1 

MOV 
 

 

Mô tả 

ZR1000Z0 

D30Z2 

 

 
 
 

ZR101000   D10 
 
 

 

 

ZR(1000+100000)=ZR101000 

D(30-20)=D10 
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                                    (2)  Khi xác định 32 bit sử dụng kĩ thuật " ZZ" 

                                          (a)   Một chỉ mục thanh ghi có thể xác định 32 bit bằng cách sử dụng kĩ 

                                                 thuật " ZZ" như là" ZR0ZZ4".  

  Ví dụ sau đây cho thấy chỉ mục 32 bit với kĩ thuật " ZZ" ". 
 

M0 

DMOVP K100000 Z4 

 

 
Lưu trữ 100000 at Z4 and Z5. 

 

M0 

MOVP K100 

 

 

ZR0ZZ4 

 

Thiết bị ZR chỉ số xới thanh 

ghi chỉ số 32 bit (Z4 and Z5) 

ZR (0+100000) =ZR100000 
 

                                          (b)   Phương pháp kĩ thuật 

       Chỉ số 32 bit sử dụng kĩ thuật " ZZ", chọn" Use ZZ" trong [ Chỉ số Thiết 

       lập cho Thiết bị ZR ] trong tab Device  trong màn hình thiết lập thông 

       số PLC. 

                                          (c)   Biến địa chỉ có thể sử dụng được chỉ số 

       Chỉ số có thể được sử dụng cho các biến địa chỉ hiển thị dưới đây  

                                                  • ZR: số sê – ri của thanh ghi tập tin định dạng truy cập 

                                                   • D: Mở rộng dữ liệu thanh ghi 

     • W: Mở rộng đường dẫn thanh ghi 
 

                                          (d)   Phạm vi Sử dụng của thanh ghi chỉ mục  

       Bảng dưới đây cho thấy phạm vi sử dụng của các thanh ghi chỉ số cho 

       lập chỉ số với các chỉ số thanh ghi 32-bit. 

       Đối với chỉ số của thanh ghi chỉ số 32 bit, thanh ghi chỉ số này  xác 

       định ( Zn ) và thanh ghi chỉ số tiếp theo của thanh ghi xác định ( Zn + 1 

       ) được sử dụng. Chắc chắn thanh ghi chỉ số này không chồng lấp 

       thanh ghi chỉ số đã được sử dụng. 
 

Kĩ thuật ZZ Thanh ghi chỉ số đã sử dụng " Kĩ thuật ZZ  

Thanh ghi chỉ số đã sử dụng 

□ZZ0 Z0, Z1 □ZZ10 Z10, Z11 

□ZZ1 Z1, Z2 □ZZ11 Z11, Z12 

□ZZ2 Z2, Z3 □ZZ12 Z12, Z13 

□ZZ3 Z3, Z4 □ZZ13 Z13, Z14 

□ZZ4 Z4, Z5 □ZZ14 Z14, Z15 

□ZZ5 Z5, Z6 □ZZ15 Z15, Z16 

□ZZ6 Z6, Z7 □ZZ16 Z16, Z17 

□ZZ7 Z7, Z8 □ZZ17 Z17, Z18 

□ZZ8 Z8, Z9 □ZZ18 Z18, Z19 

□ZZ9 Z9, Z10 □ZZ19 Không xác định  

*: □ chỉ ra t tên thiết bị (ZR, D, W) cho chỉ số đích
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                                           (e)   Ví dụ sau đây cho thấy việc lập chỉ số 32-bit với kỹ thuật  "ZZ" và  thiết 

                                                   bị xử lý thực tế. 

        Các chỉ số kỹ thuật 32-bit với  kỹ thuật "ZZ" áp dụng cho các chức năng 
        sau của GX Works2) 

 

Ví dụ ladder Thiết bị xử lý thực tế 
 

X0 
 

 

 

 

 

 

 

 

 

X1 

 

 

DMOV K100000    Z0 
 

 

 

MOV    K-20 Z2 
 

 

 

MOV    ZR1000Z0 D30Z2 

 

 

X1 

MOV 
 

 

 

Mô tả 

ZR1000Z0 

D30Z2 

 

 
 

ZR101000   D10 
 
 

 

 
ZR(1000+100000)=ZR101000 

D(30-20)=D10 

                                            (f)    Chức năng có sẵn cho kỹ thuật"ZZ"  

         Các chỉ số kỹ thuật 32-bit với  kỹ thuật "ZZ" áp dụng cho các chức 

         năng sau của GX Works2. 
 

No. Tên chức năng và mô tả 

1 Xác định biến địa chỉ  trong chương trình lệnh 

2 Màn hình nhập 

3 Thử nghiệm biến địa chỉ 

4 Thử nghiệm biến địa chỉ với điều kiện 

5 Thiết lập điều kiện màn hình 

 

6 
Tìm lỗi 

( Điểm phát hiện ( xác định thiết bị ), thiết bị phát hiện 

đích) 
 

GỢI Ý  

ZZn không thể được sử dụng đơn lẻ như là biến địa chỉ "DMOV K100000 ZZ0". 
Khi giá trị thiết lập của thanh ghi chỉ số xác định 32-bit với kỹ thuật "ZZ", thiết lập 
giá trị của Zn (Z0 đến Z19). Một mình ZZn không thể là đầu vào cho từng chức 
năng của GX Works2. 

 

Để biết chi tiết, hãy tham khảo QnUCPU User's Manual Function Explanation, 

Program Fundamentals và MELSEC-Q/L Programming Manual (điều kiện lệnh). 
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4) Dán FB vào chương trình 

Count process 1 

X1 
Count_Num1 

Y12 
i_Count o_C_UP 

Count process 2 

X2 
Count_Num2 

Y22 
i_Count o_C_UP 

Phụ lục 9  FB 
 

Phụ lục   9.1 FB  

 
FB là một từ viết tắt cho một khối chức năng được thiết kế để chuyển đổi một 

khối ladder, được sử dụng nhiều lần trong một chương trình tuần tự, một thành 

phần (FB) được sử dụng trong một chương trình tuần tự. 

Điều này không chỉ làm tăng hiệu quả của các chương trình phát triển mà còn 

giảm lỗi lập trình để nâng cao chất lượng chương trình. 

 

 

 

 
 

Hình vẽ Ứng dụng. 9.1 Chuyển đổi chương trình trình tuần tự thành phần . 
 

Phụ lục 9.1.1   Sự chuyển đổi thành thành phần 

Phần sau giải thích quy trình cho chuyển đổi chương trình đơn  trong thành phần nội bộ. 

1) Chương trình chuyển đổi trong 

thành phần nội bộ 

2) Thiết bị chia đầu vào đầu ra, ngoài ra thay thế các thiết 
bị nội bộ bằng 1 nhãn nội bộ. 

 

3) Khi chuyển sang FB 
 

  
Nhãn đầu vào  nhãn đầu        
ra 

Lập đầu vào và đầu ra(thiết lập tham biến) 

 

                           Hình vẽ  Ứng dụng. 9.2 Luồng của sự chuyển đổi thành phần nội bộ.

Đếm_số 

i_Đếm o_C_lên 

Nhãn 

đầu 

vào 

i_Count 

Nhãn 

đầu 
ra 

X1 i_Đếm 

INCP D1 INCP m_Cnt 

m_Cnt K12 o_C_lên o_c_lê
n 

D1 K12 Y12 

Đầu vào trong thiết 
bị  

Đâu ra Nhãn nội bộ 

  

 

FB 

 

  

  

 

Chuyển đổi 
nội bộ 
component 

      Đếm_Số 1 
I_Đếm    
o_c_Lên 

           Đếm_Số 2 
I_Đếm        
o_c_Lên 

Quy trính 
1 

Quy trình 2 
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Phụ lục 9.1.2   Ưu điểm của việc sử dụng FBS 

 
Phần này giới thiệu những ưu điểm của việc tạo ra các chương trình bằng cách sử dụng FBS 

(2) Chuong trình đơn giản 

Chương trình trình tuần tự có thể đã được tạo lập bằng cách dán FBs. Điều 

này giảm đáng kể phát triển chương trình man-hours.( Thư viện FB cung 

cấp bởi Công ty Mitsubishi Electric..) 
 

 
 

( 2 ) Đọc đơn giản 

       Sử dụng một FB tạo ra một chương trình đơn giản với chỉ một cái "box" 

      (FB), một đầu vào, và một đầu ra để tạo ra một chương trình tuần tự dễ đọc. 

 

 

Chỉ chọn FB từ Selection window và kéo thả 

nó 
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Converted 
into a component 

Developer A Developer B 

Quy trình riêng Quy trình riêng 

                              (3) Sử dụng lại 

Chuyển đổi chương trình chuẩn trong các thành phần cho phép chương trình 

có thể được sử dụng lại nhiều lần. 

Kết quả là hoạt động sao chép chương trình trình tuần tự và điều chỉnh thiết bị, 

thường đã yêu cầu trước đây, sẽ không cần thiết. 

                    

  
 

 
  

 

    
                              (4) Cải thiện chất lượng 

Chuyển đổi chương trình chuẩn vào thành phần như một FB để sử dụng lại 

chương trình cho phép phát triển chương trình với chất lượng không thay đổi, 

không dựa vào kỹ năng công nghệ của nhà phát triển chương trình. 

Khi nhà phát triển A và B đang phát triển chương trình tuần tự cho thiết bị khác, 

sử dụng FB tương tự cho xử lý chung tạo cơ hội cho nhà phát triển tạo ra chất 

lượng không thay đổi của chương trình tuần tự. 
 

 

 

 

 

  

FB chung 
 

  

  
 

 FB cho 

kiểm soát 

bắt đầu 

 

  

  

 

 FB cho 

kiểm soát 

bắt đầu 

 
  

  
 

 FB cho 

kiểm soát 

bắt đầu 

 
  

  
 

 FB cho 

kiểm soát 

bắt đầu 

 
  

  

 

Chuyển đổi 
thành phần 

Nhà phát triển 
A 

Nhà phát triển B 
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(5) Tài sản được bảo vệ 

                                              Do thiết lập mật khẩu khối, FB tạo ra có thể được bảo vệ sao cho nó không 

                                              thể xem được. 
 

 

 

 
 

 

Phụ lục 9.1.3 Thư viện FB 
Một thư viện FB là tập hợp các FBs đang sử dụng trong GX Works2 ( dự án Đơn 

giản ). Sử dụng thư viện FB cho phép dễ dàng sắp đặt và hoạt động của modules  

MELSEC-Q / L và sản phẩm đối tác. 

 
<Ví dụ của module MELSEC-Q /L> 

 

 
 

   
 

 

Sản phẩm đối tác 
family 

Thiết bị cảm ứng chuyển dộng 
lazes 

RFID Thiết bị cảm ứng 
tầm nhìn 

FB cho đối tác sản xuất 

Cảm ứng 
chuyển động 

lazes 

FB 

Cảm 

biến 

tầm 

FB 

RFID 

FB 

CC-Link 

Ethernet 

Chuyển đổi chương trình vào 

FB và bảo vệ nó bằng mật 

khaur. 

Chương trình trình tự liên 

quan đến kĩ thuật 
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<Ví dụ sản phẩm của đối tác > 
 

 
 

   
 

 
 

 

 

(1)  Đội hình thư viện FB 

       Thư viện FB bao gồm" FBs cho MELSEC-Q / L module" và" FBs cho sản 

       phẩm đối tác". 

 
(2)   Làm sao để có được thư viện FB 

       Thư viện FB có thể tải từ trang chủ của Mitsubishi Electric FA. 

       URL    http://www.mitsubishielectric.co.jp/fa/index.html 

       Cho thủ tục để đạt được thư viện FB, tham khảo Ứng dụng. 9.2.2" Chuẩn 

       bị trước khi dùng thư viện FB 

Nhóm sản phẩm đối tác 

Thiết bị cảm ứng chuyển dộng 
lazes 

 

RFID Thiết bị cảm ứng 
tầm nhìn 

 

FBS cho đối tác sản 
xuất products 

Cảm ứng 
chuyển động 

lazes 

FB 

Cảm 
biến 
tầm 

FB 

RFID 

FB 

CC-Link 

Ethernet 



App. - 73 

 

 

Phụ lục 9.1.4   Công cụ phát triển 

 

                                       GX Works2 ( dự ánĐơn giản ) ver 1.12 N hoặc sau đó phải phát triển chương trình 

                                       trình tự sử dụng FBs. 

 

GỢI Ý  

Tùy vào thư viện FB , hỗ trợ phiên bản GX Works2 có thể khác nhau. Đỗi với 

mỗi chi tiết nói về trang tải xuống của mỗi FB 

 

Phụ lục 9.1.5  FB quy cách và biện pháp phòng ngừa 

 
Quy cách và biện pháp phòng ngừa sau phải được hiểu rõ trước khi sử dụng FBs. 

 

1. FB không thể được dùng trong FB khác. 

2. Bởi vì một quy trình cụ thể được thêm vào FB khi một FB được bố trí, số 

lượng các bước tăng khi so sánh với một ladder được tạo ra mà không có 

một FB 

3. FBs không thể được dùng trong chương trình gián đoạn. 

4. FBS mà thực hiện không hoàn chỉnh trong vòng một lần quét không thể sử 

dụng trong các lệnh vòng lặp FOR đến NEXT theo hoặc các chương trình 

con. 
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Phụ lục 9.2  Tạo chương trình bằng cách sử dụng thư viện FB 

 
                                      Phần này giải thích thủ tục cho tạo chương trình bằng cách sử dụng thư viện FB 
 

Phụ lục 9.2.1 Các chương trình được tạo ra 

 

    Phần này giải thích cách sử dụng thư viện FB với ví dụ nhập vào giá trị tương tự 

    từ module đầu vào tương tự.  

 Ví dụ)  Đọc giá trị tương tự đến D10 từ module đầu vào tương tự ( Q64AD ) khi 

             công - tắc ( X2 ) được bật. 

Chương trình có thể dễ dàng được tạo ra bằng cách sử dụng một thư viện 
FB như sau. 

 

 
 

 

GỢI Ý  

FB tạo bởi người dùng khác với FB trong thư viện FB. 

Đối với các phương pháp sáng tạo của FB mới nhất, tham khảo "MELSOFT GX 

Works2 FB Quick Start Guide 

 

Khi công tắc X2 được bật FB đọc AD chuyển đổi dữ 

liệu cho dải kênh đặc biệt 

Thực 
hiện lệnh 

Giá trị tương 
đương tại 
đầu vào 

Giá trị tương đương lưu tại D10. 



App. - 75 

 

 

OK 

Phụ lục 9.2.2 Chuẩn bị trước khi dùng thư viện FB 

 

                                         Trước khi dùng thư viện FB, liên lạc nhà phân phối của bạn để nhận được nó.  

                                            ( Thư viện FB sẽ không được cài đặt khi cài đặt GX Works2. 
  

Theo giải thích thủ tục, hoạt động sử dụng thư viện FB cho Q64AD như một kiểu 

mẫu.. 

 
1) Khi các tập tin thu được từ các nhà phân phối của bạn là một tập tin định  

dạng zip,  
                                               giải nén "q64ad_v100a.zip". 
 

 

                                         2)    Nhắp đúp" setup. exe" trong" q64ad v100a". 
 
 

 
 
 

 
 
 

 

 

Double-click! 
 
 
 

 

 

 

3)   Màn hình cho cài đặt được hiển thị. Làm theo lời chỉ dẫn để hoàn tất cài đặt. 
 

 

                             4)   Hộp thoại sau đây được hiển thị khi cài đặt hoàn tất. Nhấp vào nút  

 

                                     để đóng hộp thoại 

 
 

 

Hoàn thành việc chuẩn bị trước khi sử dụng các thư viện FB. 

Click! 
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1) Click! 

3) Select! 

4) Click! 

5) Check! 

6) Click! 

Refresh FB List 

OK 

Phụ lục 9.2.3    Nhập vào thư viện FB dự án 

 

Phần này giải thích làm thế nào để nhập vào một thư viện FB cho module đầu vào 

analog (Q64AD) để được dán vào chương trình vào một dự án. 

Tạo dự án mới trước các hoạt động sau. (Hãy tham 

khảo phần 2.3.2) 

1)  1) Click [Dự án] → [Library] → 
[Install]. 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 

                                                                                               2) Hộp thoại Lắp đặt được hiển thị. 
 

 

                                                                                            3) Chọn" Q64AD" từ Thư viện Danh mục. 

 

                                                                                                4) Nhấp vào   

 

                                                                                      5) Kiểm tra thư viện để nhập khẩu. 

                                                                                                                                                      

 

                                                                                                6) Nhấp vào   
                

 

 
 

7) Các FBS nhập vào được trình bày dưới FB_Pool trong khung nhìn Dự ánvà hiển thị trong cửa sổ 

lựa chọn. 
 

 

 
 
 

 
 
 

 
 

. 
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Phụ lục 9.2.4     Dán FBS 

 

                                              Kéo và thả FBs để được dán đến cửa sổ chương trình từ góc nhìn Dự án 

                                              hay cửa sổ Lựa chọn. ( Kéo và thả từ góc nhìn Dự ánlà có thể từ 

                                              GX Works2 1.24A hoặc sau đó. ) 
                                              Quy trình nghiệp vụ  

1)  Dán" M + Q64AD ReadADVal" đến cửa sổ chương trình. 
 
 
 

 
 

 

 Cửa sổ lựa chọn 
 

 
 

 

Từ cửa sổ lựa chọn hoặc 

xem dự án, kéo và thả một 

FB đến nơi FB sẽ được 

dán. 
 

 
 
 

 

 

Cửa sổ Dự án 

 
2)  Không kết nối được với server. Bạn có thể thử lại sau vài giây 

. 
 

 

                                                     Để biết thêm chi tiết của thiết lập, tham khảo Đến trang sau. 
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OK 

OK 

Phụ lục 9.2.5 Cài đặt tên của dán FBs  

 
Khi thư viện FB được dán đến cửa sổ chương trình, hộp thoại tên đầu vào của FBs 

được dán( tên đối tượng FB ) được hiển thị. 

 

Tên đối tượng là một tên để phân biệt các FB. 

Tên tạm thời được tự động ấn định thành tên giải pháp. Để sử dụng tên, đóng hộp 

thoại bằng bấm 

      . 

Bảo đảm tên cũng không tồn tại trong chương trình cùng lúc khi thay đổi tên. 

 Ở phần này, mặc định được sử dụng.  
 Quy trình nghiệp vụ 

 

1)  Nhập tên tượng FB (" ReadADVal 1" trong ví dụ ) và bấm nút . 

nhập tên đối tượng FB . 
 

 
 

Click 
 

 

2) Các FB được dán vào cửa sổ chương trình. 
 

 
 

 

GỢI Ý  

Khi nhập vào tên đối tượng, lưu ý các điểm sau. 

• Trường hợp nhạy cảm 

• Chữ cái đầu tiên không thể là số. 

• Số lượng ký tự tối đa  cho  tên đối tượng là 16. 

 
Lỗi xảy ra nếu click OK với các thiết lập sau. 

(Khi viết chữ cái đầu tiên là số). 
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1) Click! 

2) Click! 

3)Hiển thị! 

Yes 

Phụ lục 9.2.6 Tạo ra đầu vào và đầu ra ladder 
Tạo ra phần ladder đầu vào và phần ladder đầu ra của FB dán để hoàn chỉnh   

chương trình. 

Tham khảo hình vẽ sau và nhập thông tin. 

 

Lệnh thi hành FB                

Module lắp đặt địa chỉ XY: 80 

Kênh số: 1 

FB đang chạy: ON 

Normal end: ON 

Error end: ON 

Lưu trữ code lỗi       .      

Lưu trữ giá trị số. 

 

 

 
 

Phụ lục 9.2.7 Thực hiện sự chuyển đổi / biên dịch 
Sự chuyển đổi / biên dịch phải được thi hành thành chương trình hoàn 

chỉnh. Sau đây giải thích làm thế nào để chuyển đổi / biên dịch tất cả 

các chương trình. 

1) Nhấp vào [Compile] → [Rebuild All]. 
 

 

 
 
 

 
 
 

 
 

 
 

2)  Thông báo bên trái được hiển thị. Click 

nút . 
 
 
 

 
 
 

 
 
 

 

 

 
 

3) Kết quả biên dịch được hiện thị trong 

cửa sổ đầu ra



 

 

Phụ lục 9.2.8 Ghi chương trình tuần tự 

                                        Đối với các thủ tục  để ghi chương trình tuần tự, tham khảo phần 2.7 ( 1 )"  

                                        Ghi dữ liệu đến CPU". 
Phụ lục 9.2.9 Thao tác kiểm tra 

Đối với các thủ tục để kiểm tra thao tác của chương trình đã tạo ra, tham khảo phần 

2.8 Giám sát Status Chương trình Ladder. 

Bật công - tắc ( X2 ) và xác nhận giá trị tương tự được đọc. 
 

 
 

                                      Nhắp đúp chuột FB trong chương trình tuần tự trên màn hình cho phép giám sát  
                                      của trạng thái chương trình tuần tự trong FB. 
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SH-081123ENG-A 

Bật công tắc 
(X10) 

Các giá trị analog 
hiện tại được hiển 



 

 



 

 

 

     
 

      
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

  

 

 
 

 

   
 

 
 

 

 
 

 

 

Khóa học cơ bản Q-series (cho GX Works2)                       
 

Tài liệu hướng dẫn khối điều khiển khả trình Mitsubishi 
 


